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Informazioni sulla Guida
In questo manuale viene introdotto il desktop KDE di SUSE Linux Enterprise®, oltre
a una vasta gamma di applicazioni a cui sarà possibile ricorrere durante l'utilizzo del
desktop KDE. Il manuale, che guida l'utente attraverso l'utilizzo di tali applicazioni e
lo assiste nell'esecuzione dei task principali, è rivolto prevalentemente agli utenti finali
che desiderano utilizzare KDE in modo efficiente nell'ambito delle proprie attività
quotidiane.

Il manuale è suddiviso nelle parti indicate di seguito:

Desktop KDE
Questa sezione consente di approfondire la conoscenza del desktop KDE e di
imparare a gestire le attività di base e quotidiane, utilizzando le applicazioni KDE
centrali e alcune piccole utility. KDE offre numerose possibilità di modificare e
personalizzare il desktop in base alle esigenze e ai desideri specifici di ogni utente.

Ufficio e collaborazione
In SUSE Linux Enterprise sono disponibili software per ufficio e collaborazione,
quali la suite OpenOffice.org, numerosi programmi per la gestione di e-mail e
calendario e applicazioni per conversazioni online. Sono inoltre disponibili
informazioni essenziali sulla gestione e lo scambio dei dati nel sistema: come
condividere i file in rete, come cercare e cifrare i dati in modo efficiente, come
gestire le stampanti.

Internet
Ecco come usare NetworkManager o KInternet per eseguire la connessione a
Internet. In questa sezione viene spiegato come utilizzare le applicazioni Internet
fornite con SUSE Linux Enterprise, quali Konqueror o il browser Web Firefox, un
gestore degli scaricamenti o un lettore di fonti di notizie.

Multimedia
In questa sezione vengono trattati argomenti quali applicazioni grafiche e audio,
fotocamere digitali e masterizzatori di CD e DVD.



1 Feedback
È possibile inviare i propri commenti e suggerimenti relativi a questo manuale e agli
altri documenti forniti con questo prodotto. Per inserire i commenti, utilizzare l'apposita
funzionalità disponibile in fondo a ogni pagina della documentazione online e immettere
eventuali commenti.

2 Documentazione aggiuntiva
Per questo prodotto &; sono disponibili manuali aggiuntivi. Se si desidera consultare
altre documentazioni per l'utente finale relative a SUSE Linux Enterprise, i seguenti
manuali possono offrire informazioni interessanti:

Guida rapida all'installazione
Elenca i requisiti di sistema e fornisce istruzioni dettagliate sul processo di
installazione di SUSE Linux Enterprise.

Guida per l'utente di GNOME
In questo manuale viene INTRODOTTO il desktop kde di SUSE Linux Enterprise®,
oltre a una vasta gamma di applicazioni a cui sarà possibile RICORRERE durante
l'utilizzo del desktop KDE. Il manuale, che guida l'utente attraverso l'utilizzo di
tali applicazioni e lo assiste nell'esecuzione dei task principali, è rivolto
prevalentemente agli utenti finali che desiderano utilizzare in modo efficiente le
applicazioni eseguite sul desktop GNOME.

Per una panoramica di tutti i manuali relativi a SUSE Linux Enterprise, consultare
http://www.novell.com/documentation/sled10/ da cui è possibile sia
scaricare i manuali sia accedere alle informazioni online disponibili nella Guida del
desktop.

3 Convenzioni della documentazione
Nel presente manuale vengono utilizzate le convenzioni tipografiche riportate di seguito.

• /etc/passwd: nomi di file e directory
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• segnaposto: sostituire segnaposto con il valore reale

• PERCORSO: PERCORSO della variabile d'ambiente

• ls, --help: comandi, opzioni e parametri

• utente: utenti o gruppi

• Alt, Alt + F1: un tasto o una combinazione di tasti da premere. I tasti vengono
rappresentati in maiuscolo come su una tastiera.

• File, File > Salva con nome: voci di menu, pulsanti

• Pinguini danzanti (capitolo Pinguini, ↑Altro manuale): riferimento a un capitolo
in un altro manuale.
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Parte I. KDE Desktop





1Introduzione al desktop di
KDE
Questo capitolo illustra i primi passi con il desktop KDE di SUSE Linux Enterprise®.
Se il sistema non è ancora stato installato, vedere Guida rapida all'installazione
all'indirizzo http://www.novell.com/documentation/sled10/.

KDE è l'acronimo di K Desktop Environment ed è un'interfaccia grafica utente dotata
di molte applicazioni progettate per aiutare l'utente nel lavoro giornaliero. KDE inoltre
offre molte opzioni per modificare il desktop in base alle proprie esigenze e desideri.
Ulteriori informazioni sulla configurazione del desktop sono disponibili nel Capitolo 2,
Personalizzazione delle impostazioni (p. 51).

La seguente descrizione si basa sulla configurazione di default del desktop KDE fornita
con il prodotto. Se l'utente o l'amministratore di sistema ha modificato le impostazioni
predefinite, alcune caratteristiche, come l'aspetto o le combinazioni di tasti di scelta
rapida, potranno risultare diverse.

1.1 Login e selezione di un desktop
Se sul computer è configurato più di un conto utente, in genere è necessario che tutti
gli utenti eseguano l'autenticazione, a meno che per un determinato utente sia configurato
il login automatico. Con il login automatico l'utente entra immediatamente nell'ambiente
desktop all'avviamento. Abilitare o disabilitare questa funzione durante l'installazione
oppure in qualsiasi momento usando il modulo di gestione degli utenti YaST.

Se il computer opera in rete e non viene utilizzato da una sola persona, viene solitamente
chiesto di fornire il nome utente e la password all'avvio del sistema. Se non si è impostato
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il sistema e il conto utente, chiedere all'amministratore di sistema i dati relativi a nome
utente e password.

Il programma che gestisce il processo di login dipende dall'ambiente desktop installato
sul sistema. Per KDE, è il programma KDM. Tuttavia, se nel sistema risulta installato
anche GNOME, potrebbe essere il programma GDM.

Come mostrato in Figura 1.1, "Schermata KDM di login" (p. 5), la finestra di login
predefinita di KDM contiene due campi di input per nome utente, password e le seguenti
voci di menu:

Session Type (Tipo di sessione)
Specifica il desktop da eseguire al login. Se sono installati desktop diversi da KDE,
questi verranno visualizzati nell'elenco. Modificare questa impostazione solo per
scegliere un tipo di sessione diverso da quello di default (solitamente KDE). Le
sessioni successive saranno automaticamente dello stesso tipo, salvo modifica
manuale del tipo di sessione.

Sistema
Esegue un'operazione di sistema, come lo spegnimento del computer o l'avvio di
operazioni di login diverse. Remote Login (Login remoto) consente di eseguire il
log in un computer remoto.

Per eseguire un login normale, immettere il nome utente e la password.
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Figura 1.1 Schermata KDM di login

Se l'amministratore di sistema ha creato una home directory cifrata per l'utente (che in
genere è utile come protezione da furto o rimozione non autorizzata dal disco rigido),
la home directory viene resa disponibile al login. Dopo il login, è possibile accedere
direttamente ai dati come al solito, senza dover immettere altre password.

NOTA: connessione a un server Active Directory

Per accedere a risorse di rete condivise, è possibile autenticare un client KDE
rispetto a un server Active Directory. Per ulteriori informazioni, fare riferimento
al Capitolo 9, Accesso alle risorse di rete (p. 173). Se il computer è configurato
per questo tipo di autenticazione, nella schermata di login è disponibile un
campo aggiuntivo. In questo caso, durante il login eseguire le operazioni
riportate di seguito.

1. Selezionare il dominio dall'elenco.

2. Digitare il nome utente Windows.

3. Specificare la password Windows e premere Enter.
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1.1.1 Controllo di una sessione
Il manager di sessione viene avviato dopo l'autenticazione di nome utente e password
da parte del processo di login, che consente di salvare determinate impostazioni per
ciascuna sessione. Questa funzione consente di salvare lo stato della sessione più recente
e di ritornare a tale stato al successivo login.

Il Manager di sessione consente di salvare e ripristinare le seguenti impostazioni:

• Impostazioni sull'aspetto e il comportamento, come font, colori e impostazioni del
mouse.

• Applicazioni in esecuzione, come un file manager o OpenOffice.org

NOTA: salvataggio e ripristino di applicazioni

Non è possibile salvare e ripristinare applicazioni non gestite dal Manager
di sessione. Se ad esempio si avvia l'editor VI dalla riga di comando in una
finestra del terminale, il Manager di sessione non potrà ripristinare la
sessione di modifica.

Per informazioni sulla configurazione delle preferenze di sessione, vedere Componenti
di KDE (p. 53).

1.1.2 Passaggio da un desktop all'altro
Se sono stati installati entrambi i desktop GNOME e KDE, utilizzare le seguenti
istruzioni per passare da un desktop all'altro.

1 Se si è effettuato il login in KDE, dal menu principale selezionare Logout >
Termina sessione corrente. Nella schermata di login, fare clic su Session Type
(Tipo di sessione).

2 Selezionare il desktop GNOME.

3 Digitare il nome utente.

4 Immettere la password. Il desktop GNOME viene avviato.
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Per ulteriori informazioni sull'utilizzo del desktop GNOME, vedere Guida per
l'utente di GNOME su http://www.novell.com/documentation/
sled10/.

5 Per tornare nuovamente a KDE, nel pannello del desktop GNOME fare clic su
Desktop > Logout e quindi scegliere OK. La sessione si chiude e viene
nuovamente visualizzata la schermata di login.

6 Prima di eseguire un ulteriore accesso, fare clic su Tipo sessione e selezionare
KDE nella schermata di login. Se non si seleziona un nuovo tipo di sessione, la
sessione successiva sarà dello stesso tipo (GNOME) di quella precedente.

1.1.3 Blocco dello schermo
Per bloccare lo schermo, procedere in uno dei seguenti modi:

• Dal menu principale, scegliere Lock Session (Blocca sessione).

• Utilizzare la combinazione di tasti di scelta rapida definita nel Centro di controllo
KDE. Solitamente, è Ctrl + Alt + L.

SUGGERIMENTO: Ricerca delle combinazioni di tasti di scelta rapida
KDE

Per altre combinazioni di tasti di scelta rapida, consultare il centro di
controllo KDE descritto nella Sezione 2.1, "Uso del Centro di controllo KDE"
(p. 51).

Per l'accesso rapido, è possibile anche aggiungere al pannello le icone Lock (Blocca)
e Logout. Per effettuare questa operazione, fare clic con il pulsante destro del mouse
sul pannello e selezionare Add Applet to Panel (Aggiungere applet al pannello). Nella
finestra successiva selezionare Pulsanti di uscita e bloccaggio schermo e fare clic su
Aggiungi a pannello.

Al blocco dello schermo, viene avviato lo screen saver. Per sbloccare lo schermo,
spostare il mouse per visualizzare la finestra di dialogo del blocco dello schermo.
Digitare nome utente e password, quindi premere Enter.
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Per informazioni sulla configurazione dello screen saver, vedere Configurazione dello
screen saver (p. 56).

1.2 Logout
Quando si desidera terminare la sessione, è possibile effettuare il logout e lasciare il
sistema in esecuzione oppure riavviare o spegnere il computer. Se il sistema offre
funzioni di risparmio energetico, è possibile anche sospendere il computer in modo da
accelerare l'avvio successivo, rispetto ad un avvio completo in caso di spegnimento.

Per effettuare il logout e lasciare il sistema in esecuzione, procedere in uno dei seguenti
modi:

• Dal menu principale, scegliere Log Out (Logout) > End Current Session (Termina
sessione corrente.

• Utilizzare la combinazione di tasti definita nel Centro di controllo KDE. In genere,
per eseguire il logout con conferma, si utilizza Ctrl + Alt + Canc. Nella finestra di
dialogo successiva è ancora possibile annullare il processo di logout. Se si desidera
effettuare il logout senza alcuna conferma, premere Ctrl + Alt + Shift + Canc.

• Fare clic sull'icona Logout presente nel pannello. Se il pannello non contiene l'icona
di logout, è possibile aggiungerla come descritto nella Sezione 1.1.3, "Blocco dello
schermo" (p. 7).

1.3 Componenti del desktop
L'ambiente desktop grafico non dovrebbe creare alcun problema agli utenti provenienti
da piattaforme Windows o Macintosh. I componenti principali sono le icone presenti
sul desktop e il pannello presente nella parte inferiore dello schermo.
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Figura 1.2 Esempio di desktop KDE

Le icone rappresentano file, directory, applicazioni, funzioni e supporti estraibili, come
CD o DVD.

Per default, sul desktop sono presenti le icone seguenti:

cestino
Contiene le cartelle e i file che sono stati eliminati. Per informazioni sull'utilizzo
del Cestino, vedere Sezione 1.3.4, "Gestione del Cestino" (p. 19).

Risorse del computer
Visualizza informazioni su hardware, stato della rete, sistema operativo, dischi
rigidi, cartelle comuni e dispositivi rimovibili. Per ulteriori informazioni, fare
riferimento alla Sezione 1.3.3, "Accesso ai supporti rimovibili" (p. 17).

Navigazione rete locale
Visualizza i servizi di rete a cui è possibile accedere. Per alcuni di questi servizi
può essere necessaria l'autenticazione. Per ulteriori informazioni, fare riferimento
al Capitolo 9, Accesso alle risorse di rete (p. 173).
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Stampante
Apre KJobViewer, che visualizza i lavori di stampa inviati alle stampanti. Per
ulteriori informazioni, vedere la Sezione 12.4, "Avvio dei lavori di stampa in KDE"
(p. 211).

Firefox
Apre il browser Web Firefox. Per ulteriori informazioni, fare riferimento al
Capitolo 15, Navigazione con Firefox (p. 235).

Ufficio
Apre un nuovo documento OpenOffice.org. Per un'introduzione a questi programmi
per l'ufficio, fare riferimento al Capitolo 3, Suite per l'ufficio OpenOffice.org (p. 75).

Il pannello, (denominato anche "Kicker" in KDE), è una barra che si trova solitamente
nella parte superiore o inferiore dello schermo. La funzione di tale barra è fornire
informazioni sull'esecuzione delle applicazioni o del sistema e di consentire un rapido
accesso ad alcune funzioni o applicazioni importanti. Se si tiene premuto il puntatore
del su di un'icona, viene visualizzata una breve descrizione.

Figura 1.3 Pannello KDE (Kicker)

Il pannello presenta solitamente le seguenti aree:

Icona del menu principale
Di default, la parte sinistra del pannello presenta un'icona che apre il menu
principale, simile al pulsante di avvio del desktop di MS Windows. Il menu
principale presenta una struttura ben ordinata per l'accesso alle applicazioni
principali. Inoltre, contiene le voci di menu per le funzioni principali, come il logout
o la ricerca di applicazioni. Per ulteriori informazioni, consultare Sezione 1.3.1,
"Accesso al menu principale" (p. 11).

Avvio veloce
Accanto all'icona del menu principale, si trova la barra di avvio veloce. Presenta
alcune icone per le funzioni o applicazioni più importanti, per consentirne l'avvio
senza il ricorso al menu principale. Contiene inoltre un'icona per il Centro di aiuto,
che offre una guida online per il sistema.
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Previsualizzatore desktop
Accanto alla barra di avvio veloce, si trova il previsualizzatore desktop, che mostra
i diversi desktop. Questi desktop virtuali consentono all'utente di organizzare il
proprio lavoro. Se si utilizzano molti programmi contemporaneamente, può essere
opportuno eseguire alcuni programmi in un desktop e altri programmi in un altro.
Per passare da un desktop all'altro, fare clic sul simbolo del desktop nel pannello.

Barra delle applicazioni
La barra delle applicazioni è posizionata accanto al previsualizzatore desktop. Per
default, tutte le applicazioni in esecuzione e le finestre aperte vengono visualizzate
sulla barra delle applicazioni, che consente l'accesso a qualsiasi applicazione
indipendentemente dal desktop attivo. Se si fa clic sul titolo di una finestra nella
barra delle applicazioni, l'applicazione verrà visualizzata in primo piano. Se
l'applicazione è già in primo piano, verrà ridotta a icona.

Barra delle applicazioni di sistema
La parte all'estrema destra del pannello presenta l'orologio del sistema, il controllo
del volume e varie applicazioni di aiuto.

Per informazioni sulla configurazione dell'aspetto e del comportamento del desktop,
inclusi menu principale, pannello o icone, fare riferimento alla Sezione 2.2,
"configurazione degli oggetti del desktop" (p. 55) e alla Sezione 2.4, "Configurazione
del pannello" (p. 61).

1.3.1 Accesso al menu principale
È possibile visualizzare il menu principale facendo clic sull'icona all'estrema sinistra
del pannello. In alternativa, premere Alt + F1. Il menu principale è suddiviso nelle
sezioni Most Used Applications (Applicazioni più usate), Tutte le applicazioni (menu
con tutte le applicazioni ordinate per categorie) e Azioni. Le applicazioni che vengono
avviate più di frequente vengono visualizzate nella sezione Most Used Applications
(Applicazioni più utilizzate).

La struttura del menu, orientata alla funzione, rende più semplice individuare
l'applicazione adeguata al proprio scopo, anche quando ancora non si conoscono i nomi
delle applicazioni. Se si conosce il nome di un'applicazione (o almeno una parte di
esso), ma non si è sicuri di come avviarla dal menu principale, è possibile utilizzare la
funzione di ricerca contenuta nella sezione Tutte le applicazioni.
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Figura 1.4 Funzione di ricerca del menu principale

È sufficiente digitare una parte del nome dell'applicazione nel campo di ricerca, senza
successivamente premere il tasto. Enter Se l'applicazione è installata nel sistema, nel
menu principale viene evidenziata la struttura del menu che conduce all'applicazione.

La sezione seguente include le informazioni sulle numerose azioni che è possibile
attivare dal menu principale.

Documento
Elenca le cartelle e i file aperti più di recente. Quando si seleziona un documento,
viene avviata l'applicazione che ne consente la visualizzazione o la modifica. La
cronologia dei documenti può essere eliminata.

Sistema
Consente di accedere rapidamente ad alcune posizioni utilizzate di frequente, ad
esempio la home directory o i dispositivi multimediali.

Esegui comando
Apre una finestra di dialogo in cui è possibile specificare un comando per avviare
un'applicazione. Spesso, ma non sempre, il nome del comando equivale al nome
dell'applicazione scritto in lettere minuscole. Per utilizzare l'autocompletamento
del comando, digitarne le prime lettere e premere →|. Se è già stato eseguito in
precedenza e può essere identificato in modo univoco, il comando viene completato
in tutta la sua lunghezza.

Cambia utente
Per avviare una seconda sessione con un'interfaccia grafica utente nel computer,
scegliere Start New Session (Avvia nuova sessione). La sessione corrente continua
a rimanere attiva mentre viene visualizzata la schermata di login che consente di
accedere come utente diverso. Per tornare alla prima sessione, premere Ctrl + Alt
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+ F7. Per accedere a una nuova sessione, premere F8 anziché F7. Per accedere alle
altre sessioni, premere Ctrl + Alt + da F9 a F12.

Lock Session (Blocca sessione)
Se ci si allontana dal computer, è possibile impedire eventuali accessi non autorizzati
bloccando lo schermo. Dopo il blocco viene avviato uno screen saver. Per riaccedere
alla sessione, è necessario immettere una password. Per sbloccare la sessione,
immettere la normale password di login.

Logout
Viene aperta una finestra di dialogo con diverse opzioni: terminare la sessione
corrente, spegnere il computer, riavviare il computer o annullare il logout. L'opzione
Termina sessione corrente lascia il sistema in esecuzione e ripristina le applicazioni
per il login successivo. Se il sistema dispone di funzioni di risparmio energetico,
viene offerta l'opzione di sospendere il computer, in modo da rendere più rapido
l'avvio successivo.

1.3.2 Inserimento o collegamento di
supporti rimovibili

In genere, quando si inserisce o si collega al computer un dispositivo rimovibile, ad
esempio CD-ROM, fotocamere digitali o stick USB, questi vengono rilevati
automaticamente. In KDE viene visualizzata una finestra di dialogo che indica i tipi di
supporto rilevati e offre la possibilità di eseguire diverse operazioni con i supporti nuovi.
L'elenco delle opzioni disponibili dipende dal tipo di supporto inserito.
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Figura 1.5 Rilevamento automatico di uno stick USB in KDE

Per visualizzare i dati utilizzando un file manager, selezionareApri in una nuova finestra
e fare clic su OK. Viene visualizzato il file manager Konqueror, che riporta i contenuti
del dispositivo rimovibile.

Figura 1.6 Visualizzazione dei contenuti di uno stick USB

Se si desidera eseguire sempre la stessa azione a ogni inserimento di un supporto
rimovibile dello stesso tipo, nella finestra di dialogo del rilevamento automatico attivare
Always do this for this type of media (Esegui sempre questa azione per questo tipo di
supporto) prima di fare clic su OK.

Se si inserisce o connette un supporto removibile cifrato con LUKS (Linux Unified
Key Setup), KDE lo riconoscerà e chiederà la password, come mostrato in Figura 1.7,
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"Rilevazione automatica di uno stick USB cifrato" (p. 15). Immettere la password di
accesso al supporto cifrato.

Figura 1.7 Rilevazione automatica di uno stick USB cifrato

Per informazioni su come cifrare i supporti removibili, consultare sezione "Encrypting
the Content of Removable Media" (Capitolo 42, Encrypting Partitions and Files,
↑Deployment Guide).

Procedura 1.1 Configurazione della gestione dei supporti removibili

Nella finestra di rilevamento automatico è anche possibile configurare in che modo
KDE debba gestire diversi tipi di supporti removibili. Ad esempio, se si è certi che
un determinato tipo di supporto, utilizzato di frequente, conterrà sempre foto, è
possibile configurarlo in modo che apra automaticamente un visualizzatore di
immagini:

1 Nella finestra di dialogo del rilevamento automatico fare clic su Configura.

2 Viene visualizzata una finestra di dialogo, che contiene un elenco di tutte le azioni
disponibili.

3 Fare clic sull'elenco a discesa Medium types (Tipi di supporti) e selezionare il
tipo di supporto per il quale si desidera configurare una determinata azione.
Nell'elenco delle azioni disponibili sono presenti solo le azioni applicabili al tipo
di supporto selezionato.

4 Selezionare l'azione da intraprendere e fare clic su Toggle as Auto Action (Cambia
in azione automatica).
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Figura 1.8 Finestra di dialogo per la configurazione di KDE per supporti rimovibili

5 Fare clic sulla scheda Avanzate e verificare che la casella di controllo Enable
medium application autostart after mount (Attiva avvio automatico applicazione
per il supporto dopo il montaggio) sia selezionata.

6 Fare clic su OK per applicare le modifiche e chiudere la finestra di dialogo per
la configurazione. Dopo aver effettuato questa operazione, a ogni inserimento
di un supporto di questo tipo viene automaticamente eseguita l'azione configurata
e la finestra di dialogo per il rilevamento automatico non viene più visualizzata.

Procedura 1.2 Ripristino delle opzioni di default di gestione dei supporti

Per annullare l'azione assegnata e ripristinare le opzioni predefinite, eseguire le
operazioni riportate di seguito.

1 Avviare il Centro di controllo KDE dal menu principale selezionando Impostazioni
personali.

2 Nella parte sinistra della barra di navigazione fare clic su Periferiche > Supporti
di memorizzazione. La finestra di dialogo per la configurazione viene visualizzata
a destra.

3 Fare clic su Predefinito e su Applica. Al successivo inserimento di un supporto
viene nuovamente visualizzata la finestra di dialogo per il rilevamento automatico,
che offre all'utente la possibilità di decidere quale azione eseguire.
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1.3.3 Accesso ai supporti rimovibili
KDE offre diversi metodi che consentono di accedere ai supporti rimovibili in qualsiasi
momento. Se sul desktop si fa clic su Risorse del computer, viene visualizzata una vista,
come illustrato in Figura 1.9, "Risorse del computer" (p. 17).

Figura 1.9 Risorse del computer

Se come file manager si avvia Konqueror (vedere la Sezione 1.4, "Gestione di cartelle
e file con Konqueror" (p. 19)) e si fa clic su Supporti di memorizzazione nella prima
finestra o si digita media:/ sulla barra di posizione, Konqueror visualizza i dispositivi
di memorizzazione come illustrato in Figura 1.10, "Visualizzazione dei supporti in
Konqueror" (p. 18).
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Figura 1.10 Visualizzazione dei supporti in Konqueror

Konqueror consente inoltre di assegnare un nome ai dispositivi rimovibili, ad esempio
agli stick USB. In Konqueror fare clic con il pulsante destro del mouse sullo stick USB
e selezionare Proprietà. Nella scheda Generale immettere un nome nel campo di input
e fare clic su OK. Al successivo inserimento dello stick, Konqueror ne visualizzerà il
nome.

Una piccola freccia verde indica che un supporto è stato montato, ovvero integrato nel
file system, operazione necessaria per poter accedere ai dati memorizzati nel supporto
stesso. In genere, in SUSE Linux Enterprise l'utente non deve eseguire il montaggio
dei dispositivi rimovibili, poiché questo viene automaticamente effettuato per default.

NOTA: rimozione sicura dei supporti

Se si desidera rimuovere o scollegare un supporto dal computer, verificare che
i dati presenti nel supporto non siano correntemente utilizzati da applicazioni
o utenti. In caso contrario, potrebbe verificarsi una perdita di dati. Per una
rimozione sicura del supporto, eseguire le operazioni riportate di seguito.
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1. Aprire una vista in cui siano indicati tutti i supporti rimovibili.

2. Fare clic con il pulsante destro del mouse sul supporto da rimuovere e
selezionare Rimozione sicura o Espelli. L'opzione Rimozione sicura disattiva
il supporto per consentirne la disconnessione dal computer. L'opzione
Espelli provoca l'apertura automatica dell'unità CD o DVD del computer.

1.3.4 Gestione del Cestino
Il cestino è una directory per i file contrassegnati per la cancellazione. Trascinare nel
cestino le icone dal file manager o dal desktop, tenendo premuto il pulsante sinistro del
mouse. Quindi rilasciare il pulsante per depositare gli oggetti trascinati. In alternativa,
fare clic con il pulsante destro del mouse su un'icona e selezionare Move to Trash
(Sposta nel cestino) dal menu. Fare clic sull'icona del cestino per visualizzarne il
contenuto. È possibile recuperare l'elemento dal cestino, se necessario.

I file rimossi con Cancella non vengono spostati nel cestino, ma eliminati
definitivamente. Per eliminare i file dal cestino in modo definitivo, fare clic con il
pulsante destro del mouse sull'icona del cestino e selezionare Empty Trash Bin (Svuota
il cestino).

1.4 Gestione di cartelle e file con
Konqueror

Konqueror include le funzioni di browser Web, file manager, visualizzatore di documenti
e visualizzatore di immagini. Nelle sezioni riportate di seguito è descritto l'utilizzo di
Konqueror per la gestione dei file. Per informazioni su Konqueror come browser Web,
vedere il Capitolo 14, Navigazione con Konqueror (p. 227).

Per avviare Konqueror come file manager, fare clic sull'icona della casa nel pannello.
Viene visualizzato il contenuto della home directory.
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Figura 1.11 File manager Konqueror

La finestra del file manager Konqueror è composta dai seguenti elementi:

Barra dei menu
La barra dei menu contiene le voci di menu relative a operazioni quali copia,
spostamento o eliminazione di file, modifica di visualizzazioni, avvio di strumenti
aggiuntivi, definizione delle impostazioni e guida online.

Barra degli strumenti
La barra degli strumenti consente l'accesso rapido alle funzioni utilizzate più di
frequente, alle quali è possibile accedere anche tramite il menu. Se si posiziona il
puntatore su di un'icona, viene visualizzata una breve descrizione. Sulla parte destra
della barra degli strumenti è visualizzata l'icona di Konqueror che viene animata
durante il caricamento di directory o pagine Web.

Barra degli indirizzi
La barra degli indirizzi mostra il percorso della directory o del file all'interno del
file system. È possibile inserire direttamente il percorso di una directory digitandolo
o facendo clic su una delle directory nel campo di visualizzazione. È possibile
eliminare il contenuto di una riga facendo clic sul simbolo nero con una X bianca
che si trova a sinistra della barra degli indirizzi. Dopo aver digitato un indirizzo,
premere Enter o fare clic su Go (Vai) a destra della riga di input.
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A differenza di un sistema operativo Windows, Linux non usa le lettere di unità.
In Windows, l'unità floppy viene chiamataA:\, i dati del sistema Windows vengono
posti nell'unità C:\ e così via. In Linux, tutti i file e le directory sono posti in una
struttura ad albero. La directory superiore è detta radice del file system o
semplicemente /. Tutte le altre directory sono accessibili a partire da questa. Di
seguito, una breve panoramica delle directory più importanti di un file system
Linux:

/home contiene i dati privati di tutti gli utenti che hanno un conto nel sistema. I
file collocati qui possono essere modificati dai rispettivi proprietari o
dall'amministratore di sistema. Ad esempio, la directory delle e-mail è collocata
qui.

NOTA: Home directory in un ambiente di rete

Se si opera in un ambiente di rete, l'home directory potrebbe non essere
denominata /home, ma essere mappata a qualsiasi directory presente nel
file system.

/media di norma contiene tutti i tipi di unità salvo il disco rigido del sistema.
L'unità della memoria flash USB verrà visualizzata sotto /media dopo averla
collegata, analogamente alla fotocamera digitale (se usa USB) e all'unità DVD o
CD.

La directory /usr/share/doc contiene tutta la documentazione sul sistema
Linux e i pacchetti installati. La sottodirectory manual contiene una copia del
presente manuale, così come altri manuali, nonché le note di rilascio della versione
di Linux installata. La directory packages contiene la documentazione inclusa
nei pacchetti software.

La directory /windows viene visualizzata solo se sul sistema sono installati sia
MS Windows, che Linux. Contiene i dati MS Windows.

Per ulteriori informazioni sul file system di Linux e per un elenco completo delle
directory, vedere la sezione "Linux Directory Structure" (Capitolo 15, Working
with the Shell, ↑Deployment Guide).

Pannello di navigazione
È possibile nascondere e visualizzare il pannello di navigazione, premendo F9. Il
pannello di navigazione visualizza le informazioni in una struttura ad albero. Per
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stabilire quali contenuti si desidera vedere, fare clic su uno dei simboli della scheda
a sinistra del pannello di navigazione. Se si tiene premuto il puntatore del mouse
su di un'icona, viene visualizzata una breve descrizione. Ad esempio, è possibile
visualizzare la struttura ad albero del file system a partire dalla cartella root o dalla
cartella home.

Campo di visualizzazione
Il campo di visualizzazione mostra il contenuto della directory o del file selezionati.
Nel menu Visualizza scegliere tra diverse modalità di visualizzazione del contenuto,
ad esempio Vista a icone, Vista ad albero o Vista a lista dettagliata. Se si fa clic
su un file, Konqueror mostra un'anteprima del contenuto oppure carica il file in
un'applicazione per un'elaborazione successiva. Se si tiene fermo il puntatore del
mouse sul file, Konqueror mostra una descrizione con informazioni dettagliate sul
file, ad esempio proprietario, permessi o data dell'ultima modifica.

Per default, Konqueror non mostra i file nascosti. Questi sono spesso i file di sistema
a cui, in genere, non si desidera accedere o si preferisce non visualizzare. In Linux
i file nascosti possono essere individuati dal punto che li precede. Per attivare o
disattivare la visualizzazione dei file nascosti, selezionare Visualizza > Visualizza
file nascosti.

1.4.1 Copia, spostamento o eliminazione di
file

Per l'esecuzione di operazioni come copia, spostamento o eliminazione di file, è
necessario disporre dei permessi appropriati per le cartelle e i file in questione. Ulteriori
informazioni sulla modifica dei permessi di accesso sono disponibili in Sezione 1.4.3,
"Modifica dei permessi di accesso" (p. 24).

SUGGERIMENTO: selezione degli oggetti in Konqueror

Facendo clic su un file o su una cartella in Konqueror viene eseguita un'azione:
la visualizzazione del file oppure l'apertura della cartella. Per gli ex utenti di
MS Windows, questo comportamento può apparire insolito. Se si desidera solo
selezionare uno o più file senza attivare altre azioni, premere Ctrl, quindi fare
clic sull'oggetto. In alternativa, modificare le impostazioni del mouse nel Centro
di controllo KDE (vedere Peripherals (Periferiche) (p. 54)).
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Per copiare o spostare un file o una cartella, procedere come segue:

1 Fare clic con il pulsante destro del mouse sull'oggetto, quindi scegliere Copia o
Taglia dal menu contestuale. L'oggetto viene memorizzato negli Appunti.

2 Accedere alla cartella di destinazione in cui si desidera inserire l'oggetto. Fare
clic con il pulsante destro del mouse su tale cartella e selezionare Incolla.
L'oggetto viene copiato o spostato nella posizione indicata.

Il modo più veloce per eseguire operazioni come la copia o lo spostamento degli oggetti
in Konqueror è il metodo trascina-e-rilascia. Ad esempio, è possibile spostare senza
difficoltà gli oggetti da una finestra a un'altra semplicemente trascinandoli. Al rilascio
degli oggetti, verrà chiesto se gli oggetti devono essere spostati o copiati.

Per eliminare un file o una cartella, procedere come segue:

• Selezionare l'oggetto, quindi premere Canc o fare clic con il pulsante destro del
mouse sul file e scegliere Sposta nel cestino dal menu contestuale. L'oggetto viene
spostato nel cestino. Se necessario, è possibile ripristinare il file o la cartella oppure
cancellarli completamente. Vedere anche la Sezione 1.3.4, "Gestione del Cestino"
(p. 19).

• Per eliminare definitivamente l'oggetto, fare clic su Modifica > Elimina o premere
Shift + Canc. Se si desidera aggiungere al menu contestuale l'opzione Elimina,
configurarla in Konqueror facendo clic su Impostazioni > Configura konqueror >
Comportamento e attivando la relativa casella di controllo.

1.4.2 Creazione di una nuova cartella
Per creare una nuova cartella in Konqueror, eseguire le operazioni riportate di seguito.

1 Fare clic con il pulsante destro del mouse sulla cartella in cui aggiungere una
sottocartella.

2 Selezionare Crea cartella.

3 Nella finestra di dialogo Nuova cartella digitare un nome, quindi premere OK.
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1.4.3 Modifica dei permessi di accesso
Poiché Linux è un sistema multiutente, ogni file presente in un file system Linux
appartiene a un utente e a un gruppo. Tutti gli utenti, inclusi i superuser, possiedono
home directory proprie, in cui possono memorizzare dati privati, quali documenti,
segnalibri o e-mail. Per default, l'accesso in scrittura a queste home directory è
esclusivamente riservato al proprietario. In qualità di proprietario del file o della
directory, l'utente può modificare i permessi di accesso ai file. Ad esempio, è possibile
proteggere i file contenenti dati sensibili contro l'accesso in lettura da parte di alcuni
utenti e autorizzarne invece altri a scrivere, leggere o eseguire alcuni di tali file, se
necessario.

Per ogni oggetto file in un sistema Linux tradizionalmente vengono definiti tre set di
autorizzazioni. Questi set includono le autorizzazioni di lettura ( r ), scrittura ( w )
ed esecuzione ( x ) per tre diversi tipi di utenti, ovvero il proprietario del file, il gruppo
e gli altri utenti. Per ulteriori informazioni sul concetto di utente di Linux, fare
riferimento alla sezione "Users and Access Permissions" (Capitolo 15, Working with
the Shell, ↑Deployment Guide). Per modificare i permessi di accesso in una shell,
anziché utilizzare il metodo "tradizionale" è possibile ricorrere all'interfaccia grafica
utente fornita da Konqueror.

Per impostare i permessi relativi a un file, in Konqueror scegliere una delle opzioni
seguenti:

Vietato
Gli utenti possono visualizzare il nome del file nel file system, ma non possono
aprirlo, né leggerlo.

Can Read (Permesso lettura)
Gli utenti possono aprire il file e leggerlo, ma non apportarvi modifiche.

Can Read & Write (Permesso lettura e scrittura)
Gli utenti possono aprire, leggere e modificare il file.

Per impostare i permessi per una cartella, in Konqueror sono disponibili le opzioni
seguenti:

Vietato
Gli utenti possono visualizzare il nome della cartella nel file system, ma non possono
aprirla.
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Can View Content (Permesso visualizzazione contenuto)
Gli utenti possono visualizzare i contenuti della cartella.

Can View & Modify Content (Permesso visualizzazione e modifica contenuto)
Gli utenti possono visualizzare i contenuti della cartella e creare nuovi file o
sottocartelle.

Per modificare i permessi di accesso:

1 Aprire Konqueror e selezionare la cartella o il file per cui si desidera modificare
i permessi di accesso.

2 Fare clic con il pulsante destro del mouse e selezionare Proprietà. Verrà
visualizzata una nuova finestra di dialogo.

3 Fare clic sulla scheda Permessi. Nella parte inferiore della schermata viene
visualizzato il proprietario del file o della cartella. Nella parte superiore sono
indicati i permessi di accesso correnti.

4 Negli elenchi Proprietario, Gruppo e Altri selezionare i permessi da impostare
per il file o la cartella.

5 Fare clic su OK per applicare le modifiche.

Oltre a questo concetto tradizionale di permesso per gli oggetti del file system, in
Konqueror è possibile utilizzare anche gli elenchi di controllo dell'accesso (ACL, Access
Control List). Tramite gli ACL è possibile definire le autorizzazioni in modo più
flessibile rispetto al meccanismo convenzionale. Questi consentono infatti di assegnare
permessi a singoli utenti o gruppi, anche quando non corrispondono al proprietario
originale o al gruppo proprietario. Per ulteriori informazioni sugli ACL, fare riferimento
a Capitolo 13, Access Control Lists in Linux (↑Deployment Guide).

Per concedere a determinati utenti o gruppi i permessi di accesso a un file o a una
cartella, eseguire le operazioni riportate di seguito.

1 Aprire Konqueror e selezionare la cartella o il file per cui si desidera modificare
i permessi di accesso.

2 Aprire la finestra di dialogo Proprietà del file o della cartella e scegliere la scheda
Permessi.
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3 Fare clic su Advanced Permissions (Permessi avanzati). La finestra di dialogo
riportata di seguito mostra i permessi correnti relativi all'oggetto.

4 Fare clic su Aggiungi voce.

5 Per concedere a un utente il permesso di accesso al file o alla cartella, selezionare
NamedUser (Utente denominato) e scegliere uno degli utenti presenti nell'elenco.

Per concedere a un gruppo il permesso di accesso al file o alla cartella, selezionare
Named Group (Gruppo denominato) e scegliere uno dei gruppi dell'elenco.

6 All'interno della finestra di dialogo Advanced Permissions (Permessi avanzati),
l'utente o il gruppo aggiunto risulta presente nell'elenco che indica i permessi
correnti. I segni di spunta verdi nelle colonne r, w e x indicano che la cartella o
il file è stato visualizzato, modificato e aperto dall'utente.
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7 Per modificare i diritti di accesso dell'utente, fare clic sui segni di spunta
corrispondenti a tale utente nella colonna r, w o x.

8 Quando tutti i permessi di accesso risultano impostati come desiderato, fare clic
su OK per chiudere la finestra di dialogo.

9 Fare clic su OK per applicare le modifiche e chiudere la finestra di dialogo
Proprietà.

1.4.4 Modifica di associazioni di file
Con Konqueror è possibile decidere quale applicazione utilizzare per l'apertura di un
determinato file.

Figura 1.12 Configurazione delle associazioni di file in Konqueror

1 In Konqueror, fare clic su Impostazioni >Configura konqueror >File Associations
(Associazioni di file).

2 Per cercare un'estensione, digitarla in Find Filename Pattern (Trova modello di
nome file). Nell'elenco verranno visualizzati solo tipi di file di tipo corrispondente.
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Ad esempio, per modificare l'applicazione per i file *.png, digitare png in Find
Filename Pattern (Trova modello di nome file).

3 Nell'elenco Known Types (Tipi conosciuti), fare clic sul tipo di file per aprire una
finestra di impostazione per quel tipo di file. È inoltre possibile modificare l'icona,
lo schema del nome file, la descrizione e l'ordine delle applicazioni.

Se lo strumento non è presente in elenco, fare clic su Aggiungi in Application
Preference Order (Ordine di preferenza applicazioni), quindi digitare il comando.

Per modificare l'ordine delle voci in elenco, fare clic sul programma da spostare
e assegnargli una priorità maggiore o minore con Move Up (Sposta in alto) o
Move Down (Sposta in basso). La prima applicazione elencata è quella utilizzata
per default quando si fa clic su questo tipo di file.

4 Se si desidera che un tipo di file non appaia nell'elenco Known Types (Tipi
conosciuti), fare clic su Aggiungi per aprire una finestra di dialogo in cui è
possibile selezionare un gruppo e digitare un nome. Il gruppo determina il tipo
principale, ad esempio, audio, immagine, testo o video. In genere, il tipo di file
può essere assegnato ad uno di tali gruppi.

4a Fare clic su OK, quindi determinare le estensioni per il nome file.

4b Inserire una descrizione nel campo di testo e selezionare l'applicazione da
utilizzare.

5 Fare clic su OK.

1.4.5 Salvataggio dei profili di
visualizzazione

Per modificare temporaneamente la visualizzazione di determinate cartelle, selezionare
una diversa ViewMode (Modalità di visualizzazione) nel menu Visualizza. Per applicare
queste modifiche a tutte le cartelle, è possibile salvare le opzioni in un profilo di
visualizzazione. Per effettuare questa operazione, modificare la visualizzazione come
desiderato e fare clic su Impostazioni > Configure View Profiles (Configura profili di
visualizzazione). Specificare un nome per il profilo da salvare e fare clic su Salva. La
visualizzazione di tutte le cartelle viene modificata e salvata in questo profilo. Il profilo
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può essere caricato in qualsiasi momento facendo clic su Impostazioni > Load View
Profile (Carica profilo di visualizzazione). Per default, Konqueror contiene numerosi
profili di visualizzazione progettati per varie attività. Questi profili possono inoltre
essere utilizzati come bozze e modificati in base alle proprie esigenze.

1.4.6 Accesso alle fotocamere digitali con
Konqueror

Con Konqueror è possibile accedere alla fotocamera digitale. Collegare la fotocamera
alla porta USB. L'icona di una fotocamera verrà visualizzata sul desktop. Fare clic su
questa icona per aprire la fotocamera in Konqueror. È possibile accedere alla fotocamera
anche immettendo l'URLcamera:/ in Konqueror. Esplorare la struttura della directory
della fotocamera per visualizzare i file. Utilizzare le consuete funzioni di gestione dei
file di Konqueror per copiare i file come desiderato.

1.4.7 Visualizzazione di immagini con
Konqueror

Konqueror può anche essere utilizzato come visualizzatore di immagini. Per un'anteprima
rapida e funzionale delle immagini di una directory, selezionare la directory e fare clic
sull'icona di visualizzazione delle immagini nella barra degli strumenti. Konqueror
genera miniature e le visualizza sul lato sinistro della finestra. Fare clic su una miniatura
per visualizzare l'immagine interamente sul lato destro della finestra. Nella barra degli
strumenti vengono visualizzate icone aggiuntive che consentono di passare da
un'immagine ad un'altra, di ingrandire o ruotare le immagini o creare una presentazione.
Per passare nuovamente alla visualizzazione "normale", fare clic su Vista a icone o
Vista ad albero nella barra degli strumenti.

Oltre a questa funzionalità è possibile creare gallerie per visualizzare le immagini sotto
forma di album. Aprire la directory delle immagini in Konqueror e selezionare Tools
> Create Image Gallery (Strumenti, crea una galleria di immagini). Verrà aperta una
finestra di dialogo in cui è possibile specificare i colori di sfondo e primo piano, il titolo
della pagina, l'ubicazione in cui salvare la galleria e altre impostazioni. Fare clic su OK
per avviare l'azione. Per default, viene creato il file index.html. Se si fa clic sul file
in Konqueror, le immagini verranno organizzate e visualizzate sotto forma di miniature.
Fare clic sulle immagini per visualizzarle interamente.
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Figura 1.13 Creazione di un'immagine con Konqueror

Per visualizzare le immagini è possibile utilizzare Gwenview. Per avviare Gwenview,
premere Alt + F2 e digitare gwenview. Per ulteriori informazioni su Gwenview,
consultare la relativa guida online.

Per scaricare fotografie da una fotocamera digitale, utilizzare Digikam come descritto
nel Capitolo 19, Gestione delle raccolte di immagini digitali (p. 279).

1.5 Accesso alle risorse di rete
Dal desktop è possibile accedere ai file e alle directory o a determinati servizi su host
remoti, oppure è possibile rendere disponibili i propri file e le proprie directory ad altri
utenti della rete. SUSE Linux Enterprise offre diverse modalità di accesso e creazione
alle risorse condivise in rete. Se la struttura della rete e la configurazione del computer
lo consentono, è possibile utilizzare il file manager Konqueror per esplorare la rete
senza difficoltà alla ricerca di servizi e risorse condivise.

Per farlo, fare clic sull'icona Navigazione rete locale presente sul desktop o aprire
Konqueror e digitare il comando remote:/ nella barra di posizione. La finestra
visualizza i tipi di condivisione di rete cui è possibile accedere. Fare clic su un tipo di
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risorsa di rete, quindi scegliere la condivisione di rete a cui si desidera accedere. È
possibile che venga richiesta l'autenticazione della risorsa tramite l'inserimento di un
nome utente e di una password.

Figura 1.14 Gruppi di lavoro in una rete Windows

Per ulteriori informazioni, vedere Capitolo 9, Accesso alle risorse di rete (p. 173).

1.6 Individuazione di dati nel
computer o nel file system

KDE fornisce più di un'applicazione per l'individuazione di dati nel computer o nel file
system. Con Kerry, è possibile eseguire senza difficoltà ricerche nello spazio delle
informazioni personali (in genere nella propria cartella principale) per trovare documenti,
e-mail, cronologia Web, conversazioni IM/ITC, codice sorgente, immagini, file musicali,
applicazioni e molto altro ancora. Per ulteriori informazioni, fare riferimento al
Capitolo 11, Esecuzione di ricerche con Kerry (p. 201).

Con KFind è possibile individuare i file desiderati nel computer o nel file system grazie
a diversi criteri di ricerca, quali contenuto o dimensione del file, date e proprietario.
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Avviarla dal menu principale con Applications (Applicazioni) > Find Files/Folders
(Trova file/cartelle). In alternativa, premere Alt + F2 e digitare il comando kfind.

Figura 1.15 Individuazione di file con KFind

1.6.1 Ricerca dei file
Per eseguire una ricerca per un determinato nome di file, procedere come segue:

1 Avviare KFind dal menu principale o dalla riga di comando.

2 Fare clic sulla schedaName/Location (Nome/Ubicazione) per eseguire una ricerca
di base.

3 Nel campo Named (Nome) specificare il nome del file da trovare. È possibile
utilizzare i seguenti caratteri jolly:

Asterisco
L'asterisco (*) rappresenta un numero qualsiasi di caratteri mancanti (anche
zero). Se ad esempio si specifica marc* come termine di ricerca, sarà
possibile trovare i file marc, marc.png e marc_non_deve_leggerlo.kwd. Se
invece si specifica mar*.kwd come termina di ricerca, sarà possibile trovare
market.kwd e marc_non_deve_leggerlo.kwd.

Punto interrogativo
Il punto interrogativo (?) rappresenta un singolo carattere. Ad esempio,
cercando mar? è possibile trovare marc, ma marc? non individua nulla se
il nome dei file èmarc o marc.png. Nella stringa di ricerca è possibile inserire
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un numero illimitato di punti interrogativi. In questo modo, si individua
esattamente il numero di caratteri.

È possibile combinare questi due caratteri jolly in qualsiasi stringa di ricerca.

4 Per trovare la cartella desiderata, in Cerca in specificare la cartella in cui cercare
oppure fare clic su Browse (Sfoglia). Selezionare Includi sottocartelle per cercare
anche tutte le sottocartelle all'interno della cartella specificata.

5 Premere Enter o fare clic su Trova.

1.6.2 Esecuzione di una ricerca avanzata di
file

Per una ricerca più dettagliata, è possibile specificare ulteriori opzioni, come un testo
contenuto nel file:

1 Avviare KFind dal menu principale o dalla riga di comando.

2 Fare clic sulla scheda Name/Location (Nome/Ubicazione).

3 Nel campo Named (Nome) specificare il nome del file da trovare.

4 Per trovare la cartella desiderata, in Cerca in specificare la cartella in cui cercare
oppure fare clic su Sfoglia.

5 Fare clic sulla scheda Contenuti.

6 In Tipo file, specificare il tipo di file da trovare.

7 In Contenenti il testo, digitare la parola o la frase contenuti nel file da cercare.

8 Se si desidera specificare altre opzioni, fare clic sulla scheda Proprietà e scegliere
le opzioni desiderate. Se si tiene premuto il puntatore del mouse su di un'opzione
o un campo, viene visualizzata una breve descrizione.

9 Per eseguire la ricerca, fare clic su Trova.
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Per informazioni dettagliate sulle opzioni di ricerca disponibili, fare riferimento alla
guida online di KFind.

Per ricerche avanzate, può essere opportuno utilizzare modelli di ricerca o espressioni
regolari. KRegExpEditor offre opzioni di ricerca basate su espressioni regolari. È
possibile installare KRegExpEditor tramite YaST dal pacchettokdeutils3-extra.
Per ulteriori informazioni sui modelli di ricerca e l'utilizzo dei caratteri jolly o le
espressioni regolari, vedere sezione "Getting Started with the Bash Shell" (Capitolo 15,
Working with the Shell, ↑Deployment Guide).

1.7 Spostamento di testo tra le
applicazioni

Per copiare il testo sugli appunti e inserirlo nuovamente, gli ex utenti di MS Windows
utilizzano automaticamente le combinazioni di tasti Ctrl + Ce Ctrl + V, che spesso
funzionano anche in Linux. Copiare e inserire testi è ancora più semplice in Linux: per
copiare un testo negli appunti, basta selezionare il testo con il mouse, quindi portare il
cursore del mouse nella posizione in cui si desidera inserire il testo. Fare clic con il
pulsante centrale del mouse per inserire il testo (su un mouse a due pulsanti, premere
contemporaneamente entrambi i pulsanti).

In alcune applicazioni, se un testo è già stato selezionato nell'applicazione in cui si
desidera inserirlo, questo metodo non funziona, poiché il testo presente in Appunti
viene sovrascritto dall'altro testo selezionato. In questi casi, l'applicazione Klipper di
KDE risulta molto utile. Klipper "ricorda" le ultime voci spostate negli appunti. Per
default, Klipper viene avviato al caricamento di KDE e viene visualizzato nel pannello
con l'icona degli appunti. Per visualizzare il contenuto degli appunti, fare clic sull'icona
di Klipper. La voce più recente è posizionata in cima all'elenco e viene contrassegnata
come attiva con un segno di spunta nero. Se in Klipper viene copiato un testo esteso,
verrà visualizzata solo la prima riga del testo.

Per copiare frammenti di testo meno recente di Klipper in un'applicazione, fare clic sui
frammenti per selezionarli, quindi spostare il puntatore del mouse nell'applicazione di
destinazione e infine fare clic con il pulsante centrale. Per ulteriori informazioni su
Klipper, consultare la relativa guida online.
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1.8 Esplorazione di Internet
In KDE, il browser Web predefinito è Konqueror. Per avviare Konqueror, fare clic
sull'icona corrispondente presente nel pannello oppure premere Alt + F2 e digitare il
comando konqueror. Ulteriori informazioni su Konqueror come browser Web sono
disponibili in Capitolo 14, Navigazione con Konqueror (p. 227).

Oltre a Konqueror, è possibile utilizzare un browser basato su Mozilla, Firefox. Avviare
Firefox dal menu principale o premendo Alt + F2 e digitando il comando firefox. È
possibile digitare un indirizzo nella barra degli indirizzi nella parte superiore oppure
fare clic sui collegamenti all'interno di una pagina, per spostarsi su pagine differenti,
come in qualsiasi altro browser Web. Per ulteriori informazioni su Firefox, vedere
Capitolo 15, Navigazione con Firefox (p. 235).

1.9 E-mail e pianificazione
KMail è un client di posta elettronica che supporta protocolli e-mail come POP3 e
IMAP. Dispone inoltre di supporto per conti e-mail multipli, filtri avanzati, privacy
PGP/GnuPG e allegati online. Avviare KMail dal menu principale o premendo Alt +
F2 e digitando il comando kmail.

Kontact è uno strumento per la gestione di informazioni personali (PIM) che combina
applicazioni molto conosciute come KMail, KOrganizer e KAddressBook in un'unica
interfaccia. In questo modo è possibile avere facile accesso a e-mail, calendario, rubrica
e altre funzionalità PIM. Per avviare Kontact, premere Alt + F2 e digitare il comando
kontact. Per informazioni dettagliate sull'utilizzo di Kontact, vedere Capitolo 4,
Kontact: e-mail e calendario (p. 113).

1.10 Apertura e creazione di
documenti con OpenOffice.org

La suite OpenOffice.org offre un insieme completo di strumenti per l'ufficio tra cui un
programma di elaborazione testi, un foglio di calcolo, un programma per le presentazioni,
un programma per il disegno vettoriale e componenti per database. Dal momento che
OpenOffice.org è disponibile per diversi sistemi operativi, è possibile utilizzare gli
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stessi dati su piattaforme diverse. È anche possibile aprire e modificare file in formati
Microsoft Office e salvarli nello stesso formato, se necessario.

Per avviare OpenOffice.org, premere Alt + F2 e digitare OOo oppure fai clic sull'icona
Office presente sul desktop.

Per un'introduzione a OpenOffice.org, vedere Capitolo 3, Suite per l'ufficio
OpenOffice.org (p. 75) o visualizzare l'aiuto in un programma OpenOffice.org.

1.11 Gestione parole d'ordine con
KWallet Manager

Ricordare tutte le parole d'ordine per risorse protette alle quali è necessario effettuare
l'accesso può essere problematico. KWallet è in grado di memorizzarle per conto
dell'utente. Questa applicazione raccoglie tutte le parole d'ordine e le memorizza in un
file cifrato. Con una sola password master è possibile aprire il portafogli per visualizzare,
cercare, cancellare o creare nuove voci. In genere non è necessario immettere una voce
manualmente. KDE è in grado di riconoscere se una risorsa richiede autenticazione e
KWallet si avvia automaticamente.

IMPORTANTE: protezione della password di KWallet

Se ci si scorda la password di KWallet, questa non potrà più essere recuperata.
Inoltre, chiunque sia a conoscenza della password potrà ottenere tutte le
informazioni contenute nel portafogli.

1.11.1 Avvio di KWallet
Al primo avvio di KWallet (ad esempio, quando si visita un sito Web in cui occorre
digitare una password per accedervi) viene visualizzata una finestra di dialogo con la
schermata di benvenuto. Scegliere fra Basic setup (Impostazione di base) e Advanced
setup (Impostazione avanzate). Se si seleziona Basic setup (Impostazione di base), nello
schermo successivo selezionare se si desidera memorizzare le informazioni personali.
Alcune applicazioni KDE, quali Konqueror o KMail, possono utilizzare il portafogli
per memorizzare i dati di moduli Web e cookie. Per attivare KWallet, selezionare Sì,
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desidero usare il portafogli di KDE per memorizzare le mie informazioni personali e
chiudere la finestra premendo Fine.

Se si sceglie Advanced setup (Impostazioni avanzate), si avranno a disposizione ulteriori
schermate per i livelli di sicurezza. Le impostazioni di default sono in genere adatte per
la maggior parte di utenti, sebbene alcuni desidereranno modificarle. Automatically
close idle wallets (Chiudi automaticamente portafogli non usati) chiude i portafogli
dopo un periodo di inattività. Per separare le parole d'ordine di rete e quelle locali,
attivare Store network passwords and local passwords in separate wallet files
(Memorizza le parole d'ordine di rete e le parole d'ordine locali in portafogli separati).
Per chiudere selezionare Fine.

È possibile modificare le impostazioni in qualsiasi momento facendo clic con il pulsante
destro del mouse su KWallet e scegliendo Configure Wallet (Configura portafogli).
Viene visualizzata una finestra di dialogo in cui è possibile selezionare diverse opzioni.
Di default, tutte le password vengono memorizzate in un unico portafogli, kdewallet,
ma è possibile aggiungere nuovi portafogli. Dopo la configurazione, KWallet verrà
visualizzato nel pannello.

1.11.2 Il KWallet Manager
Per memorizzare i dati nel portafogli o visualizzarne il contenuto, fare clic sull'icona
di KWallet presente nel pannello. Viene visualizzata una finestra di dialogo che mostra
i portafogli accessibili sul sistema. Fare clic sul portafogli da aprire. In una finestra
viene richiesta la password.

Dopo avere effettuato il login con successo, viene visualizzata la finestra del KWallet
Manager, suddivisa in quattro parti: la parte superiore sinistra è un riassunto, la parte
superiore destra visualizza le sottocartelle, la parte inferiore sinistra mostra un elenco
con voci di cartelle e la parte inferiore destra mostra il contenuto di una voce selezionata.

Nel KWallet Manager, è possibile modificare la password master di KWallet in qualsiasi
momento scegliendo File > Change Password (Modifica password).
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Figura 1.16 La finestra del KWallet Manager

È possibile aggiungere o eliminare cartelle. Selezionando una cartella viene aggiornato
l'elenco delle voci della cartella e visualizzato il riepilogo. Selezionando la voce di una
cartella viene aggiornato il riquadro del contenuto della voce, consentendone la modifica.
Le voci possono essere anche create o eliminate utilizzando il menu contestuale per il
contenuto della cartella.

Per inserire una nuova voce, procedere come segue:

Procedura 1.3 Inserimento di una nuova voce nel portafogli

1 Nella parte superiore destra della finestra, selezionare la sottocartella alla quale
aggiungere una voce.

Nella parte inferiore sinistra viene visualizzato un elenco delle voci della
sottocartella. È possibile aggiungere una nuova voce a Mappe o Passwords.
Utilizzare Mappe se si hanno coppie di chiavi e valori. Passwords può contenere
voci su più righe.

2 Per aggiungere una password, fare clic con il pulsante destro del mouse sulla
voce Passwords, quindi selezionare Nuova nel menu contestuale.

3 Specificare un nome per la nuova voce quindi fare clic su OK. La nuova voce
viene elencata sotto la cartella.

4 Fare clic sulla nuova voce per visualizzarla sulla destra (la cartella è inizialmente
vuota).

5 Fare clic su Show Contents (Mostra contenuti) per aprire un campo di input dove
è possibile immettere la nuova password.
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6 Immettere la password e fare clic su Salva. KWallet salva la password nella
cartella selezionata.

1.11.3 Copia del portafogli su un altro
computer

L'applicazione risiede per la maggior parte nel pannello e viene attivata automaticamente
quando necessario. Tuttavia, è possibile copiare i file del portafogli su un altro computer
(ad esempio il computer portatile). Per semplificare questa operazione, i portafogli
possono essere trascinati dalla finestra di gestione a quella di un browser di file. In
questo modo è possibile creare un nuovo portafogli per il trasferimento su un altro
ambiente. Ad esempio, può essere creato un nuovo portafogli per essere copiato su un
dispositivo rimovibile a memoria flash. È possibile trasferirvi le password importanti,
in maniera tale che siano disponibili in altre posizioni.

1.12 Visualizzazione, decompressione
e creazione di archivi

Per risparmiare spazio sul disco rigido, è possibile utilizzare uno strumento di
compressione che consente di ridurre le dimensioni originali di file e directory. Per la
gestione di questi archivi, è possibile utilizzare l'applicazione Ark che supporta molti
formati comuni, ovvero zip, tar.gz, tar.bz2, lha e rar.

È possibile avviare Ark dal menu principale o dalla riga di comando con ark. Se si
dispone di file compressi, spostarli dalla finestra di Konqueror aperta alla finestra di
Ark per visualizzare il contenuto dell'archivio. Per visualizzare un'anteprima dell'archivio
integrata in Konqueror, fare clic con il pulsante destro del mouse in Konqueror e
selezionare Anteprima nell'archiviatore. In alternativa, selezionare File > Apri in Ark
per aprire il file direttamente.
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Figura 1.17 Ark: anteprima archivio file

Dopo aver aperto l'archivio, è possibile eseguire diverse azioni. In Azione sono incluse
le opzioni Aggiungi file, Aggiungi cartella, Elimina, Estrai, Visualizza, Modifica con
e Apri con.

Per creare un nuovo archivio, selezionare File > Nuovo. Nella finestra di dialogo
visualizzata, immettere il nome del nuovo archivio e specificare il formato per mezzo
di Filtro. Dopo la conferma con Salva o dopo aver premuto Invio, Ark apre una finestra
vuota. È possibile trascinare e rilasciare file e directory dal file manager in questa
cartella. Come passo finale, Ark comprime il tutto nel formato di archivio
precedentemente selezionato. Per ulteriori informazioni su Ark, selezionare Aiuto >
Ark Handbook (Guida, manuale di Ark).

1.13 Cattura di schermate
Con KSnapshot è possibile creare istantanee della schermata o di singole finestre di
applicazioni. Avviare il programma dal menu principale o premendo Alt + F2 e digitando
il comando ksnapshot. La finestra di dialogo di KSnapshot è formata da due parti.
La parte superiore (Current Snapshot) include un'anteprima della schermata corrente e
tre pulsanti che consentono la creazione e il salvataggio delle screenshot. L'area inferiore
contiene altre opzioni per la creazione di screenshot.
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Figura 1.18 KSnapshot

Per acquisire le schermate, utilizzare Snapshot delay (Ritardo istantanea) per definire
il periodo di attesa in secondi tra il clic su New Snapshot (Nuova istantanea) e la
creazione della screenshot. Se è attiva l'opzione Only Grab the Window Containing the
Pointer (Cattura solo la finestra contenente il puntatore), verrà salvata solo la finestra
con il puntatore. Per salvare le screenshot, fare clic su Save Snapshot (Salva istantanea)
e assegnare un nome ai file e alla directory dell'immagine nella relativa finestra di
dialogo. Per stampare la schermata, fare clic su Print Snapshot (Stampa istantanea).

Per catturare schermate è possibile utilizzare anche The GIMP. Per avviare The GIMP,
premere Alt + F2 e digitare il comando gimp. Al pirmo avvio di The GIMP, vengono
installati alcuni file nella home directory e visualizzate finestre di dialogo che offrono
l'opportunità di adattare il programma all'ambiente. Per informazioni sull'utilizzo di
The GIMP, fare riferimento al Capitolo 18, Manipolazione delle immagini con The
GIMP (p. 259) o consultarne la guida. Potrebbe essere necessario installare la guida
tramite YaST (kdeutils3-extra).

1.14 Visualizzazione di file PDF con
KPDF

PDF è probabilmente uno dei formati di documento più importanti. KPDF è un
programma di KDE in grado di visualizzarli e stamparli.
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Per avviare KPDF, premere Alt + F2 e digitare il comando kpdf. Per caricare un file
PDF, selezionare File > Apri. KPDF lo visualizzerà nella propria finestra principale.
Sul lato sinistro è presente una barra laterale per la visualizzazione di miniature e indice.
Le miniature danno una panoramica della pagina. L'indice contiene segnalibri per
spostarsi nel documento. Talvolta questa visualizzazione è vuota, in quando i segnalibri
non sono supportati dal PDF.

Per visualizzare due pagine nella finestra principale, selezionareVisualizza > due pagine.
Il tipo di visualizzazione dipende da quale delle due ultime opzioni vengono attivate
nel menu Visualizza.

Un'altra utile opzione è quella che permette di selezionare l'area alla quale si è interessati
per mezzo dello strumento di selezione nella barra degli strumenti. Tracciare un
rettangolo e scegliere dal menu popup se si desidera che l'area selezionata sia copiata
come testo o grafica. L'area viene copiata negli appunti ed è anche possibile salvarla
in un file.

1.15 Controllo dell'audio con KMix
YaST identifica e configura automaticamente le schede audio del computer. In caso
contrario, avviare il modulo YaSTHardware e configurare la scheda audio manualmente.
Al termine della configurazione, è possibile controllare il volume e il bilanciamento
dell'audio ricorrendo a un mixer.

SUGGERIMENTO: avvio del mixer

Se l'icona del mixer (un altoparlante) non risulta visibile nel pannello del
desktop, premere Alt + F2 e digitare kmix o avviare il mixer dal menu principale.
In genere, è disponibile in Controllo volume.

Di default, quando si fa clic sull'icona di KMix, presente sulla barra della applicazioni,
viene visualizzato il controller master, che consente di aumentare o ridurre il volume
complessivo. Per disattivare l'audio, fare clic sul LED verde che, quando è inattivo,
diventa più scuro. Per riattivare l'audio, fare nuovamente clic sul LED verde. Per
ottimizzare le impostazioni audio relative a diversi canali, fare clic con il pulsante destro
del mouse sull'icona di KMix e selezionare Mostra la finestra del mixer. Nella finestra
principale è possibile configurareOutput, Input e Interruttori. Per ognuno dei dispositivi
utilizzati è disponibile un menu contestuale diverso, a cui è possibile accedere facendo
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clic con il pulsante destro del mouse sull'icona corrispondente. È possibile disattivare
o nascondere ognuno di questi in modo indipendente. Per ulteriori informazioni su
KMix, consultare la relativa Guida online.

Figura 1.19 Mixer KMix

1.16 Gestione dei pacchetti con gli
strumenti ZEN

Gli strumenti ZEN costituiscono il front-end grafico di zmd (ZENworks Management),
che permette di installare o rimuovere semplicemente software, applicare aggiornamenti
di sicurezza e gestire servizi e cataloghi in pochi clic.

1.16.1 Ottenere autorizzazioni
Per gestire pacchetti su un sistema Linux sono richiesti privilegi radice. Gli strumenti
ZEN e rug hanno un proprio sistema di gestione degli utenti che permette agli utenti
di installare gli aggiornamenti software. Quando un utente richiama un'azione che
richiede speciali privilegi negli strumenti ZEN, viene richiesta la password radice.
Una volta verificata la password, gli strumenti ZEN aggiungono automaticamente il
conto dell'utente al sistema di gestione degli utenti, con le autorizzazioni aggiornate.
Per rivedere o modificare tali impostazioni, utilizzare i comandi di gestione degli utenti
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rug (per informazioni consultare sezione "rug User Management" (Capitolo 8, System
Configuration with YaST, ↑Deployment Guide)).

1.16.2 Ottenere e installare aggiornamenti
software

Software Updater risiede nell'area di notifica (GNOME) o nella barra delle applicazioni
(KDE) del pannello; è rappresentato da un'icona che rappresenta una sfera. Cambia
colore e aspetto a seconda della disponibilità di un collegamento di rete e di nuovi
aggiornamenti. Una volta al giorno, Software Updater verifica automaticamente se
siano disponibili aggiornamenti (fare clic con il pulsante destro del mouse e selezionare
Aggiorna per avviare un controllo immediato). Quando sono disponibili nuovi
aggiornamenti, l'icona dell'applet Software Updater nel pannello da sfera diventa punto
esclamativo su sfondo arancione.

NOTA: errore durante l'accesso al catalogo di aggiornamento

Se non è possibile accedere al catalogo di aggiornamento, la sottoscrizione
potrebbe essere scaduta. Generalmente SUSE Linux Enterprise viene fornito
con una sottoscrizione valida da uno a tre anni, durante i quali è possibile
accedere al catalogo di aggiornamento. Allo scadere della sottoscrizione
l'accesso verrà negato.

Nel caso in cui venga negato l'accesso al catalogo di aggiornamento, verrà
visualizzato un messaggio di avviso in cui si invita l'utente a visitare il Novell
Customer Center e controllare la propria sottoscrizione. Novell Customer Center
è disponibile all'indirizzo: http://www.novell.com/center/.

Fare clic sull'icona per aprire la finestra degli aggiornamenti. Qui è riportato l'elenco
delle patch e delle nuove versioni del pacchetto disponibili. Ogni voce presenta una
breve descrizione e, ove opportuno, un'icona di categoria; le patch di sicurezza sono
contrassegnate infatti da uno scudo giallo. Le patch opzionali sono contrassegnate da
un cerchietto azzurro. Le patch consigliate non sono contrassegnate da alcuna icona.
Le patch di sicurezza sono elencate per prime, seguite dalle patch consigliate, dalle
patch opzionali e infine dalle nuove versioni dei pacchetti. Usare i collegamenti Tutti,
Pacchetti e Patch per filtrare l'elenco di pacchetti elencati.
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NOTA: pacchetti e patch

Gli aggiornamenti rilasciati ufficialmente da Novell vengono indicati con il
termine di Patch, mentre i nuovi pacchetti provenienti da altre origini sono
denominati Pacchetti.

Per informazioni su una determinata voce, contrassegnarla con il mouse e fare clic sul
collegamento Dettagli sotto alla finestra dell'elenco. Per selezionare una voce da
installare, contrassegnare la casella di controllo della voce. Usare i collegamenti Tutti
e Nessuno per selezionare o deselezionare tutte le patch. Fare clic su Aggiorna per
installare i programmi selezionati.

Figura 1.20 Selezione degli aggiornamenti software
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1.16.3 Installazione del software
Per installare pacchetti software, avviare Installa software dal menu o eseguire
zen-installer. L'interfaccia è praticamente identica a Software Updater (vedere
la Sezione 1.16.2, "Ottenere e installare aggiornamenti software" (p. 44)). L'unica
differenza sta nel pannello di ricerca utilizzabile per cercare pacchetti o per filtrare
l'elenco. Contrassegnare la casella di controllo dei pacchetti da installare, quindi
selezionare Installa per avviare l'installazione del pacchetto. Le possibili dipendenze
da altri pacchetti vengono risolte automaticamente dal programma di installazione.

1.16.4 Rimozione di software
Avviare Rimuovi software dal menu oppure eseguire zen-remover per disinstallare
i pacchetti software. L'elenco dei pacchetti può essere ristretto utilizzando il collegamento
Prodotti (per disinstallare prodotti completi), Patterns (vedere la Sezione "Installing
and Removing Patterns" (Capitolo 8, System Configuration with YaST, ↑Deployment
Guide) per dettagli sui modelli),Pacchetti e Patch. Contrassegnare la casella di controllo
della voce da eliminare, quindi selezionare Rimuovi per avviare la disinstallazione del
pacchetto. SE altri pacchetti dipendono da quelli contrassegnati, verranno a loro volta
rimossi. È necessario confermare la rimozione di ulteriori pacchetti. Se si fa clic su
Annulla nella finestra di dialogo di conferma, non verrà disinstallato alcun pacchetto.

1.16.5 Configurazione di Software Updater
Per configurare gli strumenti ZEN, fare clic suConfigura nella finestra dell'applicazione.
Verrà visualizzata una finestra con tre schede: Servizi, Cataloghi e Preferenze.

Servizi e cataloghi
I servizi sono essenzialmente le fonti che forniscono i pacchetti software e le
informazioni su tali pacchetti. Ogni servizio può offrire uno o più cataloghi.

La scheda dei servizi elenca tutti i servizi disponibili con informazioni di tipo e di stato
(se non è possibile visualizzare queste informazioni, ingrandire la finestra). Per
aggiungere o rimuovere servizi, selezionare Rimuovi servizio o Aggiungi servizio. Sono
disponibili i seguenti tipi di servizi:
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YUM
Un server HTTP, HTTPS o FTP che utilizza il formato MD RPM per i dati dei
pacchetti.

ZYPP
I servizi ZYPP sono le fonti di installazione di YaST aggiunte con i comandi
Software > Origine di installazione in YaST. Per aggiungere fonti di installazione,
usare Software Updater o YaST. La fonte da cui è stata eseguita la prima
installazione (solitamente DVD o CD-ROM) è preconfigurata. Se si modifica o
elimina tale fonte, sostituirla con un'altra fonte di installazione valida (servizio
ZYPP), altrimenti non sarà impossibile installare nuovo software.

NOTA: terminologia

I termini fonte di installazione YaST, archivio pacchetti YaST e servizio ZYPP
indicano tutti la fonte da cui è possibile installare software.

Monta
Con Monta è possibile incorporare una directory montata sul computer. Questo
risulta utile ad esempio in una rete che esegue regolarmente il mirroring del server
Novell YUM ed esporta il suo contenuto nella rete locale. Per aggiungere la
directory, indicarne il percorso completo in URI di servizio.

NU
NU è l'acronimo di Novell Update, aggiornamento Novell. Novell fornisce
aggiornamenti per SUSE Linux Enterprise esclusivamente come servizi NU. Se si
configura l'aggiornamento durante l'installazione, il server NU Novell è già presente
nell'elenco.

Se la configurazione degli aggiornamenti non è stata impostata durante
l'installazione, eseguiresuse_register sulla riga dei comandi oppure il modulo
YaST Software > Product Registration (Registrazione prodotto) come utente
radice. Il server NU viene aggiunto automaticamente a Software Updater.

RCE e ZENworks
I servizi Opencarpet, Red Carpet Enterprise o ZENworks sono disponibili solo se
l'azienda o l'ente hanno impostato tali servizi nella rete interna, ad esempio se
l'organizzazione utilizza software di terzi per il quale gli aggiornamenti vengono
distribuiti su un singolo server.
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Una volta installato SUSE Linux Enterprise, vengono preconfigurati due servizi: la
fonte di installazione (DVD, CD-ROM o risorsa di rete) come servizio ZYPP e un
server di aggiornamenti di SUSE Linux Enterprise come servizio, aggiunto durante la
registrazione del prodotto. In genere non è necessario modificare tali impostazioni. Se
non si individua un servizio, aprire una shell radice ed eseguire il comando
suse_register. Il servizio viene aggiunto automaticamente.

Cataloghi
I servizi possono offrire pacchetti per diversi software o per diverse versioni del software
(come è in genere il caso dei servizi RCE o ZENworks). Essi sono organizzati in
categorie diverse, denominate cataloghi. Per sottoscrivere o annullare la sottoscrizione
a un catalogo è sufficiente selezionare o deselezionare la casella di controllo
corrispondente.

Al momento i servizi SUSE Linux (YUM e ZYPP) non forniscono cataloghi diversi.
Ogni servizio ha un unico catalogo. Se Software Updater è stato configurato durante
l'installazione o con suse_register, sottoscriverà automaticamente i cataloghi
YUM e ZYPP. Se si aggiunge manualmente un servizio, è necessario sottoscrivere i
suoi cataloghi.

Preferenze
Nella scheda Preferences (Preferenze), specificare se Software Updater debba essere
o meno eseguito all'avvio. L'utente radice può anche modificare le impostazioni di
Software Updater. L'utente senza privilegi può solo visualizzare le impostazioni.
Consultare la pagina in cui viene trattato il comando rug per informazioni sulle
impostazioni.
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1.17 Ulteriori informazioni
Oltre alle applicazioni descritte nell'introduzione, KDE può eseguire molte altre
applicazioni. Ulteriori informazioni dettagliate su molte applicazioni importanti sono
disponibili in altre parti del seguente manuale.

• Per ulteriori informazioni su KDE e le relative applicazioni, fare riferimento anche
a http://www.kde.org/ e http://www.kde-apps.org/.

• Per riportare bug o aggiungere richieste di funzioni, consultare http://bugs
.kde.org/.
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2Personalizzazione delle
impostazioni
È possibile modificare l'aspetto e il comportamento del desktop KDE per adattarlo alle
esigenze personali. A seconda della portata delle modifiche da effettuare, esistono
diverse modalità per modificare l'aspetto del desktop KDE. Per gli utenti sono disponibili
le seguenti opzioni:

• Per modificare l'aspetto o il comportamento di un singolo oggetto del desktop in
genere è possibile accedere ad una finestra di configurazione facendo clic con il
pulsante destro del mouse sull'oggetto.

• Per modificare l'aspetto e il comportamento generali del desktop KDE, è necessario
usare il Centro di controllo di KDE, che offre diversi moduli e finestre di dialogo
di configurazione, alcuni dei quali possono essere richiamati dal menu contestuale
dei singoli oggetti del desktop.

2.1 Uso del Centro di controllo KDE
Il centro di controllo di KDE è lo strumento con cui gli utenti possono modificare
l'aspetto e il comportamento generale di quasi tutti i componenti del desktop KDE.
Avviare il Centro di controllo dal menu principale selezionando Preferiti > Impostazioni
personali o premere Alt + F2 e immettere kcontrol.
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Figura 2.1 Centro di controllo KDE

SUGGERIMENTO: avvio di singoli moduli

È anche possibile avviare moduli singoli del Centro di controllo KDE da un
terminale oppure aggiungendo una speciale applet al pannello.

Per avviare un modulo da una shell, immettere kcmshell --elencare per
ottenere un elenco di tutti i moduli disponibili. Immettere poi kcmshell
nome modulo per avviare il modulo desiderato.

In alternativa, aggiungere l'applet Impostazioni al pannello come descritto in
Aggiunta e rimozione di elementi del pannello (p. 62).

La barra laterale presenta diverse categorie ognuna contenente un sottoinsieme di
impostazioni. Fare clic su un'icona di categoria per esplorare le possibilità offerte. In
qualsiasi momento, è possibile tornare alla categoria superiore, facendo clic su Back
(Indietro). Per una panoramica di tutte le categorie, passare alla visualizzazione ad
albero. Per modificare la visualizzazione, scegliere Visualizzazione > Modalità > Vista
ad albero.

Fare clic su una voce per visualizzarne sulla destra le impostazioni corrispondenti.
Modificare le impostazioni desiderate. Le modifiche hanno effetto solo dopo aver
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premuto Apply (Applica). Se si è modificato un'opzione e si desidera ripristinare le
impostazioni precedenti, fare clic su Reset (Ripristina) per annullare le modifiche. Per
ripristinare i valori di default di tutte le voci presenti sulla pagina, scegliere Default.
Per la modifica di alcune impostazioni potrebbero essere necessarie le autorizzazioni
di root. Se richiesto, effettuare il login come root.

L'elenco che segue presenta le principali categorie e mette in evidenzia le impostazioni
più importanti modificabili da qui. Informazioni dettagliate sulle impostazioni di ciascuna
categoria vengono fornite premendo il pulsante Help (Guida) in ogni pagina delle
impostazioni o nel centro di aiuto.

Aspetto e temi
Contiene le impostazioni di sfondo del desktop, screen saver e font usati per il
desktop. È possibile modificare temi, decorazioni delle finestre e stili degli elementi
del desktop quali pulsanti, menu e barre di scorrimento. Qui è inoltre possibile
modificare il comportamento del cursore e l'aspetto della schermata di avvio che
viene visualizzata all'avvio di KDE.

Desktop
Contiene le impostazioni che permettono di aumentare o ridurre il numero di desktop
virtuali e di controllare opzioni del pannello di controllo quali dimensioni, posizione,
lunghezza e aspetto. Qui è anche possibile modificare il menu principale. Nella
sezione relativa alla barra delle applicazioni. Due ulteriori sezioni permettono di
controllare il comportamento della finestra.

Internet e rete
Permette di definire le opzioni Bluetooth e le preferenze quali valori di timeout per
alcune connessioni. È anche possibile condividere il desktop, attivare o disattivare
la condivisione dei file e impostare opzioni per l'esplorazione della rete locale e
per i server proxy. Qui è anche possibile modificare il comportamento di Konqueror
come browser Web.

Componenti di KDE
Con Scelta componenti è possibile cambiare client e-mail, editor di testi,
applicazione di messaggistica, terminale e browser Web di default. Ogni volta che
un'applicazione KDE deve avviare un'applicazione di questo tipo, richiama sempre
il componente di default impostato in questo modulo. È possibile configurare
opzioni per la ricerca sul desktop ad esempio con Kerry Beagle®, ad esempio, che
presenta directory di indici. Se necessario, modificare le associazioni di default dei
file per identificare il tipo di file e avviare l'applicazione adeguata. È possibile
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impostare Konqueror come programma di gestione dei file. È possibile definire in
che modo KDE gestisca le sessioni al login e allo spegnimento, nonché modificare
le opzioni di correzione ortografica.

Peripherals (Periferiche)
Contiene le opzioni di dispositivi quali fotocamere digitali, monitor, joystick,
tastiere, mouse, dispositivi OBEX, stampanti, telecomandi e supporti removibili
quali CD-ROM e stick USB. È ad esempio possibile aggiungere il modello di
fotocamera e definire il tipo di porta con cui è collegato al computer, oppure
modificare le impostazioni di tastiera e mouse, ad esempio delle opzioni di ritardo
di ripetizione, opzioni di singolo e doppio clic e intervallo di doppio clic. È possibile
assegnare azioni di default ad alcuni tipi di supporti removibili (ad esempio avviare
sempre KsCD quando viene rilevato un CD audio) e configurare stampanti.

Regional & Accessibility (Impostazioni internazionali e accesso facilitato)
Qui è possibile definire opzioni specifiche relative a paese e lingua, cioè valuta,
formato di numeri e date e layout di tastiera per le diverse lingue fra cui scegliere.
È anche possibile visualizzare e modificare le scorciatoie KDE predefinite (ad
esempio Alt + Ctrl + L per bloccare lo schermo). Questa categoria offre inoltre
opzioni di accesso facilitato per utenti handicappati, ad esempio opzioni di audio
e tastiera e movimenti del mouse.

Sicurezza & privacy
Qui è possibile modificare la password, impostare opzioni di KWallet (lo strumento
di gestione delle parole d'ordine di KDE), configurare la cifratura di KDE oppure
gestire dati privati, ad esempio i documenti aperti di recente, i siti Web visitati di
recente, i cookie e il contenuto degli Appunti.

Sound & Multimedia (Suono e multimedialità)
Contiene le opzioni per configurare il segnale acustico di sistema e le notifiche di
sistema nonché la codifica e le impostazioni dei dispositivi per i CD audio.

System Administration (Amministrazione di sistema)
Questa categoria va utilizzata per configurare l'aspetto e il comportamento di KDM
(gestione login di KDE) oppure per modificare i percorsi di default ad alcune
importanti directory, cioè Desktop, Autostart e Documents. È anche
possibile installare font personali o per l'intero sistema.

Nelle sezioni che seguono vengono riportati esempi di personalizzazione di alcuni
elementi del desktop KDE.
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2.2 configurazione degli oggetti del
desktop

Il desktop KDE presenta una serie di icone del desktop predefinite. Aggiungendo alcuni
oggetti quali cartelle, file o collegamenti, è possibile creare icone aggiuntive sul desktop,
e disporle a piacimento.

Procedura 2.1 Creazione e disposizione delle icone del desktop

1 Per aggiungere un nuovo oggetto del desktop, ad esempio, dal menu principale
o dal file manager Konqueror, selezionare una voce e trascinarla sul desktop.
Verrà visualizzato un menu contestuale in cui sarà possibile scegliere se copiare,
spostare o creare un collegamento all'oggetto.

2 Per aggiungere un nuovo oggetto del desktop, è anche possibile fare clic con il
pulsante destro del mouse su uno spazio vuoto del desktop e selezionare Create
New (Crea nuovo). Dal sottomenu, selezionare il tipo di oggetto da creare sul
desktop, cioè una cartella, un file (da scegliere fra una serie di tipi) o un
collegamento a un'applicazione, un sito Web o un dispositivo come l'unità CD.

3 Per disporre le icone sul desktop, fare clic con il pulsante destro del mouse su
uno spazio vuoto del desktop e selezionare una delle opzioni sotto Icone.

SUSE Linux Enterprise® presenta impostazioni predefinite dello screen saver, ma è
possibile modificarle.
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Procedura 2.2 Configurazione dello screen saver

1 Fare clic con il pulsante destro del mouse su uno spazio vuoto del desktop, quindi
scegliere Configura desktop.

2 Nella finestra di dialogo che viene visualizzata, fare clic su Screen Saver.

3 Nell'elenco di screen saver, fare clic su uno screen saver per visualizzare
un'anteprima nel lato destro della finestra di dialogo.

4 Fare clic su Setup (Configurazione) per regolare opzioni quali velocità o forme.

5 È anche possibile visualizzare una schermata vuota, oppure fare in modo che
KDE avvii uno screen saver casuale. Queste opzioni sono disponibili alla fine
dell'elenco di screen saver.

6 Sotto Impostazioni, stabilire dopo quanto tempo di inattività debba partire lo
screen saver e se sia necessaria una password per sbloccare lo schermo dopo
l'avvio dello screen saver.

7 Fare clic su OK per applicare le modifiche e chiudere la finestra di dialogo per
la configurazione.
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È possibile modificare i colori di sfondo del desktop o selezionare un'immagine da
utilizzare come sfondo. Poiché KDE offre desktop virtuali, è possibile applicare queste
modifiche a uno o a tutti i desktop virtuali.

Procedura 2.3 Modifica dello sfondo del desktop

1 Fare clic con il pulsante destro del mouse su uno spazio vuoto del desktop, quindi
scegliere Configura desktop. Verrà visualizzata una finestra di configurazione.

2 In Settings for Desktop (Impostazioni desktop) selezionare i desktop virtuali ai
quali applicare le modifiche.

3 Per modificare l'immagine di sfondo, fare clic su Immagine e selezionare
un'immagine dall'elenco. Per utilizzare un'immagine personalizzata, fare clic sul
pulsante della cartella al di sotto dell'elenco e selezionare un file di immagine
dal file system.

4 Fare clic su Presentazione per visualizzare più immagini in modalità
presentazione.

5 Se non si desidera un'immagine sullo sfondo, fare clic su Nessuna immagine.

6 Dal gruppo Opzioni, fare clic sul pulsante sinistro in Colori per selezionare il
colore dello sfondo. Per uno sfondo multicolore, impostare Colori su un'opzione
diversa da Single Color (Colore singolo) e fare clic sul pulsante destro del mouse
per selezionare un secondo colore.

7 Fare clic su Applica quindi su OK per chiudere la finestra di configurazione.
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Alcuni utenti potrebbero richiedere più desktop di quelli forniti per default.

Procedura 2.4 Aggiunta di altri desktop virtuali

1 Fare clic col pulsante destro del mouse e selezionare Configura desktop. Viene
visualizzata una finestra di configurazione che consente di aumentare o ridurre
il numero di desktop virtuali. È inoltre possibile cambiare i nomi di default del
desktop.

2 Fare clic su OK per applicare le modifiche e chiudere la finestra di dialogo per
la configurazione.

3 Per visualizzare i nomi dei desktop invece del numero nel previsualizzatore dei
desktop, fare clic col pulsante destro del mouse sul previsualizzatore dei desktop
e selezionare Pager Options (Opzioni pager) > Desktop Name (Nome desktop).
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2.3 Configurazione di effetti desktop
3D

Per configurare gli effetti desktop (Xgl) per il desktop KDE, sono sufficienti poche
operazioni in YaST e nel Centro di controllo KDE (Personal Settings (Impostazioni
personali)

Figura 2.2 Effetti desktop 3D in KDE

Per scoprire se l'hardware in uso supporta gli effetti desktop e per prepararlo alla
configurazione, eseguire le seguenti operazioni:

1 Installare i seguenti pacchetti con YaST: compiz-kde, xgl,
xgl-hardware-list e compiz.

2 Verificare che l'hardware supporti completamente gli effetti desktop nel file
/etc/X11/xgl-hardware-list.

3 Scaricare e installare gli eventuali driver mancanti seguente le istruzioni del
fornitore.

Per abilitare gli effetti desktop 3D sul desktop, eseguire le operazioni seguenti:

Personalizzazione delle impostazioni 59



1 Avviare YaST dal menu principale o premendo Alt + F2 e digitando il comando
yast.

2 In YaST selezionare Sistema > /etc/sysconfig Editor.

3 Nell'elenco a sinistra, espandere le voci Desktop > Display manager (Gestore
visualizzazioni)

4 Selezionare DISPLAYMANAGER_XSERVER e impostarne il valore su Xgl.

5 Per applicare le modifiche, fare clic su Finish (Fine).

6 Riavviare il computer.

Gli effetti desktop saranno ora disponibili.

Queste sono le funzioni più importanti disponibili quando si utilizzano gli effetti desktop
e le relative scorciatoie di default:

• Adatta i desktop virtuali a un cubo e ruota quest'ultimo intorno a un altro desktop
virtuale. Ruotare il cubo utilizzando le combinazioni di tasti Ctrl + Alt + → o Ctrl
+ Alt + ←.

• Esplorare il gruppo di desktop virtuali senza utilizzare il pager e selezionare quello
da utilizzare. Per passare alla vista a pannello, utilizzare la combinazione di tasti
Ctrl + Alt + ↓. Per scorrere un desktop a sinistra o a destra di quello attuale, tenere
premuto Ctrl + Alt e utilizzare le chiavi → e ←.

• Ingrandire alcune parti del desktop. Selezionare l'area da ingrandire e fare clic con
il pulsante destro del mouse tenendo premuto il tasto Windows.

• Adatta tutte le finestre aperte in un desktop virtuale in modo che vengano
visualizzate per intero per trasferire facilmente lo stato attivo da una all'altra.
Disporre le finestre utilizzando la combinazione di tasti Ctrl + Alt + ↑. Tenere
premuto Ctrl + Alt, utilizzare i tasti freccia per definire la finestra da attivare.

• Creare gocce di pioggia virtuali sul desktop e utilizzare un tergicristallo per
rimuoverle. Utilizzare Shift + F9 per attivare e disattivare le gocce di pioggia e Shift
+ F8 per attivare o disattivare il tergicristallo.
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SUGGERIMENTO: Configurazione di effetti desktop

Utilizzare l'utility gnome-xgl-settings per selezionare il tipo di effetti desktop
da eseguire, configurare le scorciatoie da tastiera ed eseguire altre ottimizzazioni
correlate agli effetti desktop. Eseguire il comando gnome-xgl-settings in
una finestra di terminale o dal prompt Esegui comando.

Per disabilitare gli effetti desktop in una sessione in esecuzione, eseguire le seguenti
operazioni:

1 Aprire il centro di controllo KDE e selezionare Componenti di KDE > Gestione
della sessione.

2 Nel gruppo Avanzate impostare Preferred Window Manager (Gestore finestre
preferite) su kwin.

3 Applicare le impostazioni e uscire dal modulo.

Per disabilitare gli effetti desktop, eseguire le seguenti operazioni

1 Avviare YaST.

2 Selezionare System (Sistema) > /etc/sysconfig Editor (Editor /etc/sysconfig).

3 Nell'elenco a sinistra, espandere le voci Desktop > Display manager (Gestore
visualizzazioni)

4 Selezionare DISPLAYMANAGER_XSERVER e impostarne il valore su Xorg.

5 Per applicare le modifiche, fare clic su Finish (Fine).

6 Riavviare il computer.

2.4 Configurazione del pannello
È possibile aggiungere i seguenti oggetti al pannello: applicazioni, applet (cioè mini
programmi) e altri pannelli. Applicazioni e applet possono essere aggiunte all'area di
avvio rapido o dalla barra delle applicazioni nel pannello principale o nei pannelli
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aggiuntivi. Gli elementi dei pannelli e i pannelli aggiuntivi possono essere spostati in
punti diversi oppure eliminati completamente in qualsiasi momento.

Procedura 2.5 Aggiunta e rimozione di elementi del pannello

1 Fare clic con il pulsante destro del mouse in una zona vuota del pannello.

2 Per aggiungere una nuova applicazione al pannello:

2a Dal menu contestuale, selezionare Add Application to Panel (Aggiungere
applicazione al pannello).

2b Da una delle categorie del sottomenu, selezionare l'applicazione da
aggiungere. L'icona dell'applicazione viene inserita nel pannello.

2c Per modificare l'icona dell'applicazione, fare clic con il pulsante destro del
mouse, quindi scegliere Configure Application Button (Configura pulsante
applicazione). Facendo clic sull'icona dell'applicazione nella finestra di
dialogo visualizzata, aprire una nuova finestra in cui selezionare un'icona
diversa.

2d Per rimuovere l'icona dal pannello, fare clic su di essa con il pulsante destro
del mouse e selezionare Elimina pulsante.

3 Per aggiungere una nuova applet al pannello:

3a Dal menu contestuale, selezionare Add Applet to Panel (Aggiungere applet
al pannello.

3b Nella finestra di dialogo che viene visualizzata, selezionare l'applet da
aggiungere e fare clic su Aggiungi a pannello. L'applet viene inserita nel
pannello.
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3c Per rimuovere l'applet dal pannello, fare clic su di essa con il pulsante destro
del mouse e selezionare Esci. Se nel menu contestuale dell'applet non è
presente la voce di menu Esci, tenere il cursore del mouse sul limite sinistro
dell'area e fare clic con il pulsante destro del mouse sulla piccola freccia nera
che viene visualizzata. Selezionare Rimuovi.

4 È anche possibile aggiungere ulteriori pannelli di tipi diversi. Per farlo, fare clic
con il pulsante destro del mouse su una zona vuota del pannello e selezionare
Add Panel (Aggiungi pannello). Selezionare nel sottomenu il tipo di pannello da
aggiungere.

5 Per rimuovere il pannello aggiuntivo, fare clic con il pulsante destro del mouse
su una zona vuota del pannello, selezionare Remove Panel (Rimuovere pannello)
e selezionare il pannello da rimuovere dal desktop.

Procedura 2.6 Spostamento degli elementi all'interno dei pannelli

1 Per spostare l'icona di un'applicazione in una posizione diversa all'interno del
pannello, fare clic su di essa con il pulsante destro del mouse e selezionare Sposta.
Il puntatore del mouse si trasforma in una croce. Trascinare il puntatore nel punto
del pannello in cui si desidera inserire l'icona, quindi premere il pulsante sinistro
del mouse. L'icona viene collocata nella nuova posizione.

2 Allo stesso modo è possibile spostare le zone del pannello, ad esempio l'anteprima
del desktop, la barra delle applicazioni e il vassoio di sistema: tenere il puntatore
del mouse sul limite della zona e fare clic sulla freccetta nera visualizzata. Dal
menu contestuale selezionare Sposta. Fare nuovamente clic per inserire l'area
nella nuova posizione.
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È possibile configurare molti aspetti del pannello principale e dei pannelli aggiuntivi.
Ad esempio è possibile modificare dimensioni, lunghezza e posizione di un pannello
o attivare gli effetti di trasparenza. È anche possibile influenzare il comportamento della
barra delle applicazioni.

Procedura 2.7 Modifica dell'aspetto e del comportamento del pannello

1 Fare clic con il pulsante destro del mouse su uno Spazio Vuoto del desktop,
quindi scegliere Configura desktop. Verrà visualizzata una finestra di dialogo
in cui è possibile configurare diversi aspetti del pannello. Per accedere alle
varie categorie, fare clic su una delle icone nel riquadro della finestra di sinistra.
Per default, la finestra di dialogo visualizza le opzioni della categoria
Arrangement (Disposizione).

2 Se sono stati aggiunti pannelli, viene visualizzato il loro elenco alla sommità
della finestra. Selezionare il pannello da configurare.

3 Se desiderato, selezionare una posizione diversa sul desktop, regolare la
lunghezza del pannello o ridurre le dimensioni del pannello e selezionare
Apply (Applica).

4 Per nascondere o visualizzare automaticamente il pannello oppure per
modificare le opzioni di default per nascondere i pannelli, fare clic su Hiding
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(Nascondere) nel riquadro della finestra di sinistra. Impostare le opzioni in
base alle proprie preferenze e fare clic su Apply (Applica).

5 Per modificare il colore del pannello o attivare la trasparenza o le immagini
di sfondo, fare clic su Appearance (Aspetto).

6 Sotto Button Backgrounds (Pulsanti sfondo) è possibile selezionare lo sfondo
delle varie parti dei pannelli. Per attribuire un colore a una parte del pannello,
selezionare Colore personalizzato dall'elenco del pulsante corrispondente e
fare clic sul pulsante a destra per selezionare un colore.

7 Per rendere trasparente il pannello, attivare Enable transparency (Attiva
trasparenza). Per aumentare la visibilità del pannello trasparente anche per
sfondi molto scuri e molto chiari, fare clic su Opzioni avanzate e impostare
un colore e la sua intensità per il pannello. Fare clic su Applica per applicare
le modifiche.

8 Per modificare il comportamento di default della barra delle applicazioni, fare
clic su Barra delle applicazioni nel riquadro della finestra di sinistra.

9 Per fare in modo che la barra delle applicazioni venga visualizzata solo nel
desktop attivo corrente anziché in tutte le applicazioni, disattivare Show
windows from all desktops (Mostra finestre in tutti i desktop).

10 Se desiderato apportare modifiche anche alle altre barre delle applicazioni e
fare clic su Applica.

11 Una volta impostate tutte le opzioni in base alle proprie preferenze, uscire
dalla finestra di dialogo di configurazione facendo clic su OK.

Procedura 2.8 Configurazione del menu principale

Per configurare il menu principale, procedere come segue:

1 Avviare il Centro di controllo da menu principale oppure premere Alt + F2 quindi
digitare il comando kcontrol.

2 Fare clic su Desktop > Pannelli.
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Figura 2.3 Modifica del menu principale

3 Fare clic sulla scheda Menu.

4 Il menu principale consente di scegliere se visualizzare il nome delle applicazioni
o il testo descrittivo (o entrambi). Selezionare Name only (Solo nome), Name
(Description) (Nome (Descrizione)), Description only (Solo descrizione) o
Description (name) (Descrizione (nome)).

5 Se si desidera modificare una voce di menu, fare clic su Edit K Menu (Modifica
menu K). L'editor del menu K visualizza un elenco delle voci di menu sulla
sinistra.

5a Fare clic su una voce nell'elenco e modificarne le opzioni sulla destra.

5b È possibile aggiungere nuove voci di menu, sottomenu o separatori con il
menu File o la barra degli strumenti.

5c Per tagliare, copiare, incollare o eliminare oggetti nel menu principale,
utilizzare il menu Modifica o le icone nella barra delle applicazioni.

5d Per applicare le modifiche nell'editor del menu K, fare clic su File > Esci.

6 Per applicare tutte le modifiche nella schedaMenu e chiudere il Centro di controllo
KDE, fare clic su Applica.
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2.5 Configurazione del sistema e delle
funzionalità di sicurezza

Per default, SUSE Linux Enterprise include di default tipi di carattere generalmente
disponibili in diversi formati file (Bitmap, TrueType e così via.). Questi sono noti come
font del sistema. Gli utenti possono installare font personalizzati disponibili in diverse
raccolte. Tali font, tuttavia, possono essere visualizzati e utilizzati solo dall'utente che
li ha installati.

Procedura 2.9 Installazione di nuovi font

Per verificare i font disponibili, immettere l'URL fonts:/ nel campo dell'indirizzo
della sessione di Konqueror. Vengono visualizzate due finestre: Personale e
Sistema. I font installati dall'utente sono indicati nella finestra Personale.
L'installazione nella cartella Sistema è possibile solo da parte di root.

Per installare nuovi font, procedere come segue:

1 Avviare il centro di controllo da menu principale oppure premere Alt + F2 quindi
digitare il comando kcontrol.

2 Fare clic su Amministrazione di sistema > Installatore dei tipi di carattere.

3 Per aggiornare i font di sistema, fare clic su Administrator Mode (Modalità
amministratore) e immettere la password root. Procedere poi come spiegato
qui di seguito.

4 Per installare i font come utente, fare clic su Add Font (Aggiungi font).

5 Nella finestra di dialogo visualizzata, selezionare uno o più font da installare. I
font contrassegnati vengono installati nella cartella font personale. Se si seleziona
un font viene visualizzata un'anteprima.

Per default, quando si utilizza per la prima volta KWallet, le impostazioni relative al
manager delle password KWallet vengono definite con il supporto di una procedura
guidata. È sempre possibile modificare le impostazioni iniziali per aumentarne la
sicurezza.
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Procedura 2.10 Modifica delle impostazioni di KWallet

1 Se KWallet è già stato avviato, fare clic sul simbolo di KWallet nel pannello e
selezionare Configure Wallet (Configura portafogli). Altrimenti, aprire la Guida
di KDE e fare clic su Sicurezza e Privacy > Portafogli di KDE.

2 Se KWallet Manager non è ancora stato abilitato, attivarne la casella di controllo
nella parte superiore.

3 Per default un portafogli viene chiuso dopo che l'ultima applicazione cessa di
utilizzarlo. Per aumentare la sicurezza, è possibile impostare norme più restrittive:
per chiudere automaticamente un portafogli dopo un periodo di inattività o l'avvio
dello screen saver, attivare le rispettive caselle di controllo.

4 Per rimuovere l'icona di KWallet dal pannello, disattivare Show manager in
system tray (Visualizza gestore nella barra delle applicazioni). È possibile
accedere a KWallet solo dal menu principale.

5 Per default, in KWallet tutte le password vengono memorizzate in un unico
portafogli denominato kdewallet. Per memorizzare le password locali e di
rete in portafogli differenti, attivare Different wallet for local passwords
(Portafogli diverso per password locali). Fare clic su Nuovo per creare un altro
portafogli se necessario.
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Anziché utilizzare KWallet per gestire le password, è possibile utilizzare la tecnologia
single sign-on con Novell CASA, se configurato per il sistema in uso. Single sign-on
è un sistema di controllo degli accessi che consente agli utenti di autenticarsi una sola
volta per accedere alle risorse di più sistemi software. CASA (Common Authentication
Service Adapter) consente di gestire le credenziali di autenticazione in numerose
piattaforme, quali SUSE Linux Enterprise, Microsoft* Windows* e Macintosh* OS
10. È possibile effettuare l'accesso e memorizzare le password dei programmi e dei
servizi installati in una qualsiasi di queste piattaforme. CASA è anche compatibile con
GNOME Keyring, KWallet di KDE, e Firefox Password Manager e consente quindi
di gestire tutte queste applicazioni da un'unica interfaccia.

Per utilizzare CASA per la gestione delle password, è innanzitutto necessario abilitare
questa applicazione in YaST. A questo scopo, avviare YaST e fare clic su Sicurezza >
CASA. Nella finestra di dialogo Configurazione di CASA fare clic su Enable CASA
(Abilita CASA) e, dopo che viene visualizzato il messaggio di conferma, fare clic su
Fine per chiudere YaST.

Procedura 2.11 Gestione di password con Novell CASA

1 Avviare Novell CASA Manager dal menu principale selezionando Sistema >
Configurazione > Novell CASA Manager.

2 Se i servizi di CASA non sono ancora disponibili, verrà visualizzata una casella
per il testo del messaggio che consente di avviare il modulo YaST appropriato
in modo da abilitare innanzitutto CASA.

3 Se si avvia CASA per la prima volta, verrà chiesto di immettere una password
master per la cifratura e la protezione delle credenziali. Immettere due volte la
password master e fare clic su OK. Verrà aperto Novell CASA Manager.
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IMPORTANTE: memorizzazione permanente in CASA in base alla
password di login

Assicurarsi che la password di login sia stata registrata e che nella scheda
miCASA venga visualizzata la voce SS_CredSet:Desktop. Se questa voce
non viene visualizzata, eseguire il logout dal desktop e quindi di nuovo
il login in modo da registrare la password con CASA. Se la password di
login non viene riconosciuta da CASA, non è possibile utilizzare la
tecnologia single sign-on.

4 Per configurare CASA, selezionare Opzioni > Preferenze.

5 Nella finestra di dialogo Preferenze, selezionare gli archivi che dovranno essere
supportati da CASA e fare clic su OK. Viene aggiunta una scheda per ogni
archivio selezionato, in modo che sia possibile accedere e gestire le password in
esso memorizzate da Novell CASA Manager.

6 Per cancellare una password da uno degli archivi, selezionare la voce, fare clic
con il pulsante destro del mouse, quindi scegliere Cancella.
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7 Se è necessario cambiare la password master di CASA, selezionare Opzioni >
Cambia password master.

È anche possibile cambiare, importare o esportare le password esistenti oppure collegarle
a Novell CASA. Per ulteriori informazioni, fare clic suGuida > Sommario per accedere
alla Guida online di CASA. La documentazione completa su CASA è disponibile
all'indirizzo:http://developer.novell.com/wiki/index.php/Special:
Downloads/casa.
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Parte II. Office e collaborazione





3Suite per l'ufficio
OpenOffice.org
OpenOffice.org è una potente suite open-source Linux che offre strumenti per tutti i
tipi di compiti d'ufficio, come scrittura di testi, utilizzo di fogli di calcolo o creazione
di illustrazioni e presentazioni. OpenOffice.org consente di utilizzare gli stessi dati su
più piattaforme di elaborazione. È anche possibile aprire e modificare file in altri formati
come Microsoft Office e salvarli nello stesso formato, se necessario. Questo capitolo
fornisce informazioni sulla Novell® Edition di OpenOffice.org e descrive alcune delle
funzioni principali che è necessario conoscere per iniziare a utilizzare la suite.

3.1 Descrizione di OpenOffice.org
In OpenOffice.org sono inclusi alcuni moduli di applicazioni (sottoprogrammi), progettati
per interagire reciprocamente. Questi moduli sono elencati nella Tabella 3.1 . Una
descrizione esaustiva di ciascun modulo è disponibile nella guida in linea, come descritto
nella Sezione 3.8, "Ricerca di assistenza e informazioni su OpenOffice.org" (p. 110).

Tabella 3.1 Moduli delle applicazioni di OpenOffice.org

ScopoModulo

Modulo applicativo per l'elaborazione di testiWriter

Modulo applicativo per i fogli di calcoloCalc

Modulo applicativo per le presentazioniImpress

Suite per l'ufficio OpenOffice.org 75



ScopoModulo

Modulo applicativo per databaseBase

Modulo applicativo per la creazione di grafici vettorialiDraw

Modulo applicativo per la generazione di formule matematicheMath

L'aspetto dell'applicazione varia in relazione al tipo di desktop o di gestore delle finestre
in uso. Indipendentemente dall'aspetto, il layout e le funzioni di base sono le stesse.

Questa sezione include informazioni valide per tutti i moduli applicativi disponibili in
OpenOffice.org. Le informazioni specifiche di un modulo sono disponibili nelle
sottosezioni seguenti.

3.1.1 Vantaggi dell'edizione Novell di
OpenOffice.org

SUSE Linux Enterprise Desktop include l'edizione Novell di OpenOffice.org. L'edizione
Novell include diversi miglioramenti non ancora inclusi nell'edizione standard.

Miglioramenti in Calc
L'edizione Novell di OpenOffice.org Calc include i seguenti miglioramenti non ancora
disponibili nella versione standard:

• Migliore compatibilità con Excel per alcune funzioni, ad esempio
ADDRESS/OFFSE.

• Ergonomia migliorata, ad esempio correzioni alle edizioni standard senza
associazioni di tasti e al problema di "unione e centratura".

• Supporto per gli indirizzi stile R1C1.

• Interazione tra i Data Pilot di OpenOffice.org e le Tabelle Pivot* di Microsoft*.

• La possibilità di modificare i piloti di dati dopo averli creati.
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• Aggiunta alla funzione GETPIVOTDATA per semplificare l'elaborazione delle
informazioni dalle tabelle Pivot.

• Inclusione di un sottoinsieme di Macro VBA di Excel che è possibile caricare ed
eseguire in OpenOffice.org come se fossero native, per consentire a numerosi
piccoli strumenti di contabilità e gestione di migrare a openoffice.Org senza dover
essere riscritti in starbasic di destinazione.

• Semplice programma di risoluzione lineare che consente l'analisi numerica semplice.

Miglioramenti in Writer
L'edizione Novell di openoffice.Org calc Include i seguenti miglioramenti non ancora
disponibili nella versione standard:

• Il riquadro di spostamento include una visualizzazione ad albero della struttura dei
documenti per migliorarne l'esplorazione.

• Migliore interoperabilità di rilevamento delle modifiche.

• Migliore esportazione HTML.

• Stampa di font migliorata.

• "Gestione di campi dei moduli" migliorata.

In Microsoft Office i "campi dei moduli" consentono agli utenti di aggiungere nei
documenti campi di testo, caselle di controllo ed elenchi a discesa per creare moduli
facili da compilare.

Se si desidera disabilitare il supporto per i campi ottimizzati e utilizzare i campi
dei moduli limitati, impostare il seguente elemento di configurazione:
<?xml version="1.0" encoding="UTF-8"?>
<oor:component-data 
  xmlns:oor="http://openoffice.org/2001/registry" 
  xmlns:xs="http://www.w3.org/2001/XMLSchema"
  oor:name="Common" 
  oor:package="org.openoffice.Office">
 <node oor:name="Filter">
  <node oor:name="Microsoft">
   <node oor:name="Import">
    <prop oor:name="ImportWWFieldsAsEnhancedFields" oor:type="xs:boolean">
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     <value>false</value>
    </prop>
   </node>
  </node>
 </node>
</oor:component-data>

Miglioramenti ai font
L'edizione Novell di OpenOffice.org include numerosi miglioramenti ai font, inclusi:

• I font con alias (bitmap) non sono consentiti per evitare una scarsa visualizzazione
dei caratteri quando un documento viene proiettato.

• Inclusione di un gruppo di font concessi in licenza da AGFA metricamente
compatibili con alcuni caratteri principali di default di Microsoft con i quali vengono
mappati in maniera trasparente durante l'importazione o l'esportazione di documenti.

• Un font OpenSymbol migliorato con accattivanti elenchi puntati e numerati
visualizzato al posto di un simbolo quando un glifo non è disponibile.

OpenClipart
OpenClipart http://openclipart.org Per accedere a questa clipart, fare clic
su Strumenti > Galleria.

Multimedia
L'edizione Novell include il supporto multimediale della piattaforma nativa con
gstreamer su Linux.

Miglioramenti alle prestazioni
L'edizione Novell di OpenOffice.org su Linux si avvia più velocemente rispetto alla
versione standard grazie a numerosi miglioramenti. Si applica anche ai sistemi con una
memoria inferiore.
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Integrazione con GroupWise
L'edizione Novell di OpenOffice.org include un'integrazione di base con GroupWise
per consentite di inserire e caricare i documenti dal sistema di gestione dei documenti
GroupWise.

3.1.2 Uso della versione standard di
OpenOffice.org

È inoltre possibile utilizzare l'edizione standard di OpenOffice.org anziché quella di
Novell. Se si installa la versione più recente di OpenOffice-org, tutti i file dell'edizione
Novell in uso rimangono compatibili. L'edizione standard non contiene tuttavia i
miglioramenti apportati nella versione Novell.

3.1.3 Compatibilità con altre applicazioni
per l'ufficio

OpenOffice.org può essere usato con documenti, fogli di calcolo, presentazioni e
database in più formati compreso Microsoft Office. Tutti questi documenti possono
essere facilmente aperti come un qualsiasi altro documento e salvati nel formato
originale. Poiché i formati Microsoft sono proprietari e le loro specifiche non sono
utilizzate in altre applicazioni, i problemi di formattazione sono rari. Se si verificano
problemi con i documenti, provare ad aprirli nell'applicazione originale e a salvarli di
nuovo in un formato open, ad esempio RTF per i documenti di testo o CSV per i fogli
di calcolo.

SUGGERIMENTO

Per informazioni valide sulla migrazione da altre office suite in OpenOffice.org,
consultare la Guida alla migrazione di OpenOffice.org disponibile in http://
documentation.openoffice.org/manuals/oooauthors2/
0600MG-MigrationGuide.pdf.
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Conversione dei documenti nel formato
OpenOffice.org
OpenOffice.org è in grado di leggere, modificare e salvare i documenti in molti formati.
Per utilizzare questi file, non è necessario convertirli nel formato OpenOffice.org.
sebbene questa operazione sia naturalmente possibile. Per convertire più documenti,
ad esempio quando si passa inizialmente a OpenOffice.org, effettuare le seguenti
operazioni:

1 Selezionare File > Wizard (Procedura guidata) > Document Converter
(Convertitore documenti).

2 Selezionare il formato di file da convertire.

Sono disponibili diversi formati StarOffice e Microsoft Office.

3 Fare clic su Avanti.

4 Specificare dove OpenOffice.org deve ricercare i modelli e i documenti da
convertire e la directory in cui devono essere salvati i file convertiti.

IMPORTANTE

I documenti di una partizione Windows si trovano normalmente in una
sottodirectory di /windows.

5 Verificare che tutte le altre impostazioni siano corrette, quindi fare clic su Avanti.

6 Rivedere il riepilogo delle operazioni da effettuare, quindi avviare la conversione
facendo clic su Converti.

La quantità di tempo richiesta per effettuare la conversione dipende dal numero
di file e dalla loro complessità. Per la maggior parte dei documenti, la conversione
non richiede molto tempo.
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Condivisione dei file con utenti di altre suite di
programmi per l'ufficio
OpenOffice.org è disponibile per numerosi sistemi operativi e rappresenta quindi un
ottimo strumento nel caso di gruppi di utenti che devono condividere frequentemente
i file e non dispongono dello stesso sistema nei computer in uso.

Quando si condividono documenti con altri utenti, è possibile scegliere tra varie opzioni.

Se il destinatario deve poter modificare il file
Salvare il documento nel formato richiesto dal destinatario. Per salvare ad esempio
un file di Microsoft Word, fare clic su File > Salva come, quindi scegliere il tipo
di file di Microsoft Word per la versione utilizzata dall'utente.

Se il destinatario deve solo poter leggere il documento
Per esportare il documento come file PDF, fare clic su File > Export as PDF
(Esporta come PDF). I file PDF possono essere letti su qualsiasi piattaforma che
disponga di un visualizzatore quale Adobe Acrobat Reader.

Per rendere un documento condivisibile per le modifiche
Usare uno dei formati di documenti standard. I formati di default sono conformi
al formato XML standard OASIS e pertanto sono compatibili con diverse
applicazioni. I formati TXT e RTF, sebbene presentino una formattazione limitata,
possono rappresentare una valida opzione per i documenti di testo. Comma
Separated Value (CSV) è utile per i fogli di calcolo. In OpenOffice.org può anche
essere disponibile il formato preferito del destinatario, in particolare i formati
Microsoft.

Per inviare il documento come allegato PDF
Fare clic su File > Invia > E-mail as PDF (E-mail come PDF). Verrà visualizzato
il programma e-mail di default con il file allegato.

Per inviare un documento per e-mail a un utente di Microsoft Word
Fare clic su File > Invia > E-mail as Microsoft Word (E-mail comeMicrosoft Word).
Il programma di posta di default si apre con il file allegato.

Inviare un documento come corpo di un messaggio e-mail
Fare clic su File > Invia > Document as E-mail (Documento come e-mail). Verrà
aperto il programma e-mail di default con il contenuto del documento come corpo
del messaggio.
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3.1.4 Avvio di OpenOffice.org
Avviare l'applicazione in uno dei seguenti modi:

• Fare clic su Computer > OpenOffice.org Writer.

Si apre Writer. Per aprire un altro modulo, fare clic su File > Nuovo nel documento
Writer appena aperto, quindi scegliere il modulo che si desidera aprire.

• Fare clic su Computer > Altre applicazioni > Office, quindi fare clic sul nome del
modulo OpenOffice.org che si desidera avviare.

• Nella finestra del terminale, immettere ooffice. Viene visualizzata la finestra di
OpenOffice.org. Fare clic su File New (Nuovo), quindi scegliere il modulo che si
desidera aprire.

Se è aperta un'applicazione OpenOffice.org, è possibile aprire una delle altre applicazioni
facendo clic su File > Nuovo > Nome dell'applicazione.

3.1.5 Miglioramento del tempo di
caricamento di OpenOffice.org

Per rendere più veloce il caricamento di OpenOffice.org mediante il precaricamento
dell'applicazione all'avvio del sistema:

1 Fare clic su Strumenti > Opzioni > Memoria.

2 Selezionare Enable systray quickstarter (Abilita quickstarter barra delle
applicazioni).

Al successivo riavvio del sistema, OpenOffice.org viene caricato automaticamente.
Quando si apre il modulo di un'applicazione OpenOffice.org, questa verrà aperta più
velocemente.
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3.1.6 Personalizzazione di OpenOffice.org
OpenOffice.org può essere personalizzato in base alle proprie esigenze e al proprio stile
di lavoro. Le barre degli strumenti, i menu e le scorciatoie dalla tastiera possono essere
riconfigurati per accedere rapidamente alle funzioni usate più frequentemente. Inoltre,
se si desidera che vengano effettuate operazioni specifiche al momento in cui si
verificano determinati eventi, è possibile anche assegnare macro agli eventi
dell'applicazione. Ad esempio se si utilizza sempre lo stesso foglio di calcolo, è possibile
creare una macro che apra il foglio di calcolo nell'evento Avvia applicazione.

Questa sezione fornisce una serie di istruzioni semplici e generiche per la
personalizzazione dell'ambiente. Le modifiche vengono applicate subito dopo essere
state apportate, per consentire di controllare se sono soddisfacenti e, in caso negativo,
rimodificarle. Per istruzioni dettagliate, consultare i file della Guida di OpenOffice.org.

Personalizzazione delle barre degli strumenti
Usare la finestra di dialogo Personalizza per modificare le barre degli strumenti di
OpenOffice.org.

1 Fare clic sull'icona a freccia alla fine di una barra degli strumenti.

2 Fare clic su Customize Toolbar (Personalizza barra degli strumenti).

3 Selezionare la barra degli strumenti da personalizzare.

La barra degli strumenti su cui si è fatto clic dovrebbe già essere selezionata. Per
modificare una barra degli strumenti, selezionare quella che si desidera
personalizzare nel menu Barra degli strumenti.

4 Selezionare le caselle di controllo accanto ai comandi che si desidera visualizzare
sulla barra degli strumenti, quindi deselezionare le caselle di controllo accanto
ai comandi che si desidera nascondere.

5 Specificare se si desidera salvare la barra personalizzata nel modulo
OpenOffice.org in uso o in un documento.

• Modulo OpenOffice.org
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La barra degli strumenti personalizzata viene visualizzata ogni volta che si
apre il modulo.

• Nome file del documento

La barra degli strumenti personalizzata viene visualizzata ogni volta che si
apre il documento.

6 Ripetere le operazioni descritte per personalizzare altre barre degli strumenti.

7 Fare clic su OK.

È possibile scegliere rapidamente i pulsanti da visualizzare su una barra degli strumenti
specifica.

1 Fare clic sull'icona a freccia alla fine della barra degli strumenti che si desidera
modificare.

2 Fare clic su Visible Buttons (Pulsanti visibili) per visualizzare un elenco dei
pulsanti.

3 Dall'elenco selezionare i pulsanti da abilitare (selezionando la casella) e
disabilitare (deselezionando la casella).

Personalizzazione dei menu
È possibile aggiungere o eliminare voci dai menu esistenti, riorganizzare i menu e
perfino crearne di nuovi.

1 Fare clic su Strumenti > Personalizza > Menu.

2 Selezionare il menu da modificare oppure fare clic su Nuovo per crearne uno
nuovo.

Fare clic su ? per visualizzare ulteriori informazioni sulla finestra di dialogo
Personalizza.

3 Modificare, aggiungere o eliminare le voci di menu desiderate.

4 Fare clic su OK.
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Personalizzazione delle scorciatoie da tastiera
È possibile riassegnare le scorciatoie da tastiera già assegnate per assegnarle alle funzioni
più frequentemente usate.

1 Fare clic su Strumenti > Personalizza > Tastiera.

2 Selezionare i tasti da assegnare a una funzione oppure selezionare la funzione e
assegnare alla stessa i tasti o le combinazioni di tasti.

Fare clic su ? per visualizzare ulteriori informazioni sulla finestra di
dialogoPersonalizza.

3 Modificare, aggiungere o eliminare le scorciatoie da tastiera desiderate.

4 Fare clic su OK.

Personalizzazione degli eventi
OpenOffice.org fornisce anche funzioni che consentono di assegnare le macro ad eventi
quali l'avvio dell'applicazione o il salvataggio di un documento. La macro assegnata
viene eseguita automaticamente quando si verifica l'evento selezionato.

1 Fare clic su Strumenti > Personalizza > Eventi.

2 Selezionare l'evento da modificare.

Fare clic su ? per visualizzare ulteriori informazioni sulla finestra di dialogo
Personalizza.

3 Assegnare o rimuovere le macro desiderate all'evento/dall'evento selezionato.

4 Fare clic su OK.

Modifica delle impostazioni generali
Per modificare le impostazioni globali in qualsiasi applicazione OpenOffice.org, fare
clic su Strumenti > Opzioni sulla barra dei menu. Viene visualizzata la finestra mostrata
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nella seguente figura. Per visualizzare le categorie delle impostazioni viene utilizzata
una struttura ad albero.

Figura 3.1 Finestra Opzioni

La tabella che segue elenca le categorie delle impostazioni, oltre a fornire una breve
descrizione di ciascuna categoria:

NOTA

Le categorie delle impostazioni visualizzate dipendono dal modulo attualmente
utilizzato. Se ad esempio è attiva la categoria Writer (Scrittura), la categoria
Writer di OpenOffice.org verrà visualizzata nell'elenco ma non la categoria Calc
corrispondente. La categoria Base di OpenOffice.org viene visualizzata sia in
Calc che in Writer. La colonna Applicazione nella tabella mostra la posizione
in cui è disponibile ogni categoria di impostazione.

Tabella 3.2 Categorie delle impostazioni globali

UtenteDescrizioneCategoria
impostazioni

TuttiVarie impostazioni di base, compresi i dati utente
(come l'indirizzo e l'e-mail), i percorsi importanti

OpenOffice.org

e le impostazioni di stampanti e programmi
esterni.
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UtenteDescrizioneCategoria
impostazioni

TuttiComprende le impostazioni per l'apertura e il
salvataggio di vari tipi di file. È disponibile una

Carica/Salva

finestra di dialogo per le impostazioni generali
e diverse finestre di dialogo speciali per la
definizione della modalità di gestione dei formati
esterni.

TuttiComprende le impostazioni relative alle lingue
e agli ausili per la scrittura, come le impostazioni

Impostazioni
lingua

internazionali e per il controllo ortografico.
Questa opzione consente inoltre di attivare il
supporto per le lingue asiatiche.

WriterConfigura le opzioni globali per l'elaborazione
del testo, come i font di base e il layout di Writer.

Documento di
testo
OpenOffice.org

WriterModifica le impostazioni relative alle funzioni
di creazione e modifica di documenti HTML di
OpenOffice.org.

Documento di
testo/Web
OpenOffice.org

CalcModifica le impostazioni di Calc, come quelle
per gli elenchi di ordinamento e le griglie.

Calc
OpenOffice.org

ImpressModifica le impostazioni applicabili a tutte le
presentazioni. Ad esempio, è possibile

Impress
OpenOffice.org

specificare l'unità di misura per la griglia usata
per ordinare gli elementi.

DrawComprende le impostazioni relative al modulo
per il disegno dei vettori, come la scala del

Disegno
OpenOffice.org

disegno, le proprietà della griglia e alcune
opzioni di stampa.
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UtenteDescrizioneCategoria
impostazioni

MathVisualizza una finestra di dialogo in cui è
possibile impostare le opzioni di stampa per le
formule.

OpenOffice.org
Math

BaseInclude finestre di dialogo che consentono di
impostare e modificare le connessioni e i
database registrati.

Base
OpenOffice.org

TuttiConsente di definire i colori di default utilizzati
per i nuovi grafici.

Grafici

TuttiComprende le finestre di dialogo utilizzabili per
configurare tutti i proxy e modificare le
impostazioni relative ai motori di ricerca.

Internet

IMPORTANTE

Tutte le impostazioni elencate nella tabella vengono applicate globalmente alle
applicazioni specificate. e usate come impostazioni di default per tutti i nuovi
documenti.

3.1.7 Ricerca di modelli
I modelli permettono di usare più agevolmente OpenOffice.org poiché semplificano le
operazioni di formattazione di vari tipi di documenti. OpenOffice.org viene fornito con
alcuni modelli, ma è possibile anche scaricarne altri da Internet. Naturalmente è possibile
anche creare modelli personalizzati. Poiché la creazione dei modelli esula dallo scopo
di questo documento, per informazioni più dettagliate su questa operazione è necessario
consultare la Guida di OpenOffice.org nonché gli altri documenti e le esercitazioni
disponibili in linea.

Le risorse in linea contengono anche moduli supplementari e aggiuntivi oltre ai modelli.
La tabella che segue elenca alcune delle risorse in cui è possibile trovare modelli ed
elementi aggiuntivi. Le informazioni nella tabella seguente potrebbero non essere
aggiornate perché i siti Web vengono chiusi o modificati frequentemente.
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Tabella 3.3 Dove trovare modelli ed elementi aggiuntivi per OpenOffice.org

Informazioni disponibiliUbicazione

Modelli per i fogli di calcolo di Calc,
copertine per CD, pacchetti seed,
copertine fax e molto altro ancora.

Sito Web della documentazione di
OpenOffice.org, vedere http://
documentation.openoffice
.org/Samples_Templates/User/
template_2_x/index.html

Modelli per molti tipi di etichette.Worldlabel.com, vedere http://www
.worldlabel.com/Pages/
openoffice-template.htm

Per ulteriori informazioni sulle etichette, vedere la Sezione 3.2.4, "Uso dei modelli per
la formattazione dei documenti" (p. 95) e la Sezione 3.3.2, "Uso dei modelli in Calc"
(p. 101).

3.2 Elaborazione di testi con Writer
OpenOffice.org Writer è un programma di elaborazione testi completo con opzioni per
la formattazione di pagine e testo. La sua interfaccia è simile a quella della maggior
parte dei programmi di elaborazione testo e comprende alcune funzioni normalmente
disponibili nelle applicazioni di desktop publishing per uso professionale.

Questa sezione descrive le funzioni principali di Writer. Per ulteriori informazioni su
queste funzioni o per istruzioni complete su come usare Writer, consultare la Guida di
OpenOffice.org o una delle risorse elencate nella Sezione 3.8, "Ricerca di assistenza e
informazioni su OpenOffice.org" (p. 110).

NOTA

Molte delle informazioni disponibili in questa sezione sono valide anche per
altri moduli di OpenOffice.org, ad esempio perché altri moduli utilizzano gli
stili con modalità analoghe a quelle di Writer.
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3.2.1 Creazione di un nuovo documento
Esistono due modi per creare un nuovo documento:

Per creare un documento da zero, fare clic su File > New (Nuovo) > Text Document
(Documento di testo).

Per utilizzare un formato standard ed elementi predefiniti per i documenti, scegliere
una procedura guidata. Le procedure guidate sono piccole utility che consentono di
prendere alcune decisioni essenziali e di generare un documento pronto per la lettura
da un modello. Per creare ad esempio una lettera commerciale, fare clic su File >
Wizards (Procedure guidate) > Letter (Lettera). Utilizzando le finestre di dialogo della
procedura guidata, è possibile creare facilmente un documento base mediante un formato
standard. Una finestra di dialogo campione della procedura guidata è mostrata in
Figura 3.2 .

Figura 3.2 Procedura guidata di OpenOffice.org

Immettere il testo nella finestra del documento in base alle esigenze. Utilizzare la barra
degli strumenti Formatting (Formattazione) o il menu Format (Formattare) per
modificare l'aspetto del documento. Per stampare e salvare il documento, utilizzare il
menu File o i pulsanti rilevanti. Per aggiungere elementi extra al documento, ad esempio
una tabella, un'immagine o un grafico, utilizzare le opzioni del menu Insert (Inserisci).
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3.2.2 Condivisione di documenti con altri
programmi di elaborazione testo

È possibile usare Writer per modificare documenti creati con svariati tipi di programmi
di elaborazione testi. Ad esempio è possibile importare un documento di Microsoft
Word, modificarlo e salvarlo nuovamente in formato Word. La maggior parte dei
documenti Word può essere importata in OpenOffice.org senza problemi. La
formattazione, i font e tutti gli altri elementi rimangono invariati. Tuttavia, alcuni
documenti particolarmente complessi, ad esempio quelli che contengono tabelle avanzate,
macro di Word oppure formattazione o caratteri insoliti, potrebbero richiedere alcune
modifiche dopo l'importazione. OpenOffice.org è in grado di salvare i documenti nei
formati più comunemente usati dai programmi di elaborazione testo. Allo stesso modo
i documenti creati in OpenOffice.org e salvati come file Word possono essere aperti in
Microsoft Word senza problemi.

Se quindi si utilizza OpenOffice.org in un ambiente in cui si condividono frequentemente
documenti con utenti di Word, non dovrebbero verificarsi problemi durante lo scambio
dei file. È infatti sufficiente aprire i file, modificarli e salvarli come file Word.

3.2.3 Formattazione con gli stili
OpenOffice.org usa gli stili per applicare una formattazione uniforme ai vari elementi
del documento. Gli stili disponibili sono descritti di seguito.

Tabella 3.4 Informazioni sui tipi di stili

AzioneTipo di stile

Applica la formattazione standard ai vari tipi di paragrafi
presenti nel documento. È possibile, ad esempio, applicare

Paragrafo

lo stile paragrafo a un'intestazione di primo livello per
impostare il font e le relative dimensioni, la spaziatura sopra
e sotto l'intestazione, la posizione dell'intestazione e le
specifiche di formattazione.

Applica la formattazione standard per i tipi di testo. Per
evidenziare un testo in corsivo, è possibile ad esempio creare

Carattere
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AzioneTipo di stile

uno stile di evidenziazione che applichi il corsivo al testo
selezionato quando si seleziona lo stile corrispondente.

Applica la formattazione standard ai riquadri. Se nel
documento sono presenti barre laterali, è possibile ad esempio

Frame (Riquadro)

creare riquadri impostando la grafica, i bordi e la posizione
desiderati nonché applicando le opzioni di formattazione
necessarie a conferire un aspetto uniforme a tutte le barre
laterali.

Applica la formattazione standard al tipo di pagina
specificato. Ad esempio se tutte le pagine del documento,

Pagina

eccetto la prima, contengono un'intestazione e un piè di
pagina, è possibile usare lo stile della prima pagina per
disabilitare l'uso dell'intestazione e del piè di pagina sulle
altre pagine. Inoltre, è possibile anche usare stili di pagina
diversi per le pagine destra e sinistra in modo da avere
margini più ampi sulle pagine interne e includere i numeri
di pagina nell'angolo esterno.

Applica la formattazione standard al tipo di elenco
specificato. È ad esempio possibile definire un elenco di

Elenco

controllo con caselle di controllo quadrate e un elenco puntato
con punti elenco rotondi facilmente applicabili allo stile
corretto durante la creazione degli elenchi.

Visualizzazione della finestra Styles and Formatting
(Stili e formattazione)
La finestra Styles and Formatting (Stili e formattazione), che era chiamata Stilista nelle
versioni precedenti di OpenOffice.org, è uno strumento di formattazione versatile che
consente di applicare stili a testo, paragrafi, pagine, riquadri ed elenchi. Per aprire questa
finestra, fare clic suFormat (Formattare) > Styles and Formatting (Stili e formattazione).
OpenOffice.org include numerosi stili di default che possono essere usati così come
sono oppure modificati e usati per creare nuovi stili.
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SUGGERIMENTO

Per default, la finestra Styles and Formatting (Stili e formattazione) è una finestra
mobile, ovvero apre una finestra a parte che può essere posizionata in
qualunque punto dello schermo. Se si utilizzano frequentemente gli stili, può
essere utile ancorare la finestra in modo che venga visualizzata sempre nello
stesso punto dell'interfaccia di Writer. Per ancorare la finestra Styles and
Formatting (Stili e formattazione), premere Control e fare contemporaneamente
doppio clic sull'area grigia della finestra. Questa operazione può essere
effettuata anche in altre finestre di OpenOffice.org, compreso il riquadro di
navigazione.

Applicazione di uno stile
Per applicare uno stile, selezionare l'elemento a cui si desidera applicare lo stile, quindi
fare doppio clic sullo stile nella finestra Styles and Formatting (Stili e formattazione).
Ad esempio per applicare uno stile a un paragrafo, posizionare il cursore su qualsiasi
punto del paragrafo, quindi fare doppio clic sullo stile desiderato.

Differenze tra l'uso degli stili rispetto ai pulsanti di
formattazione e alle opzioni di menu
L'uso degli stili anziché le opzioni e i pulsanti del menu pulsante Format (Formato)
consente di applicare alle pagine, ai paragrafi, ai testi e agli elenchi un aspetto più
uniforme oltre a semplificare le operazioni di formattazione. Ad esempio per modificare
in corsivo un testo evidenziato in grassetto con l'opzione Bold (Grassetto), è necessario
ricercare tutti i blocchi di testo evidenziati in grassetto e modificarli manualmente in
corsivo. Se si utilizza uno stile carattere, è invece sufficiente modificare lo stile da
grassetto a corsivo per applicare automaticamente la modifica a tutto il testo evidenziato
con lo stile specificato.

Il testo formattato con un'opzione di menu ha la priorità su tutte le altre impostazioni
applicate manualmente. Se si utilizza il pulsante Bold (Grassetto) per formattare parte
del testo e uno stile di evidenziazione per un'altra parte del testo, la modifica dello stile
non viene applicata al testo formattato con il pulsante anche nel caso in cui lo stile
venga successivamente applicato al testo evidenziato in grassetto con il pulsante. Per
consentire la modifica, è necessario rimuovere l'evidenziazione del grassetto dal testo,
quindi applicare lo stile.
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Allo stesso modo, se si formattano manualmente i paragrafi utilizzando Format
(Formattare) > Paragraph (Paragrafo), si rischia facilmente di ottenere una
formattazione incoerente del paragrafo. Ciò è particolarmente importante quando si
copiano e incollano paragrafi da altri documenti con formattazioni diverse.

Modifica di uno stile
Gli stili permettono di modificare la formattazione di un documento mediante la semplice
modifica dello stile, anziché dover applicare manualmente lo stile in tutti i punti in cui
si desidera impostare la nuova formattazione.

1 Nella finestra Styles and Formatting (Stili e formattazione), fare clic con il
pulsante destro del mouse sullo stile da modificare.

2 Fare clic su Modifica.

3 Modificare le impostazioni per lo stile selezionato.

Per informazioni sulle impostazioni disponibili, vedere la Guida di
OpenOffice.org.

4 Fare clic su OK.

Creazione di uno stile
OpenOffice.org viene fornito con una raccolta di stili adatti alla maggior parte ’delle
esigenze. Tuttavia, è possibile che sia necessario usare uno stile non ancora disponibile.
Per creare un nuovo stile:

1 Fare clic con il pulsante destro del mouse su un'area vuota della finestra Styles
and Formatting (Stili e formattazione).

Verificare di aver selezionato l'elenco di stili adatto al tipo di stile da creare. Ad
esempio se si sta creando uno stile carattere, verificare di aver selezionato l'elenco
degli stili caratteri.

2 Fare clic su Nuovo.

3 Fare clic su OK.
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4 Assegnare un nome allo stile e selezionare le impostazioni da applicare allo stile.

Per informazioni più dettagliate sulle opzioni stile disponibili in una scheda, fare
clic sulla scheda, quindi scegliere ?.

3.2.4 Uso dei modelli per la formattazione
dei documenti

La maggior parte degli utenti di elaboratori di testo creano più tipi di documenti, ad
esempio perché ha l'esigenza di scrivere lettere, promemoria e rapporti che hanno aspetti
diversi e richiedono stili specifici. Creando un modello per ciascun tipo di documento,
è possibile avere a disposizione lo stile più idoneo al documento da creare.

Per la creazione di un modello, è necessaria una preventiva pianificazione. perché è
necessario stabilire l'aspetto del documento per poter creare gli stili che si prevede di
usare per il documento stesso. Benché i modelli possano essere modificati in qualunque
momento, la definizione delle impostazioni richieste consente di risparmiare tempo.

NOTA

I modelli di Microsft Word possono essere convertiti come gli altri documenti
Word. Per ulteriori informazioni, vedere la Sezione "Conversione dei documenti
nel formato OpenOffice.org" (p. 80).

Questa sezione non fornisce una descrizione dettagliata dei modelli, che esula dallo
scopo di questo documento. Per ulteriori informazioni, consultare il Sistema di guida
mentre per articoli pratici vedere la pagina della documentazione di OpenOffice.org
all'indirizzo http://documentation.openoffice.org/HOW_TO/index
.html.

Creazione di un modello
Un modello è un documento di testo che contiene solo gli stili e il contenuto che devono
essere visualizzati in tutti i documenti; ad esempio l'indirizzo o l'intestazione nel caso
specifico di una lettera. Quando si crea o si apre un documento con un modello, gli stili
vengono automaticamente applicati al documento stesso.

Per creare un modello:
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1 Fare clic su File > Nuovo > Text Document (Documento di testo).

2 Creare gli stili e il contenuto da usare per i documenti che utilizzano il modello
selezionato.

3 Fare clic su File > Templates (Modello) > Salva.

4 Assegnare un nome al modello.

5 Nella casella Categorie fare clic sulla categoria a cui deve essere assegnato il
modello.

La categoria è la cartella che contiene il modello.

6 Fare clic su OK.

3.2.5 Uso di documenti estesi
È possibile utilizzare Writer per elaborare documenti di grandi dimensioni. che possono
essere costituiti da un singolo file o da una raccolta di file raggruppati in un unico
documento.

Navigazione in documenti estesi
Lo strumento Navigator consente di visualizzare informazioni sul contenuto di un
documento e consente anche di passare rapidamente agli elementi desiderati. Ad esempio
è possibile usare questo strumento per visualizzare rapidamente una panoramica di tutte
le immagini incluse nel documento.

Per aprire il Navigatore, fare clic su Modifica > Navigator (Navigatore). Gli elementi
riportati nel riquadro di navigazione variano in base al documento caricato in Writer.
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Figura 3.3 Strumento Navigator di Writer

Fare clic su una voce di Navigator per passare rapidamente alla voce corrispondente
nel documento.

Utilizzo di un documento master per la creazione di
un unico documento da più file
Quando si lavora con documenti estesi, come i libri, può essere preferibile gestirli come
documenti master anziché come singoli file. I documenti master consentono di applicare
rapidamente le nuove impostazioni di formattazione a un documento esteso oppure di
passare a ciascuna sezione secondaria per poterla modificare.

Un documento master è un documento Writer che funge da contenitore per più file di
Writer. È possibile aggiornare i capitoli e altri documenti secondari come singoli file
che fanno parte del documento master. I documenti master sono utili quando più persone
lavorano allo stesso documento poiché è possibile dividere’ le sezioni su cui lavorano
i singoli utenti in documenti secondari del documento master e consentire così a più
utenti di lavorare contemporaneamente sulla loro parte senza ostacolare il lavoro di’
altri.

NOTA

Gli utenti che passano a OpenOffice.org da Microsoft Word hanno talvolta
qualche difficoltà a usare i documenti master poiché questa funzione in Word
tende a danneggiare i documenti. Questo problema non esiste in Writer di
OpenOffice.org, quindi è possibile usare i documenti master per gestire i
progetti senza alcun problema.
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Per creare un documento master:

1 Fare clic su Nuovo > Master Document (Documento master).

oppure

Aprire un documento esistente e fare clic su File > Invia > Create Master
Document (Crea documento master).

2 Inserire i documenti secondari.

3 Fare Clic Su file Save As (Salva con nome).

I file della Guida di OpenOffice.org forniscono informazioni più dettagliate su come
usare i documenti master. Cercare l'argomento intitolato Using Master Documents and
Subdocuments (Utilizzo di documenti e sottodocumenti master).

SUGGERIMENTO

Gli stili di tutti i documenti secondari vengono importati nel documento master.
Per mantenere la stessa formattazione in tutto il documento master, è
consigliabile usare lo stesso modello per ciascun documento secondario. Benché
questa operazione non sia obbligatoria, evita la possibile necessità di
riformattare i documenti secondari nel documento master nel caso in cui i
documenti secondari contengano formattazione diversa. Ad esempio se due
documenti importati nel documento master utilizzano stili diversi con lo stesso
nome, il documento master utilizzerà la formattazione specificata per lo stile
del primo documento da importare.

3.2.6 Uso di Writer come editor HTML
Oltre ad essere un programma di elaborazione testi completo, Writer può essere usato
anche come Editor HTML. Writer fornisce tag HTML che possono essere applicati con
le stesse modalità con cui si applicano gli stili ai documenti. È possibile visualizzare il
documento così come verrà visualizzato in linea oppure modificare direttamente il
codice HTML.
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Creazione di un documento HTML
1 Fare clic su File > Nuovo > HTML Document (Documento HTML).

2 Fare clic sulla freccia nella parte inferiore della finestra Formatting and Styles
(Formattazione e stili).

3 Selezionare HTML Styles (Stili HTML).

4 Creare un documento HTML utilizzando gli stili desiderati per applicare i tag al
testo.

5 Fare clic su File > Salva come.

6 Selezionare la posizione in cui salvare il file, quindi scegliere HTML Document
(.html) (Documento HTML) dall'elenco Filter (Filtro).

7 Fare clic su OK.

Se si preferisce modificare direttamente il codice HTML oppure visualizzare il codice
HTML creato durante la modifica del file HTML come documento Writer, fare clic su
Visualizza > HTML Source (Origine HTML). L'elenco Formatting and Styles
(Formattazione e stili) non è disponibile nella modalità HTML Source (Origine HTML).

NOTA

Quando si seleziona per la prima volta la modalità HTML Source (Origine HTML)
viene visualizzato un messaggio che chiede di salvare il file come HTML, se
questa operazione non è ancora stata effettuata.

3.3 Utilizzo dei fogli di calcolo con
Calc

Calc è l'applicazione di calcolo di OpenOffice.org. Creare un nuovo foglio di calcolo
selezionando File >New (Nuovo) > Spreadsheet (Foglio di calcolo) oppure aprirne uno
mediante File > Open (Apri). Poiché Calc è in grado di leggere e salvare i file in format
Microsoft Excel, consente di scambiare facilmente i fogli di calcolo con utenti di Excel.
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NOTA

Sebbene Calc sia in grado di elaborare molte macro VBA nei documenti Excel,
il supporto per le macro VBA non è ancora completo. Quando si apre un foglio
di calcolo di Excel che contiene molte macro, è possibile che alcune non
funzionino correttamente.

Nelle celle del foglio di calcolo immettere dati o formule fissi. Una formula consente
di utilizzare dati di altre celle per generare un valore nella cella in cui è stata immessa.
È inoltre possibile creare grafici sulla base dei valori delle celle.

3.3.1 Uso della formattazione e degli stili in
Calc

Calc fornisce alcuni stili incorporati per celle e pagine che consentono di migliorare
l'aspetto dei fogli di calcolo e dei rapporti. Benché gli stili incorporati siano adatti alla
maggior parte degli usi, può talvolta essere necessario creare stili per le preferenze di
formattazione più frequentemente usate.

Creazione di uno stile
1 Fare clic su Format (Formattare) > Styles and Formatting (Stili e formattazione).

2 Nella pagina Formatting and Styles (Formattazione e stili), fare clic sull'icona
Cell Styles (Stili celle) o Page Styles (Stili pagine).

3 Fare clic con il pulsante destro del mouse sulla finestra Formatting and Styles
(Formattazione e stili), quindi selezionare Nuovo.

4 Assegnare un nome allo stile e usare le schede disponibili per impostare le opzioni
di formattazione desiderate.

5 Fare clic su OK.

Modifica di uno stile
1 Fare clic su Format (Formattare) > Styles and Formatting (Stili e formattazione).
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2 Nella pagina Formatting and Styles (Formattazione e stili), fare clic sull'icona
Cell Styles (Stili celle) o Page Styles (Stili pagine).

3 Fare clic con il pulsante destro del mouse sul nome dello stile da modificare,
quindi selezionare Modifica.

4 Modificare le opzioni di formattazione desiderate.

5 Fare clic su OK.

3.3.2 Uso dei modelli in Calc
Quando si utilizzano stili diversi per tipi specifici di fogli di calcolo, è possibile usare
modelli per salvare gli stili per ciascun tipo di foglio di calcolo. In questo modo quando
si crea un modello di foglio di calcolo specifico, è sufficiente aprire il modello e gli
stili necessari per il modello disponibili nella finestra Formatting and Styles
(Formattazione e stili).

Questa sezione non fornisce una descrizione dettagliata dei modelli, che esula dallo
scopo di questo documento. Per ulteriori informazioni, consultare il Sistema di guida
mentre per articoli pratici vedere la pagina della documentazione di OpenOffice.Org
all'indirizzo http://documentation.openoffice.org/HOW_TO/index
.html.

Creazione di un modello
Un modello Calc è un foglio di calcolo che contiene gli stili e i contenuti che devono
essere presenti in tutti i fogli di calcolo creati con il modello, come le intestazioni e gli
stili per le altre celle. Al momento della creazione o dell'apertura di un foglio di calcolo,
gli stili vengono automaticamente applicati al foglio di calcolo.

Per creare un modello:

1 Fare clic su File > Nuovo > Foglio di calcolo.

2 Creare gli stili e il contenuto da usare in tutti i fogli di calcolo che utilizzano il
modello.

3 Fare clic su File > Templates (Template) > Salva.
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4 Assegnare un nome al modello.

5 Nella casella Categorie fare clic sulla categoria a cui deve essere assegnato il
modello.

La categoria è la cartella che contiene il modello.

6 Fare clic su OK.

3.4 Uso delle presentazioni con
Impress

Il modulo Impress di OpenOffice.org può essere usato per creare presentazioni da
visualizzare sullo schermo o stampare, come presentazioni di diapositive e lucidi. Gli
utenti esperti nell'uso di software per la creazione di presentazioni, non avranno alcuna
difficoltà a usare Impress che funziona in modo analogo ad altri programmi dello stesso
tipo.

Poiché Impress è in grado di aprire e salvare presentazioni di Microsoft Powerpoint
consente di scambiare presentazioni con gli utenti di Powerpoint purché vengano salvate
in formato Powerpoint.

3.4.1 Creazione di una presentazione
1 Fare clic su File > Nuovo > Presentazioni.

2 Selezionare le opzioni da usare per la creazione della presentazione.

Le presentazioni possono essere create in due modi:

• Create an empty presentation (Crea presentazione vuota)

Apre Impress con una diapositiva vuota. Usare questa opzione per creare
una nuova presentazione senza diapositive preformattate.

• Create a presentation from a template (Crea presentazione da modello)
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Apre Impress con la selezione di modelli personalizzati. Usare questa opzione
per creare una nuova presentazione con un modello OpenOffice.org
predefinito ’o un modello personalizzato creato e installato direttamente nel
programma, ’ad esempio il modello di una presentazione aziendale. Impress
usa gli stili e i modelli con le stesse modalità degli altri moduli di
OpenOffice.org. Per ulteriori informazioni sui modelli, vedere la
Sezione 3.2.4, "Uso dei modelli per la formattazione dei documenti" (p. 95).

3.4.2 Uso delle pagine master
Le pagine master consentono di dare alla presentazione un aspetto uniforme, poiché
consentono di definire l'aspetto delle singole pagine, i font da usare e le caratteristiche
di altri elementi grafici. Impress utilizza due tipi di pagine master:

• Slide Master (Schema diapositiva)

Contiene gli elementi che vengono visualizzati in tutte le diapositive. Questa opzione
può essere utile, ad esempio, se si desidera visualizzare il logo aziendale nello
stesso punto su tutte le pagine. Questa opzione specifica anche lo stile di
formattazione del testo per l'intestazione e la struttura di tutte le diapositive che
utilizzano la pagina master, oltre alle informazioni che devono essere presenti
nell'intestazione e nel piè di pagina.

• Notes Master (Schema note)

Specifica la formattazione e l'aspetto delle note contenute nella presentazione.

Creazione di una struttura diapositive
Impress fornisce una raccolta di pagine master preformattate. Tuttavia, è possibile che
gli utenti desiderino personalizzare le loro presentazioni creando strutture diapositive
personalizzate.

1 Avviare Impress e creare una presentazione vuota.

2 Fare clic su Visualizza > Master > Slide Master (Schema diapositiva).
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Verrà aperto lo schema dispositiva attuale nella Master View (Visualizzazione
master).

3 Fare clic con il pulsante destro del mouse sul riquadro sinistro, quindi selezionare
New Master (Nuova struttura).

4 Modificare la struttura diapositive fino ad applicare tutte le caratteristiche
desiderate.

5 Fare clic su Close Master View (Chiudi visualizzazione master) o su Visualizza
> Normale per tornare alla Normal View (Visualizzazione normale).

SUGGERIMENTO

Dopo aver creato tutte le strutture diapositive da usare nelle presentazioni, è
possibile salvarle in un modello Impress. Così facendo, è possibile usare le
strutture diapositive create per aprire una presentazione con un modello
desiderato al momento della creazione di una nuova presentazione.

Applicazione di una struttura diapositive
Le strutture diapositive possono essere applicate ad alcune o a tutte le diapositive di
una presentazione.

1 Aprire la presentazione , quindi fare clic su Visualizza > Master > Slide Master
(Schema diapositiva).

2 (Facoltativo) Per applicare la struttura diapositive a più diapositive, ma non a
tutte, selezionare le diapositive da usare con la struttura.

Per selezionare più diapositive, premere Ctrl nel Slides Pane (Riquadro
diapositive) e contemporaneamente fare clic sulle diapositive che si desidera
utilizzare.

3 Nel riquadro Task (Attività), fare clic con il pulsante destro del mouse sulla
pagina master da applicare.

Se non viene visualizzato il Riquadro task, fare clic su Visualizza > Task pane
(Riquadro task).
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4 Per applicare la struttura diapositive, fare clic su una delle seguenti opzioni:

• Apply to All Slides (Applica a tutte le diapositive)

Applica la struttura diapositive a tutte le diapositive della presentazione.

• Apply to Selected Slides (Applica alle diapositive selezionate)

Applica la struttura diapositive selezionata alla diapositiva corrente o a tutte
le diapositive selezionate prima dell'applicazione della struttura diapositive.
Se ad esempio si desidera applicare un altro schema diapositive alla prima
diapositiva in una presentazione, selezionare la diapositiva in questione,
quindi aprire laMaster View (Visualizzazionemaster) e applicarvi uno schema
diapositive.

3.5 Uso dei database con Base
OpenOffice.org include un modulo di database: Base. che permette di creare database
per l'archiviazione di vari tipi di informazioni come rubriche, file di ricette o sofisticati
sistemi per la gestione di documenti.

Le tabelle, i moduli, le query e i rapporti possono essere creati manualmente o tramite
utili procedure guidate. La procedura guidata per la creazione delle tabelle, ad esempio,
contiene molti campi comuni utili ad utenti privati e aziende. I database creati in Base
possono essere utilizzati come origini dati, ad esempio nella creazione di lettere tipo.

Questo documento non fornisce informazioni dettagliate sulla creazione di database
con Base, poiché questo argomento esula dallo scopo del documento. Per ulteriori
informazioni, vedere le risorse elencate nella Sezione 3.8, "Ricerca di assistenza e
informazioni su OpenOffice.org" (p. 110).

3.5.1 Creazione di un database con opzioni
predefinite

Base fornisce molti campi database predefiniti che semplificano la creazione di database.
Le operazioni descritte in questa sezione si riferiscono alla creazione di una rubrica con
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campi predefiniti, ma possono essere usate anche per creare campi predefiniti per
qualunque opzione incorporate dei database.

La procedura per la creazione di un database può essere suddivisa in più operazioni:

Creazione del database
In primo luogo è necessario creare il database.

1 Fare clic su File > Nuovo > Database.

2 Selezionare Crea un nuovo database > Next (Successivo).

3 Fare clic su Yes, register the database for me (Registra il database a mio nome)
per rendere le informazioni del database disponibili ad altri moduli di
OpenOffice.org, selezionare le caselle di controllo nella sezione inferiore della
finestra di dialogo, quindi fare clic su Fine.

4 Individuare la directory in cui salvare il database, assegnare un nome al database,
quindi fare clic su OK.

Impostazione della tabella del database
Il passaggio successivo consiste nella definizione dei campi della tabella del database.

1 Aprire la procedura guidata della tabelle e fare clic su Personale.

L'elenco Sample tables (Tabelle campione) visualizza le tabelle predefinite
per uso personale. Se si seleziona Lavoro l'elenco visualizza le tabelle di lavoro
predefinite.

2 Nell'elenco Sample tables (Tabelle campione) fare clic su Indirizzi.

I campi disponibili per la rubrica predefinita vengono visualizzati nel menu
Available fields (Campi disponibili).

3 Nel menu Available fields (Campi disponibili) fare clic sui campi da usare per
la rubrica.
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È possibile selezionare una voce alla volta oppure selezionare più voci con il
mouse tenendo premuto il tasto Maiusc.

4 Fare clic sul singolo→ per spostare gli elementi selezionati nel menu Selected
fields (Campi selezionati).

Per spostare tutti i campi nel menu Selected fields (Campi selezionati), usare
la doppia freccia destra.

5 Utilizzare i tasti ↑ e ↓ per modificare l'ordine dei file selezionati.

I campi vengono visualizzati nella tabella e nei moduli nell'ordine in cui sono
presenti nell'elenco.

6 Fare clic su Avanti.

7 Verificare che tutti i campi siano stati definiti correttamente.

È possibile modificare il nome e il tipo di campo, se la voce è obbligatoria, e
la lunghezza massima del campo (ovvero il numero di caratteri che è possibile
immettere nel campo specificato). In questo caso specifico, non modificare
le impostazioni.

8 Fare clic su Avanti.

9 Fare clic su Create a primary key (Crea chiave primaria), selezionare
Automatically add a primary key (Aggiungi automaticamente chiave primaria),
scegliere Auto value (Valore automatico), quindi fare clic su Avanti.

10 Accettare il nome di default della tabella, selezionare Create a form based on
this table (Crea modulo basato sulla tabella), quindi fare clic su Fine.

Creazione di un modulo
Il passaggio successivo consiste nel creare il modulo da usare per l'inserimento dei dati
nella rubrica.

1 In Form Wizard (Creazione guidata moduli) fare clic sull'icona con le due frecce
a destra per spostare tutti i campi disponibili nell'elenco Fields in the form (Campi
nel modulo), quindi fare clic due volte su Next (Successivo).
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2 Selezionare la disposizione del modulo, quindi fare clic su Avanti.

3 Selezionare l'opzione che consente di utilizzare il modulo per visualizzare tutti
i dati e lasciare le caselle di controllo vuote, quindi fare clic su Avanti.

4 Applicare uno stile e un bordo campo, quindi fare clic su Avanti.

In questo esempio, lasciare le selezione predefinite.

5 Assegnare un nome al modulo, selezionare l'opzione Modify the form (Modifica
modulo), quindi fare clic su Fine.

Modifica di un modulo
Dopo aver definito un modulo, è possibile modificare il suo aspetto in base alle proprie
preferenze.

1 Chiudere il modulo aperto al termine del passaggio precedente.

2 Nella finestra principale del database, fare clic con il pulsante destro del mouse
sul modulo da modificare (deve essere presente una sola opzione), quindi fare
clic su Modifica.

3 Disporre i campi sul modulo trascinandoli nelle posizioni desiderate.

Ad esempio spostare il campo Nome a destra del campo Cognome, quindi spostare
tutti gli altri campi nelle posizioni desiderate in base alle proprie preferenze.

4 Dopo aver apportato tutte le modifiche desiderate, salvare il modulo e chiuderlo.

Cosa occorre fare a questo punto?
Dopo aver creato le tabelle e i moduli del database è possibile inserire i dati oppure
creare query e rapporti per semplificare l'ordinamento e la visualizzazione dei dati.

Per ulteriori informazioni su Base, vedere la Guida in linea di OpenOffice.org e le altre
risorse elencate nella Sezione 3.8, "Ricerca di assistenza e informazioni su
OpenOffice.org" (p. 110).
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3.6 Creazione di grafici con Draw
Il modulo Draw di OpenOffice.org consente di creare grafici e diagrammi. I disegni
possono essere salvati nei formati più comunemente usati e importati in qualsiasi
applicazione che consenta l'importazione di grafici, compresi gli altri moduli di
OpenOffice.org. È possibile anche creare versioni flash dei propri disegni.

Per istruzioni complete su come usare Draw, vedere la documentazione di
OpenOffice.org. Per ulteriori informazioni, vedere la Sezione 3.8, "Ricerca di assistenza
e informazioni su OpenOffice.org" (p. 110).

Per usare un grafico Draw in un documento:

1 Aprire Draw e creare un grafico.

2 Salvare il grafico.

3 Copiare il grafico e incollarlo nel documento oppure inserirlo direttamente dal
documento.

Una delle funzioni più utili di Draw è quella che consente di aprire l'applicazione in
altri moduli di OpenOffice.org per creare disegni da importare direttamente nel
documento.

1 In un modulo di OpenOffice.org, ad esempio in Writer, fare clic su Inserisci >
Oggetto > OLE Object (Oggetto OLE) > OpenOffice.org 2.x Drawing (Disegno
di OpenOffice.org 2.x) > OK.

Viene aperto il modulo Draw.

2 Creare il disegno desiderato.

3 Fare clic sul documento all'esterno del riquadro di Draw.

Il disegno viene automaticamente inserito nel documento.

Suite per l'ufficio OpenOffice.org 109



3.7 Creazione di formule matematiche
con Math

È generalmente difficile creare complesse formule matematiche nei documenti. L'editor
delle equazioni Math di OpenOffice.org permette di creare formule mediante operatori,
funzioni e procedure guidate per la formattazione. Queste formule possono essere
salvate come oggetti e importate in altri documenti. Le funzioni di Math possono essere
inserite in altri documenti OpenOffice.org come qualsiasi altro oggetto grafico.

NOTA

Math non è un programma di calcolo poiché le funzioni create da questo
programma sono oggetti grafici. Ciò significa che non possono essere valutate
anche se importate in Calc.

3.8 Ricerca di assistenza e
informazioni su OpenOffice.org

OpenOffice include una Guida in linea esauriente ed è supportato da un'ampia comunità
di utenti e sviluppatori. Pertanto, è generalmente facile trovare informazioni sull'uso di
OpenOffice.org. La tabella che segue fornisce alcune indicazioni su altre risorse
utilizzabili per ottenere ulteriori informazioni sull'uso del programma. Tuttavia, è utile
ricordare che le informazioni contenute nella tabella possono non essere aggiornate
perché alcuni siti Web possono essere stati chiusi e alcuni dei loro contenuti modificati.

Menu della Guida in linea di OpenOffice.org
Informazioni complete su tutte le operazioni che possono essere eseguite in
OpenOffice.org.

Pagina di supporto ufficiale di OpenOffice.org (http://support.openoffice
.org/index.html)

Manuali, tutorial, forum di utenti e sviluppatori, mailing list users@openoffice.org,
domande frequenti e molto altro.
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Guida alla migrazione a OpenOffice.org (http://documentation.openoffice
.org/manuals/oooauthors2/0600MG-MigrationGuide.pdf)

Informazioni sulla migrazione a OpenOffice.org da altre suite di programmi per
l'ufficio, compreso Microsoft Office.

Taming OpenOffice.org (http://www.taming-openoffice-org.com/)
Libri, news, suggerimenti e consigli utili.

Macro per OpenOffice.org (http://www.pitonyak.org/oo.php)
Informazioni complete sulla creazione e l'uso di macro.
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4Kontact: e-mail e calendario
Kontact offre un'unica pratica interfaccia per la gestione di informazioni personali nella
quale vengono riunite le funzionalità di varie applicazioni KDE, tra cui KMail per i
messaggi e-mail, KOrganizer per il calendario, KAddressbook per i contatti e KNotes
per le annotazioni. È inoltre possibile sincronizzare dati con dispositivi esterni, quali
PalmPilot o altri palmari. Kontact si integra facilmente con il resto del desktop KDE e
si connette a numerosi server groupware. Sono disponibili funzionalità supplementari,
ad esempio il filtraggio di posta indesiderata e virus e un lettore RSS.

Avvio di Kontact dal menu principale. In alternativa, digitare kontact su una riga di
comando o nella finestra di dialogo Run Command (Esegui comando). Se è necessario
utilizzare solo alcune funzionalità, è anche possibile aprire i singoli componenti anziché
l'applicazione combinata.

4.1 Panoramica di Kontact
La vista di default della finestra, Summary (Riepilogo), è illustrata nella Figura 4.1,
"Finestra di Kontact contenente il riepilogo" (p. 114). Utilizzare i pulsanti nella sezione
di sinistra per accedere ai vari componenti.

Nella Finestra summary (riepilogo) sono disponibili informazioni di base, tra cui i
compleanni che ricorreranno nei giorni immediatamente successivi, le attività da
completare e il numero di nuovi messaggi e-mail. La sezione delle news consente di
accedere a feed RSS per ottenere notizie aggiornate su argomenti di proprio interesse.
Utilizzare Settings (Impostazioni) >Configure Summary view (configura vista riepilogo)
per configurare le informazioni da visualizzare.
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Figura 4.1 Finestra di Kontact contenente il riepilogo

4.1.1 Posta
L'area cartelle visualizzata a sinistra contiene un elenco delle cartelle principali (caselle
postali) in cui è indicato il numero totale di messaggi e il numero di messaggi ancora
non letti. Per selezionare una cartella, è sufficiente fare clic su di essa. I messaggi
contenuti in tale cartella vengono visualizzati nel riquadro in alto a destra. Sulla barra
di stato nella parte inferiore della finestra dell'applicazione è inoltre indicato il numero
di messaggi presenti nella cartella.

Nell'area di intestazione visualizzata a destra vengono indicati l'oggetto, il mittente e
l'ora di ricezione. È sufficiente fare clic sui messaggi per selezionarli e visualizzarli
nell'apposita finestra. Per ordinare i messaggi, è possibile fare clic sull'intestazione di
una delle colonne (oggetto, mittente, data e così via). Il contenuto del messaggio
selezionato viene visualizzato nell'apposito riquadro della finestra. Gli allegati sono
rappresentati da icone riportate alla fine del messaggio, che variano in base al tipo
MIME dell'allegato, oppure possono essere visualizzati in linea.
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I messaggi possono essere contrassegnati con diversi flag di stato. Per modificare lo
stato, Selezionare Message (Messaggio) > mark Message (Contrassegna messaggio).
È possibile utilizzare questa funzionalità per assegnare uno stato a un messaggio, ad
esempio per contrassegnare un messaggio importante da non dimenticare oppure un
messaggio che può essere ignorato. Per visualizzare solo i messaggi con un determinato
Stato, utilizzare Status (stato) sulla barra di ricerca.

4.1.2 Contatti
Nel riquadro in alto a sinistra di questo componente sono riportati tutti gli indirizzi
presenti nella rubrica attivata. Nel riquadro in basso a sinistra sono elencate le rubriche
disponibili ed è indicato se sono attivate. Nel riquadro a destra è visualizzato il contatto
selezionato. Per trovare un particolare contatto, utilizzare la barra di ricerca nella parte
superiore.

4.1.3 Calendario
La vista del calendario è suddivisa in vari riquadri. Per default, vengono visualizzati
un piccolo calendario del mese corrente e una vista della settimana corrente. Sono
inoltre disponibili un elenco delle attività, una vista dettagliata dell'evento o dell'attività
corrente e un elenco dei calendari con il relativo stato. Per selezionare una vista diversa,
utilizzare la barra degli Strumenti oppure il menu View (Visualizza).

4.1.4 Elenco delle attività
In To-do List (Elenco attività) è riportato l'elenco delle attività. Fare clic sul campo
nella parte superiore per aggiungere un nuovo elemento all'elenco. Fare clic con il
pulsante destro del mouse in una colonna di un elemento esistente per apportare
modifiche al valore di tale colonna. Un elemento può essere suddiviso in più elementi
secondari. Fare clic con il pulsante destro del mouse e selezionare new sub-to-do (Nuova
attività secondaria) per creare un elemento secondario. È inoltre possibile assegnare
attività ad altri.
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4.1.5 Registro
Il Journal (Diario) consente di memorizzare riflessioni, ricorrenze o esperienze. Scegliere
una data nel calendario e fare clic su Add Journal Entry (Aggiungi voce del diario) per
aggiungere una nuova voce. Se nella data prescelta è già presente una voce del diario,
questa può essere modificata.

4.1.6 Note
Utilizzare il componente per le annotazioni per creare annotazioni personali. Se si
utilizza KDE, scegliere l'icona KNote sulla barra delle applicazioni per visualizzare le
annotazioni sul desktop.

4.1.7 Fonti
La Finestra Feeds (fonti) è suddivisa in tre strutture, una vista ad albero CON le fonti
rss a sinistra, un elenco di articoli in alto a destra e la vista degli articoli in basso a
destra. Per visualizzare una fonte della vista ad albero, fare clic su di essa. Fare clic con
il pulsante destro del mouse su una fonte per aggiornarla, modificarla o eliminarla. Fare
clic con il pulsante destro del mouse su una cartella della vista ad albero per aprire un
menu che consenta di aggiungere una nuova fonte o di modificare le fonti esistenti nella
cartella.

4.2 Posta
Kontact utilizza KMail come componente per i messaggi e-mail. Per configurarlo, aprire
il componente per la posta, quindi Selezionare Settings (Impostazioni) > configure
KMail (Configura KMail). KMail è un client completo per i messaggi e-mail che
supporta vari protocolli. Nel menu Tools (Strumenti) sono disponibili vari strumenti
che consentono di gestire i messaggi e-mail indesiderati. Utilizzare Find (Trova) per
eseguire una ricerca dettagliata dei messaggi.Anti-SpamWizard (Configurazione guidata
posta indesiderata) consente di configurare in modo semplificato gli strumenti per
filtrare i messaggi e-mail commerciali indesiderati. Anti-Virus Wizard (Configurazione
guidata strumenti anti-virus) consente di configurare in modo semplificato gli strumenti
anti-virus per i messaggi e-mail. Queste due procedure guidate possono essere utilizzate
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con prodotti software anti-virus e per la posta indesiderata esterni. Se queste opzioni
sono disabilitate, installare pacchetti aggiuntivi per garantire una protezione contro
posta indesiderata e virus.

Figura 4.2 Componente di Kontact per la posta

4.2.1 Configurazione di identità e account
Kontact è in grado di gestire più account e-mail, ad esempio l'indirizzo e-mail privato
e quello dell'ufficio. Quando si scrive un messaggio e-mail, selezionare una delle identità
definite in precedenza facendo Clic su View (Visualizza) > Identity (Identità). Per creare
un nuovo profilo di identità, Selezionare Settings (Impostazioni) > configure Kmail
(Configura kmail), quindi Identities (Identità) >Add (Aggiungi). Nella finestra di dialogo
visualizzata assegnare un nome alla nuova identità, ad esempio "privata" o "ufficio".
Fare clic su OK per visualizzare una finestra di dialogo in cui è possibile immettere
informazioni aggiuntive. È inoltre possibile assegnare un'identità a una cartella affinché,
quando si risponde a un messaggio in tale cartella, venga selezionata l'identità assegnata.

Nella scheda General (Generale) immettere il proprio nome, l'organizzazione e
l'indirizzo e-mail. In Cryptography (Cifratura) selezionare le chiavi per l'invio di
messaggi cifrati o con firma digitale. Per poter utilizzare le funzionalità di cifratura, è
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prima necessario creare una chiave con KGpg, come descritto nel Capitolo 10,Cifratura
con KGpg (p. 191).

In Advanced (Avanzate) è possibile immettere un indirizzo di risposta e un indirizzo
ccn (copia per conoscenza nascosta) di default, scegliere un dizionario, selezionare le
cartelle per le bozze e i messaggi inviati e definire la modalità di invio dei messaggi.
In Signature (Firma) specificare se e come si desidera firmare ogni messaggio
aggiungendo un blocco di testo supplementare alla fine. Ad esempio, si potrebbe firmare
ogni messaggio e-mail specificando le proprie informazioni di contatto. Per attivare
questa opzione, selezionare Enable Signature (abilita firma) e scegliere se si desidera
ottenere la firma da un file, da un campo di input oppure dall'output di un comando.
Picture (Immagine) consente di specificare il percorso relativo a una piccola (48x48
pixel) icona monocromatica che verrà visualizzata in tutti i messaggi e-mail, a
condizione che il software del destinatario supporti tale funzionalità. Dopo avere
configurato tutte le impostazioni dell'identità desiderate, confermarle facendo clic su
OK.

Le impostazioni in Accounts (Account) stabiliscono la modalità di invio e ricezione dei
messaggi e-mail in Kontact. Sono disponibili due schede, una per l'invio e l'altra per la
ricezione della posta. Molte delle impostazioni variano in base al sistema e alla rete in
cui si trova il server della posta. Se non si è sicuri delle impostazioni o degli elementi
da selezionare, consultare il proprio ISP (Provider di servizi Internet) o l'amministratore
di sistema.

Per creare caselle postali per la posta in uscita, nella scheda Sending (Invio) fare clic
su Add (Aggiungi). Scegliere tra i tipi di trasporto SMTP e sendmail. Nella maggior
parte dei casi la scelta corretta è SMTP. Al termine di questa selezione, viene visualizzata
una finestra in cui è possibile immettere i dati del server SMTP. Specificare un nome
e immettere l'indirizzo del server (ricevuto dall'ISP). Se il server richiede l'autenticazione
dell'utente, selezionare Server requires authentication (Il server richiede
l'autenticazione). Le impostazioni di sicurezza sono incluse nella scheda Security
(Sicurezza). In questa scheda, è possibile specificare il metodo di cifratura preferito.

Nella scheda Receiving (Ricezione) è possibile definire le impostazioni per la ricezione
dei messaggi di e-mail. Si può utilizzareAggiungi per creare un nuovo account. Scegliere
tra i diversi metodi di recupero della posta, ad esempio i formati Mbox e Maildir locali
oppure POP3 o IMAP. Configurare le impostazioni appropriate in base al server in uso.
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4.2.2 Importazione di messaggi e-mail da
altri programmi di posta

Per importare messaggi e-mail da altre applicazioni, selezionare File > Import Messages
(Importa messaggi) dalla vista e-mail di Kontact. Attualmente sono disponibili filtri di
importazione per Outlook Express, il formato mbox, il formato di testo dei messaggi
e-mail, Pegasus Mail, Opera, Evolution e altri ancora. L'utility di importazione può
essere avviata anche separatamente con il comando kmailcvt.

Selezionare l'applicazione corrispondente e confermare facendo clic su Continue
(Continua). In base al tipo selezionato, è necessario specificare un file o una cartella.
Il processo verrà completato automaticamente da Kontact.

4.2.3 Creazione di messaggi
Per comporre nuovi messaggi, selezionare Message (Messaggio) > New Message
(Nuovo messaggio) oppure fare clic sull'icona corrispondente nella barra degli strumenti.
Per inviare i messaggi utilizzando account e-mail diversi, selezionare un'identità come
descritto nella Sezione 4.2.1, "Configurazione di identità e account" (p. 117). In To (A)
immettere un indirizzo e-mail oppure parte di un nome o un indirizzo presente nella
rubrica. Se Kontact è in grado di associare le informazioni specificate alle informazioni
presenti nella rubrica, viene visualizzato un elenco di selezione. Fare clic sul contatto
desiderato oppure completare l'input se non viene rilevata alcuna corrispondenza. Per
selezionare direttamente dalla rubrica, fare clic sul pulsante ... accanto al campo Address
(Indirizzo).

Per allegare file al messaggio, fare clic sull'icona a forma di graffetta e selezionare il
file da allegare. In alternativa, trascinare un file dal desktop o da un'altra cartella nella
finestra New Message (Nuovo messaggio) o selezionare una delle opzioni nel menu
Attach (Allega). In genere, il formato di un file viene riconosciuto correttamente. In
caso contrario, fare clic con il pulsante destro del mouse sull'icona. Dal menu che viene
visualizzato, selezionare Properties (Proprietà). Impostare il formato e il nome di file
nella finestra di dialogo successiva e aggiungere una descrizione. Specificare inoltre
se il file allegato deve essere firmato o cifrato.

Dopo avere creato il messaggio, è possibile inviarlo immediatamente selezionando
message (Messaggio) > Send (invia) oppure spostarlo nella cartella outbox selezionando
Message (Messaggio) > Send Later (Invia dopo) . Se si sceglie di inviare il messaggio
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e-mail e l'invio ha esito positivo, il messaggio viene copiato nella cartella sent-mail.
I messaggi spostati nella cartella outbox possono essere modificati o cancellati.

4.2.4 Messaggi e-mail cifrati e firme
Per cifrare un messaggio e-mail, generare innanzitutto una coppia di chiavi come
descritto nel Capitolo 10, Cifratura con KGpg (p. 191). Per configurare i dettagli della
procedura di cifratura, selezionare Settings (Impostazioni) >Configure Kmail (configura
kmail) > Identities (identità)per specificare l'identità da utilizzare per inviare messaggi
cifrati e con firma. Fare quindi Clic su Modify (Modifica). Quando si fa clic su OK per
confermare l'operazione, la chiave dovrebbe venire visualizzata nel campo
corrispondente. Chiudere la finestra di dialogo di configurazione facendo clic su OK.

4.2.5 Cartelle
Le cartelle dei messaggi consentono di organizzare i messaggi e-mail. Per default, si
trovano nella directory ~/.kde/share/apps/kmail/mail. Al primo avvio di
KMail, il programma crea alcune cartelle inboxè quella in cui i nuovi messaggi
recuperati da un server vengono inizialmente posti, outbox viene usata per archiviare
temporaneamente i messaggi in coda per essere inviati, sent-mail viene usata per
archiviare le copie dei messaggi inviati.trash contiene tutti i messaggi e-mail eliminati
con Canc o con il comando Edit (Modifica) > Move to Trash (Sposta nel cestino).
drafts è la cartella in cui è possibile salvare i messaggi incompleti. Se si utilizza
IMAP, le cartelle IMAP sono elencate sotto quelle locali. L'elenco Cartella contiene le
cartelle specifiche di ogni server di posta in entrata.

Per oganizzare i messaggi in cartelle aggiuntive, creare nuove cartelle selezionando
Cartella > Nuova Cartella. Viene visualizzata una finestra in cui è possibile specificare
il nome e il formato della nuova cartella.

Fare clic con il pulsante destro del mouse sulla cartella per visualizzare un menu
contestuale che consente di eseguire diverse operazioni sulle cartelle. Fare clic su Expire
(Scadenza) per specificare la data di scadenza dei messaggi letti e non letti, l'operazione
da eseguire dopo la scadenza e se i messaggi scaduti devono essere cancellati o spostati
in una cartella. Se si desidera utilizzare la cartella per memorizzare i messaggi ricevuti
da una mailing list, impostare le opzioni necessarie In Folder (Cartella) > Mailing list
Management (Gestione mailing list).
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Per spostare da una cartella a un'altra uno o più messaggi, selezionarli nella finestra
superiore, trascinarli e rilasciarli nella cartella appropriata della finestra a sinistra. I
messaggi possono inoltre essere spostati evidenziandoli e premendo M o selezionando
Message (messaggio) > Move To (sposta in). Verrà visualizzato un elenco nel quale è
possibile selezionare la cartella in cui si desidera spostare i messaggi.

4.2.6 Filtri
I filtri rappresentano un utile strumento per elaborare automaticamente i messaggi e-
mail in entrata. Possono essere utilizzati per spostare messaggi e-mail in determinate
cartelle, cancellare messaggi e-mail indesiderati, rinviare messaggi e-mail al mittente
o eseguire varie altre operazioni in base a particolari caratteristiche del messaggio, ad
esempio il mittente o la dimensione.

Impostazione di un filtro
Per creare un filtro da zero, selezionare Settings (Impostazioni) > Configure filters
(Configura filtri) . Per creare un filtro in base a un messaggio esistente, fare clic con il
pulsante destro del mouse sul messaggio e quindi selezionareCreate Filter (Crea filtro)
e i criteri di filtro desiderati.

Selezionare il metodo di corrispondenza desiderato per i criteri di filtro, ovvero
specificare se è necessario che vengano soddisfatti tutti i criteri oppure solo uno di essi.
Selezionare quindi i criteri applicabili solo ai messaggi desiderati. In Filter Actions
(azioni filtro) impostare le azioni che il filtro deve eseguire sui messaggi che soddisfano
i criteri. Advanced Options (opzioni avanzate) consente di controllare quando il filtro
viene applicato e se è necessario considerare filtri aggiuntivi per questi messaggi.

Applicazione di filtri
I filtri vengono applicati nell'ordine specificato nella finestra di dialogo a cui si accede
selezionando Settings (Impostazioni) >Configure Filters (Configura filtri). Per cambiare
l'ordine, selezionare un filtro e fare clic sui pulsanti freccia. I filtri vengono applicati
solo ai nuovi messaggi in entrata o ai messaggi inviati, in base alle impostazioni
configurate nelle opzioni avanzate del filtro. Per applicare i filtri ai messaggi esistenti,
fare clic con il pulsante destro del mouse sui messaggi e scegliere Apply Filter (Applica
filtro) e il filtro desiderato.
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Se i filtri non vengono applicati come previsto, selezionare tools (strumenti) > Filter
Log Viewer (Visualizzatore log filtri) per controllare le modalità di applicazione. Quando
la registrazione è abilitata in questa finestra di dialogo, vengono visualizzate le modalità
in base a cui i filtri elaborano i messaggi per semplificare l'individuazione del problema.

4.3 Contatti
Il componente per i contatti utilizza KAddressBook. Per configurarlo, selezionare
Settings (Impostazioni) > Configure kaddressbook (Configura KAddressBook). Per
cercare un particolare contatto, utilizzare la barra di ricerca. Filter (Filtro) consente di
visualizzare solo i contatti di una determinata categoria. Fare clic con il pulsante destro
del mouse su un contatto per visualizzare un menu in cui è possibile selezionare diverse
opzioni, ad esempio per inviare le informazioni di contatto in un messaggio e-mail.

Figura 4.3 Rubrica di Kontact

4.3.1 Aggiunta di contatti
Per aggiungere nella rubrica un contatto con nome e indirizzo e-mail dall'interno di un
messaggio e-mail, fare clic con il pulsante destro del Mouse sull'indirizzo Nel
Componente per la posta e selezionare Open in Address Book (Apri nella rubrica). Per
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aggiungere un nuovo contatto senza utilizzare un messaggio e-mail, Selezionare File
(File) > new contact (nuovo contatto) nel componente per la rubrica. Entrambe queste
procedure consentono di visualizzare una finestra di dialogo in cui è possibile immettere
informazioni sul contatto.

Nella scheda General (Generale) immettere le informazioni di base sul contatto, ad
esempio il nome, gli indirizzi e-mail e i numeri di telefono. Per ordinare gli indirizzi è
possibile utilizzare le categorie.Details (Dettagli) contiene informazioni più specifiche,
ad esempio la data di compleanno e il nome del coniuge.

Se il contatto utilizza un servizio di messaggistica in tempo reale, è possibile aggiungere
queste identità in IM Addresses (Indirizzi messaggistica in tempo reale). Se si effettua
questa operazione e viene eseguito Kopete o un altro programma di chat KDE
contemporaneamente a Kontact, è possibile visualizzare le informazioni di stato su
queste identità in Kontact. In Crypto Settings (Impostazioni cifratura) immettere i dati
relativi alla cifratura del contatto, ad esempio la chiave pubblica.

Misc (Varie) contiene ulteriori informazioni, ad esempio una fotografia e la posizione
delle informazioni Free/Busy (Disponibilità) dell'utente. Utilizzare Custom Fields
(Campi personalizzati) per aggiungere informazioni personalizzate al contatto o alla
rubrica.

I contatti possono inoltre essere importati in numerosi formati. Utilizzare File (File) >
Import (importa) e scegliere il formato desiderato. quindi selezionare il file da importare.

4.3.2 Creazione di una lista di distribuzione
Se si inviano spesso messaggi e-mail a uno stesso gruppo di persone, una lista di
distribuzione consente di memorizzare più indirizzi e-mail come un singolo contatto,
in modo da non dovere immettere tutti i nomi in ogni messaggio e-mail inviato a tale
gruppo. Fare innanzitutto clic su Settings (Impostazioni) > Show Extension Bar (mostra
barra estensioni) > Distribution List Editor (Editor lista di distribuzione). Nella nuova
sezione visualizzata fare clic su New List (Nuova lista). Immettere un nome per la lista
e quindi fare clic su OK. Aggiungere contatti alla lista trascinandoli dall'elenco degli
indirizzi nella finestra della lista di distribuzione. Quando si crea un messaggio e-mail,
è possibile utilizzare questa lista come un normale contatto.
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4.3.3 Aggiunta di rubriche
IMPORTANTE: rubriche groupware

Il modo migliore per aggiungere risorse groupware consiste nell'utilizzare uno
strumento separato denominato groupware wizard (configurazione guidata
groupware). A tale scopo, chiudere Kontact, quindi eseguire
groupwarewizard in una riga di comando o dal gruppo Office (Ufficio) del
menu KDE. Selezionare il tipo di server, ad esempio SLOX, GroupWise o
Exchange, dall'elenco visualizzato, quindi immettere l'indirizzo e i dati per
l'autenticazione. La procedura guidata aggiungerà le risorse disponibili a Kontact.

Kontact consente di accedere a più rubriche, ad esempio quelle condivise da Novell
GroupWise o in un server LDAP. Selezionare Settings (Impostazioni) > Show Extension
Bar (Mostra barra estensioni) > Address Books (rubriche) per visualizzare le rubriche
correnti. Fare clic su Add (Aggiungi) per aggiungerne una, quindi selezionare il tipo e
immettere le informazioni richieste.

Le caselle di controllo accanto alle rubriche indicano lo stato di attivazione di ognuna
di esse. Per impedire che una rubrica venga visualizzata senza però cancellarla,
deselezionare la casella di controllo. Remove (Rimuovi) cancella la rubrica selezionata
dall'elenco.

4.4 Calendario
Kontact utilizza KOrganizer come componente per il calendario. Per configurarlo,
utilizzare Settings (Impostazioni) > Configure KOrganizer (configura KOrganizer).
Nel calendario è possibile immettere appuntamenti e pianificare riunioni. Se lo si
desidera, è possibile impostare un promemoria per gli eventi imminenti. È inoltre
possibile importare, esportare e archiviare calendari utilizzando le opzioni del menu
File.
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Figura 4.4 Calendario di Kontact

4.4.1 Pianificazione di un evento
Per aggiungere un nuovo evento o una nuova riunione, selezionare Actions (Azioni) >
New Event (Nuovo evento). Immettere i dettagli desiderati. In Reminder (promemoria)
specificare il momento esatto (numero di minuti, ore o giorni in anticipo) in cui si
desidera ricordare l'evento ai partecipanti. Se un evento è ricorrente, specificare
l'intervallo appropriato. Un altro modo per creare un evento in un punto specifico del
calendario consiste nel fare doppio clic sul campo corrispondente in una delle viste del
calendario del programma. Viene visualizzata la stessa finestra di dialogo accessibile
dal menu. In alternativa, selezionare un intervallo di tempo nella vista del calendario e
fare clic con il pulsante destro del mouse.

Specificare i partecipanti a un evento immettendo i relativi dati manualmente nella
finestra di dialogo oppure inserendo i dati dalla rubrica. Per immettere i dati
manualmente, selezionare New (Nuovo). Per importare i dati dalla rubrica, fare clic su
Select Addressee (Seleziona destinatario), quindi selezionare le voci corrispondenti
nella finestra di dialogo. Per pianificare l'evento in base alla disponibilità dei partecipanti,
utilizzare Free/Busy (Disponibilità) e fare clic su Pick Date (Seleziona data).
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Utilizzare la scheda Recurrence (Ricorrenza) per configurare un evento che si verifica
periodicamente. Attachments (Allegati) può essere utile per collegare altre informazioni
all'evento, ad esempio l'agenda per una riunione.

4.4.2 Aggiunta di calendari
IMPORTANTE: calendari groupware

Il modo migliore per aggiungere risorse groupware consiste nell'utilizzare Uno
Strumento separato denominato groupware wizard (configurazione guidata
groupware). A tale scopo, chiudere Kontact, quindi eseguire
groupwarewizard in una riga di comando o dal gruppo Office (Ufficio) del
menu KDE. Selezionare il tipo di server, ad esempio SLOX, GroupWise o
Exchange, dall'elenco visualizzato, quindi immettere l'indirizzo e i dati per
l'autenticazione. La procedura guidata aggiungerà le risorse disponibili a Kontact.

Il modulo del calendario può connettersi contemporaneamente a più calendari. Questa
funzionalità risulta utile, ad esempio, per utilizzare un calendario personale in
combinazione con un calendario organizzativo. Per aggiungere un nuovo calendario,
fare clic su Add (Aggiungi), quindi selezionare il tipo di calendario. Completare i campi
necessari.

Le caselle di controllo accanto ai calendari indicano lo stato di attivazione di ognuno
di essi. Per impedire che un calendario venga visualizzato senza però cancellarlo,
deselezionare la casella di controllo.Remove (Rimuovi) cancella il calendario selezionato
dall'elenco.

4.5 Sincronizzazione di dati con un
palmare

Kontact è stato progettato in modo da supportare la sincronizzazione dei dati con
dispositivi palmari, ad esempio Palm. È possibile visualizzare le informazioni sullo
stato di KPilot nel riepilogo. Per informazioni sulla configurazione e sull'uso di kpilot,
fare riferimento al Capitolo 6, Sincronizzazione di un palmare con KPilot (p. 149).
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4.6 Informazioni su Kontact per gli
utenti di GroupWise

Gli utenti che conoscono già GroupWise non avranno difficoltà a utilizzare Kontact.
Questi due programmi condividono molti concetti di base e offrono un gran numero di
servizi comuni a entrambi. In questa sezione vengono illustrate le differenze
terminologiche più importanti e vengono forniti alcuni suggerimenti per consentire agli
utenti di GroupWise di sfruttare al meglio le funzionalità di Kontact.

4.6.1 Differenze terminologiche
Nella seguente tabella vengono elencate alcune delle principali differenze terminologiche
esistenti tra Kontact e GroupWise.

Tabella 4.1 Differenze terminologiche tra Kontact e GroupWise

KontactGroupWise

EventsAppuntamenti

DisponibilitàRicerca ore libere

Journal Entries (Voci del journal)Note

Un evento senza partecipanti è pubblicato, un
evento con partecipanti è un elemento inviato

Elementi pubblicati, non pubblicati

To-dos (Attività)Compiti

4.6.2 Suggerimenti per gli utenti di
GroupWise

In questa sezione viene fornito qualche suggerimento per consentire agli utenti di
GroupWise di familiarizzare con alcune delle differenze esistenti tra GroupWise e
Kontact.
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Informazioni di contatto
È possibile aggiungere il proprio GroupWise Messenger e i contatti e-mail alle
informazioni di contatto di Kontact. È quindi possibile creare un messaggio e-mail
oppure aprire una sessione di messaggistica in tempo reale con tale contatto facendo
clic con il pulsante destro del mouse sul nome nella vista del contatto.

Codifica a colori
Può essere utile contrassegnare con un colore gli elementi sia di GroupWise sia
provenienti da altre origini. La codifica a colori semplifica la scansione dei messaggi
e-mail, dei contatti e di altre informazioni per gli elementi di una particolare origine.

Invito alla partecipazione di un evento
Kontact si differenzia da GroupWise in quanto il nome dell'utente che ha pianificato
un evento non viene immesso automaticamente come partecipante. Ricordarsi pertanto
di inviare un invito anche a se stessi.

4.7 Ulteriori informazioni
In Kontact è disponibile una guida contenente informazioni sia su questo programma
che sui relativi componenti. Per accedervi, selezionare Help (Guida) > Kontact
Handbook (Manuale Kontact). Informazioni sul programma sono inoltre disponibili
nella pagina Web del progetto all'indirizzo http://www.kontact.org.
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5Client Linux GroupWise:
e-mail e calendario
GroupWise® è un affidabile sistema di messaggistica e collaborazione che consente
agli utenti di connettersi ovunque e in qualsiasi momento alla propria casella di posta
universale. La presente sezione include una panoramica del client GroupWise per
consentire di iniziare a utilizzare questa applicazione in maniera facile e veloce.

5.1 Descrizione della finestra
principale di GroupWise

L'area di lavoro principale di GroupWise è denominata finestra principale. Dalla finestra
principale di GroupWise, è possibile leggere i messaggi, pianificare gli appuntamenti,
visualizzare il calendario, gestire i contatti, modificare la modalità di esecuzione di
GroupWise, aprire le cartelle e altro ancora.
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Figura 5.1 Finestra principale di GroupWise

Per aprire più finestre principali in GroupWise, fare clic su Finestra NewMain Window
(Nuova finestra principale). Ciò risulta particolarmente utile se si dispone dei diritti di
utente incaricato per un altro utente. È anche possibile visualizzare la finestra principale
personale e quella della persona di cui si è utente incaricato. Può essere opportuno aprire
una cartella in una finestra e visualizzare il calendario in un'altra. È possibile aprire il
numero di finestre supportato dalla memoria del computer in uso.

Di seguito sono illustrati i componenti di base della finestra principale.

5.1.1 Barra degli strumenti
La barra degli strumenti consente di eseguire i task comuni di GroupWise, ad esempio
l'apertura della Rubrica, l'invio di messaggi e-mail e la ricerca di un elemento. Per
ulteriori informazioni sulla barra degli strumenti, vedere la Sezione 5.4, "Utilizzo della
barra degli strumenti" (p. 142).

5.1.2 Intestazione degli elenchi delle cartelle
e degli elementi

Nell'intestazione della cartella e dell'elenco di elementi è disponibile un elenco a discesa
in cui è possibile selezionare la modalità di esecuzione di GroupWise (Online o Caching),
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scegliere di aprire la casella postale archiviata o di backup e selezionare una casella
postale proxy.

5.1.3 Elenco cartelle
L'elenco di cartelle a sinistra della finestra principale consente di organizzare gli elementi
di GroupWise. È possibile creare nuove cartelle in cui memorizzare gli elementi. Accanto
a ogni cartella, fatta eccezione per quelle condivise, il numero degli elementi non letti
è riportato tra parentesi quadre. Accanto alla cartella degli elementi inviati è visualizzato
un numero tra parentesi quadre che corrisponde agli elementi ancora da inviare dalla
modalità Caching.

Di seguito è illustrato il contenuto di ciascuna delle due cartelle di default:

• Sezione "Cartella utente" (p. 131)

• Sezione "Cartella Casella postale" (p. 132)

• Sezione "Cartella Elementi inviati" (p. 132)

• Sezione "Cartella Calendario" (p. 133)

• Sezione "Cartella Contatti" (p. 133)

• Sezione "Cartella Elenco di controllo" (p. 133)

• Sezione "Cartella Documenti" (p. 135)

• Sezione "Cartella Cestino" (p. 135)

• Sezione "Cartelle condivise" (p. 136)

Cartella utente
La cartella degli utenti (indicata dal nome) rappresenta il database di GroupWise. Tutte
le cartelle incluse nella Finestra principale sono sottocartelle della cartella utente.
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Cartella Casella postale
La cartella Casella postale contiene tutti gli elementi ricevuti, ad eccezione degli elementi
pianificati (appuntamenti, compiti e note) accettati o rifiutati dall'utente. Gli elementi
pianificati accettati vengono spostati nel calendario.

Cartella Elementi inviati
La cartella Elementi inviati mostra tutti gli elementi inviati dalla Casella postale e dal
Calendario. Nelle versioni di GroupWise precedenti alla 6.5, Elementi inviati è una
cartella di interrogazioni con alcune differenze rispetto alla cartella Elementi inviati
attuale.

Di seguito è riportata una tabella comparativa tra la cartella Sent Items Query
(Interrogazione elementi inviati) delle versioni precedenti e la cartella Elementi inviati
della versione attuale.

Tabella 5.1 Confronto tra la cartella di interrogazione Elementi inviati e la cartella
Elementi inviati

Cartella di interrogazione Elementi inviati
(precedente)

Cartella Elementi inviati (versione
corrente)

In realtà questa è una cartella dei risultati di
ricerca e non contiene quindi alcun elemento.

Tutti gli elementi inviati sono
presenti in questa cartella, a meno

in quanto si tratta di una cartella Risultati dellache non vengano spostati in una
ricerca. Quando si seleziona la cartella vienecartella diversa da Casella postale o
infatti eseguita una ricerca e i risultati, ossiaCalendario. Se un elemento inviato
tutti gli elementi inviati, vengono visualizzativiene spostato in un'altra cartella,
nella cartella. Se si elimina un elemento danon sarà più visualizzato nella

cartella Elementi inviati. questa cartella, l'elemento originale rimane
nella relativa cartella di origine e viene di
nuovo visualizzato alla successiva apertura
della cartella.

È possibile inviare o pianificare nuovamente
oppure ritirare gli elementi inviati da questa
cartella.

È possibile inviare o pianificare
nuovamente oppure ritirare gli
elementi inviati da questa cartella.
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Cartella Calendario
La icona della cartella Calendario include numerose opzioni per la visualizzazione
del calendario.

Cartella Contatti
Per default la cartella Contatti rappresenta la rubrica Contatti frequenti nella Rubrica.
Le modifiche apportate nella cartella Contatti vengono applicate anche alla rubrica
Contatti frequenti.

Questa cartella consente di visualizzare, creare e modificare contatti, risorse,
organizzazioni e gruppi.

Gli utenti incaricati non possono visualizzare la cartella Contatti.

Cartella Elenco di controllo
La cartella Elenco di controllo consente di creare un elenco di compiti. È possibile
spostare in questa cartella elementi di qualsiasi tipo (messaggi, telefonate, note, compiti
o appuntamenti) e disporli nell'ordine desiderato. A ogni elemento è associata una
casella di controllo, che è possibile selezionare per contrassegnare gli elementi una
volta completati.

Di seguito sono illustrate le differenze tra la cartella Elenco di controllo e la cartella di
interrogazione Elenco dei compiti disponibile nelle versioni precedenti di GroupWise.

Tabella 5.2 Confronto tra la cartella Elenco di controllo e la cartella Elenco dei
compiti

Cartella Elenco dei compitiCartella Elenco di controllo

In realtà questa è una cartella dei risultati di ricerca
e non contiene quindi alcun elemento. in quanto

Questa cartella contiene i
seguenti elementi:

si tratta di una cartella Risultati della ricerca.
• Elementi spostati dall'utente

nella cartella
Quando si seleziona la cartella viene infatti
eseguita una ricerca e i risultati, ossia tutti i
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Cartella Elenco dei compitiCartella Elenco di controllo

compiti pianificati, vengono visualizzati nella
cartella. Se si elimina un elemento da questa

• Elementi pubblicati in questa
cartella

cartella, l'elemento originale rimane nella relativa
• Elementi appartenenti a un

elenco di controllo creato
dall'utente in un'altra cartella

cartella di origine e viene di nuovo visualizzato
alla successiva apertura della cartella.

In questa cartella vengono visualizzate solo
attività, ossia elementi pianificati associati a una
data di scadenza.

Questa cartella può contenere
elementi di qualsiasi tipo.

Per contrassegnare un elemento come completato,
aprirlo e fare clic su Completato.

Per contrassegnare un compito
come completato, fare clic sulla
casella di controllo accanto
all'elemento corrispondente
nell'Elenco elementi.

Le date di scadenza vengono impostate dall'utente
che ha inviato il compito. Se un utente pubblica
un compito per se stesso, può impostare la relativa
data di scadenza.

Per impostare un priorità per un elemento, aprirlo
e digitare una priorità nel campo Priorità.

I compiti vengono visualizzati nell'Elenco dei
compiti del calendario e possono essere

Gli elementi dell'elenco di
controllo non vengono

contrassegnati come completati dal calendario
stesso.

visualizzati nell'Elenco dei
compiti del calendario.

I compiti la cui data di scadenza è stata
oltrepassata vengono visualizzati in rosso nel
calendario.
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Cartella Documenti
I riferimenti ai documenti sono organizzati nella cartella Documenti in modo da poter
essere individuati con facilità.

La cartella Documenti può contenere solo documenti. Pertanto, se in questa cartella
viene spostato un altro tipo di documento da parte di un client GroupWise precedente
alla versione 5.5, l'elemento viene eliminato.

Cartella Schedario
La cartella Schedario contiene tutte le cartelle personali dell'utente. Per riordinare e
nidificare le cartelle, fare clic su Modifica > Cartelle. Per modificare il criterio di
ordinamento delle cartelle, fare clic con il pulsante destro del mouse sulla cartella
Schedario, scegliereProprietà, quindi selezionare il criterio di ordinamento desiderato.

Cartella Posta indesiderata
La cartella Posta indesiderata contiene tutti gli elementi provenienti da indirizzi e domini
Internet impostati come indesiderati in Gestione posta indesiderata. Questa cartella
viene creata solo se viene abilitata un'opzione di Gestione posta indesiderata.

Se le opzioni di Posta indesiderata sono abilitate, non è possibile eliminare questa
cartella, è possibile rinominarla o spostarla in una posizione diversa nell'elenco di
cartelle. Se tutte le opzioni di Posta indesiderata sono disabilitate, è possibile eliminare
la cartella. o se tale funzione è stata disabilitata dall'amministratore di sistema.

Per eliminare gli elementi dalla cartella Posta indesiderata, fare clic con il pulsante
destro del mouse sulla cartella, quindi su Empty Junk Mail Folder (Svuota cartella
Posta indesiderata) e infine su Sì.

Cartella Cestino
Tutti i messaggi, le telefonate, gli appuntamenti, i compiti, i documenti e le note
cancellati vengono memorizzati nella cartella Cestino. Gli elementi inclusi nel cestino
possono essere visualizzati, aperti o rinviati alla casella postale prima di svuotare il
cestino. Lo svuotamento del cestino implica la rimozione degli elementi in esso contenuti
dal sistema.
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È possibile svuotare l'intero cestino oppure rimuovere soltanto gli elementi selezionati.
Gli elementi nel Cestino vengono svuotati automaticamente in base al numero di giorni
specificato nella scheda di pulizia nelle opzioni dell'ambiente. In alternativa, è possibile
svuotare il cestino manualmente. L'amministratore di sistema può impostare lo
svuotamento automatico del cestino a intervalli regolari.

Cartelle condivise
Una cartella condivisa non differisce dalle altre cartelle dello schedario se non per il
fatto di essere accessibile anche ad altri utenti. È possibile creare cartelle condivise o
condividere cartelle personali già presenti nel proprio schedario. È possibile scegliere
gli utenti con cui condividere la cartella e i diritti da assegnare a ciascuno di essi. Gli
utenti scelti potranno pubblicare elementi nella cartella condivisa, trascinare elementi
esistenti nella cartella e creare sviluppi di discussioni. Non è possibile condividere le
cartelle del sistema, tra cui le cartelle Schedario, Cestino e Lavori in corso.

5.1.4 Elenco elementi
Nell'elenco di elementi visualizzato nella parte destra della finestra principale vengono
visualizzati i messaggi, le telefonate, gli appuntamenti, le note, i compiti e i riferimenti
ai documenti. Per ordinare l'elenco di elementi, fare clic su un'intestazione di colonna.
Fare nuovamente clic sull'intestazione di colonna per invertire l'ordinamento. Per
ulteriori informazioni sulle icone utilizzate con diversi elementi, vedere la Sezione 5.3.2,
"Icone accanto agli elementi della Casella postale e del Calendario" (p. 139).

5.1.5 QuickViewer
QuickViewer viene visualizzato sotto gli elenchi delle cartelle e degli elementi.
QuickViewer consente di effettuare rapidamente la scansione degli elementi e dei relativi
allegati senza aprire ciascuno di essi in un'altra finestra.
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5.2 Utilizzo di diverse modalità di
GroupWise

GroupWise fornisce due diversi sistemi per l'esecuzione del client di GroupWise: la
modalità In linea e la modalità Caching.

È possibile che un utente sia autorizzato a eseguire GroupWise in entrambe le modalità
oppure che l'amministratore di sistema imposti l'utilizzo di una sola modalità specifica.

Quasi tutte le funzioni di GroupWise sono disponibili in entrambe le modalità di
esecuzione di GroupWise, con alcune eccezioni. L'attivazione delle notifiche di altri
utenti non è disponibile in modalità caching.

5.2.1 Modalità in linea
Quando si utilizza la modalità in linea, si è connessi al proprio ufficio postale in rete.
Nella casella postale vengono visualizzati i messaggi e le informazioni memorizzati
nella casella postale di rete, denominata anche Casella postale in linea. In modalità in
linea si è continuamente connessi alla casella postale di rete. In questa modalità, se
l'agente dell'ufficio postale si spegne o la connessione di rete viene interrotta, si perde
temporaneamente la connessione alla casella postale.

Utilizzare questa modalità se il traffico di rete è ridotto o se si utilizzano più workstation
e non si desidera scaricare una casella postale locale su ciascuna di esse.

5.2.2 Modalità caching
In modalità caching una copia della casella postale di rete, inclusi i messaggi e altre
informazioni, viene memorizzata sull'unità locale. In questo modo è possibile utilizzare
GroupWise anche se la rete o l'agente dell'ufficio postale non è disponibile. Poiché non
si è continuamente connessi alla rete, questa modalità riduce il traffico di rete e offre
prestazioni migliori. Per richiamare e inviare nuovi messaggi viene stabilita
automaticamente una connessione. Tutti gli aggiornamenti vengono eseguiti in
background, senza interruzioni del lavoro.
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Per utilizzare la modalità Caching, per il client deve essere effettuata l'installazione
standard anziché workstation.

Utilizzare questa modalità se si dispone di sufficiente spazio sul disco locale per
memorizzare la casella postale.

Diversi utenti possono configurare le proprie caselle postali di caching su un singolo
computer condiviso.

5.3 Descrizione della Casella postale
Tutti gli elementi, inviati o ricevuti, vengono memorizzati nella Casella postale di
GroupWise. Per visualizzare velocemente solo gli elementi ricevuti, gli elementi inviati,
gli elementi pubblicati o gli elementi bozza, fare clic su un'impostazione dell'elenco a
discesa Visualizzazione. Per limitare ulteriormente la visualizzazione degli elementi
nella casella postale, utilizzare i filtri.

Per organizzare i messaggi, spostarli nelle cartelle dello Schedario. È possibile creare
nuove cartelle se necessario.

5.3.1 Elementi in grassetto nella Casella
postale

Tutti gli elementi non aperti nella casella postale vengono visualizzati in grassetto. Ciò
consente di identificare facilmente tutti gli elementi e i documenti non ancora letti.
Accanto a ogni elemento è inoltre visualizzata un'icona che indica se non è ancora stato
aperto.

Anche gli elementi inviati vengono visualizzati in grassetto per indicare che sono in
coda ma non caricati, che le informazioni sullo stato dell'elemento da consegnare non
sono ancora state ricevute oppure non ancora trasferite in Internet.
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5.3.2 Icone accanto agli elementi della
Casella postale e del Calendario

Le icone visualizzate accanto agli elementi nella casella postale e nel calendario
forniscono informazioni sugli elementi. La seguente tabella descrive il significato di
ciascuna icona.

Tabella 5.3 Descrizioni delle icone

DescrizioneIcona

Se situata accanto a un elemento inviato in modalità Caching, l'icona
indica che l'elemento è stato accodato, ma la coda non è stata

caricata. Se l'elemento è stato caricato, questa icona indica che non
sono pervenute informazioni di stato sulla consegna dell'elemento
all'ufficio postale di destinazione o sull'invio a Internet.

Se situata accanto alla cartella Elementi inviati, l'icona indica che
è presente almeno un elemento che è stato accodato ma non caricato.

Viene visualizzata accanto a un elemento inviato. Se l'elemento è
stato aperto da almeno un destinatario, questa icona rimane
visualizzata finché tutti i destinatari: 1) aprono il messaggio di posta,
la telefonata o la nota 2) accettano l'appuntamento o 3) completano
il task.

Viene visualizzata accanto a un elemento inviato. Non è possibile
consegnare l'elemento all'ufficio postale di destinazione oppure
trasferirlo in Internet.

Viene visualizzata accanto a un elemento inviato. Se questa icona
è visualizzata accanto a un appuntamento o task, significa che
almeno una persona ha rifiutato o eliminato l'elemento. Accanto a
un messaggio di posta, messaggio telefonico o nota, indica che
almeno un destinatario ha cancellato l'elemento senza aprirlo.

Elemento accompagnato da uno o più allegati.
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DescrizioneIcona

Una o più annotazioni sonore sono incluse con l'elemento o si tratta
di un messaggio di posta vocale.

Elemento bozza.

Viene visualizzata accanto a un elemento inviato.

Viene visualizzata accanto a un elemento a cui si è risposto.

Viene visualizzata accanto a un elemento inoltrato.

Viene visualizzata accanto a un elemento delegato.

Viene visualizzata accanto a un elemento a cui si è risposto e
inoltrato.

Viene visualizzata accanto a un elemento a cui si è risposto e
delegato.

Viene visualizzata accanto a un elemento inoltrato e delegato.

Viene visualizzata accanto a un elemento a cui si è risposto. inoltrato
e delegato.

Elemento pubblicato.

Versione specifica di un documento.

Versione ufficiale di un documento.

Messaggio non aperto con priorità bassa, normale o alta.

Messaggio aperto con priorità bassa, normale o alta.

Appuntamento non aperto con priorità bassa, normale o alta.

Appuntamento aperto con priorità bassa, normale o alta.
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DescrizioneIcona

Compito non aperto con priorità bassa, normale o alta.

Compito aperto con priorità bassa, normale o alta.

Nota non aperta con priorità bassa, normale o alta.

Nota aperta con priorità bassa, normale o alta.

Telefonata non aperta con priorità bassa, normale o alta.

Telefonata aperta a priorità bassa, normale o alta.

Il mittente ha richiesto una risposta all'elemento. La priorità
dell'elemento può essere bassa, normale o alta.

Viene visualizzata in un ricerca ore libere. Se questa icona viene
visualizzata a sinistra di un nome utente o di una risorsa, è possibile
fare clic su un'ora pianificata di fronte al nome utente o alla risorsa
nella scheda Pianificazioni individuali per visualizzare ulteriori
informazioni nella casella sottostante. Affinché questa icona venga
visualizzata, è tuttavia necessario che l'utente o il proprietario della
risorsa ne conceda i diritti di lettura nell'elenco degli accessi.

Se questa icona è visualizzata nel Calendario, significa che per
l'elemento è stato impostato un allarme.

Se questa icona viene visualizzata nel Calendario, significa che
l'elemento corrisponde a un appuntamento, a una nota o a un task
di gruppo.

Se questa icona è visualizzata nel Calendario, significa che
l'elemento è contrassegnato come privato.

Se questa icona è visualizzata nel Calendario, significa che
l'elemento è stato rifiutato ma non eliminato.
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5.4 Utilizzo della barra degli
strumenti

Le barre degli strumenti consentono di accedere a numerose funzioni disponibili in
GroupWise. La barra degli strumenti nella parte superiore di una cartella o elemento è
sensibile al contesto, ovvero cambia per fornire le opzioni più utili in tale posizione.

5.5 Utilizzo delle combinazioni di tasti
in GroupWise è possibile utilizzare molte combinazioni di tasti per migliorare
l'accessibilità o risparmiare tempo durante l'esecuzione di numerose operazioni. Nella
tabella seguente sono illustrati alcuni di questi tasti di scelta rapida, con la relativa
funzione e il contesto in cui possono essere utilizzati.

Tabella 5.4 Tasti di scelta rapida

ContestoAzioneTasti di scelta
rapida

Finestra principale,
calendario, elemento,
finestra di dialogo

Apre la Guida in linea.F1

ElementoRicerca del testo.F2

Finestra principale,
calendario

Aggiorna la vista.F5

ElementoApre il controllo ortografico.F7

Elenco elementiContrassegna l'elemento
selezionato come Privato.

F8

ElementoApre la finestra di dialogo dei font.F9
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ContestoAzioneTasti di scelta
rapida

Elenco di elementi, testoSeleziona tutti gli elementi o tutto
il testo.

Ctrl+A

TestoApplica lo stile grassetto al testo.Ctrl+B

TestoCopia il testo selezionato.Ctrl+C

Finestra principale,
calendario, elemento,
finestra di dialogo

Apre la finestra di dialogo Trova.Ctrl+F

CalendarioPassa alla data odierna.Ctrl+G

TestoApplica lo stile corsivo al testo.Ctrl+I

ElementoAllega un file a un messaggio.Ctrl+L

Finestra principale,
calendario, elemento,
finestra di dialogo

Apre un nuovo messaggio.Ctrl+M

Elenco elementiApre il messaggio selezionato.Ctrl+O

Finestra principale,
elemento

Apre la finestra di dialogo Stampa.Ctrl+P

Finestra principale,
calendario

Attiva e disattiva QuickViewer.Ctrl+Q

Elenco elementiContrassegna l'elemento
selezionato come non letto.

Ctrl+R

ElementoSalva una bozza nella cartella
Lavori in corso.

Ctrl+S
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ContestoAzioneTasti di scelta
rapida

TestoApplica lo stile sottolineato al
testo.

Ctrl+U

TestoIncolla il testo selezionato.Ctrl+V

TestoTaglia il testo selezionato.Ctrl+X

TestoAnnulla l'ultima azione.Ctrl+Z

ElementoApre l'elemento precedente o
successivo.

Ctrl+freccia su

oppure

Ctrl+freccia giù

TestoSeleziona il testo una parola alla
volta.

Ctrl+Ma-
iusc+freccia
sinistra

oppure

Ctrl+Ma-
iusc+freccia destra

Finestra principale,
calendario, elemento,
finestra di dialogo.

Apre un nuovo appuntamento.Ctrl+Maiusc+A

Finestra principale,
calendario, elemento,
finestra di dialogo.

Apre un nuovo compito.Ctrl+Maiusc+T

Finestra principale,
calendario, elemento,
finestra di dialogo.

Apre una nuova nota.Ctrl+Maiusc+R
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ContestoAzioneTasti di scelta
rapida

Finestra principale,
calendario, elemento,
finestra di dialogo.

Apre una nuova telefonata.Ctrl+Maiusc+P

Finestra principale,
calendario, elemento,
finestra di dialogo.

Nella finestra principale o nel
calendario chiude GroupWise.

In un elemento chiude l'elemento.

Alt+F4

In una finestra di dialogo chiude
la finestra di dialogo.

Finestra principale,
calendario, elemento.

Attiva la barra dei menu (utilizzare
le lettere sottolineate nei nomi dei
menu).

Alt + [lettera]

Nuovo elementoInvia l'elementoAlt+D

Nuovo elementoInvia l'elementoAlt+S

Elenco elementiVisualizza le proprietà
dell'elemento selezionato.

Alt+Invio

ElementoCancella un elemento.Alt+Canc

TestoSeleziona il testo un carattere alla
volta.

Maiusc+freccia
sinistra

oppure

Maiusc+freccia
destra

TestoSeleziona il testo fino alla fine o
all'inizio di una riga.

Maiusc+Fine

oppure
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ContestoAzioneTasti di scelta
rapida

Maiusc+Home

Elenco di cartelleNell'elenco di cartelle, Maiusc +
la prima lettera del nome di una

MAIUSC+[lettera]

sottocartella consente di passare
alla sottocartella.

Finestra principale,
calendario, finestra di
dialogo, elemento

Passa da un'area, un campo o un
pulsante all'altro in sequenza.

TAB

Finestra principale,
calendario, finestra di
dialogo, elemento

Passa da un'area, un campo o un
pulsante all'altro in sequenza, in
senso inverso.

Maiusc+TAB

Testo, finestra di dialogoIn un testo fa rientrare il testo.Ctrl+Tab

In una finestra di dialogo a schede
apre la scheda successiva.

ElementoIngrandisce il corpo del messaggio
di un elemento.

Alt+freccia rivolta
verso l'alto

ElementoRimpicciolisce il corpo del
messaggio di un elemento.

Alt+freccia rivolta
verso il basso

5.6 Ulteriori informazioni
Ulteriori informazioni su GroupWise sono disponibili nelle risorse seguenti.
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5.6.1 Guida in linea
La documentazione completa per gli utenti è disponibile nella Guida. Fare clic su ? >
Argomenti della Guida, quindi utilizzare la scheda Sommario, Indice o Cerca per
individuare l'argomento desiderato.

5.6.2 Pagina Web della documentazione di
GroupWise 7

Per la versione più aggiornata della guida dell'utente e per la documentazione completa
sull'amministrazione di GroupWise, accedere all'area dedicata a GroupWise 7 nel sito
Web della documentazione Novell (http://www.novell.com/
documentation/gw7).

Il manuale per l'utente è anche disponibile sul client di GroupWise, facendo clic su ?
> User Guide (Guida utente).

5.6.3 Comunità Web GroupWise Cool
Solutions

La comunità GroupWise Cool Solutions include suggerimenti, consigli, articoli sulle
funzioni e risposte alle domande frequenti. Nella Finestra principale fare clic su ? >
Comunità Web Cool Solutions oppure visitare la pagina Web http://www.novell
.com/coolsolutions/gwmag.
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6Sincronizzazione di un
palmare con KPilot
I palmari sono molto diffusi tra gli utenti che devono avere sempre a portata di mano
pianificazioni, elenchi delle attività e annotazioni ovunque essi vadano. Spesso questi
utenti hanno necessità di utilizzare gli stessi dati sia sul desktop che sul portatile. A tale
scopo, è possibile ricorrere a KPilot, uno strumento che consente di sincronizzare i dati
di un palmare con quelli utilizzati dalle applicazioni KDE: KAddressBook, KOrganizer
e KNotes, tutte facenti parte di Kontact.

Scopo principale di KPilot è consentire la condivisione di dati tra le applicazioni di un
palmare e le applicazioni KDE corrispondenti. In KPilot sono incorporati un
visualizzatore di promemoria, un visualizzatore degli indirizzi e un programma di
installazione dei file, che non possono però essere utilizzati al di fuori dell'ambiente di
KPilot. Per tutte queste funzioni, tranne il programma di installazione dei file, sono
disponibili applicazioni KDE indipendenti.

Per le comunicazioni tra il palmare e i vari programmi desktop, KPilot si affida a conduit.
KPilot è il programma che controlla lo scambio di dati tra i due computer. Per utilizzare
sul desktop una particolare funzione del palmare è necessario abilitare e configurare il
conduit corrispondente. Nella maggior parte dei casi, questi conduit sono progettati in
modo da interagire con programmi KDE specifici, pertanto in genere non è possibile
utilizzarli con altre applicazioni desktop.

Il conduit della sincronizzazione dell'orario si differenzia dagli altri in quanto non esiste
un programma visibile all'utente. Viene attivato in background a ogni operazione di
sincronizzazione, ma deve essere abilitato solo sui computer che utilizzano un server
dell'orario di rete per correggere gli scostamenti.
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All'avvio di una sincronizzazione, i conduit vengono attivati uno dopo l'altro per eseguire
il trasferimento dei dati. Esistono due metodi di sincronizzazione: un'operazione HotSync
sincronizza solo i dati per I quali sono stati abilitati dei conduit, mentre un'operazione
di backup esegue il backup completo di tutti i dati memorizzati nel palmare.

Alcuni conduit aprono un file durante la sincronizzazione, pertanto il programma
corrispondente non deve essere in esecuzione in questa fase. In particolare, non eseguire
KOrganizer durante un'operazione di sincronizzazione.

6.1 Conduit utilizzati da KPilot
Per abilitare e configurare i conduit utilizzati da KPilot, selezionare Impostazioni >
Configure Kpilot (Configura KPilot). Di seguito è riportato un elenco con alcuni conduit
importanti:

Rubrica
Questo conduit gestisce lo scambio di dati con la rubrica del palmare. L'applicazione
KDE corrispondente per la gestione di questi contatti è KAddressBook. Per avviarla,
utilizzare il menu principale o il comando kaddressbook.

KNotes/Memos (KNotes/Promemoria)
Questo conduit consente di trasferire le annotazioni create con KNotes
nell'applicazione per i promemoria del palmare. Per avviare l'applicazione KDE,
utilizzare il menu principale o il comando knotes.

Calendar (Calendario - KOrganizer)
Questo conduit è preposto alla sincronizzazione degli appuntamenti (eventi) del
palmare. L'applicazione corrispondente nel desktop è KOrganizer.

ToDos (Attività - KOrganizer)
Questo conduit è preposto alla sincronizzazione delle attività. L'applicazione
corrispondente nel desktop è KOrganizer.

Sincronizzazione dell'orario
L'abilitazione di questo conduit consente di regolare l'orologio del palmare con
quello del desktop durante ogni operazione di sincronizzazione. Questa scelta è
consigliata solo se l'orologio del desktop viene regolato da un server dell'orario a
intervalli abbastanza frequenti.
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Figura 6.1 Finestra di dialogo di configurazione con i conduit disponibili

6.2 Configurazione della connessione
del palmare

Per poter utilizzare KPilot, impostare innanzitutto la connessione con il palmare. La
configurazione dipende dal tipo di unità di alloggiamento utilizzato con il palmare.
Esistono due tipi di unità di alloggiamento: unità di alloggiamento USB o cavi e unità
di alloggiamento seriali o cavi.

6.2.1 Configurazione della connessione da
KPilot

Il modo più facile per impostare la connessione consiste nell'utilizzare l'apposito
assistente. Effettuare le seguenti operazioni:

1 Selezionare Settings (Impostazioni) > Configuration Wizard (Configurazione
guidata) per avviare l'assistente.
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2 Immettere il proprio nome utente e il nome del dispositivo al quale è connesso
il palmare.

3 Scegliere una delle seguenti opzioni:

• Se si desidera che l'assistente rilevi il palmare, selezionare Automatically
Detected Handheld & Username (Rilevamento automatico palmare e nome
utente). Se il rilevamento automatico non riesce, fare riferimento alla
Sezione 6.2.2, "Creazione di un collegamento /dev/pilot" (p. 152).

• Fare clic su Next (Avanti) per eseguire la configurazione manualmente.

4 Indicare le applicazioni da utilizzare per la sincronizzazione. È possibile scegliere
tra la suite di applicazioni KDE (impostazione di default), Evolution e nessuna
applicazione. Dopo avere selezionato l'opzione desiderata, chiudere la finestra
facendo clic su Finish (Fine).

6.2.2 Creazione di un collegamento
/dev/pilot

L'impostazione della connessione con un alloggiamento seriale per palmare è diversa
da quella con un alloggiamento USB. La necessità di creare un collegamento simbolico
denominato /dev/pilot dipende dall'alloggiamento utilizzato.

USB
In genere, un alloggiamento USB viene rilevato automaticamente e non dovrebbe
essere necessario creare il collegamento simbolico.

Seriale
Nel caso di un alloggiamento seriale, è necessario sapere a quale porta seriale è
connesso. Ai dispositivi seriali vengono assegnati nomi del tipo /dev/ttyS?, a
partire da /dev/ttys0 per la prima porta. Per impostare un alloggiamento
connesso alla prima porta seriale, immettere il seguente comando:
ln -s /dev/ttyS0 /dev/pilot
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6.3 Configurazione del conduit
KAddressBook

Inizialmente, dovrebbe essere sufficiente abilitare il conduit KAddressBook senza
modificare le impostazioni di default. Dopo che i dati sono stati sincronizzati per la
prima volta, configurare i dettagli: operazioni da eseguire in caso di conflitto, modalità
di salvataggio dei database di backup, modalità di assegnazione dei campi memorizzati
sul palmare ai file attesi da KAddressBook.

6.4 Gestione delle attività e degli
eventi

Sul desktop KDE le attività (task) e gli eventi (appuntamenti) vengono gestiti tramite
KOrganizer. Questa applicazione può essere avviata dal menu principale, tramite il
comandokorganizer o come componente di Kontact. Dopo avere abilitato i conduit
del calendario e delle attività di KPilot, prima di utilizzarli è necessario impostare alcune
opzioni di configurazione.

Figura 6.2 Configurazione di KPilot

KOrganizer memorizza i file nella directory ~/.kde/share/apps/korganizer.
Tuttavia, dato che la directory .kde inizia con un punto, è possibile che non venga
visualizzata nella finestra di dialogo per la selezione dei file. In tal caso, immettere il
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percorso completo manualmente o attivare esplicitamente la visualizzazione dei file
nascosti (file dot) nella finestra di dialogo per la selezione dei file. Il tasto di scelta
rapida di default è F8.

Dopo avere aperto la directory ~/.kde/share/apps/korganizer, selezionare
un file che possa essere utilizzato come file del calendario da KOrganizer. In questo
esempio viene utilizzato il file palm.ics. Nel caso di un utente il cui nome è tux,
il percorso completo e il nome di file saranno /home/tux/.kde/share/apps/
korganizer/palm.ics, come illustrato nella Figura 6.3, "Finestra di dialogo in
cui è indicato il percorso di un file del calendario di KOrganizer" (p. 154).

Figura 6.3 Finestra di dialogo in cui è indicato il percorso di un file del calendario
di KOrganizer

Durante lo scambio di dati con il palmare, KOrganizer non deve essere in esecuzione.
In caso contrario, KPilot non riuscirà a portare a termine l'operazione di sincronizzazione.

6.5 Uso di KPilot
Sincronizzare i dati delle applicazioni KDE con quelli del palmare è semplice. È
sufficiente avviare KPilot e quindi premere il pulsante HotSync sull'alloggiamento o
sul cavo per avviare l'operazione di sincronizzazione.
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Figura 6.4 Finestra principale di KPilot

6.5.1 Backup di dati dal palmare
Per eseguire un backup completo, selezionare File > Backup. Il backup verrà eseguito
durante l'operazione di sincronizzazione successiva. Selezionare quindi File > HotSync
dal menu. Se non si esegue questa operazione, durante l'operazione di sincronizzazione
successiva verrà eseguito di nuovo tutto il lungo processo di backup completo.

Dopo un backup completo, tutte le copie dei programmi e dei database del palmare
sono disponibili in ~/.kde/share/apps/kpilot/DBBackup/NOMEUTENTE,
dove NOMEUTENTE è il nome dell'utente registrato nel palmare.

I due visualizzatori incorporati di KPilot possono essere utilizzati per una ricerca rapida
di indirizzi o promemoria, ma non sono stati progettati in modo da offrire funzionalità
di gestione per questi dati. Per eseguire queste operazioni, è preferibile utilizzare le
applicazioni KDE sopra indicate.
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6.5.2 Installazione di programmi nel
palmare

Il modulo File Installer (Installazione file) è un utile strumento per l'installazione dei
programmi del palmare. Questi programmi in genere hanno l'estensione prc e possono
essere avviati subito dopo il caricamento nel palmare. Prima di utilizzare questi
programmi aggiuntivi, leggere le licenze e le istruzioni allegate.
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7Messaggistica in tempo reale
con Kopete
Kopete è un'applicazione di messaggistica online che consente la connessione di più
interlocutori a una chat via Internet. Kopete attualmente supporta tutti i protocolli di
messaggistica comuni, quali AOL* Instant Messenger (AIM), GroupWise® Messenger,
ICQ, IRC, Jabber*, Lotus* Sametime, MSN, SMS e Yahoo!*.

7.1 Configurazione di Kopete
Per conversare via chat con gli amici, è necessario configurare un conto:

1 Aprire Kopete premendo la combinazione di tasti Alt + F2 e digitando kopete.
Se Kopete non si avvia, controllare che il pacchetto
kdenetwork3-InstantMessenger sia installato.

2 Al primo avvio di Kopete, viene visualizzata una procedura guidata per la
configurazione che guida l'utente nella creazione del profilo. Altrimenti
selezionare Impostazioni > Configura.

3 Scegliere Conto e selezionare un conto dall'elenco a cui applicare l'opzione
Modifica o fare clic su Nuovo per creare un conto nuovo.

4 Selezionare il servizio di messaggistica. In genere si seleziona il servizio utilizzato
dagli amici.

5 Se il servizio di messaggistica richiede la registrazione ma non si dispone ancora
di un apposito conto, fare clic su Register New Account (Registra nuovo conto).
Nella finestra del browser visualizzata, immettere i dati dell'utente da registrare.
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6 Tornare a Kopete e immettere i dati ricevuti al momento della registrazione al
servizio di messaggistica. Questi dati solitamente sono un nickname o l'indirizzo
e-mail e una password. Completare la configurazione del conto facendo clic su
Fine.

Dopo aver configurato il conto è necessario aggiungere i contatti con cui si desidera
conversare via chat. Se è già stato creato un conto su un altro PC, questi dati verranno
importati e aggiunti automaticamente all'elenco dei contatti. Per creare manualmente
un contatto, fare clic su File > Add Contact (Aggiungi contatto). Viene visualizzato un
nuovo assistente alla creazione. Per aggiungere un contatto all'elenco, tuttavia, è
necessario essere online e connettersi con Kopete al servizio di messaggistica selezionato.

7.2 La chat con gli amici
Per poter conversare via chat con altri partecipanti, è necessario stabilire una connessione
a Internet. Una volta stabilita la connessione, è opportuno impostare il proprio stato
facendo clic su File > Imposta stato > Online. In questo modo viene stabilita una
connessione tra Kopete e il servizio di messaggistica selezionato. Dopo aver effettuato
con successo il login, l'utente sarà visibile agli altri.

Nella finestra principale dell'applicazione è presente un elenco dei contatti. È necessario
disporre dei contatti per conversare via chat con altri utenti. Facendo clic con il pulsante
destro del mouse s un contatto mentre l'utente è online, viene aperto un menu con varie
opzioni. È possibile inviare un messaggio a quella persona o iniziare una sessione di
chat. Una chat consente l'invio di inviti di altri partecipanti a conversazioni in tempo
reale. La connessione viene chiusa a tutti i partecipanti quando questa è chiusa dal
creatore della sessione.
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Figura 7.1 Finestra Chat

Se si desidera visualizzare la precedente sessione di chat, selezionare un contatto e
scegliere Modifica > View History (Visualizza cronologia). Questa voce di menu
consente di aprire una finestra di dialogo in cui è possibile cercare e visualizzare le
sessioni di chat effettuate con la persona specificata.

Facendo clic con il pulsante destro del mouse su un nome utente, è possibile visualizzare
altre opzioni. Si apre un menu popup. Un'opzione importante è Start Chat (Avvia chat)
che consente di avviare una sessione di chat. Scegliendo Rinomina contatto e Rimuovi
contatto, è possibile eseguire la relativa operazione. Il menu di scelta rapida contiene
anche una voce di sottomenu con il nome utente dove è possibile bloccare l'utente o
ottenere informazioni sull'utente.

SUGGERIMENTO: Esplorazione di vecchie sessioni di chat

Per controllare ciò che è stato scritto durante una delle ultime sessioni di chat
con una persona, fare clic su un contatto per aprire di nuovo la finestra della
chat, quindi premere Alt +← o Alt +→ per espolarare le sessioni. In alternativa
è possibile utilizzare le icone a freccia sulla barra degli strumenti per spostarsi
avanti e indietro.
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7.3 Personalizzazione di Kopete
Kopete include numerose opzioni di personalizzazione in base alle proprie esigenze.
Nelle sezioni seguenti sono disponibili alcuni esempi.

7.3.1 Aggiunta di gruppi
Raggruppare i contatti nell'elenco può aiutare a fornire una migliore panoramica. Fare
clic su File > Crea nuovo gruppo. Assegnare un nome al gruppo e confermare facendo
clic su OK. Viene visualizzato una nuova cartella nell'elenco dei contatti che sarà
utilizzata per memorizzarvi i contatti desiderati. Trascinare e incollare i contatti nella
cartella desiderata.

Figura 7.2 Finestra principale di Kopete

I gruppi vuoti possono essere disabilitati selezionando Impostazioni > Hide Empty
Groups (Nascondi gruppi vuoti).
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7.3.2 Utilizzo di un'identità globale
Kopete è in grado di gestire numerosi conti per consentire di comunicare con amici che
utilizzano protocolli di messaggistica differenti. Anziché creare numerose identità per
vari protocolli, è anche possibile configurare un'"identità globale":

1 In Kopete, selezionare Impostazioni > Configura.

2 Nella finestra di configurazione selezionare Identità e attivare Enable global
identity (Abilita identità globale).

3 Fare clic su New Identity (Nuova identità) e immettere un nome per la propria
identità globale.

4 Specifica alcuni dettagli sulla propria identità, ad esempio un soprannome o una
foto.

4a Nella schedaNickname scegliere se utilizzare un soprannome Personalizzato
oppure un soprannome già specificato in un altro conto Kopete.

4b Per aggiungere una foto, selezionare una delle opzioni nella scheda Foto.

4c Per utilizzare i dati già specificati in KAddressbook, selezionare innanzitutto
la schedaAddress Book Link (Collegamento Rubrica). Fare clic suModifica...,
selezionare la propria voce dall'elenco e fare clic su OK. È ora possibile
tornare alla scheda Nickname (Soprannome) o Foto in cui attivare le opzioni
della Rubrica.

7.3.3 Modifica dell'aspetto
Kopete consente di installare nuovi temi, di cambiare lo stile della finestra della chat o
di modificare i colori e i font. Per cambiare l'aspetto, selezionare Impostazioni >
Configura, quindi fare clic su Aspetto. Di seguito sono illustrati due esempi:

Installazione di un nuovo tema di icona
Nella scheda Emoticons (Emoticon) fare clic su per ottenere un elenco dei temi
disponibili in Internet. Per scaricare uno o più temi, selezionare una voce nell'elenco
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e fare clic su Installa. Il nuovo tema verrà aggiunto all'elenco nella schedaEmoticons
(Emoticon). Da qui è possibile scegliere il tema desiderato e fare clic su Applica.

Modifica dello stile della finestra di chat
Scegliere uno dei numerosi stili di Kopete disponibili nella scheda Finestra di chat
oppure scaricare nuovi stili utilizzando l'opzione Ottieni nuovo....

7.3.4 Configurazione di notifiche
Kopete consente di configurare le notifiche per eventi, quali contatti che si collegano
online oppure che si disconnettono o per un messaggio in arrivo per l'utente.

Per ricevere una notifica quando un determinato contatto diventa disponibile online,
eseguire le seguenti operazioni:

1 Assicurarsi che tutti i contatti siano visualizzati nella finestra Kopete (altrimenti
scegliere Impostazioni > Show offline users (Mostra utenti offline)).

2 Fare clic con il pulsante destro del mouse sul contatto preferito, quindi selezionare
Proprietà.

3 Passare alla scheda Custom Notification (Personalizza notifica) e scegliere A
contact has gone online (Contatto disponibile online).

4 Definire le azioni che devono essere eseguite per l'evento specificato: Play a
Sound (Riproduci suono), Display a Message (Visualizza messaggio), Start a
Chat (Avvia chat) o Suppress Standard Notifications (Elimina notifiche standard).

5 Fare clic su OK per confermare le impostazioni.

Per modificare le opzioni di notifica di default, selezionare Impostazioni > Configura
notifiche. Scegliere l'evento che si ritiene importante e modificare le impostazioni di
notifica. Se ad esempio si desidera essere informati mediante un suono quando uno dei
propri contatti diventa disponibile online, selezionare A contact has come online
(Contatto disponibile online) e attivare Play a sound (Riproduci suono). Selezionare il
suono e fare clic su OK per chiudere la finestra di dialogo di configurazione.
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7.3.5 Configurazione dei plug-in di Kopete
Kopete offre alcune interessanti estensioni per le sessioni di chat a cui è possibile
accedere tramite le opzioni Impostazioni > Configure Plugins (Configura plug-in). Ad
esempio è possibile sostituire automaticamente del testo, cifrare i messaggi in uscita,
evidenziare il testo se il messaggio contiene alcune parole interessanti, eseguire il
rendenring delle formule LaTeX o tradurre i messaggi.

7.4 Ulteriori informazioni
Ulteriori informazioni su Kopete e le chat sono disponibili sui seguenti siti Web:

Home page di Kopete
http://kopete.kde.org/

Abbreviazioni utilizzate nelle sessioni di chat
http://www.webopedia.com/quick_ref/
textmessageabbreviations.asp

Forum "Internet & Network" di KDE
http://www.kde-forum.org/board.php?boardid=34
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8Utilizzo di Voice over IP con
Ekiga
I moderni mezzi di comunicazioni consentono di effettuare molte operazioni oltre alle
telefonate, ad esempio scambiare messaggi di testo e a volte perfino video conferenze.
La funzionalità Roaming consente di essere raggiungibili da tutto il mondo utilizzando
un unico numero di telefono. Ekiga supporta tutte queste funzionalità su un desktop
Linux, per consentire di comunicare mediante Internet a banda larga.

Prima di avviare l'applicazione, assicurarsi che siano soddisfatti i requisiti seguenti:

• Scheda audio configurata in maniera appropriata,

• Auricolare o microfono e altoparlanti collegati al computer,

• Conto SIP per la composizione in reti telefoniche tradizionali. SIP (Signaling
protocol for Internet Telephony) è il protocollo utilizzato per stabilire sessioni per
conferenze audio e video o per inoltrare le chiamate. Per un elenco completo dei
provider, vedere http://www.voipproviderslist.com/. Versioni di
valutazione gratuite sono disponibili in http://www.voipbuster.com.

• Per effettuare video conferenze, è necessario che una webcam sia collegata al
computer.

8.1 Configurazione di Ekiga
Al primo avvio di Ekiga verrà visualizzato un assistente di configurazione in cui viene
chiesto di immettere i dati necessari per la configurazione di un'istanza di Ekiga. Per
configurare Ekiga, eseguire le operazioni seguenti:
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1 Immettere il nome completo (nome e cognome).

2 Immettere i dati del conto ekiga.net oppure scegliere di non iscriversi a
ekiga.net.

Per aggiungere altri conti in seguito, configurarli medianteModifica > Account
(Conto).

3 Determinare il tipo di connessione.

4 Determinare il tipo di firewall da utilizzare per l'esecuzione di telefonate con
Ekiga.

5 Scegliere il gestore audio da utilizzare. Accettare l'impostazione di default
ALSA poiché garantisce la migliore qualità audio e poiché non sono disponibili
in SUSE Linux Enterprise altri sistemi audio, quali OSS.

6 Scegliere i dispositivi di input e output audio e controllare le impostazioni.

7 Accettare la selezione del gestore video V4L.

8 Scegliere il dispositivo di input video e controllare le impostazioni.

9 Controllare tutte le impostazioni e applicarle.

10 Se dopo aver apportato le modifiche alla configurazione non è possibile
completare la registrazione, riavviare Ekiga.

Ekiga consente di gestire più conti. Per configurare un conto aggiuntivo, eseguire le
seguenti operazioni:

1 Aprire Modifica > Conto, quindi selezionare Aggiungi.

2 Scegliere un Nome conto.

3 Selezionare unProtocollo appropriato in base al tipo di conto in uso. Normalmente
in questo campo si seleziona SIP.

4 Immettere il Registrar a cui registrarsi, generalmente un indirizzo IP o un nome
host fornito dal provider dei servizi di telefonia Internet. Immettere l'Utente e la
Password in base ai dati forniti dal provider.
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5 Scegliere OK per uscire dalla finestra di dialogo di configurazione e attivare il
conto. Lo stato del conto visualizzato nella finestra principale di Ekiga diventerà
Registered (Registrato).

8.2 Interfaccia utente di Ekiga
Tutte le funzioni di Ekiga sono disponibili mediante la barra dei menu. Le scorciatoie
alle funzioni più importanti sono disponibili nella barra degli strumenti a sinistra oppure
mediante speciali combinazioni di tasti.

Figura 8.1 Interfaccia utente di Ekiga

L'interfaccia utente dispone di diverse modalità: Per passare da una visualizzazione
all'altra, utilizzare Visualizza > View Mode (Modalità di visualizzazione) e Visualizza
> Pannello di controllo oppure selezionare l'icona della modalità di visualizzazione a
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sinistra dell'interfaccia utente e le varie schede in basso. Verrà visualizzata la Full View
(Visualizzazione intera) in Figura 8.1, "Interfaccia utente di Ekiga" (p. 167). Tutte le
icone nella barra degli strumenti dispongono di una descrizione comandi che viene
visualizzata quando il puntatore del mouse passa sopra all'icona.

Nella parte inferiore dell'interfaccia utente sono disponibili numerose schede che
includono funzionalità per Dialpad, Audio, Video e Statistiche. Alcune impostazioni,
ad esempio quelle Audio, possono essere modificate solo durante una telefonata.

Molte funzioni di Ekiga sono disponibili con le scorciatoie della tastiera. In Tabella 8.1,
"Scorciatoie della tastiera per Ekiga" (p. 168) sono illustrate quelle più importanti.

Tabella 8.1 Scorciatoie della tastiera per Ekiga

DescrizioneSequenza con Ctrl

Avvia una telefonata con il numero attuale.Ctrl + O

Disconnessione.CtrlD +

Mette in attesa la telefonata.Ctrl + G

Trasferisce la chiamata attuale a un'altra parte.Ctrl + T

Salva l'immagine attuale sul disco rigido.Ctrl + S

Chiude l'interfaccia utente di Ekiga.Ctrl + W

Chiude Ekiga.Ctrl + Q

Avvia il programma di gestione dei conti.Ctrl + E

Apre la panoramica Ekiga Preferences (Preferenze di
Ekiga). Questa finestra di dialogo consente di apportare
miglioramenti alle impostazioni di Ekiga.

Ctrl + P

Ingrandisce l'immagine della webcam.Ctrl + +

Rimpicciolisce l'immagine della webcam.Ctrl + -
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DescrizioneSequenza con Ctrl

Ripristina le normali dimensioni di visualizzazione della
webcam.

Ctrl + =

Utilizza lo schermo intero per la webcam.Ctrl + F

Visualizza la cronologia delle telefonate.Ctrl + H

8.3 Composizione di una chiamata
Se Ekiga è configurato correttamente, è molto semplice effettuare una telefonata.

1 Avviare Ekiga tramite il menu o la riga di comando.

2 Immettere l'indirizzo SIP della persona da chiamare in Indirizzo SIP. Il risultato
dovrebbe essere il seguente:

• per le chiamate locali dirette: sip:nomeutente@nomedominio o
nomeutente@nomehost

• sip:nomeutente@nomedominio o idutente@serversip.

Se si utilizza un provider SIP che accetta le telefonate reali, è possibile immettere
il numero, ad esempio sip:<numero chiamata>.

3 Fare clic su Chiamata oppure premere Ctrl +O e attendere che l'altra parte accetti
la telefonata.

4 Per terminare la telefonata, fare clic su Hang up (Disconnetti) oppure premere
Ctrl + D.

Per regolare i parametri audio durante una telefonata, fare clic su Visualizza > View
Mode (Modalità di visualizzazione) > Full View (Visualizzazione completa) per
visualizzare quattro schede che includono altre opzioni. La seconda scheda include le
opzioni Audio relative a Livello di riproduzione e Livello di registrazione. Per regolare
i livelli, utilizzare i dispositivi di scorrimento.
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8.4 Risposta a una chiamata
Ekiga può ricevere le chiamate in due diversi modi. È possibile chiamare l'utente
direttamente con sip:utente@host. In alternativa, è possibile effettuare le chiamate
tramite un provider SIP. La maggior parte dei provider SIP consente di ricevere
telefonate da una normale linea fissa sul conto VoIP. In base alla modalità di esecuzione
di Ekiga, sono disponibili diversi metodi di notifica di una telefonata in entrata:

Applicazione normale
È possibile ricevere e rispondere alle telefonate in entrata solo se Ekiga è già in
esecuzione. Verrà emesso uno squillo sulle cuffie o gli altoparlanti. Se Ekiga non
è esecuzione, le telefonate non possono essere ricevute.

Applet del pannello
Di norma, l'applet del pannello per Ekiga viene eseguita in modo invisibile senza
segnali esterni. Questo stato cambia non appena giunge una chiamata. Verrà
visualizzata la finestra principale di Ekiga e verrà emesso uno squillo sulle cuffie
o gli altoparlanti.

Dopo aver ricevuto la notifica di una telefonata in ingresso, è sufficiente fare clic su
Accetta per rispondere e avviare una conversazione. Per rifiutare la telefonata, fare clic
su Rifiuta. È anche possibile trasferire la chiamata a un altro indirizzo SIP.

8.5 Uso della rubrica
Ekiga consente di gestire i contatti SIP. Avviare la Rubrica mediante Strumenti >
Rubrica. Verrà visualizzato un elenco vuoto. Per aggiungere un contatto, selezionare
Personale. Fare clic con il pulsante destro del mouse sulla finestra dell'indirizzo e
scegliere Nuovo contatto. In alternativa, è possibile premere Ctrl > N.

Affinché il contatto sia valido, è necessario immettere le seguenti voci:

Nome
Digitare il nome del contatto. Nel campo è possibile digitare il nome completo o
un soprannome.

SIP Address (Indirizzo SIP)
Immettere un indirizzo SIP valido per il contatto.
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Email
Immettere l'indirizzo e-mail del contatto da utilizzare come riferimento personale.

Composizione veloce
La funzione Speed Dial (Composizione veloce) consente di accedere
più facilmente ai numeri utilizzati di frequente. L'aggiunta di commenti è facoltativa.

Categorie
Se si dispone di molti contatti diversi, è possibile aggiungere le proprie categorie.

Rubrica locale
Per default è disponibile una Rubrica locale denominata Personale. Se si desidera
utilizzare altre rubriche, crearle selezionandoFile > Nuova rubrica oppure utilizzare
la scorciatoia Ctrl + B.

Per aprire un contatto nella Rubrica, fare doppio clic su di esso. La telefonata verrà
subito avviata.

8.6 Ulteriori informazioni
La home page ufficiale di Ekiga è http://www.ekiga.org/. In questo sito sono
disponibili risposte alle domande frequenti e documentazione più dettagliata.

Per informazioni sul supporto del protocollo di teleconferenza H323 in Linux, vedere
http://www.voip-info.org/wiki/view/H.323. Questo rappresenta un
buon punto di partenza per le ricerche di progetti che supportano la tecnologia VoIP.

Per configurare una rete telefonica privata, può essere opportuno utilizzare il software
Asterisk perPBXhttp://www.asterisk.org/. Per ulteriori informazioni, vedere
http://www.voip-info.org/wiki-Asterisk.
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9Accesso alle risorse di rete
Dal desktop è possibile accedere ai file e alle directory o a determinati servizi su host
remoti, oppure è possibile rendere disponibili i propri file e le proprie directory ad altri
utenti della rete. SUSE Linux Enterprise® offre diverse modalità di accesso e creazione
alle risorse condivise in rete:

Navigazione rete locale
Il file manager Konqueror consente di esplorare la rete alla ricerca di risorse e
servizi condivisi. Per ulteriori informazioni, consultare Sezione 9.2, "Accesso alle
condivisioni di rete" (p. 175).

Condivisione di cartelle in ambienti eterogenei
Utilizzare Konqueror per configurare cartelle e file da condividere con altri membri
della rete e rendere i dati disponibili in lettura o scrittura per gli utenti di qualsiasi
workstation Windows o Linux. Per ulteriori informazioni, consultare Sezione 9.3,
"Condivisione di cartelle in ambienti eterogenei" (p. 176).

Gestione dei file di Windows
SUSE Linux Enterprise Desktop può essere configurato in modo da integrarsi in
una rete Windows esistente. per consentire a un sistema Linux di comportarsi come
un client Windows. Tutte le informazioni sul conto vengono ricavate dal controller
del dominio Active Directory, come per i client Windows. Per ulteriori informazioni,
consultare Sezione 9.4, "Gestione dei file di Windows" (p. 179).

Configurazione e accesso a una stampante di rete Windows
Per configurare una stampante di rete Windows, ricorrere al Centro di controllo
KDE. Per ulteriori informazioni, consultare Sezione 9.5, "Configurazione e accesso
a una stampante di rete Windows" (p. 182).
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Configurazione di scorciatoie per le cartelle di rete
La creazione di scorciatoie per le cartelle di rete remote (FTP, WebDAV, unità di
rete Windows e SSH) semplifica considerevolmente l'interazione con esse. Per
ulteriori informazioni, consultare Sezione 9.6, "Configurazione di scorciatoie per
le cartelle di rete" (p. 184).

Configurazione di un piccolo server Web
Se si desidera un metodo facile per condividere le informazioni con altri utenti,
configurare un semplice server Web. Per ulteriori informazioni, consultare
Sezione 9.7, "Configurazione e utilizzo di un piccolo server Web" (p. 186).

9.1 Note generali sulla condivisione
di file e sull'esplorazione della
rete

Se e in che misura è possibile utilizzare l'esplorazione della rete e la condivisione di
file nel sistema e in rete dipende principalmente dalla struttura della rete stessa e dalla
configurazione del computer. Prima di configurare una di queste operazioni, contattare
l'amministratore di sistema per verificare se la struttura della rete supporta tali
funzionalità e per controllare se queste rientrano nelle norme di sicurezza dell'azienda.

L'esplorazione della rete, sia SMB per le condivisioni Windows o SLP per i servizi
remoti, dipende prevalentemente dalla capacità del computer di inviare messaggi
broadcast a tutti i client della rete. Tali messaggi e le relative risposte dei client
consentono al sistema di individuare eventuali condivisioni o servizi disponibili. Per
consentire il corretto funzionamento dei broadcast, è necessario che il computer
appartenga alla stessa sottorete di tutti gli altri sistemi a cui le richieste vengono inviate.
Se l'esplorazione della rete non funziona o se le condivisioni e i servizi individuati non
sono quelli previsti, contattare l'amministratore di sistema per accertarsi di essere
connessi alla sottorete appropriata.

Per consentire l'esplorazione della rete, è necessario che il computer mantenga aperte
numerose porte di rete per inviare e ricevere messaggi che forniscono informazioni
dettagliate sulla rete e sulla disponibilità di condivisioni e servizi. nld; standard è
configurato per garantire un elevato livello di sicurezza e dispone di un firewall in grado
di proteggere il sistema da eventuali minacce provenienti da Internet. Per ottimizzare
la configurazione del firewall, è possibile chiedere all'amministratore di sistema di
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aprire un determinato gruppo di porte alla rete o di disattivare completamente il firewall
rispettando le norme di sicurezza dell'azienda. Se si tenta di esplorare una rete mentre
nel sistema viene eseguito un firewall restrittivo, Konqueror segnala che le restrizioni
di protezione non consentono di inviare richieste alla rete.

9.2 Accesso alle condivisioni di rete
Le workstation di rete possono essere configurate per la condivisione delle cartelle. In
genere, i file e le cartelle vengono contrassegnati per consentire agli utenti remoti di
accedervi Vengono denominati condivisioni di rete. Se il sistema è configurato per
l'accesso alle condivisioni di rete, utilizzare il proprio file manager per accedere a tali
condivisioni e per esplorarle come se si trovassero nel computer locale. La possibilità
di accedere alle cartelle condivise in sola lettura o anche in scrittura dipende dai permessi
concessi all'utente dal proprietario delle condivisioni stesse.

Per accedere alle condivisioni di rete, fare clic sull'iconaNavigazione rete locale presente
sul desktop o aprire Konqueror e digitare il comando remote:/ nella barra di
posizione. Konqueror accede a una cartella virtuale che visualizza i tipi di condivisione
di rete a cui l'utente può accedere. Fare clic su un tipo di risorsa di rete, quindi scegliere
la condivisione di rete a cui si desidera accedere. È possibile che venga richiesta
l'autenticazione della risorsa tramite l'inserimento di un nome utente e di una password.

Figura 9.1 Navigazione rete locale
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9.3 Condivisione di cartelle in
ambienti eterogenei

Negli ambienti aziendali la condivisione e lo scambio di documenti sono attività
necessarie. Konqueror consente di condividere i file grazie a Samba, che rende i file e
le cartelle disponibili per gli utenti sia Linux che Windows. Per configurare la
condivisione di file Samba con Konqueror, eseguire le operazioni riportate di seguito.

1 Premere ALT > F2 e digitare ~ nel campo di testo per aprire Konqueror.

2 Fare clic con il pulsante destro del mouse sullo sfondo della finestra, quindi
selezionare Proprietà dal menu contestuale.

3 Nella finestra di dialogo Proprietà scegliere la scheda Condivisione. Se la
condivisione di file non è ancora stata attivata a livello generale, questo viene
segnalato nella scheda. Per attivare la condivisione di file o per selezionare i file
da condividere, fare clic su Configura la condivisione dei file e immettere la
password.

4 Per attivare o disattivare la condivisione di file, selezionare o deselezionare
l'opzione Attiva la condivisione di file per reti locali.

Figura 9.2 Attivazione della condivisione di file
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5 Selezionare l'opzione di condivisione appropriata: Simple sharing (Condivisione
semplice) o Advanced sharing (Condivisione acanzata).

6 Per limitare il numero di utenti autorizzati a condividere le cartelle di determinati
gruppi, fare clic su Utenti ammessi, selezionare Solo gli utenti di un certo gruppo
possono condividere cartelle, fare clic su Scegli gruppo e scegliere il gruppo
appropriato dall'elenco presente nella finestra visualizzata.

7 Aggiungere la cartella da condividere all'elenco degli elementi condivisi, presente
nella parte inferiore della finestra di dialogo, facendo clic su Aggiungi e indicando
il percorso esatto della cartella.

Figura 9.3 Opzioni di condivisione dettagliate

8 Selezionare Condividi con Samba per attivare la condivisione di file Samba. Se
necessario, procedere all'ottimizzazione delle opzioni di Samba:

Nome
Specificare un nome diverso da quello impostato come predefinito.

Pubblico/Scrivibile
Determinare il tipo di accesso alla propria condivisione da concedere ad altri
utenti. È possibile garantire l'accesso completo in lettura e scrittura o limitarlo
alla sola lettura.
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Ulteriori opzioni Samba
Queste includono impostazioni essenziali quali il nome, un commento
facoltativo e i diritti di accesso di base, oltre a impostazioni utente e di
sicurezza e un'opzione che consente di nascondere determinati file e
sottocartelle presenti nella cartella condivisa.

9 Applicare le impostazioni e premereOK per chiudere la finestra di dialogo relativa
alla condivisione di file.

L'icona della cartella, che raffigura una spina, risulta ora visualizzata in
Konqueror.

Figura 9.4 Cartella condivisa

Per revocare la condivisione, accedere nuovamente alla finestra di dialogo relativa
alla condivisione di file ed eliminare la cartella dall'elenco degli elementi
condivisi. L'icona della cartella visualizzata non riporta più il simbolo della spina.

Per accedere alla condivisione, gli altri membri della rete possono digitare smb:/ nella
barra di posizione di Konqueror e fare clic sull'icona del gruppo di lavoro desiderato e
sul nome host.

IMPORTANTE: Esplorazione del dominio Samba

L'esplorazione del dominio Samba può essere effettuata solo se il firewall del
sistema è stato configurato in modo appropriato. È possibile disattivare
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completamente il firewall o assegnare l'interfaccia di esplorazione alla zona
interna del firewall stesso. Per istruzioni sulla procedura da applicare, contattare
l'amministratore di sistema. Per ulteriori informazioni su questa procedura,
vedere sezione "Configuring a Linux Client for Active Directory" (Capitolo 12,
Active Directory Support, ↑Deployment Guide).

9.4 Gestione dei file di Windows
Se il sistema SUSE Linux Enterprise è un client Active Directory come illustrato nel
Capitolo 12, Active Directory Support (↑Deployment Guide), è possibile esplorare,
visualizzare e modificare i dati presenti nei server Windows. Di seguito sono riportati
alcuni degli esempi più significativi:

Esplorazione di file di Windows con Konqueror
Per esplorare i dati di Windows, utilizzare l'opzione smb:/ di Konqueror.

Visualizzazione dei dati di Windows con Konqueror
Utilizzare Konqueror per visualizzare i contenuti della cartella utente di Windows
come se fosse una directory Linux. Creare nuovi file e cartelle nel server Windows.

Modifica dei dati di Windows con le applicazioni KDE
Le applicazioni KDE, ad esempio l'editor di testo Kate, consentono di aprire i file
presenti nel server Windows, modificarli e quindi salvarli sempre nello stesso
server.

Single-Sign-On
Le applicazioni KDE, incluso Konqueror, supportano il servizio Single-Sign-On.
Questo significa che, per accedere ad altre risorse Windows, quali server Web,
proxy o groupware come MS Exchange, non è necessario eseguire un'ulteriore
autenticazione, poiché in tali casi questa viene effettuata automaticamente in
background dopo che l'utente ha fornito nome utente e password al momento del
login.

Per accedere ai dati di Windows utilizzando Konqueror, eseguire le operazioni riportate
di seguito.

1 Premere Alt + F2 e digitare il comando smb:///
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Viene visualizzata una finestra di Konqueror che riporta tutti i domini e i gruppi
di lavoro Samba presenti in rete.

2 Fare clic sull'icona del gruppo di lavoro o del dominio relativo al proprio server
AD.

Figura 9.5 Esplorazione dei dati presenti nel server AD

3 Fare clic sulla cartella Utenti e selezionare l'icona della cartella utente personale.
Vengono visualizzati i contenuti della cartella I miei documenti.

Per creare cartelle nella cartella utente di Windows mediante Konqueror, applicare la
stessa procedura utilizzata per creare una cartella di Linux:

1 Fare clic con il pulsante destro del mouse sullo sfondo della vista cartelle di
Konqueror per aprire il menu.

2 Selezionare > Create New Folder (Crea nuova cartella).

3 Quando richiesto, digitare il nome della nuova cartella.

Per creare un file nel server AD, procedere come descritto nell'esempio riportato di
seguito per l'editor di testo Kate.

1 Premere Alt + F2 e digitare il comando kate.
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2 Immettere il testo desiderato.

Figura 9.6 Modifica di un file di testo con Kate

3 Per salvare il testo appena creato, selezionare Salva con nome.

4 Fare clic sull'icona Cartelle di rete situata a sinistra e selezionare Condivisioni
SMB.

Figura 9.7 Salvataggio di un file in una cartella remota di Windows

5 Accedere alla cartella di Windows.

6 Immettere il nome di file e fare clic su Salva.

Il file viene salvato nel server Windows.
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Utilizzare il supporto Single-Sign-On di Konqueror come indicato nell'esempio seguente
per l'accesso Web alla casella postale di MS Exchange:

1 Verificare di disporre di un conto MS Exchange valido nell'ambito della propria
identità utente Windows corrente.

2 Richiedere l'indirizzo del server Exchange all'amministratore di sistema.

3 Premere Alt + F2 e digitare il comando konqueror
http://indirizzo_server_exchange.

Il login al conto viene effettuato senza dover eseguire ulteriori autenticazioni.

Figura 9.8 Accesso a MS Exchange tramite Konqueror

4 Scrivere o leggere le proprie e-mail ed eseguire il logout come di consueto.

9.5 Configurazione e accesso a una
stampante di rete Windows

Poiché appartiene a una rete aziendale ed effettua l'autenticazione rispetto a un server
Windows Active Directory, l'utente è autorizzato ad accedere alle risorse aziendali, ad
esempio le stampanti. KDE consente di configurare la stampa da un client Linux a una
stampante di rete Windows.

Per configurare una stampante di rete Windows da utilizzare da una workstation Linux,
eseguire le operazioni riportate di seguito.
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1 Avviare il Centro di controllo KDE dal menu principale.

2 Selezionare Peripherals > Printers.

Figura 9.9 Aggiunta di una stampante

3 Selezionare Aggiungi > Aggiungi stampante speciale.

Figura 9.10 Aggiunta di dettagli relativi alla stampante
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4 Immettere il nome della stampante, una breve descrizione e il relativo percorso.

5 In Impostazioni comandi immettere una riga di comando simile a quella riportata
nell'esempio seguente:

smbclient //domain/printer -k -d 0 -c 'put %in' > /dev/null 2>&1

Sostituire dominio e stampante con i valori esatti corrispondenti alla propria
configurazione.

6 Selezionare Abilita file di output e scegliere application/postscript per collegare
a cascata tutti i lavori di stampa a un file postscript.

7 Chiudere la finestra di dialogo relativa alla configurazione della stampante
selezionando OK.

8 Chiudere il Centro di controllo KDE selezionando File > Esci.

La stampante è pronta per l'uso.

Per stampare utilizzando la stampante di rete Windows sopra configurata, è sufficiente
selezionarla nell'elenco delle stampanti disponibili in KPrinter.

9.6 Configurazione di scorciatoie per
le cartelle di rete

KNetAttach consente di aggiungere alla vista nuove cartelle di rete facendo clic su
Aggiunge una cartella di rete in una vista remote:/ di Konqueror. Viene visualizzata
una procedura guidata che consente di selezionare il tipo di cartella di rete a cui accedere
e di specificare dettagli quali nome della cartella di rete, indirizzo del server (indirizzo
IP o nome di dominio), nome di login, porta e percorso della cartella.
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Figura 9.11 Aggiunta di una cartella di rete

Al termine, sarà possibile accedere alla condivisione di rete in Konqueror facendo clic
sul collegamento appena creato, anziché immettere l'intero URL della condivisione
nella barra di posizione.

Figura 9.12 Nuova cartella di rete

Se la cartella di rete viene aggiunta utilizzando questa procedura, sarà possibile accedervi
senza difficoltà anche quando si apre o si salva un file da un'applicazione KDE. Se si
fa clic sull'icona Cartelle di rete situata sulla barra sinistra di una finestra di dialogo
Apri file o Salva file, la cartella di rete aggiunta viene visualizzata.
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Figura 9.13 Apertura di un file da una condivisione di rete

SUGGERIMENTO: Collegamento a condivisioni di rete sul desktop

Per un accesso più rapido alle condivisioni di rete utilizzate con maggiore
frequenza, è possibile creare sul desktop collegamenti a tali risorse. Per
effettuare questa operazione, selezionare la risorsa desiderata in Konqueror e
trascinarla sul desktop tenendo premuto il pulsante sinistro del mouse. Dal
menu contestuale selezionare Collega qui. Sul desktop viene visualizzata una
nuova icona. Se si fa clic su tale icona, Konqueror si apre e viene visualizzato
il contenuto della directory.

9.7 Configurazione e utilizzo di un
piccolo server Web

L'utility kpf semplifica la condivisione di file ricorrendo al protocollo HTTP (Hyper
Text Transfer Protocol), lo stesso utilizzato dai siti Web per fornire i dati ai browser
Web. Poiché kpf è un file server esclusivamente pubblico, non esiste alcuna restrizione
di accesso ai file condivisi. Qualsiasi elemento selezionato per la condivisione è
disponibile per chiunque.
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IMPORTANTE: Considerazioni sulla sicurezza

Prima di impostare un file server con kpf, verificare con l'amministratore di
sistema se le norme di sicurezza dell'azienda consentono tale operazione. Se
non si è assolutamente certi che la rete sia protetta da un firewall esterno, è
consigliabile evitare di impostare un file server in ambienti sia aziendali che
privati. È infatti possibile che si verifichi la divulgazione accidentale sul Web di
informazioni riservate. Ogni server Web è inoltre un potenziale obiettivo degli
attacchi di pirati informatici. Impostare un server Web in modo sicuro non è
semplice e kpf non è stato progettato per essere utilizzato come un server di
questo tipo.

kpf rappresenta la soluzione ideale per la condivisione di file con gli amici e non per
svolgere la funzione di server Web completo, come nel caso di Apache. kpf è stato
infatti creato essenzialmente per condividere file con altri utenti durante le conversazioni
tramite IRC (Internet Relay Chat o sessioni di chat).

In genere, kpf viene utilizzato per trasferire i file da una cartella public_html alla
home directory di un utente. Se ad esempio si desidera rendere disponibile un file ad
alcuni utenti con cui si conversa online, anziché inviarlo per e-mail come allegato a
ciascun utente, è possibile utilizzare kpf per copiare il file in questione nella cartella
public_html e segnalarne la disponibilità all'indirizzo: http:///NOMEHOST:
8001/thefile.

1 Fare clic con il pulsante destro del mouse sul pannello inferiore di KDE,
selezionare Aggiungi al pannello e fare clic su Server pubblico di file.

Nel pannello inferiore viene visualizzata una nuova icona che raffigura un piccolo
globo.

2 Fare clic sull'icona con il pulsante destro del mouse, quindi selezionare Nuovo
server.

3 Specificare la directory contenente i file che si desidera condividere, quindi fare
clic su Avanti.
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Figura 9.14 Selezione della directory radice del file server

Tutti i file presenti nella cartella e nelle relative sottocartelle, inclusi i file nascosti
(ovvero quelli che iniziano con un punto) e i collegamenti simbolici, sono
disponibili per il pubblico. È pertanto consigliabile prestare attenzione a non
condividere informazioni riservate, quali password, chiavi di cifratura, rubriche
o documenti privati della propria organizzazione. Accertarsi che tutti i
collegamenti simbolici inclusi non portino a percorsi esterni alla cartella
pubblicata, poiché questo consentirebbe ad altri utenti di accedere ad aree del
sistema non destinate alla visualizzazione pubblica.

4 Completare la parte restante della procedura guidataNuovo server per condividere
la cartella specificata in Passo 3 (p. 187).

L'icona della directory, che raffigura il mondo, viene ora visualizzata nella parte
inferiore destra della schermata di Konqueror.

Gli utenti che desiderano connettersi al server devono specificare nei propri browser
un URL del tipo HTTP:///NOMEHOST:8001. Viene visualizzata una panoramica
del contenuto pubblicato.
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Figura 9.15 Contenuti pubblicati

Per monitorare il traffico di rete relativo al file server nel computer host, fare clic con
il pulsante destro del mouse sull'icona a forma di globo e selezionare Monitor. Viene
visualizzato un breve elenco di statistiche simile a quello riportato di seguito.

Figura 9.16 Statistiche del file server
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10Cifratura con KGpg
KGpg è un componente importante dell'infrastruttura di cifratura del sistema. Questo
programma consente di generare e gestire tutte le chiavi necessarie. nonché di utilizzare
la relativa funzione dell'editor per la creazione e la cifratura rapida dei file o di usare
l'applet del pannello per eseguire la cifratura o la decifratura mediante trascinamento
e rilascio. In altri programmi, ad esempio i programmi di posta (Kontact o Evolution),
è possibile accedere ai dati delle chiavi per elaborare il contenuto firmato o cifrato. Nel
presente capitolo sono descritte le funzioni di base richieste per la normale gestione dei
file cifrati.

10.1 Perché utilizzare la firma e la
cifratura?

Firma
Con Firma si intende l'aggiunta di firme elettroniche a messaggi e-mail o
applicazioni per dimostrarne la corretta provenienza. Per impedire che altri scrivano
messaggi e-mail utilizzando il proprio nome e per proteggere sia il mittente sia i
destinatari, è consigliabile aggiungere una firma ai messaggi e-mail. Le firme
consentono di controllare con facilità il mittente dei messaggi e-mail ricevuti e di
individuare quelli nocivi.

Gli sviluppatori software usano firmare le proprie applicazioni per consentire agli
utenti di verificarne l'integrità. Anche se si ottiene il programma da un server non
ufficiale, è possibile verificare il pacchetto con la firma.
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Cifratura
Se si dispone di informazioni riservate che si desidera proteggere, è possibile
utilizzare la cifratura per modificare i dati in modo da renderli illeggibili agli altri
utenti. Questa funzionalità è particolarmente importante per le aziende, poiché
consente di proteggere le informazioni interne e la privacy dei dipendenti.

10.2 Generazione di una nuova coppia
di chiavi

Per poter scambiare messaggi cifrati con altri utenti, è necessario innanzitutto generare
una coppia di chiavi personalizzata. Una parte della chiave, ovvero la chiave pubblica,
viene distribuita ai partner di comunicazione e può essere utilizzata per cifrare i file o
i messaggi di e-mail da inviare. L'altra parte della coppia di chiavi, ovvero la chiave
privata, viene utilizzata per decifrare il contenuto cifrato.

IMPORTANTE: Confronto tra chiave privata e chiave pubblica

La chiave pubblica è destinata al pubblico e deve essere distribuita a tutti i
partner di comunicazione. Al contrario, la chiave privata deve essere nota solo
all'utente a cui appartiene. È consigliabile evitare che altri utenti abbiano accesso
a questi dati.

Avviare KGpg dal menu principale o premere Alt + F2 e digitare kgpg. Al primo avvio
del programma verrà visualizzato un assistente per facilitare la configurazione. Seguire
le istruzioni fino alla fase in cui viene richiesta la creazione di una chiave. Immettere
un nome, un indirizzo e-mail e se necessario un commento. Per modificare le
impostazioni di default, scegliere l'ora di scadenza della chiave, la sua dimensione e
l'algoritmo di cifratura utilizzato. Vedere Figura 10.1, "KGpg: creazione di una chiave"
(p. 193).

Quando si avvia KGpg nelle sessioni successive, sulla barra delle applicazioni viene
visualizzata solo una piccola icona che raffigura un lucchetto. Fare clic su tale icona
per visualizzare la finestra principale di KGpg sul desktop.
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Figura 10.1 KGpg: creazione di una chiave

Confermare le impostazioni premendo OK. La finestra di dialogo successiva richiede
di immettere due volte una password. La complessità relativa della password prescelta
viene misurata e visualizzata dal Password strength meter (Indicatore complessità
password). Il programma quindi genera la coppia di chiavi e visualizza un riepilogo.
Si consiglia di stampare o salvare subito un certificato di revoca. Tale certificato sarà
necessario per revocare la chiave privata nel caso in cui si dimentichi la password.
Confermare con OK; KGpg visualizza la finestra principale. Vedere Figura 10.2,
"Gestione chiavi" (p. 194).
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Figura 10.2 Gestione chiavi

10.3 Esportazione della chiave
pubblica

Dopo aver generato la coppia di chiavi, è necessario rendere disponibile la chiave
pubblica ad altri utenti. In questo modo si consente loro di cifrare o firmare i file e i
messaggi inviati. Per rendere la chiave pubblica disponibile ad altri utenti, selezionare
Keys (Chiavi) > Export Public Key(s) (Esporta chiavi pubbliche). Verrà visualizzata
una finestra di dialogo in cui sono incluse quattro opzioni:

Email
La chiave pubblica viene inviata tramite e-mail al destinatario scelto. Se si attiva
questa opzione e si conferma con OK, verrà visualizzata la finestra di dialogo per
la creazione di un nuovo messaggio di e-mail con KMail. Immettere il destinatario
e fare clic su Send (Invia). Il destinatario riceverà la chiave e sarà in grado di inviare
contenuto cifrato.

Clipboard (Appunti)
Prima di continuare l'elaborazione della chiave pubblica, è possibile inserirla negli
Appunti.

Default Key Server (Server chiavi di default)
Per rendere la chiave pubblica disponibile a un numero di utenti maggiore, è
sufficiente esportarla in un server delle chiavi su Internet. Per ulteriori informazioni,
fare riferimento a Sezione 10.5, "Finestra server delle chiavi" (p. 197).
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File
Se si preferisce distribuire la chiave in un file tramite un supporto dati anziché
inviarla tramite e-mail, selezionare questa opzione, quindi confermare o modificare
il nome e il percorso del file, quindi fare clic su OK.

10.4 Importazione delle chiavi
Se si riceve una chiave in un file (ad esempio come allegato di e-mail), è possibile
inserire tale chiave nell'apposito contenitore con Importa chiave e utilizzarla per stabilire
comunicazioni cifrate con il mittente. La procedura è simile a quella utilizzata per
l'esportazione delle chiavi riportata in precedenza.

10.4.1 Firma delle chiavi
Le chiavi possono essere firmate come qualsiasi altro file per garantirne autenticità e
integrità. Se si è assolutamente certi che la chiave importata appartenga all'utente
specificato come proprietario, è possibile apporre la propria firma alla chiave per
confermarne l'autenticità.

IMPORTANTE: Consolidamento dell'attendibilità del Web

Le comunicazioni cifrate sono sicure solo per il fatto che è possibile associare
senza alcun dubbio le chiavi pubbliche in circolazione all'utente specificato.
Mediante il controllo incrociato e la firma delle chiavi, si contribuisce al
consolidamento dell'attendibilità del sito Web. Per questi motivi è necessario
assicurarsi di firmare solo chiavi controllate personalmente.

Selezionare la chiave da firmare nell'elenco delle chiavi. Selezionare Chiavi > Firma
chiavi. Nella finestra di dialogo visualizzata, indicare la chiave privata da utilizzare per
la firma. Prima di apporre la firma, verrà visualizzato un avviso in cui viene indicato
di verificare l'autenticità della chiave. Se la verifica è già stata eseguita, fare clic su
Continua e immettere la password per la chiave privata selezionata nel passaggio
successivo. La firma può ora essere verificata da altri utenti mediante l'utilizzo della
chiave pubblica.
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10.4.2 Affidabilità delle chiavi
Di norma, il programma corrispondente richiede all'utente di confermare l'attendibilità
della chiave, ossia di confermare che la chiave sia effettivamente utilizzata dal legittimo
proprietario. Ciò si verifica ogni volta che un messaggio deve essere decifrato o una
firma verificata. Per evitare ciò, modificare il livello di attendibilità della nuova chiave
importata. Per default, una chiave appena importata viene inserita nell'elenco
accompagnata da una casella bianca, a indicare che non è stato assegnato alcun valore
concreto per il livello di attendibilità. Per considerare attendibile una chiave, eseguire
le seguenti operazioni:

1 Per accedere a un piccolo menu contestuale per la gestione delle chiavi, fare clic
con il pulsante destro del mouse sulla chiave appena importata.

2 Selezionare Sign Keys (Firma chiavi). In KGpg verrà aperta una finestra di dialogo
in cui viene chiesto all'utente di ricontrollare l'impronta digitale della chiave.

3 fare clic su Continue (Continua) per accedere alla finestra di dialogo relativa alla
firma della chiave.

4 Selezionare il livello di attendibilità, ad esempio I Have Done Very Careful
Checking (Il controllo è stato eseguito accuratamente). Chiudere la finestra di
dialogo.

5 Immettere la stringa di cifratura per completare il processo di firma della chiave.
La chiave importata verrà visualizzata in verde nella colonna di attendibilità.

Minore è il livello di affidabilità, inferiore sarà la certezza che il firmatario della chiave
abbia verificato la reale identità delle chiavi firmate. È possibile essere completamente
certi dell'identità del firmatario, ma quest'ultimo potrebbe non essere in grado di
controllare le identità degli altri utenti prima di firmarne le chiavi. Di conseguenza, si
potrebbero ancora ritenere attendibili il firmatario e la sua chiave pur assegnando livelli
di attendibilità inferiori alle chiavi da questi firmate. Si noti che il livello di attendibilità
non comporta l'attivazione di azioni automatiche da parte di KGpg.
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10.5 Finestra server delle chiavi
Alcuni server delle chiavi basati su Internet includono le chiavi pubbliche di molti
utenti. Per stabilire comunicazioni cifrate con un numero elevato di utenti, è possibile
utilizzare i server per distribuire la chiave pubblica. A questo scopo, è necessario
esportare la chiave pubblica in uno dei server. Analogamente, KGpg consente la ricerca
delle chiavi degli utenti nei server e l'importazione delle relative chiavi pubbliche dal
server. Aprire la finestra di dialogo Server delle chiavi selezionando File > Server delle
chiavi.

10.5.1 Importazione di una chiave da un
server delle chiavi

Mediante l'utilizzo della scheda Importa nella finestra del server delle chiavi, importare
le chiavi pubbliche da uno dei server delle chiavi basati su Internet. Selezionare uno
dei server delle chiavi preconfigurati e immettere una stringa di ricerca (indirizzo e-
mail del partner di comunicazione) o l'ID della chiave da trovare. Quando si fa clic su
Ricerca, verrà stabilita la connessione a Internet e nel server delle chiavi specificato
verrà eseguita la ricerca della chiave che corrisponde alle specifiche. Vedere Figura 10.3,
"Schermata di ricerca per l'importazione di una chiave" (p. 197).

Figura 10.3 Schermata di ricerca per l'importazione di una chiave

Se la ricerca nel server delle chiavi ha esito positivo, in una nuova finestra verrà
visualizzato un elenco di tutte le voci recuperate dal server. Selezionare la chiave da
inserire nel contenitore e fare clic su Importa. Vedere la Figura 10.4, "Risultati e
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importazione" (p. 198). Scegliere OK per confermare il messaggio successivo, quindi
uscire dalla finestra di dialogo Server delle chiavi con Chiudi. La chiave importata,
visualizzata nella panoramica principale di gestione chiavi, è pronta per l'uso.

Figura 10.4 Risultati e importazione

10.5.2 Esportazione delle chiavi in un server
delle chiavi

Per esportare una chiave in uno dei server delle chiavi liberamente accessibili su Internet,
selezionare la scheda Esporta nella finestra Server delle chiavi. Specificare il server di
destinazione e la chiave da esportare mediante l'utilizzo dei due menu a discesa. Quindi
avviare l'esportazione con Esporta.

Figura 10.5 Esportazione di una chiave in un server delle chiavi
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10.6 Cifratura di file e testo
KGpg offre anche la possibilità di cifrare il testo o il contenuto degli Appunti. Fare clic
con il pulsante destro del mouse sull'icona con il lucchetto per visualizzare le opzioni
Encrypt clipboard (Cifra Appunti) e Decrypt clipboard (Decifra Appunti) nonché
l'opzione per l'apertura dell'editor integrato.

10.6.1 Cifratura e decifratura degli Appunti
I file copiati negli Appunti possono essere cifrati in modo semplice e rapido. Fare clic
con il pulsante destro del mouse sull'icona a forma di lucchetto di KGpg per visualizzare
la panoramica delle funzioni. SelezionareEncrypt clipboard (Cifra Appunti) e specificare
la chiave da utilizzare. Sul desktop verrà visualizzato un messaggio di stato relativo
alla procedura di cifratura. È quindi possibile elaborare il contenuto cifrato degli Appunti
in base alle proprie esigenze. La decifratura del contenuto degli Appunti è altrettanto
semplice. È sufficiente aprire il menu del pannello, selezionare Decrypt clipboard
(Decifra Appunti), quindi immettere la password associata alla chiave privata. La
versione decifrata è pronta per essere elaborata negli Appunti e nell'editor di KGpg.

10.6.2 Cifratura e decifratura mediante
trascinamento e rilascio

Per cifrare e decifrare i file, è possibile fare clic sulle icone presenti sul desktop o nel
file manager, trascinarle in corrispondenza del lucchetto nel pannello e rilasciarle. Se
il file non è cifrato, in KGpg verrà chiesto di specificare la chiave da utilizzare. Dopo
aver selezionato una chiave, il file viene cifrato e non verranno visualizzati altri
messaggi. Nel file manager, i file cifrati vengono indicati dal suffisso .asc e dall'icona
con il lucchetto. Per decifrare i file, è sufficiente fare clic sull'icona del file, trascinarla
in corrispondenza del simbolo di KGpg nel pannello e rilasciarla. Se il nome del file
originale risulta già esistente, si apre una finestra di dialogo che richiede quale nome
si desidera assegnare al file o se questo deve essere sovrascritto.
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10.6.3 Editor di KGpg
Anziché creare il contenuto da cifrare in un editor esterno e cifrare poi il file con uno
dei metodi sopra riportati, è possibile utilizzare l'editor integrato di KGpg per la creazione
del file. È sufficiente aprire l'editor (Apri editor dal menu contestuale), immettere il
testo desiderato e fare clic su Cifra. Quindi selezionare la chiave da utilizzare e
completare la procedura di cifratura. Per decifrare i file, utilizzare Decifra e immettere
la password associata alla chiave.

La procedura di generazione e controllo delle firme sui documenti è facile quanto la
cifratura eseguita direttamente dall'editor. Selezionare un file nel file manager e copiarlo
negli Appunti. Fare clic con il pulsante destro del mouse sull'icona a forma di lucchetto
presente nel pannello e selezionare Sign/Verify Clipboard (Firma/verifica Appunti).
Indicare la chiave privata da utilizzare e immettere la password associata. In KGpg
verrà indicato se la generazione della firma è stata eseguita in modo corretto. Se si
decide di firmare i file nell'editor, è sufficiente fare clic su Firma/Verifica. Per verificare
un file firmato, scegliere File (File) > Open Editor (Apri editor), caricare il file da
verificare nell'editor e fare clic su Sign/Verify (Firma/verifica.

10.7 Ulteriori informazioni
Per informazioni di base sul metodo di cifratura, consultare l'introduzione disponibile
nelle pagine dedicate al progetto GnuPG all'indirizzo http://www.gnupg.org/
documentation/howtos.html.en. Questo documento fornisce inoltre un elenco
di altre fonti di informazioni.
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11Esecuzione di ricerche con
Kerry
Kerry è un'applicazione front-end di KDE per lo strumento di ricerca Beagle, che
indicizza lo spazio delle informazioni personali per consentire all'utente di individuare
ciò che desidera. È possibile utilizzare Kerry per cercare documenti, e-mail, cronologia
Web, conversazioni IM/ITC, codice sorgente, immagini, file musicali, applicazioni e
molto altro ancora.

Poiché Kerry è un'applicazione front-end per Beagle, è necessario che il daemon di
Beagle funzioni correttamente. Kerry e Beagle possono ora indicizzare molte origini
di informazioni specifiche di KDE, ad esempio conversazioni Kopete, cronologia
Konqueror o messaggi KMail. Il risultato è una maggiore integrazione nell'ambiente
KDE tramite l'interfaccia Kerry. Ulteriori informazioni su Beagle in Guida per l'utente
di GNOME.

11.1 Esecuzione di ricerche con Kerry
Per individuare i dati utilizzando lo strumento Kerry, attenersi alla procedura seguente:

1 Premere Alt + Spazio per aprire la finestra Ricerca Kerry Beagle. In alternativa,
aprire la finestra di ricerca facendo clic sull'icona dell'applet Kerry (la testa di
un cane) nella barra delle applicazioni.

2 Digitare in Cerca il termine che si desidera cercare. Per eliminare rapidamente
il testo precedentemente immesso, premere la freccia nera situata a sinistra.
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Poiché la ricerca non fa distinzione tra i caratteri, è possibile utilizzare
indifferentemente caratteri minuscoli e maiuscoli. Per cercare termini aggiuntivi,
utilizzare la parola chiaveOR (in lettere maiuscole). Ad esempio, la ricercaMarte
OR Venere individua tutti i dati contenenti qualsiasi occorrenza di Marte, Venere
o entrambi. Per escludere termini di ricerca, inserire un segno meno (–) davanti
a tali termini. Ad esempio, la ricerca Marte -Venere individua tutti i dati
contenenti qualsiasi occorrenza di Marte, ma eliminando tutte le occorrenze di
Venere. Per cercare una frase esatta, racchiuderla tra virgolette. Se si desidera
includere nei risultati solo determinati tipi di file, specificarne l'estensione del
nome file con ext:. Ad esempio, la ricerca Marte ext:xml individua i file
xml contenenti il termine Marte.

3 Selezionare la portata della ricerca nella sezione Mostra del pannello di destra.
Per eseguire la ricerca in tutto il contenuto indicizzato, scegliere Tutto. È però
possibile limitare la ricerca ai soli elementi indicizzati, ossia Applicazioni,
Contatti, Documenti Office, messaggistica immediata Conversazioni, Immagini,
File multimediali, Pagine Web o Nomi File/Percorso facendo clic sull'elemento
che interessa nel pannello. È possibile modificare la portata della ricerca prima
o dopo la sua esecuzione.

Modificare l'ordinamento dei risultati nella sezione Ordina per del pannello
destro. Per ordinare i risultati per tipo, fare clic su Tipo. È inoltre possibile
ordinarli per Data, Nome e Pertinenza. È possibile modificare l'ordinamento dei
risultati prima o dopo la sua esecuzione.

È possibile circoscrivere i risultati per data di ultima modifica. Per visualizzare
tutti i risultati indipendentemente dalla data dell'ultima modifica, fare clic su
Qualsiasi data nel pannello di destra. È possibile visualizzare gli elementi
modificati oggi, fino a ieri, la settimana, il mese o l'anno correnti facendo clic
sulla voce desiderata nel pannello di destra. Questo parametro può essere
modificato prima o dopo l'esecuzione della ricerca.

4 Premere Invio o fare clic sull'icona a destra del campo di ricerca per avviare la
ricerca. I risultati vengono visualizzati nell'area principale della finestra.

I risultati vengono visualizzati in una finestra e ordinati in base alle impostazioni definite.
Fare clic su un qualsiasi elemento per attivarlo. Per aprire la cartella contenente un file
trovato invece del file stesso, fare clic sul nome della cartella a destra del nome file.
Per visualizzare ulteriori informazioni su un elemento, fare clic sull'icona con la i a
sinistra.
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È possibile modificare la portata della ricerca, l'ordinamento dei risultati e la limitazione
per data in qualsiasi momento, facendo clic sull'elemento desiderato nel pannello a
destra.

Per spostarsi tra le pagine dell'elenco dei risultati, utilizzare Risultati precedenti e
Risultati successivi. Il numero di voci trovate viene visualizzato nella parte inferiore
della finestra.

11.2 Configurazione di Kerry
Per configurare Kerry è sufficiente fare clic con il pulsante destro del mouse sulla sua
icona e scegliendo Configura Kerry oppure facendo clic su Configura nella finestra
principale di Kerry. Nella finestra di configurazione sono disponibili quattro schede.

Nella scheda Ricerca è possibile modificare Ordinamento risultati predefinito, Numero
massimo di risultati visualizzati su una pagina e le scelte rapide da tastiera per avviare
Kerry Beagle Search.

Nella scheda Indicizzazione, determinare se il servizio di indicizzazione di Beagle debba
essere avviato automaticamente e se i dati debbano essere indicizzati mentre il computer
è alimentato da batteria. È anche possibile stabilire quali cartelle debbano essere
indicizzate da Kerry Beagle Search e quali no. Per istruzioni dettagliate, consultare
Sezione 11.2.1, "Indicizzazione di un maggior numero di directory" (p. 204) e
Sezione 11.2.2, "Come impedire che file e directory siano indicizzati" (p. 204).

Nella scheda Back-end, selezionare quali dei back-end Beagle disponibili debbano
essere abilitati. Per disabilitare un back-end, deselezionarlo. Se per esempio non si
desidera che Kerry Beagle indicizzi le conversazioni Kopete, deselezionare il back-end
Kopete.

Nella scheda Stato daemon, selezionare lo stato del daemon Beagle. Qui è possibile
interrompere o avviare manualmente il daemon. Per utilizzare le funzionalità di Kerry
Beagle Search, il daemon deve essere in esecuzione.
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11.2.1 Indicizzazione di un maggior numero
di directory

Di default, Kerry indicizza solo la cartella principale. Per non indicizzare la cartella
home, deselezionare l'opzione Indicizza cartella principale personale nella scheda
Indicizzazione della configurazione di Kerry. Per indicizzare più cartelle, procedere
come segue:

1 Se la finestra di dialogo di configurazione di Kerry Beagle non è ancora aperta,
fare clic con il pulsante destro del mouse sull'icona Kerry nella barra e selezionare
Configura Kerry.

2 Fare clic sulla scheda Indicizzazione.

3 Fare clic sul pulsante Aggiungi nella sezione centrale (Indice) della scheda.

4 Nella finestra di dialogo che verrà visualizzata, selezionare la cartella da
indicizzare e fare clic su OK.

5 Fare clic su OK.

11.2.2 Come impedire che file e directory
siano indicizzati

Per escludere alcune cartelle o file dall'indicizzazione eseguita da Kerry, attenersi alla
procedura seguente:

1 Se la finestra di dialogo di configurazione di Kerry Beagle non è ancora aperta,
fare clic con il pulsante destro del mouse sull'icona Kerry nella barra e selezionare
Configura Kerry.

2 Fare clic sulla scheda Indicizzazione.

3 Fare clic Aggiungi nella parte inferiore (Privacy) della scheda.

4 Nella finestra di dialogo che viene visualizzata, scegliere la cartella che si desidera
escludere dall'indicizzazione selezionando l'opzione Cartella. Specificare il
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percorso della cartella nel campo di testo o premere il pulsante che raffigura una
cartella e scegliere la cartella desiderata in una finestra di dialogo file.

È inoltre possibile specificare i file da non indicizzare selezionando Modello
nome file e indicando il relativo percorso.

5 Fare clic su OK.
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12Gestione stampanti
Le stampanti possono essere collegate direttamente al sistema locale o tramite rete.
Esistono diversi modi per impostare una stampante in SUSE Linux Enterprise®: con
YaST, con KDE Printing Manager o dalla riga di comando. In questo capitolo viene
spiegato come impostare le stampanti utilizzando Gestione stampanti di KDE. Dopo
aver configurato correttamente la stampante, sarà possibile accedervi da qualsiasi
applicazione.

Per informazioni su come gestire le stampanti con iPrint®, fare riferimento a Guida
dell'utente di iPrint disponibile all'indirizzo http://www.novell.com/
documentation/sled10/.

NOTA: soluzione dei problemi

In caso di problemi durante la configurazione della stampante, contattare
l'amministratore di sistema. La configurazione della stampante per
amministratori viene illustrata dettagliatamente in Capitolo 20, Printer Operation
(↑Deployment Guide).

12.1 Installazione di una stampante
Prima di poter installare una stampante, è necessario disporre della password root e
delle informazioni sulla stampante. In base al tipo di connessione alla stampante,
potrebbe essere necessario specificare l'indirizzo URI, TCP/IP oppure l'host e il driver
per la stampante. Con SLED vengono forniti numerosi driver di stampanti comuni. Se
non è possibile trovare un driver per la stampante, controllare il sito Web del produttore.
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Per configurare una stampante in KDE, avviare Gestione stampanti dal menu principale
(Strumenti > Stampa > Gestione stampanti). In alternativa, premere Alt + F2 e digitare
il comando kcontrol. Nella parte sinistra della barra di navigazione del Centro di
controllo KDE, fare clic su Periferiche > Stampanti.

Figura 12.1 Gestione stampanti

È possibile configurare una stampante comeroot avvalendosi di una procedura guidata,
come descritto di seguito. Se non si è sicuri dell'opzione da selezionare e delle
informazioni da immettere, rivolgersi all'amministratore di sistema.

Per informazioni dettagliate su come accedere a una stampante di rete Windows e su
come configurarla, fare riferimento a Sezione 9.5, "Configurazione e accesso a una
stampante di rete Windows" (p. 182).

1 Fare clic su Modalità amministratore e specificare la password root.

2 Fare clic su Aggiungi e selezionare Aggiungi stampante/classe. Viene avviata la
procedura Aggiunta guidata stampanti.

3 Fare clic su Avanti.
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4 Scegliere il tipo di connessione per questa stampante. Sono disponibili le seguenti
opzioni:

• Stampante locale (parallela, seriale, USB): stampante collegata alla
workstation tramite connessione parallela, seriale o USB.

• Remote LPD queue (Coda LPD remota): una stampante collegata a un altro
sistema UNIX o Linux a cui è possibile accedere tramite una rete TCP/IP,
ad esempio una stampante collegata a un altro sistema Linux in rete.

• Stampante SMB condivisa (Windows): una stampante collegata a un diverso
sistema che condivide la stampante tramite una rete SMB (ad esempio, un
stampante collegata a un computer dotato di Microsoft Windows).

• Stampante di rete (TCP): una stampante collegata in rete tramite il protocollo
TCP.

• Remote CUPS server (IPP/HTTP) (Server CUPS remoto (IPP/HTTP)): una
stampante collegata a un altro sistema Linux nella stessa rete che esegue
CUPS oppure una stampante configurata in un altro sistema operativo tramite
IPP.

• Network printer w/IPP (IPP/HTTP) (Stampante di rete w/IPP (IPP/HTTP)):
una stampante collegata alla rete che usa il protocollo IPP/HTTP.

• Altro tipo di stampante: se la stampante non rientra nelle classi elencate in
precedenza, scegliere questa opzione.

• Classe di stampanti: per trovare le stampanti in base a una classe specifica,
scegliere questa opzione.

5 Fare clic su Avanti e immettere le informazioni richieste per la scelta effettuata.
Nell'ultima finestra di dialogo della procedura guidata fare clic su Fine. La
procedura guidata viene chiusa.

6 Fare clic su OK per chiudere la finestra di dialogo Gestione stampanti.

A questo punto, quando si esegue la stampa da un'applicazione in KDE, è possibile
selezionare la stampante nella finestra di dialogo KPrinter e avviare un lavoro di stampa.
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Per ulteriori informazioni sull'invio e sul monitoraggio dei lavori di stampa in KDE,
fare riferimento a Sezione 12.4, "Avvio dei lavori di stampa in KDE" (p. 211).

12.2 Modifica delle impostazioni della
stampante

1 Avviare Gestione stampanti dal menu principale (Strumenti > Stampa > Gestione
stampanti).

2 Fare Clic Su modalità amministratore e specificare la password root.

3 Nel campo di visualizzazione che riporta l'elenco delle stampanti disponibili
selezionare la stampante che si desidera modificare.

4 Fare clic con il pulsante destro del mouse e selezionare Configura.

5 Modificare le proprietà nella finestra di dialogo di configurazione, quindi fare
clic su OK.

12.3 Cancellazione di una stampante
1 Avviare Gestione stampanti dal menu principale (Strumenti > Stampa > Gestione

stampanti).

2 Fare Clic Su modalità amministratore e specificare la password root.

3 Nel campo di visualizzazione che riporta l'elenco delle stampanti disponibili
selezionare la stampante che si desidera eliminare.

4 Fare clic con il pulsante destro del mouse e selezionare Rimuovi.

5 Fare clic su OK per chiudere la finestra di dialogo Gestione stampanti.
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12.4 Avvio dei lavori di stampa in KDE
In genere, in KDE i lavori di stampa vengono avviati con KPrinter. Questa applicazione
si avvia automaticamente ogni volta che si effettua una stampa da un'applicazione KDE.
Nella finestra di dialogo KPrinter, scegliere una stampante e modificare le Proprietà
del lavoro di stampa, quali orientamento della pagina, pagine per foglio e stampa
fronte/retro.

SUGGERIMENTO: invio di file a una stampante senza aprire l'applicazione

Per avviare KPrinter manualmente, premere Alt + F2 e digitare il comando
kprinter. Questo risulta particolarmente utile se si desidera stampare uno
o più file senza avviare l'applicazione per visualizzare o modificare il file. La
finestra di dialogo KPrinter include inoltre la scheda File, che consente di
specificare i file da stampare. Questi possono essere trascinati dal desktop e
rilasciati nell'elenco oppure, per individuarli, è possibile utilizzare la finestra di
dialogo file.

Per specificare il numero di copie e altre opzioni, fare clic su Espandi in basso a sinistra.
La finestra viene espansa e presenta tre schede: Copie, Opzioni avanzate e Additional
Tags (contrassegni aggiuntivi). Vedere la Figura 12.2, "Avvio di un lavoro di stampa
con KPrinter" (p. 212).
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Figura 12.2 Avvio di un lavoro di stampa con KPrinter

La schedaCopie definisce le pagine da stampare (tutte le pagine del documento indicato,
quella selezionata o un intervallo di pagine) e il numero di copie. È inoltre possibile
scegliere di stampare solo quelle pari o quelle dispari. La scheda Opzioni avanzate
consente di specificare ulteriori informazioni sul lavoro di stampa. Inserire eventuali
informazioni di fatturazione in Billing information o impostare se necessario una dicitura
personalizzata nella parte superiore o inferiore della pagina. Impostare anche se
necessario il valore di Job Priority (Priorità lavoro). L'ultima scheda, Tag aggiuntivi
risulta necessaria molto di rado. Una volta avviato il lavoro di stampa, è possibile
seguirne l'avanzamento tramite KJobViewer.
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12.5 Monitoraggio dei lavori di
stampa in KDE

Avviare KJobViewer dal menu principale o con il comando kjobviewer dalla riga
di comando. Verrà visualizzata una finestra come quella in Figura 12.3, "Monitoraggio
dei lavori di stampa con KJobViewer" (p. 213), contenente tutti i lavori di stampa accodati
nella stampante. Il lavoro di stampa può essere modificato fintanto che non è attivo.
Per fare ciò, servirsi delle voci del menu Lavori.

Figura 12.3 Monitoraggio dei lavori di stampa con KJobViewer

Se, ad esempio, si desidera verificare se è stato inviato alla stampante il documento
corretto, è possibile arrestare il lavoro e riprenderlo nel momento in cui si decide di
eseguirne la stampa. È possibile rimuovere i lavori di stampa dalla coda con Rimuovi.
Per cambiare la stampante, selezionare una stampante diversa con Move to Printer
(Stampante di destinazione).

Il comando Riavvia consente di ristampare un documento. Per fare ciò, selezionare
Filtro > Toggle Completed Jobs (Mostra/nascondi lavori completati), selezionare il
documento desiderato, quindi fare clic su Lavori > Riavvia. Per visualizzare i dettagli
tecnici di un lavoro, fare clic su Jobs (Lavori) > Job IPP Report (Rapporto IPP sui
lavori. Per impostare la priorità > in base all'urgenza del documento, usare Jobs
(Lavori)Increase Priority (Aumenta priorità) > Jobs (Lavori) e Decrease Priority
(Diminuisci priorità.

Filtro consente di passare da una stampante all'altra, alternare i lavori completati e
limitare la visualizzazione ai soli lavori di stampa dell'utente mediante la selezione di
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Mostra solo i lavori dell'utente. L'utente attuale verrà quindi visualizzato nel campo
superiore destro.

Impostazioni > Configura KJobViewer... consente l'apertura della finestra di
configurazione. Nella finestra è possibile specificare il numero massimo di lavori di
stampa da visualizzare. Per specificare un valore, immettere un numero nel campo o
utilizzare il dispositivo di scorrimento sulla destra. Premere OK per salvare
l'impostazione o Annulla per uscire dalla finestra di dialogo senza salvare.

Le icone della barra degli strumenti corrispondono alle funzioni accessibili tramite
menu. Per visualizzare il testo della guida che descrive una funzione, posizionare il
puntatore del mouse su una delle icone.

L'elenco dei lavori è costituito da otto colonne. L'ID del lavoro viene assegnato
automaticamente dal sistema di stampa e consente di identificare i diversi lavori. La
colonna successiva contiene il login dell'utente che ha inviato il lavoro seguito dal nome
del file del documento. La colonna dello stato indica se il lavoro è ancora in coda, in
fase di stampa o è stato già stampato. Inoltre, vengono visualizzati le dimensioni del
documento in kilobyte e il numero di pagine. Se necessario, è possibile aumentare o
ridurre la priorità di default di 50. Le informazioni sulla fatturazione possono essere
rilevate dai centri di costo o da altre informazioni specifiche della società. Se si fa clic
con il pulsante destro del mouse su un lavoro dell'elenco, in corrispondenza del puntatore
del mouse verrà visualizzato il menu Lavori in cui è possibile selezionare un'azione.
Per i lavori completati sono disponibili poche funzioni. Se si attiva Keep window
permanent (Mantieni finestra permanente), la finestra di KJobViewer verrà aperta
automaticamente al login successivo.
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Parte III. Internet





13Gestione delle connessioni di
rete
Per navigare in Internet e inviare e ricevere messaggi e-mail, è necessario aver
configurato una connessione a Internet con YaST. In base all'ambiente in uso, scegliere
in YaST se utilizzare NetworkManager. In KDE è quindi possibile stabilire connessioni
a Internet con NetworkManager o KInternet.

Per un elenco dei criteri che consentono di stabilire se utilizzare NetworkManager,
consultare sezione "Managing Network Connections with NetworkManager"
(Capitolo 30,Basic Networking, ↑Deployment Guide) e sezione "Integration in Changing
Operating Environments" (Capitolo 25, Mobile Computing with Linux, ↑Deployment
Guide).

13.1 Utilizzo di KNetworkManager
L'applet NetworkManager viene avviata automaticamente con l'ambiente desktop.
L'applet viene quindi visualizzata come icona nella barra delle applicazioni. Scegliere
una rete da utilizzare sempre in maniera esplicita mediante l'applet. La rete selezionata
in questo modo è prioritaria rispetto alle altre reti selezionate automaticamente e La
rete selezionata viene utilizzata finché disponibile. Se la rete diventa inaccessibile,
NetworkManager tenta automaticamente di connettersi a un'altra rete disponibile.

Se KNetworkManager non è in esecuzione, avviarlo con il comando
knetworkmanager. Quando l'applet è in esecuzione, sulla barra delle applicazioni
viene visualizzata un'icona che mostra lo stato corrente della rete. L'aspetto dell'icona
del pannello varia a seconda dello stato della connessione di rete:
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È stata stabilita una connessione cablata.

Non è stabilita alcuna connessione a Internet.

È stata stabilita una connessione wireless. Le barre blu indicano l'intensità del
segnale. Più barre blu indicano che il segnale è migliore.

Una connessione è in corso o è terminata.

Per aprire il menu di KNetworkManager con varie opzioni per la gestione delle
connessioni di rete, fare clic con il pulsante destro del mouse sull'icona. Vedere
Figura 13.1, "Reti disponibili nell'applet KNetworkManager" (p. 218). Il menu contiene
le connessioni di rete disponibili eseguite tramite dispositivi sia cablati che wireless.
Tenendo il mouse su di esse, vengono visualizzate informazioni dettagliate. La
connessione utilizzata viene contrassegnata nel menu.

Figura 13.1 Reti disponibili nell'applet KNetworkManager
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13.1.1 Reti wireless
Nel menu viene visualizzata anche l'intensità del segnale delle reti wireless. Le reti
wireless cifrate vengono contrassegnate con un'icona a forma di lucchetto. Per connettersi
a una rete cifrata, sceglierla dal menu. Nella finestra di dialogo visualizzata, scegliere
il tipo di Cifratura utilizzato dalla rete, quindi digitare la corretta Frase chiave o Chiave.

SUGGERIMENTO: reti nascoste

Per connettersi a una rete che non trasmette il proprio ESSID (Identificatore
set di servizi, Service Set Identifier) e che quindi non è possibile rilevare
automaticamente, scegliere Connetti ad altre reti wireless. Nella finestra di
dialogo visualizzata, inserire l'identificatore ESSID e, se necessario, impostare i
parametri di cifratura.

Per visualizzare tutte le reti sicure e non sicure, fare clic su Opzioni > Show Networks
(Mostra reti).

13.1.2 Connessioni remote
Per accedere alle connessione ad accesso remoto, scegliere Dial-Up Connections
(Connessioni ad accesso remoto). Se le connessioni ad accesso remoto sono già state
definite, avviare la connessione facendo clic sulla connessione da utilizzare. Scegliendo
Configure Dial-Up connections (configura connessioni ad accesso remoto) viene aperto
yast in cui è possibile definire una nuova connessione ad accesso remoto. Per ulteriori
informazioni, vedere sezione "Modem" (Capitolo 30, Basic Networking, ↑Deployment
Guide).

13.1.3 Utilizzo di NetworkManager con VPN
NetworkManager supporta numerose tecnologie VPN. Per utilizzarle, è innanzitutto
necessario installare il supporto di NetworkManager per la tecnologia VPN. Sono
disponibili le tecnologie seguenti:

• NovellVPN

• OpenVPN
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• vpnc (Cisco)

Il supporto per VPN è incluso nei pacchetti NetworkManager-novellvpn,
NetworkManageropenvpn e NetworkManager-vpnc.

Per configurare una nuova connessione VPN con KNetworkManager, fare clic sull'applet
KNetworkManager e seguire i seguenti passaggi:

1 Scegliere VPN Connections (Connessioni VPN) > Configure (Configura VPN).

2 Scegliere Aggiungi e Inoltra per avviare la configurazione guidata.

3 Nella finestra di dialogo successiva, scegliere il tipo di connessione VPN da
creare.

4 Assegnare un nome alla configurazione in Nome connessione.

5 Inserire tutte le informazioni obbligatorie per il tipo di connessione in uso. Ad
esempio, per una connessione OpenVPN immettereGateway e scegliere il metodo
di autenticazione in Connection type (Tipo di connessione). Compilare le altre
opzioni obbligatorie in base al tipo di connessione selezionata.

In alternativa, caricare le impostazioni da un file di configurazione salvato
selezionando Import Saved Configuration (Importa configurazione salvata) e
selezionare il file di configurazione salvato in una finestra di dialogo di file
standard.

6 Fare clic su Inoltra.

Una volta configurata la rete VPN, è possibile selezionarla da Connessioni VPN. Per
chiudere una connessione VPN, fare clic Disconnetti VPN.

13.1.4 NetworkManager e sicurezza
NetworkManager distingue due tipi di connessioni wireless: sicure e non sicure. Una
connessione sicura è costituita da una qualsiasi rete selezionata esplicitamente in passato.
Tutte le altre connessioni sono non sicure. Le connessioni sicure vengono identificate
in base al nome e all'indirizzo MAC del punto di accesso. L'utilizzo dell'indirizzo MAC
serve a garantire che non venga usato un altro punto di accesso con il nome della
connessione sicura.
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Se non sono disponibili connessioni cablate, in NetworkManager vengono cercate le
reti wireless disponibili. Se vengono individuate più reti sicure, viene automaticamente
selezionata l'ultima utilizzata. Se tutte le reti sono sicure, è necessario selezionare
manualmente quella desiderata in NetworkManager.

Se vengono modificate le impostazioni di cifratura ma non il nome e l'indirizzo MAC,
NetworkManager tenta di connettersi, ma prima chiede di confermare le nuove
impostazioni di cifratura e di fornire tutti gli aggiornamenti, ad esempio la nuova chiave.

In un sistema dotato solo di una connessione wireless, NetworkManager non supporta
il lancio automatico della connessione durante l'avvio. Per stabilire una connessione, è
innanzitutto necessario effettuare il login. Per rendere una connessione wireless
accessibile senza login, configurare la connessione sicura con YaST. Per ulteriori
informazioni, vedere sezione "Configuration with YaST" (Capitolo 29, Wireless
Communication, ↑Deployment Guide). Solo le connessioni wireless configurate con
YaST vengono considerate affidabili da NetworkManager in modo da poter essere
utilizzate durante l'avvio.

Se durante l'utilizzo di una connessione wireless si passa alla modalità non online, viene
bloccato l'ESSID. Ciò garantisce che la scheda venga effettivamente disassociata.

13.1.5 Disattivazione della rete in KDE
Se ci si trova in aereo o in un altro ambiente in cui non è consentito l'utilizzo della rete
wireless, è possibile disattivarla tramite l'applet KNetworkManager. È anche possibile
disattivare tutte le connessioni di rete, cablate e wireless.

Per disattivare la rete wireless sul desktop KDE, fare clic con il pulsante destro del
mouse sull'applet KNetworkManager, quindi selezionare Options (Opzioni) > Disable
Wireless (Disabilita wireless). Per attivare di nuovo la connessione di rete, fare clic
con il pulsante destro del mouse sull'applet KNetworkManager quindi scegliereOptions
(Opzioni) > Enable Wireless (Abilita wireless).

Per disattivare tutte le reti wireless sul desktop KDE, fare clic con Il pulsante destro
del mouse sull'applet KNetworkManager, quindi selezionareOptions (Opzioni) > Switch
to Offline Mode (Passa a modalità offline). Per attivare di nuovo tutte le connessioni
di rete, fare clic con il pulsante destro del mouse sull'applet KNetworkManager quindi
scegliere Opzioni > Switch to Online Mode (Passa a modalità online).
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13.2 KInternet
Se anziché NetworkManager si utilizza KDE, è possibile gestire le connessioni Internet
con KInternet. Se KInternet non è installato per default, installare il pacchetto
kinternet con YaST. Il programma controlla se è possibile stabilire la connessione
a Internet. In caso affermativo, nella parte destra del pannello di KDE verrà visualizzata
automaticamente l'icona dell'applicazione, ovvero una spina. L'aspetto dell'icona del
pannello varia a seconda dello stato della connessione di rete:

Non è stabilita alcuna connessione a Internet.

La connessione è in corso o è terminata.

La connessione è stata stabilita.

È in corso una trasmissione di dati tramite Internet.

Si è verificato un errore. Se la connessione è già stata configurata con YaST,
utilizzareView Log (Visualizza log) per identificare la causa dell'errore. Per accedere
al menu, fare clic con il pulsante destro del mouse sull'icona di KInternet.

La connessione non è ancora attiva, ma verrà stabilita non appena viene inoltrata
la richiesta.

Fare clic con il pulsante destro del mouse sull'icona KInternet del pannello per accedere
al menu di configurazione. Aprire la finestra di dialogo della configurazione YaST
selezionando Settings (Impostazioni) > Configure with YaST) (Configura con YaST).
Dopo aver immesso la password di utente root, YaST viene avviato. A seconda del tipo
di accesso, avviare la configurazione modem, ISDN, di rete o DSL di YaST.
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Se si utilizza una connessione ISDN e si seleziona Channel Bundling (Accoppiamento
dei canali) in YaST, è possibile aggiungere un secondo canale ISDN alla connessione
esistente tramite Add link (Aggiungi link). In questo modo viene raddoppiata la velocità
di trasferimento (anche se a una tariffa maggiore). È possibile attivare l'accoppiamento
dei canali se è necessario scaricare file di grandi dimensioni. Se l'accoppiamento dei
canali è attivato, nell'angolo superiore sinistro dell'icona di KInternet verrà visualizzato
un simbolo più di colore rosso.

Se il computer dispone di più dispositivi di rete e tutti sono stati configurati con YaST,
è possibile utilizzare l'opzione Interface (Interfaccia) di KInternet per passare da un
dispositivo all'altro. A questo scopo, è necessario selezionare l'attivazione del dispositivo
tramite l'opzione User Controlled (controllato dall'utente) nella corretta finestra di
dialogo YaST per la configurazione di rete. Se viene fatto ricorso a più provider,
effettuare la scelta tramite Provider in KInternet. Anche i provider vengono impostati
in YaST.

Per stabilire la connessione Internet automaticamente, è possibile utilizzare una
connessione DoD. Se questa modalità è selezionata, in KInternet verrà eseguita la
connessione automatica all'ISP non appena viene inoltrata la richiesta. Dopo un periodo
di timeout specifico, la connessione viene terminata. Le connessioni DoD vengono
evidenziate dalla presenza di una D di colore blu nell'angolo inferiore destro dell'icona
di KInternet.

AVVERTIMENTO: controllo dei costi

Si noti che le connessioni DoD sono indicate solo se si dispone di un conto
Internet a tariffa fissa. Altrimenti, la continua connessione e disconnessione
può diventare molto costosa.

Per utilizzare una scheda di rete wireless per la connessione a Internet, configurala
tramite YaST come descritto in Reference e accertarsi che l'attivazione del dispositivo
in YaST sia impostata su User Controlled (Controllato dall'utente). Dopo aver
configurato l'interfaccia, è possibile utilizzare KInternet per controllare la connessione
di rete wireless.

Per accedere alla funzionalità WLAN di KInternet, fare clic con il pulsante destro del
mouse sull'icona per aprire il menu. Selezionare Wireless Connection (Connessione
wireless) per aprire una finestra con due schede. Nella prima fase, effettuare una
scansione delle reti wireless adatte a cui è possibile connettersi. Selezionare la scheda
Scansione reti wireless e avviare la scansione selezionandoAvvia scansione. Selezionare
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Auto refresh (Aggiornamento automatico) per consentire a KInternet di eseguire una
scansione costante dell'ambiente di rete. Attivare un segnale sonoro per ciascuna
connessione trovata selezionando Scansione sonora. Tutte le connessioni trovate
verranno visualizzate nell'elenco. Selezionarne una e fare clic su Connect (Connetti)
per connettersi alla rete selezionata. Se sono necessarie ulteriori configurazioni per
connettersi alla rete selezionata, fare clic su Start YaST (Avvia YaST) per aprire il
modulo di rete YaST per i dispositivi di rete wireless.

La scheda Current Connection (Connessione attuale) consente di monitorare lo stato
della connessione wireless attuale. La parte sinistra di questa scheda offre un riepilogo
di tutti i parametri di connessione relativi a: indirizzo di rete, nome ESSID, qualità del
segnale, livello e disturbo del segnale, frequenza e velocità del canale e parametri di
cifratura, come tipo di cifratura e lunghezza della chiave. Selezionare uno di questi
parametri nella struttura ad albero ed esaminare i dettagli visualizzati nella parte destra
della finestra.

13.3 Soluzione dei problemi
Possono verificarsi problemi di connessione. I metodi più appropriati per risolvere ed
evitare i problemi dipendono dallo strumento utilizzato.

13.3.1 KNetworkManager
Alcuni problemi comuni correlati a KNetworkManager includono l'applet che non si
avvia, un'opzione VPN mancante e problemi con SCPM.

L'applet desktop NetworkManager non si avvia
Se la rete è configurata per controllare NetworkManager, l'applet KNetworkManager
si avvia automaticamente. Se l'applet non si avvia, assicurarsi che il pacchetto
NetworkManager-kde sia installato.

Se l'applet desktop è installato ma per qualsiasi motivo non è in esecuzione, ad esempio
perché è stato chiuso accidentalmente, è possibile avviarlo manualmente. Per l'applet
manualmente, eseguire knetworkmanager da un prompt dei comandi.
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L'applet NetworkManager non include l'opzione VPN
Gli applet NetworkManager e il supporto VPN per NetworkManager vengono distribuiti
in pacchetti separati. Se l'applet NetworkManager non include l'opzione VPN, controllare
che il pacchetto con il supporto di NetworkManager per la tecnologia VPN sia installato.

Il supporto VPN è incluso nei pacchetti seguenti:

• Pacchetto NovellVPN NetworkManager-novellvpn

• Pacchetto OpenVPN NetworkManager-openvpn

• Pacchetto vpnc (Cisco) NetworkManager-vpns

SCPM non passa alla configurazione di rete
È probabile che si stia utilizzando SCPM con NetworkManager. NetworkManager non
supporta attualmente l'utilizzo dei profili SCPM. Non utilizzare NetworkManager
insieme a SCPM quando i profili corrispondenti modificano anche le impostazioni di
rete. Per utilizzare SCPM e NetworkManager contemporaneamente, disabilitare le
risorse di rete nella configurazione di SCPM.

13.3.2 KInternet
I problemi correlati a KInternet includono l'applet che non si avvia o la mancata
visualizzazione di alcuni dispositivi.

L'applet desktop KInternet non si avvia
Se KInternet non si avvia automaticamente, assicurarsi innanzitutto che il pacchetto
kinternet sia installato. Se KInternet è installato ma per qualsiasi motivo non è in
esecuzione, è possibile avviarlo manualmente. Per avviarlo manualmente, eseguire
kinternet da un prompt dei comandi.
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KInternet non include tutti i dispositivi configurati
Di default in KInternet sono visibili solo i modem configurati. Per abilitare altre
interfacce di rete in KInternet, è necessario che sia selezionata l'attivazione del
dispositivo User Controlled (Controllato dall'utente) nella finestra di dialogo della rete
YaST appropriata.
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14Navigazione con Konqueror
Konqueror non è solo un file manager versatile, ma è anche un moderno browser Web.
Se si avvia il browser con l'icona del pannello, verrà visualizzato un profilo del browser
Web. Come browser, Konqueror offre la navigazione a schede, la possibilità di salvare
pagine Web contenenti immagini, parole chiave di Internet, segnalibri e supporto per
Java e JavaScript.

Figura 14.1 Finestra del browser di Konqueror
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Avviare Konqueror dal menu principale o immettendo il comando konqueror. Per
caricare la pagina Web, immettere il relativo indirizzo nella barra degli indirizzi, ad
esempio, http://www.suse.com. Konqueror avvia la ricerca dell'indirizzo per
visualizzare la pagina. Non è necessariamente richiesta l'immissione del protocollo
all'inizio dell'indirizzo (http:// in questo caso). Il programma è in grado di completare
l'indirizzo automaticamente, ma funziona in modo affidabile solo con gli indirizzi Web.
Per l'indirizzo FTP, è necessario immettere sempre ftp:// all'inizio del campo di
input.

14.1 Navigazione a schede
Se si utilizza spesso più di una pagina Web contemporaneamente, la navigazione a
schede rende più facile il passaggio da una pagina all'altra. Caricare i siti Web in schede
separate all'interno di una sola finestra. In tal modo si ha il vantaggio di un maggiore
controllo del desktop poiché la finestra principale è una sola. Dopo il logout, la gestione
di sessione KDE consente di salvare la sessione Web in Konqueror. Al successivo login,
Konqueror carica esattamente gli URL visitati l'ultima volta.

Per aprire una nuova scheda, selezionare Finestra > Nuova scheda oppure premere Ctrl
+ Shift + N. Per modificare il funzionamento delle schede, accedere a Impostazioni >
Configura Konqueror. Nella finestra di dialogo che si apre, selezionareComportamento
Web > Tabbed Browsing (Navigazione a schede). Per aprire nuove schede invece di
finestre, attivare Open links in new tab instead of in new window (Apri collegamenti
nella nuova scheda invece che nella nuova finestra). È possibile anche nascondere la
scheda con Hide the tab bar when only one tab is open (Nascondi la barra delle schede
solo quando è aperta una sola scheda). Per visualizzare opzioni ulteriori, premere
Opzioni avanzate.

14.2 Scorrimento automatico
In genere, lo scorrimento con il mouse rappresenta il metodo più utilizzato per
visualizzare le informazioni presenti nella parte inferiore delle pagine Web. In alcune
occasioni è tuttavia consigliabile evitare di ricorrere al mouse, utilizzando piuttosto una
combinazione di tasti per non spostare le mani dalla tastiera.

Per eseguire automaticamente lo scorrimento, utilizzare Shift + ↓. Questo consente di
scorrere la pagina senza effettuare ulteriori operazioni. Per aumentare la velocità,
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premere nuovamente Shift + ↓. Se si preme Shift + ↑ la velocità diminuisce. Per
interrompere lo scorrimento, utilizzare ↓.

14.3 Profili
Sezione 14.1, "Navigazione a schede" (p. 228) viene descritto come gestire le schede
presenti in Konqueror. È possibile salvare le schede con gli URL e la posizione della
finestra in un profilo. Questa operazione differisce dalla gestione di sessione già citata.
Grazie ai profili, si hanno a disposizione le schede salvate senza perdere tempo per
l'avvio, come accade nella gestione di sessione.

Per creare un profilo, effettuare le operazioni riportate di seguito.

1 Accedere a Impostazioni > Configure View profiles (Configura nuovi profili).

2 Nella finestra di dialogo visualizzata immettere un nome in Nome del profilo.

3 Per salvare gli URL, selezionare Save URLs in profile (Salva URL nel profilo).

4 Per bloccare la posizione e le dimensioni della finestra, selezionare Save window
size in profile (Salva dimensioni finestra nel profilo).

5 Confermare con Salva.

La volta successiva in cui è necessaria la raccolta delle schede, accedere a Settings
(Impostazioni) > Load View Profile (Carica profilo della vista) e visualizzare il nome
elencato nel menu. Dopo la selezione del nome, Konqueror ripristina le schede.

14.4 Salvataggio di pagine Web e
immagini

Come in altri browser, è possibile salvare le pagine Web. A questo scopo, selezionare
Posizione > Salva come e specificare il nome per il file HTML. Le immagini, tuttavia,
non verranno salvate. Per archiviare un'intera pagina Web, incluse le immagini,
selezionare Strumenti > Archive Web Page (Archivia pagina Web). In Konqueror viene
utilizzato un nome file che in genere è possibile accettare. Il nome file termina con
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.war, ovvero l'estensione per gli archivi Web. Per visualizzare l'archivio Web salvato
in un secondo momento, è sufficiente fare clic sul file relativo per visualizzare la pagina
Web in Konqueror insieme alle immagini.

14.5 Ricerca con Konqueror
L'esecuzione di ricerche con Konqueror è pratica e semplice. È possibile utilizzare la
barra di ricerca o le scorciatoie del Web.

14.5.1 Utilizzo della barra dei motori di
ricerca

Konqueror contiene una barra di ricerca che consente di scegliere tra numerosi motori
di ricerca. Se si desidera cercare un termine specifico, procedere come segue:

1 Avviare Konqueror.

2 Individuare la barra di ricerca, situata a destra dopo la barra di posizione.

3 Fare clic sull'icona all'interno della barra di ricerca. Scegliere un motore di ricerca
dal menu popup.

4 Inserire il termine di ricerca e premere Enter. Il risultato viene visualizzato in
Konqueror.

Se si desidera utilizzare un motore di ricerca non presente nel menu popup, è possibile
aggiungerlo effettuando i passaggi seguenti:

Procedura 14.1 Aggiunta di ulteriori motori di ricerca

1 Avviare Konqueror.

2 Fare clic sull'icona all'interno della barra di ricerca.

3 Scegliere Select Search Engines (Seleziona motori di ricerca).
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4 Verificare che l'opzione Enable Web shortcuts (Attiva scorciatoie del Web) sia
stata attivata.

5 Abilitare il motore di ricerca desiderato e chiudere la finestra di dialogo scegliendo
Ok. Il motore di ricerca selezionato può essere visualizzato facendo clic sull'icona
presente sulla barra di ricerca.

14.5.2 Utilizzo delle scorciatoie del Web
Ogni motore di ricerca definito viene associato a una scorciatoia del Web, che può
essere immessa nella barra di posizione.

Per visualizzare le scorciatoie già definite, accedere a Impostazioni > Configure
Konqueror (Configura konqueror) > Web Shortcuts (Scorciatoie del Web). È possibile
visualizzare i nomi dei provider di ricerca e le scorciatoie. Konqueror definisce molti
motori di ricerca, quali Google, Yahoo e Lycos, oltre a numerose risorse meno comuni,
ad esempio le ricerche di un database degli acronimi, un database dei film di Internet
o applicazioni KDE.

Definire un nuovo motore di ricerca nel caso non si trovi il proprio. Per cercare ad
esempio alcuni articoli interessanti in Cool Solutions™ di Novell, accedere a http://
www.novell.com/coolsolutions, cercare la pagina di ricerca e immettere la
propria interrogazione. Per semplificare l'operazione, eseguire la seguente procedura:

Procedura 14.2 Creazione di nuove scorciatoie del Web

1 Sulla barra di ricerca fare clic sull'icona e scegliere Select Search Engines
(Seleziona motori di ricerca).

2 Verificare che l'opzione Enable Web shortcuts (Attiva scorciatoie del Web) sia
stata attivata.

3 Fare clic su Nuovo.

4 Creare una nuova scorciatoia del Web:

4a Assegnare un nome alla scorciatoia in Search provider name (Cerca nome
provider).
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4b Immettere l'URI di ricerca. Premere Shift + F11 e fare clic nel campo per
aprire una breve guida. L'interrogazione di ricerca è specificata come \{@}.
A questo punto è fondamentale inserirla nella posizione corretta. Utilizzare
http://search.novell.com/qfsearch/SearchServlet
?sortbydate=true&noredirect=true&index=Cool
+Solutions&query=\{@} per effettuare la ricerca nel database Cool
Solutions di Novell.

4c Immettere le proprie abbreviazioni in URI shortcuts (Scorciatoie URI), che
possono essere più di una, separate da virgola.

5 Procedere con Ok.

SUGGERIMENTO: utilizzo diretto di scorciatoie senza aprire Konqueror

Non è necessario aprire Konqueror per immettere una scorciatoia del Web.
Questa può infatti essere richiamata direttamente. Selezionare Esegui comando
dal menu principale o premere Alt + F2. Viene visualizzata una finestra di dialogo
in cui è possibile immettere la scorciatoia con il termine di ricerca.

Dopo aver creato una nuova scorciatoia Web, ad esempionc, questa può essere utilizzata
nella barra di posizione. Il risultato viene visualizzato nella finestra corrente.

14.6 Segnalibri
Invece di ricordare e reimmettere gli indirizzi dei siti visitati spesso, è possibile
contrassegnare questi URL utilizzando il menu Segnalibri. Oltre agli indirizzi delle
pagine Web, è possibile utilizzare il segnalibro anche per qualsiasi directory del disco
locale.

Per creare un nuovo segnalibro in Konqueror, fare clic su Segnalibri > Aggiungi
segnalibro. Ogni segnalibro aggiunto in precedenza viene incluso come voce di menu.
Si consiglia di organizzare la raccolta di segnalibri per argomento in una struttura
gerarchica in modo da non perdere traccia delle diverse voci. È possibile creare un
nuovo sottogruppo per i segnalibri con New Bookmark Folder (Nuova cartella
segnalibri). Per aprire l'editor dei segnalibri, selezionare Segnalibri > Modifica
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segnalibri. Utilizzare il programma per organizzare, riordinare, aggiungere ed eliminare
i segnalibri.

Se si utilizza Netscape, Mozilla o Firefox come browser aggiuntivo, non è necessario
creare di nuovo i segnalibri. Se nell'editor dei segnalibri si seleziona File > Importa >
Import Netscape Bookmarks (Importa segnalibri di Netscape), è possibile integrare i
segnalibri di netscape e Mozilla nella raccolta più recente. È possibile eseguire anche
l'operazione inversa tramite Export as Netscape Bookmarks (Esporta come segnalibro
di Netscape).

Per modificare i segnalibri, fare clic con il pulsante destro del mouse sulla voce. Verrà
visualizzato un menu a comparsa in cui è possibile selezionare l'azione desiderata (taglia,
copia, elimina e così via). Quando si ottiene il risultato desiderato, salvare i segnalibri
con File > Salva. Se si desidera modificare soltanto il nome o il collegamento, è
sufficiente fare clic con il pulsante destro del mouse sulla voce nella barra degli strumenti
del segnalibro e selezionare Proprietà. Modificare il nome e la posizione, quindi
confermare con Aggiorna.

Per salvare l'elenco dei segnalibri e consultarlo in modo rapido, attivare la visualizzazione
dei segnalibri in Konqueror. È sufficiente selezionare Impostazioni > Barre degli
strumenti > Bookmark Toolbar (Konqueror) (Barra degli strumenti dei segnalibri)
(Konqueror). Nella finestra corrente di Konqueror, verrà visualizzato automaticamente
un pannello con i segnalibri.

14.7 Java e JavaScript
È opportuno evitare che questi due linguaggi vengano confusi. Java è un linguaggio di
programmazione indipendente dalla piattaforma e orientato agli oggetti di Sun
Microsystems. È molto utilizzato per piccoli programmi (applet) eseguiti su Internet
per servizi bancari online, commercio elettronico e chat. Javascript è un linguaggio di
scripting interpretato che viene utilizzato principalmente per creare la struttura dinamica
delle pagine Web (ad esempio per i menu e altri effetti).

Konqueror consente di attivare e disattivare questi due linguaggi anche in base alle
specifiche del dominio, consentendo l'accesso ad alcuni host e rifiutandolo ad altri. Per
motivi di sicurezza, Java e JavaScript sono spesso disattivati. Tuttavia, per la
visualizzazione corretta di alcune pagine Web è richiesta l'attivazione di JavaScript.
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14.8 Abilitazione dei blocchi delle
pubblicità

Con alcune pagine Web vengono aperti anche fastidiosi annunci pubblicitari. Grazie a
Konqueror, queste finestre possono essere bloccate. Procedere come segue:

Procedura 14.3 Bloccare di annunci pubblicitari

1 Avviare Konqueror.

2 Accedere a Impostazioni > configure Konqueror (Configura Konqueror) >
AdBlock Filter (Filtro AdBlock).

3 Selezionare Enable filters (Attiva filtri).

4 Fare clic su Inserisci.

5 Immettere un'espressione per la pagina Web da filtrare. Ad esempio:
http://www.example.com/*

Questo consente di filtrare qualsiasi contenuto proveniente dall'URL specificato.

14.9 Ulteriori informazioni
Per eventuali domande o problemi che possono derivare dall'utilizzo di Konqueror, fare
riferimento al manuale dell'applicazione disponibile nel menu della Aiuto. È possibile
anche visitare la pagina Web di Konqueror all'indirizzo http://www.konqueror
.org.

234 Guida per l'utente KDE

http://www.konqueror.org
http://www.konqueror.org


15Navigazione con Firefox
Il browser Web Mozilla Firefox viene fornito con SUSE Linux Enterprise®. Grazie a
funzioni quali l'esplorazione a schede, il blocco delle finestre popup e il download e la
gestione delle immagini, Firefox combina le più recenti tecnologie di esplorazione e
sicurezza con un'interfaccia molto intuitiva. Le schede consentono di visualizzare più
pagine Web in un'unica finestra. È possibile sopprimere i fastidiosi messaggi pubblicitari
e disabilitare le immagini per accelerare l'esplorazione. La facilità di accesso ai vari
motori di ricerca consente di trovare facilmente le informazioni necessarie.

Avviare Firefox dal menu principale oppure immettendo il comando firefox. Le
principali funzioni del programma vengono descritte nelle seguenti sezioni.

15.1 Visualizzazione di siti Web
L'aspetto e l'utilizzo di Firefox sono analoghi a quelli di altri browser. La finestra è
mostrata in Figura 15.1, "Finestra del browser Firefox" (p. 236). La barra degli strumenti
di navigazione include i pulsanti per la navigazione, quali Avanti e Indietro oltre a una
barra degli indirizzi per l’accesso ai siti Web. Per un accesso più rapido alle pagine è
possibile utilizzare i segnalibri. Per ulteriori informazioni sulle varie funzioni di Firefox,
fare clic su ? nella barra dei menu.
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Figura 15.1 Finestra del browser Firefox

15.1.1 Navigazione a schede
Se si utilizzano spesso più pagine Web contemporaneamente, l'esplorazione a schede
semplifica il passaggio tra le pagine. Questa funzionalità consente di caricare siti Web
in schede separate di un'unica finestra.

Per aprire una nuova scheda, selezionare File > Nuova scheda oppure premere Ctrl +
T. Verrà aperta una scheda vuota nella finestra di Firefox. In alternativa, fare clic con
il pulsante destro del mouse su un collegamento e selezionare Apri in nuova scheda.
Fare clic con il pulsante destro del mouse sulla scheda stessa per accedere ad altri menu
e opzioni. È possibile creare una nuova scheda, caricare nuovamente una o tutte le
schede presenti o chiuderle. È inoltre possibile modificare la sequenza delle schede
trascinandole e rilasciandole nella posizione desiderata.
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15.1.2 Utilizzo della barra laterale
Utilizzare il lato sinistro della finestra del browser per visualizzare i segnalibri o la
cronologia. Le estensioni possono aggiungere nuove modalità di utilizzo anche alla
barra laterale. Per visualizzare la barra laterale, selezionare Visualizza > Riquadro
laterale e selezionare il contenuto desiderato.

15.2 Ricerca di informazioni
Esistono due metodi per trovare informazioni in Firefox: mediante la barra Cerca che
consente di effettuare ricerche in Internet con un motore di ricerca oppure mediante la
barra Trova che consente di effettuare ricerche nella pagina attualmente visualizzata.

15.2.1 Individuazione di informazioni sul
Web

Firefox è dotato di una barra di ricerca che consente di accedere a vari motori, quali
Google, Yahoo o Amazon. Ad esempio, se si desidera reperire informazioni su SUSE
utilizzando il motore corrente, fare clic nella barra dei motori di ricerca, digitare SUSE
e premere Invio. I risultati verranno visualizzati nella finestra. Per scegliere il motore
di ricerca, fare clic sull'icona a sinistra della barra di ricerca. Viene visualizzato un
elenco di motori di ricerca disponibili.

Personalizzazione della barra Cerca
Se si desidera cambiare l'ordine, oppure aggiungere o eliminare un motore di ricerca
sulla barra, stabilire una connessione a Internet ed eseguire le operazioni seguenti.

1 Fare clic sull'icona a sinistra della barra di ricerca.

2 Scegliere Manage Search Engines (Gestisci motori di ricerca) dal menu.

3 Fare clic su Rimuovi per eliminare una voce, oppure su Move Up/Down (Sposta
su/giù) per cambiare l'ordine.
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Per aggiungere un motore di ricerca, fare clic suGet more search engines (Scarica
altri motori di ricerca). In Firefox verrà visualizzata una pagina Web con i plug-
in disponibili. È possibile scegliere tra Wikipedia, IMDB e altri ancora. Fare clic
su un collegamento di un plug-in e scegliere Aggiungi per installarlo.

15.2.2 Ricerca nella pagina corrente
Per eseguire la ricerca all'interno di una pagina Web, fare clic su Edit (Modifica) > Find
in This Page (Trova in questa pagina) oppure premere Ctrl + F. Verrà aperta la barra
di ricerca nella pagina. In genere, viene visualizzata nella parte inferiore di una finestra.
Digitare la richiesta nel campo di immissione. Verranno individuate le prime occorrenze
di questa frase. Per trovare altre occorrenze della frase, premere F3 oppure fare clic su
Successivo nella barra di ricerca. Per evidenziare tutte le occorrenze, premere il pulsante
Evidenzia tutte. Se si seleziona Match case (Maiuscole/minuscole), nell'interrogazione
verrà attivata la distinzione tra maiuscole e minuscole.

15.3 Gestione dei segnalibri
I segnalibri forniscono una modalità di accesso pratica ai siti Web preferiti. Per
aggiungere il sito Web corrente all'elenco dei segnalibri, fare clic su Bookmarks
(Segnalibri) > Bookmark this page (Aggiungi pagina a Preferiti). Se nel browser sono
attualmente visualizzati più siti Web nelle schede, nell'elenco dei segnalibri viene
aggiunto solo l'URL della scheda attualmente selezionata.

Quando si aggiunge un segnalibro è possibile specificare un nome alternativo per
individuarlo e selezionare la cartella in cui memorizzarlo. Se si desidera aggiungere ai
segnalibri siti Web presenti in più schede, selezionare Crea un segnalibro con tutte le
schede. Verrà creata una nuova cartella in Firefox che comprende i segnalibri di ciascun
sito visualizzato in ogni singola scheda. Per eliminare un sito Web dall'elenco dei
segnalibri, fare clic su Segnalibri, individuare il segnalibro nell'elenco, quindi fare clic
con il pulsante destro del mouse e selezionare Elimina.
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15.3.1 Utilizzo di Bookmark Manager
(Gestore segnalibri)

È possibile utilizzare lo strumento di gestione dei segnalibri per gestire le proprietà
(nome e destinazione) di ciascun segnalibro nonché per organizzarli in cartelle e sezioni.
Tale strumento ha l'aspetto seguente Figura 15.2, "Utilizzo di Gestione segnalibri di
Firefox" (p. 239).

Figura 15.2 Utilizzo di Gestione segnalibri di Firefox

Per aprire il gestore dei segnalibri, fare clic su Bookmark (Segnalibro) > Organize
bookmark (Organizza segnalibri). Verrà visualizzata una finestra contenente i segnalibri.
Selezionare Nuova cartella per creare una nuova cartella con nome e descrizione. Per
creare un nuovo segnalibro, fare clic suNuovo segnalibro. In questo modo sarà possibile
inserire nome, indirizzo, parola chiave e descrizione. La parola chiave corrisponde a
una scorciatoia al segnalibro che è possibile digitare nella barra di navigazione al posto
dell'URL completo. Se fosse necessario visualizzare il nuovo segnalibro nella barra
laterale, selezionare Carica questo segnalibro nella barra laterale.
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15.3.2 Importazione di segnalibri da altri
browser

Se in passato si utilizzava un altro browser, potrebbe essere opportuno importare i
vecchi segnalibri anche in Firefox. Firefox consente infatti di importare i segnalibri da
altri browser installati nel sistema, quali Netscape o Opera. È inoltre possibile importare
i segnalibri da un file esportato da un browser in un altro computer.

Per importare le impostazioni, fare clic su File > Import (Importa). Selezionare il
browser dal quale importare le impostazioni. Dopo aver fatto clic su Avanti, le
impostazioni verranno importate. I segnalibri importati si trovano in una nuova cartella,
il cui nome inizia con Da.

15.3.3 Segnalibri Live
I segnalibri Live visualizzano i titoli nel menu dei segnalibri e consentono di essere
aggiornati con le ultime notizie. In questo modo è possibile risparmiare tempo con un
rapido sguardo ai siti preferiti.

Questo formato è supportato da molti siti e blog. Un sito Web indica questa possibilità
inserendo un'icona arancione nella parte destra della barra di posizione. Fare clic
sull'icona e scegliere Subscribe now (Sottoscrivi) nella pagina che viene visualizzata.
Verrà visualizzata una finestra di dialogo in cui è possibile selezionare il nome e il
percorso del segnalibro attivo. Confermare con Aggiungi. Da questa pagina è possibile
scegliere applicazioni alternative a cui a effettuare la sottoscrizione, ad esempioBloglines
o My Yahoo. Per aggiungere manualmente un segnalibro attivo, è necessario l'URL del
feed. Procedere come segue:

Procedura 15.1 Aggiunta manuale di un segnalibro attivo

1 Aprire il programma di gestione dei segnalibri mediante Segnalibri > Organize
Bookmarks (Organizza segnalibri).

2 Selezionare File > New Live Bookmark (Nuovo segnalibro attivo).

3 Immettere un nome per il segnalibro attivo e quindi l'URL in Feed Location
(Ubicazione feed), ad esempio http://www.novell.com/newsfeeds/
rss/coolsolutions.xml. Firefox mantiene aggiornati i segnalibri Live.
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4 Chiudere Gestione segnalibri.

15.3.4 Barra degli strumenti di Segnalibri
La barra degli strumenti di Segnalibri viene visualizzata sotto alla
barra di navigazione e consente di accedere velocemente ai segnalibri. È anche possibile
aggiungere, organizzare e modificare i segnalibri direttamente. Per default la barra
degli strumenti di Segnalibri include un gruppo predefinito di segnalibri
organizzati in diverse cartelle (vedere Figura 15.1, "Finestra del browser Firefox"
(p. 236)).

Per gestire la barra degli strumenti di Segnalibri è possibile utilizzare
il programma di gestione dei segnalibri come descritto in Sezione 15.3.1, "Utilizzo di
Bookmark Manager (Gestore segnalibri)" (p. 239). Il relativo contenuto è disponibile
nella Bookmarks Toolbar Folder (Cartella Barra degli strumenti Segnalibri). È anche
possibile gestire direttamente la barra degli strumenti. Per aggiungere una cartella, un
segnalibro o un separatore, fare clic con il pulsante destro del mouse su uno spazio
vuoto nella barra degli strumenti, quindi scegliere la voce appropriata dal menu popup.
Per aggiungere la pagina attuale alla barra, utilizzare la funzione di trascinamento: fare
clic sull'icona della pagina Web nella barra di navigazione e trascinarla nella posizione
desiderata sulla barra degli strumenti dei segnalibri tenendo premuto il pulsante del
mouse. Quando si passa il puntatore del mouse per un breve periodo sopra a una cartella
di segnalibri esistente, questa viene aperta automaticamente per consentire di inserirvi
il segnalibro all'interno.

Per gestire una cartella o un segnalibro particolare, fare clic con il pulsante destro del
mouse su di esso. Verrà visualizzato un menu popup da cui è possibile selezionare
Delete (Cancella) per eliminare l'elemento oppureProprietà per modificarne le proprietà.
Per spostare o copiare una voce, selezionare Taglia o Copia e Incolla.

15.4 Utilizzo di Gestione download
Tenere traccia dei download attuali e precedenti con l'aiuto del download manager.
Viene aperta automaticamente ogni volta che si scarica un file. Per avviare manualmente
il download manager, fare clic su Strumenti > Download. Quando si scarica un file
viene visualizzata una barra di stato che indica l'avanzamento del download. Se
necessario, sospendere il download e ripristinarlo in seguito. Per aprire un file scaricato,
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fare clic su Open (Apri), per rimuoverlo, fare clic su Rimuovi. Per informazioni sul
file, fare clic con il pulsante destro del mouse sul nome e scegliere Proprietà.

NOTA

Se si rimuove un file dal download manager, verrà rimossa solo la voce
dell'elenco ma il file rimarrà sul disco rigido.

Per default tutti i file vengono scaricati sul desktop. Per cambiare questo comportamento,
aprire la finestra di configurazione del download manager selezionando Modifica >
Preferenze e aprire la schedaMain (Principale). Nell'areaDownload selezionare un'altra
ubicazione di default oppure scegliere Always ask me where to save files (Chiedi sempre
percorso di salvataggio dei file).

15.5 Gestione password
Ogni volta che si immettono un nome utente e una password in un sito Web, Firefox
consente di memorizzare questi dati. Se si accetta facendo clic su Remember
(Memorizza), la password verrà memorizzata sul disco rigido in formato cifrato. La
prossima volta che si accede al sito in questione, verranno automaticamente inseriti i
dati di login.

Per controllare o gestire le password, aprire il Gestore di password facendo clic su
Modifica > Preferenze > Sicurezza >Mostra le password.... Verrà visualizzato il Gestore
di password con un elenco dei siti e dei relativi nomi utente. Per default le password
non vengono visualizzate, fare clic suMostra le password per visualizzarle. Per eliminare
una o più voci dall'elenco, utilizzare Rimuovi o Remove All (Rimuovi tutto)
rispettivamente.

Se si utilizza il Gestore portachiavi di GNOME o il Portafogli di KDE per memorizzare
la altre password, SUSE Linux Enterprise consente di gestirle insieme al Gestore di
password di Firefox via CASA (Common Authentication Service Adapter). Informazioni
sull'utilizzo e la configurazione di CASA in Guida per l'utente di GNOME oppure
Guida per l'utente KDE.
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15.6 Personalizzazione di Firefox
Firefox offre numerose opportunità di personalizzazione. Consente infatti di installare
estensioni, modificare i temi e aggiungere parole chiave intelligenti per le ricerche in
linea.

15.6.1 Extensions (Estensioni)
Le estensioni consentono di personalizzare Firefox esattamente in base alle proprie
esigenze. Con le estensioni è possibile modificare l'aspetto di Firefox, migliorare le
funzionalità esistenti, (ad esempio il download manager o l'esplorazione a schede)
oppure aggiungere funzioni quali l'editor dei log Web, il supporto per Bit Torrent e
anche un lettore musicale. Alcune estensioni sono di supporto per gli sviluppatori Web
mentre altre aumentano la sicurezza mediante il blocco dinamico dei contenuti attivi.
Sono disponibili più di 1000 estensioni per Firefox. Il gestore dei componenti aggiuntivi
consente di installare nuove estensioni e di disabilitarle, abilitarle o eliminarle. Consente
inoltre di individuare gli aggiornamenti per le estensioni installate.

Per aggiungere un'estensione, avviare il gestore dei componenti aggiuntivi mediante
Strumenti > Add-ons (Componenti aggiuntivi). Fare clic sulla scheda Estensione Get
Extensions (Scarica estensioni) nell'angolo in basso a destra pe aprire la pagina Web
delle estensioni Firefox in cui è possibile sfogliare le estensioni per categoria. È anche
possibile visitare direttamente http://addons.mozilla.org/. Per installare
un'estensione, fare clic sul collegamento Install Now (Installa ora) nella pagina in cui
viene descritta l'estensione. Per attivare l'estensione, è necessario riavviare Firefox.
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Figura 15.3 Installazione delle estensioni di Firefox

Per disabilitare o attivare un'estensione disabilitata temporaneamente, fare clic su
un'estensione nel gestore dei componenti aggiuntivi, quindi scegliereDisabilita oAbilita.
Per rimuovere definitivamente un'estensione, utilizzare Cancella. Per rendere effettive
le modifiche, è sempre necessario riavviare Firefox.

15.6.2 Modifica dei temi
Se si desidera modificare l'aspetto standard di Firefox, installare un nuovo tema. I temi
non modificano la funzionalità, ma solo l'aspetto del browser. L'installazione di un tema
è molto simile all'installazione di un'estensione. Avviare il gestore dei componenti
aggiuntivi come descritto nella Sezione 15.6.1, "Extensions (Estensioni)" (p. 243), quindi
fare clic sulla scheda Temi. Aprire la pagina Web dei temi facendo clic su Get Themes
(Scarica temi) nell'angolo in basso a destra. Procedere come descritto nella
Sezione 15.6.1, "Extensions (Estensioni)" (p. 243).

244 Guida per l'utente KDE



Figura 15.4 Installazione dei temi di Firefox

È sempre possibile passare da un tema installato a un altro facendo clic su Strumenti >
Add-ons (Componenti aggiuntivi) > Temi e quindi suUse Theme (Usa tema). Per rendere
effettive le modifiche, è sempre necessario riavviare Firefox. Se un tema non è più
utilizzato, sarà possibile eliminarlo nella stessa finestra di dialogo selezionando
Disinstalla.

15.6.3 Aggiunta di parole chiave intelligenti
alle ricerche in linea

La ricerca su Internet è uno dei compiti principali svolti da un browser. Firefox consente
di definire le parole chiave intelligenti: abbreviazioni da utilizzare come scorciatoia
URL per la ricerca di un particolare sito Web. Se ad esempio si effettuano spesso
ricerche in Wikipedia, è possibile assegnare una parola chiave intelligente a questa
ricerca per semplificare l'operazione:

1 Accedere ad http://en.wikipedia.org.

2 Dopo la visualizzazione della pagina Web in Firefox, fare clic con il pulsante
destro del mouse sul campo di ricerca nella pagina Web di Wikipedia, quindi
scegliere Add a Keyword for this Search (Aggiungi una parola chiave per questa
ricerca) dal menu che viene visualizzato.
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3 Verrà visualizzata la finestra di dialogo Aggiungi segnalibro. Nel campo Nome,
immettere un nome per la parola chiave intelligente, ad esempio Wikipedia (it).

4 Immettere la Parola chiave della ricerca, ad esempio ws.

5 MedianteCreate in (Crea in) scegliere l'ubicazione in cui salvare la parola chiave
intelligente nei segnalibri.

6 Finalizzare con Aggiungi.

Si è generata così una nuova parola chiave. Quando si desidera effettuare una ricerca
in Wikipedia, è possibile digitarews TERMINEDIRICERCA nella barra di navigazione.

15.6.4 Disabilitazione di funzioni
In casi di utilizzi speciali, ad esempio quando si utilizza SUSE Linux Enterprise come
terminale Internet, è consigliabile disabilitare (bloccare) alcune funzioni, ad esempio
il salvataggio o la stampa di una pagina, la visualizzazione dell'origine di una pagina
o la disabilitazione della cache. A questo scopo, è possibile utilizzare il sistema GConf.
Per informazioni dettagliate, consultare il capitolo Configurazione di GNOME per gli
amministratori in Guida per l'utente di GNOME.

15.7 Stampa da Firefox
Prima di stampare effettivamente una pagina Web, è possibile utilizzare la funzione di
anteprima di stampa per controllare l'aspetto della pagina stampata. A questo scopo,
selezionare File > Anteprima di stampa. Personalizzare l'output di stampa mediante
File > Impostazione pagina. Specificare l'orientamento e il fattore di proporzione della
pagina in Format & Options (Formato e opzioni). In questa sezione è anche possibile
scegliere se stampare lo sfondo. Per regolare i margini di una pagina e personalizzarne
l'intestazione e i piè di pagina, selezionare Margins & Header/Footer (Margini e
Intestazione/Piè di pagina).

Per stampare una pagina Web, selezionareFile > Stampa o premere Ctrl + P. Selezionare
la Stampante e modificarne le Proprietà. Oltre all'intervallo di stampa e al numero di
copie da stampare, è possibile specificare la modalità di stampa di una pagina Web con
frame.
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15.8 Apertura di archivi MHTML
Microsoft* Word, Internet Explorer e Opera consentono di salvare una pagina Web
come singolo file MHTML, denominato archivio Web. Un archivio di questo tipo
include tutte le risorse necessarie per la visualizzazione di una pagina Web in un unico
file che è possibile visualizzare offline. Per default gli archivi MHTML non sono
supportati da Firefox. Il pacchetto mhtml-firefox installa l'estensione Firefox
MHTML Archive Reader per tutti gli utenti e assegna inoltre gli archivi MHTML
(che terminano in .mht o .mhtml) a Firefox nella shell del desktop.

15.9 Ulteriori informazioni
È possibile ottenere ulteriori informazioni su Firefox per mezzo della home page ufficiale
all'indirizzo http://www.mozilla.com/firefox/. Per ulteriori informazioni
su determinate opzioni o funzioni, consultare la guida integrata. Per aprirla, premere
F1.
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16Trasferimento di dati da
Internet
KGet è il gestore scaricamenti di KDE. Oltre a gestire i trasferimenti nelle finestre,
consente di arrestare, riprendere, cancellare, accodare trasferimenti e aggiungerne di
nuovi. Per avviare KGet, utilizzare il menu principale oppure premere il tasto Alt + F2
e immettere kget.

Quando si avvia KGet per la prima volta, è possibile scegliere di integrarlo in Konqueror.
Se si esegue questa operazione, KGet viene aggiunto alla barra delle applicazioni sotto
forma di icona con una freccia rivolta verso il basso. Per visualizzare i trasferimenti
KGet, fare clic su questa freccia.

Figura 16.1 KGet
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16.1 Aggiunta di trasferimenti
all'elenco

Per aggiungere un trasferimento, fare clic su File > Incolla. Specificare un URL, quindi
fare clic su OK. Infine, selezionare la posizione in cui si desidera salvare il file scaricato.
La voce relativa al trasferimento viene aggiunta alla finestra principale di KGet e il
download viene avviato. Un metodo alternativo per aggiungere un trasferimento consiste
semplicemente nel selezionare un file (ad esempio, di un server FTP) in Konqueror e
trascinarlo e rilasciarlo nella finestra principale di KGet.

SUGGERIMENTO: utilizzo della funzione Destinazione

Per aggiungere occasionalmente trasferimenti all'elenco senza dover uscire
ogni volta dalla finestra KGet sul desktop, selezionare Impostazioni > Mostra
destinazione e ridurre a icona la finestra di KGet. È ora possibile trascinare e
rilasciare i trasferimenti sulla freccia blu visualizzata.

Per modificare le preferenze relative ai download, fare clic su Impostazioni > Configura
KGet.

16.2 Aggiunta di trasferimenti da un
file

Se si desidera scaricare più file da numerose ubicazioni diverse, è possibile raggruppare
i collegamenti agli scaricamenti in un unico file di testo da importare in KGet. Questa
è una funzionalità molto pratica poiché per trasferire l'elenco non è necessario aggiungere
ogni URL separatamente. KGet supporta l'analisi sintattica degli URL nel file di testo
purché questi inizino in corrispondenza del margine sinistro del file. Per utilizzare
questa funzione, selezionare File > Import Text File... (Importa file di testo...). Per ogni
URL è necessario specificare un'ubicazione in cui salvare il file scaricato. Al termine,
verrà avviato il download.
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16.3 Trasferimenti controllati tramite
timer

È possibile configurare KGet per eseguire i trasferimenti a un'ora specifica.

1 Avviare KGet.

2 Fare clic su Opzioni > Modalità offline. Tutti i trasferimenti inseriti in seguito
non verranno avviati immediatamente ma saranno messi in coda.

3 Per avviare l'orologio, fare doppio clic sulla relativa voce e selezionare Avanzate.

4 Indicare il giorno, il mese, l'anno e l'ora in cui deve avvenire l'avvio del
trasferimento, fare clic sull'icona Timer e chiudere la finestra di dialogo.

5 Dopo aver inserito le impostazioni desiderate per tutti i trasferimenti, impostare
nuovamente KGet in modalità online facendo clic su Opzioni > Modalità offline.

I trasferimenti verranno avviati alle date specificate.

SUGGERIMENTO: esportazione di elenchi di trasferimento

Se all'elenco di trasferimento file sono stati aggiunti numerosi scaricamenti ed
è necessario utilizzare l'elenco in questione su un altro computer, selezionare
Opzioni > Modalità offline. Selezionare le voci dall'elenco che si desidera
esportare, quindi scegliere File > Export Transfer List (Esporta elenco di
trasferimento). Le voci verranno salvate in un file *.kgt che è possibile
importare da un altro computer.
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17Lettura di news con Akregator
Gli utenti che desiderano mantenersi aggiornati con le notizie possono utilizzare un
lettore di fonti di notizie. Akregator è un programma di questo tipo. Consente infatti di
collegarsi a un server contenente un ticker per notizie, scaricarlo e visualizzare i titoli
e talvolta un breve testo riassuntivo. Vedere la Figura 17.1, "Visualizzazione di notizie
con Akregator" (p. 253). Se si è interessati alla notizia, fare clic su di essa e visualizzarla
in una scheda separata.

Figura 17.1 Visualizzazione di notizie con Akregator

Akregator contiene alcune fonti di notizie predefinite per KDE. È possibile aggiungere
manualmente fonti di notizie o consentire che siano alcuni siti Web ad annunciarle. Ad
esempio, un sito Web indica il supporto per fonti mostrando nell'angolo inferiore destro
un rettangolo arancione. Fare clic su di esso per aprire un menu a comparsa dove sarà
possibile selezionare Add Feed to Akregator (Aggiungi fonte ad Akregator). Talvolta
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un sito Web non indica che sono supportate le fonti di notizie. È quindi possibile eseguire
una ricerca sul sito utilizzando parole chiave quali feed o rss. Talvolta la ricerca
riesce ed è possibile ottenere un collegamento.

Per aggiungere una fonte di notizie, effettuare le operazioni riportate di seguito.

Procedura 17.1 Aggiunta di una fonte di notizie ad Akregator

1 Determinare l'URL della fonte di notizie. Questo è normalmente reperibile dal
sito preferito per le notizie. Sono disponibili ulteriori collegamenti per mezzo
dello strumento KNewsticker, un'applet per il pannello di KDE.

2 Per avviare Akregator, premere Alt + F2 e immettere il comando akregator.
Verrà aperta una nuova finestra contenente un elenco di tutte le fonti nella propria
configurazione. Se si chiude la finestra, questa verrà agganciata alla barra delle
applicazioni.

3 Creare una nuova cartella per mezzo di Feed > New Folder (Fonte, Nuova
cartella). In questo modo sarà possibile raggruppare le fonti in categorie.

4 Assegnare un nome alla nuova cartella.

5 Fare clic sulla cartella e selezionare Feed > Add Feed (Fonte, Aggiungi fonte).

6 Inserire l'URL della fonte, ad esempio, http://www.novell.com/
newsfeeds/rss/coolsolutions.xml. Verrà visualizzata una nuova
finestra dove sarà possibile modificare il nome della fonte, l'URL o l'intervallo
di aggiornamento. Modificare il periodo di memorizzazione di un articolo per
mezzo della scheda Feed Archive (Archivio delle fonti).

7 Procedere con Ok. Akregator scarica gli articoli più recenti.

Quando tutti i titoli più recenti sono stati scaricati, sarà possibile fare clic su una voce.
In base al tipo fonte selezionata, verrà visualizzato un breve riassunto o semplicemente
un collegamento. Per leggere l'intero articolo, selezionare Complete Story (Storia
completa).

È possibile controllare le nuove notizie manualmente per mezzo di Fetch Feed (Scarica
fonte). Un'altra opzione consiste nello specificare un intervallo di aggiornamento. Questo
può essere configurato facendo clic su Settings > Configure Akregator (Impostazioni,
Configura Akregator). Viene aperta una finestra di dialogo dove è possibile selezionare
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l'intervallo per mezzo di General > Use interval fetching (Generale, Usa download
periodico). Confermare con OK.

Sarà possibile leggere la storia completa in Akregator o in un browser esterno. Facendo
clic su Complete Story (Storia completa) sarà possibile selezionare quale dei due.
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18Manipolazione delle immagini
con The GIMP
The GIMP (il programma di GNU per la manipolazione delle immagini) è
un'applicazione per la creazione e la modifica di immagini raster. Per molti aspetti, le
relative funzioni sono paragonabili a quelle di Adobe Photoshop e altri programmi
commerciali. Consente di ridimensionare e ritoccare fotografie, progettare grafica per
le pagine Web, creare copertine per i CD personalizzati o quasi tutti gli altri progetti di
grafica. È in grado di soddisfare le esigenze di dilettanti e professionisti.

Come molti altri programmi Linux, The GIMP è sviluppato grazie alla collaborazione
di sviluppatori di tutto il mondo che hanno offerto il loro tempo e le loro conoscenze
per il progetto. Poiché il programma è in costante fase di sviluppo, la versione inclusa
nel sistema potrebbe variare leggermente rispetto alla versione descritta qui. Soprattutto
il layout delle singole finestre e sezioni di finestre è l'elemento che potrebbe differire.

The GIMP è un programma estremamente complesso. In questo capitolo vengono
discussi solo alcune funzioni, strumenti e voci di menu. Per suggerimenti su dove trovare
ulteriori informazioni sul programma, vedere la Sezione 18.7, "Ulteriori informazioni"
(p. 277).

18.1 Formati grafici
Sono disponibili due tipi principali di grafica: raster e vettoriale. The GIMP deve essere
utilizzato per le immagini raster, ovvero il formato normale di fotografie e immagini
digitalizzate. La grafica raster è costituita da piccoli blocchi di colore, o pixel, che
insieme creano l'intera immagine. Le dimensioni dei file possono diventare abbastanza
grandi a causa di questo fattore. Non è altrettanto possibile aumentare le dimensioni di
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un'immagine in pixel senza perdere la qualità. The GIMP supporta i più diffusi formati
di immagini raster.

La grafica vettoriale, a differenza di quella raster, non supporta la memorizzazione delle
informazioni di tutti i singoli pixel, ma utilizza primitive geometriche come punti, linee,
curve e poligoni. Le immagini vettoriale possono essere ridimensionte molto facilmente.
Esistono molte applicazioni specializzate per la grafica vettoriale, ad esempio Inkscape.
The GIMP supporta un numero limitato di immagini vettoriali. Può ad esempio aprire
e convertire le immagini vettoriali nel formato SVG oppure utilizzare i percorsi vettoriali.

18.2 Avvio di The GIMP
Avviare The GIMP dal menu principale. In alternativa, immettere gimp & nella riga
di comando.

18.2.1 Configurazione iniziale
Quando si avvia The GIMP per la prima volta, viene aperta una Configurazione guidata
per una configurazione preliminare dell'applicazione. Le impostazioni di default sono
adatte per la maggior parte delle finalità. Fare clic suContinua in ogni finestra di dialogo,
a meno che non si conoscano le impostazioni e si preferisca un'altra configurazione.

18.2.2 Finestre di default
Tre finestre vengono visualizzate per default. Possono essere posizionate sullo schermo
e, ad eccezione dell'area strumenti, chiuse in base alle proprie esigenze. La chiusura
dell'area strumenti determina la chiusura dell'applicazione. Nella configurazione di
default, The GIMP salva il layout della finestra alla chiusura. Le finestre di dialogo
lasciate aperte verranno visualizzate di nuovo al successivo avvio del programma.

Area strumenti
La finestra principale di The GIMP visualizzata in Figura 18.1, "Finestra principale"
(p. 261), include i controlli principali dell'applicazione. La chiusura della finestra
determina la chiusura dell'applicazione. Nella parte in alto, la barra dei menu offre
l'accesso alla Guida, alle estensioni e alle funzioni dei file. Al di sotto, è possibile trovare
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le icone dei diversi strumenti. Posizionare il puntatore del mouse su un'icona per
visualizzare le relative informazioni.

Figura 18.1 Finestra principale

I colori di sfondo e in primo piano attuale vengono mostrati in due caselle sovrapposte.
I colori di default sono nero per il primo piano e bianco per lo sfondo. Fare clic sulla
casella per aprire la finestra di dialogo per la selezione del colore. Cambiare i colori di
sfondo e in primo piano con il simbolo di freccia curva nella parte in altro a destra della
caselle. Utilizzare il simbolo del bianco e del nero nella parte in basso a sinistra per
ripristinare i colori di default.

A destra, vengono mostrati il pennello, il motivo e la sfumatura attuale. Fare clic
sull'elemento visualizzato per accedere alla finestra di selezione. La parte inferiore della
finestra contiene le opzioni di configurazione disponibili per lo strumento corrente.
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Nella casella degli strumenti viene visualizzata una finestra di dialogo con le opzioni
relative allo strumento attualmente selezionato. Se non è visibile, aprirla facendo doppio
clic sull'icona dello strumento nella casella degli strumenti.

Livelli, canali, percorsi e annullamento delle
modifiche
Nella prima sezione, utilizzare la casella di riepilogo a discesa per selezionare l'immagine
a cui si riferiscono le schede. Fare clic suAuto (Automatico) per controllare se l'immagine
attiva viene selezionata automaticamente. Per default l'opzione Auto (Automatico) è
abilitata.

L'opzione Livelli mostra i differenti livelli delle immagini attuali e può essere utilizzata
per manipolarli. Le informazioni sono disponibili nella Sezione 18.5.6, "Livelli" (p. 274)
L'opzione Canali mostra i canali dei colori dell'immagine e consente di manipolarli.

I percorsi sono un metodo basato su vettori per la selezione delle parti di un'immagine.
Possono essere anche utilizzati per il disegno. L'opzione Percorsi mostra i percorsi
disponibili per un'immagine e fornisce l'accesso alle funzioni dei percorsi. L'opzione
Annulla mostra una cronologia limitata di modifiche apportate all'immagine attuale.
descritto nella Sezione 18.5.5, "Annullamento delle modifiche" (p. 274).

18.3 Operazioni preliminari
Benché The GIMP possa risultare un po' complicato per i nuovi utenti, diventerà molto
più semplice da utilizzare dopo aver acquisito alcune nozioni di base. Le funzioni di
base di GIMP sono la creazione, l'apertura e il salvataggio di immagini.

18.3.1 Creazione di una nuova immagine
Per creare una nuova immagine, selezionare File > New (Nuovo) o premere Ctrl + N.
Viene aperta una finestra di dialogo in cui definire le impostazioni per la nuova
immagine. Se lo si desidera, selezionare un'impostazione predefinita denominata
Template (Modello). Per creare un modello personalizzato, selezionare File > Dialogs
(Finestre di dialogo) > Templates (Modelli) e utilizzare i controlli disponibili nella
finestra che viene visualizzata.
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Nella sezione Dimensione immagine, impostare la dimensione dell'immagine da creare
in pixel o un'altra unità. Fare clic sull'unità per selezionare un'altra unità dall'elenco di
unità disponibili. Il rapporto tra i pixel e un'unità viene specificato come Risoluzione,
la quale viene visualizzata all'apertura della sezione Opzioni avanzate. Una risoluzione
di 72 pixel per pollice corrisponde a una visualizzazione su schermo comune. È
sufficiente per la grafica di pagine Web. Si deve utilizzare una risoluzione superiore
per le immagini da stampare. Per la maggior parte delle stampanti, una risoluzione di
300 pixel per pollice produce una qualità accettabile.

In Colorspace (Colorspace), scegliere se si desidera ottenere l'immagine a colori (RGB)
o in gradazioni di grigio (Grayscale). Per ulteriori informazioni sui tipi di immagini,
vedere le Sezione 18.5.7, "Modalità per le immagini" (p. 275). In Fill With (Riempi)
selezionare il colore di riempimento dell'immagine. È possibile scegliere Foreground
Color (Colore in primo piano) e Colore di sfondo nella casella degli strumenti, White
(Bianco) o Trasparenza per un'immagine trasparente. L'effetto di trasparenza è
rappresentato da una schema di scacchiera grigio. Immettere un commento per la nuova
immagine in Comment (Commento).

Se le impostazioni soddisfano le proprie esigenze, fare clic su OK. Per ripristinare le
impostazioni di default, fare clic su Reimposta. Per interrompere la creazione di una
nuova immagine, fare clic su Annulla.

18.3.2 Apertura di un'immagine esistente
Per aprire un'immagine esistente, selezionare File > Apri oppure premere Ctrl + O.
Nella finestra di dialogo visualizzata, selezionare il file desiderato. È anche possibile
premere Ctrl + L e digitare direttamente il percorso dell'immagine desiderata. Quindi
fare clic su Apri per aprire l'immagine selezionata. Scegliere Cancel (Annulla) per
ignorare l'apertura di un'immagine.

18.3.3 Scansione di un'immagine
Anziché aprire un'immagine esistente o crearne una nuova, è possibile sottoporre
un'immagine a scansione. Per effettuare la scansione direttamente in The GIMP,
assicurarsi che il pacchetto xsane sia installato. Per aprire la finestra di dialogo di
scansione, selezionare File > Acquire (Acquisisci) > XSane: Device dialog (Finestra
di dialogo XSane: Dispositivo).
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Creare un'anteprima quando l'oggetto di cui eseguire la scansione è più piccolo dell'area
di scansione totale. Selezionare Acquire preview (Anteprima di acquisizione) nella
finestra di dialogo Preview (Anteprima) per creare un'anteprima. Per sottoporre a
scansione solo una parte dell'area, selezionare con il mouse la parte di rettangolo
desiderata.

Nella finestra di dialogo xsane scegliere se effettuare la scansione di un'immagine
binaria (bianco e nero senza ombreggiature), in scala di grigi o a colori e quindi la
risoluzione di scansione desiderata. Quanto maggiore è la risoluzione selezionata, tanto
migliore è la qualità dell'immagine digitalizzata. Tuttavia, una risoluzione elevata
comporta l'aumento delle dimensioni del file e rallenta il processo di scansione. La
dimensione dell'immagine finale, sia in pixel che in byte, viene visualizzata nella parte
inferiore della finestra di dialogo.

Utilizzare i dispositivi di scorrimento presenti nella finestra di dialogo xsane per
impostare i valori di gamma, luminosità e contrasto desiderati. Questi dispositivi di
scorrimento non sono disponibili in modalità binaria. Le modifiche apportate risultano
immediatamente visibili nell'anteprima. Una volta definite tutte le impostazioni, fare
clic su Scan (Acquisisci) per eseguire la scansione dell'immagine.

18.3.4 Finestra dell'immagine
L'immagine nuova, aperta in precedenza o sottoposta a scansione viene visualizzata
nella relativa finestra. La barra dei menu nella parte superiore della finestra fornisce
l'accesso a tutte le funzioni delle immagini. In alternativa, accedere al menu facendo
clic con il pulsante destro del mouse sull'immagine oppure facendo clic sul piccolo
pulsante freccia nell'angolo sinistro dei righelli.

In File sono disponibili le opzioni standard del menu File, ad esempio Save (Salva) e
Print (Stampa). Chiudi consente di chiudere l'immagine dialogo. Esci consente di
chiudere l'intera applicazione.

Le voci nel menu View (Visualizza) consentono di controllare la visualizzazione
dell'immagine e della relativa finestra. New View (Nuova visualizzazione) consente di
aprire una seconda finestra in cui viene visualizzata l'immagine corrente. Le modifiche
apportate in una vista vengono applicate a tutte le altre viste di quell'immagine. Viste
alternative sono utili per l'ingrandimento di una parte di un'immagine per la
manipolazione durante la visualizzazione dell'immagine completa in un'altra vista.
Regolare il livello di ingrandimento della finestra attuale con Zoom. Quando si seleziona
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Giusto sulla finestra, la finestra dell'immagine viene ridimensionata in modo da adattarsi
esattamente alla visualizzazione dell'immagine attuale.

18.4 Salvataggio delle immagini
La funzione più importante èFile > Salva. Si consiglia di salvare molto spesso. Scegliere
File (File) > Save as (Salva con nome) per salvare le immagini con un nuovo nome di
file. Si consiglia di salvare stadi di immagini con nomi differenti o eseguire backup in
un'altra directory in modo da poter ripristinare facilmente uno stato precedente.

Durante il primo salvataggio o l'utilizzo di Save As (Salva con nome) viene visualizzata
una finestra di dialogo in cui è possibile specificare il nome e il tipo di file. Immettere
il nome del file nel campo situato nella parte superiore. Nel caso di Save in folder (Salva
in cartella) scegliere la directory di salvataggio del file da un elenco delle directory
utilizzate più di frequente. Per utilizzare un'altra directory o crearne una nuova, aprire
Browse for other folders (Cerca altre cartelle). È consigliabile lasciare l'opzione Select
File Type Seleziona tipo di file) impostata su By Extension (Per estensione), per
consentire a The GIMP di determinare il tipo di file in base all'estensione aggiunta al
nome del file. I seguenti tipi di file sono utilizzati di frequente:

XCF
È il formato nativo dell'applicazione. Consente di salvare tutte le informazioni sui
percorsi e sui livelli insieme all'immagine stessa. Anche se è necessaria un'immagine
in un altro formato, si consiglia in genere di salvare una copia in formato XCF per
semplificare le future modifiche. Per informazioni sui livelli, vedere la
Sezione 18.5.6, "Livelli" (p. 274).

PAT
È il formato utilizzato per gli schemi The GIMP. Se si salva un'immagine in questo
formato, sarà possibile utilizzarla come un motivo di riempimento in The GIMP.

JPEG
JPG o JPEG è un formato comune per fotografie e per la grafica di pagine Web
senza la trasparenza. Il relativo metodo di compressione consente la riduzione delle
dimensioni dei file, ma comporta anche la perdita di informazioni durante la
compressione. Si consiglia di utilizzare l'opzione di anteprima durante la regolazione
del livello di compressione. I livelli compresi tra 85% e 75% spesso determinano
una qualità dell'immagine accettabile con una compressione ragionevole. Si consiglia
anche di salvare un backup in un formato che non comporti perdita di dati, ad
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esempio XCF. Se si modifica un'immagine, salvare solo l'immagine completata in
formato JPG. Se si carica ripetutamente un file JPG e si salva, la qualità
dell'immagine risulterà scarsa.

GIF
Sebbene molto conosciuto in passato per la grafica con effetti di trasparenza, tale
formato è oggi meno utilizzato per problemi di licenza. Il formato GIF viene
utilizzato anche per immagini animate. Il formato supporta il salvataggio di
immagini solo indicizzate. Per ulteriori informazioni sulle immagini indicizzate,
vedere la Sezione 18.5.7, "Modalità per le immagini" (p. 275). Le dimensioni del
file possono spesso risultare piccole solo se si utilizzano pochi colori.

PNG
Con il supporto per la trasparenza, la compressione senza perdita di dati, la
disponibilità gratuita e il crescente supporto da parte dei browser, tale formato sta
sostituendo il formato GIF nella grafica di pagine Web con effetti di trasparenza.
Tra gli altri vantaggi, il formato PNG offre una trasparenza parziale, non disponibile
con il formato GIF. Ciò consente di eseguire transizioni più uniformi dalle aree
colorate a quelle trasparenti (antialias).

Per salvare l'immagine nel formato selezionato, premere Save (Salva. Per interrompere
l'operazione, scegliere Cancel (Annulla). Se l'immagine presenta caratteristiche che
non possono essere salvate nel formato scelto, viene visualizzata una finestra di dialogo
con le opzioni per la risoluzione del problema. Se si sceglie Esporta, se disponibile, in
genere vengono forniti i risultati desiderati. Viene aperta una finestra con le opzioni
del formato. Vengono forniti i valori di default appropriati.

18.5 Modifica di immagini
In The GIMP sono disponibili numerosi strumenti per la modifica delle immagini. Le
funzioni descritte di seguito sono destinate agli utenti privati

18.5.1 Modifica delle dimensioni
dell'immagine

Dopo aver digitalizzato un'immagine o aver caricato una fotografia digitale dalla
fotocamera, è spesso necessario modificare le dimensioni di visualizzazione in una
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pagina Web per la stampa. Le immagini possono essere facilmente ridotte in scala o
ritagliandone le parti. L'ingrandimento di un'immagine richiede una procedura più
complessa. A causa della natura della grafica raster, la qualità dell'immagine diminuisce
quando questa viene ingrandita. Si consiglia di conservare una copia dell'immagine
originale prima di ridurla in scala o di ritagliarla.

Ritaglio di un'immagine
Il ritaglio di un'immagine è simile al taglio dei bordi di un pezzo di carta. Selezionare
lo strumento di ritaglio dall'area strumenti (simile a un bisturi) o con Strumenti >
Strumenti trasformazione > Ritaglia e ridimensiona. Fare clic sull'angolo di avvio e
trascinare fino a delimitare l'area da mantenere.

Viene aperta una piccola finestra con le informazioni sul punto di avvio e le dimensioni
dell'area selezionata. Regolare questi valori facendo clic e trascinando un angolo della
casella di ritaglio oppure modificandoli nella finestra. From Selection (Da selezione)
consente di modificare il ritaglio per adattarlo alla selezione corrente (le selezioni sono
descritte in Sezione 18.5.2, "Selezione di parti delle immagini" (p. 268)). L'opzione
Riduzione automatica consente di eseguire un ritaglio più piccolo in base ai cambiamenti
di colore nell'immagine.

Fare clic su Cancella per interrompere il ritaglio. Fare clic su Ritaglia per ritagliare
l'immagine. I risultati ottenuti conResize (Ridimensiona) sono identici a quelli diChange
canvas Size (Modifica dimensioni tela), descritta in Sezione "Modifica delle dimensioni
dell'area da disegno" (p. 268).

Scala di un'immagine
Selezionare Immagine > Scala immagine per modificare le dimensioni totali di
un'immagine. Selezionare le nuove dimensioni specificando Larghezza o Altezza. Per
modificare le proporzioni dell'immagine durante il ridimensionamento (deformandola),
fare clic sull'icona a forma di catena a destra dei campi per interrompere il collegamento.
Quando questi campi sono collegati, alla modifica di un valore in uno di questi tutti gli
altri campi cambiano in maniera proporzionale Modificare la risoluzione utilizzando
X resolution (Risoluzione X) e Y resolution (Risoluzione Y).

Interpolazione è un'opzione per utenti esperti che controlla il metodo di scala. Dopo
aver terminato la regolazione delle dimensioni, fare clic su Scale (Scala) per scalare
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l'immagine. L'opzione Reimposta consente di ripristinare i valori originali. L'opzione
Cancella consente di interrompere la procedura.

Modifica delle dimensioni dell'area da disegno
La modifica delle dimensioni dell'area da disegno è simile all'inserimento di uno sfondo
intorno a un'immagine. Anche se lo sfondo è più piccolo, il resto dell'immagine è
presente, ma è possibile visualizzarne solo una parte. Se lo sfondo è più grande, viene
visualizzata l'immagine originale con spazio in eccesso intorno ad essa. Per effettuare
questa operazione, selezionare Immagine > Dimensione superficie.

Nella finestra di dialogo aperta, immettere le nuove dimensioni. Per default, la larghezza
e l'altezza mantengono le stesse proporzioni dell'immagine attuale. Per modificarle,
fare clic sull'icona a forma di catena.

Dopo aver regolato le dimensioni, determinare il modo in cui l'immagine esistente deve
essere posizionata in base alle nuove dimensioni. Utilizzare i valori di spostamento o
trascinare la casella all'interno del riquadro nella parte inferiore. Se si è soddisfatti delle
modifiche, fare clic su Resize (Ridimensiona) per modificare le dimensioni della
superficie. Fare clic su Reimposta per ripristinare i valori originali oppure su Cancella
per annullare le dimensioni dell'area di disegno.

18.5.2 Selezione di parti delle immagini
È spesso utile eseguire un'operazione solo su una parte di un'immagine. Per effettuare
questa operazione, si deve selezionare la parte dell'immagine da modificare. Le aree
possono essere selezionate utilizzando gli strumenti di selezione disponibili nell'area
strumenti, la maschera veloce oppure combinando differenti opzioni. È possibile
modificare le selezioni anche con gli elementi sotto Seleziona. La selezione viene
delimitata con una riga tratteggiata, denominata cornice tratteggiata.

Utilizzo degli strumenti di selezione
I principali strumenti di selezione sono piuttosto facili da utilizzare. Lo strumento del
percorso, che può anche essere utilizzato per altre operazioni oltre alla selezione, è più
complicato è non viene pertanto descritto nella presente documentazione. Nelle opzioni
dello strumento relative agli altri strumenti di selezione, utilizzare una delle icone nella
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riga Mode (Modalità) per definire se sostituire, aggiungere, eliminare o intersecare la
selezione con una esistente.

Selezione rettangolo
Questo strumento può essere utilizzato per selezionare aree rettangolari o quadrate.
Nelle opzioni degli strumenti, selezionare tra Selezione libera, Dimensioni fisse) e
Rapporto di visualizzazione fisso) per controllare la forma e le dimensioni della
selezione. Per effettuare una selezione quadrata in modalità selezione libera, tenere
premuto Maiusc e contemporaneamente selezionare una regione.

Selezione ellissi
Utilizzare questo strumento per selezionare aree ellittiche o circolari. Sono
disponibili le stesse opzioni della selezione rettangolare. Tenere premuto Maiusc
durante la selezione per ottenere un cerchio.

Selezione libera (Lazo)
Disegnare un'area di selezione a mano libera con questo strumento trascinando il
mouse sull'immagine tenendo premuto il pulsante sinistro del mouse. I punti finali
verranno collegati con una linea retta quando si rilascia lo strumento. L'area
all'interno viene selezionata.

Fuzzy Select (Magic Wand) (Selezione Fuzzy (Bacchetta magica))
Questo strumento consente di selezionare una regione continua in base alle
somiglianze nei colori. Per impostare la differenza massima tra i colori, è possibile
utilizzare Threshold (Soglia) nella finestra di dialogo delle opzioni dello strumento.

By Color Select (Selezione Per colore)
Questo strumento consente di selezionare tutti i pixel inclusi nell'immagine che
presentano lo stesso colore, oppure colori simili rispetto al pixel su cui si è fatto
clic. Per impostare la differenza massima tra i colori, è possibile utilizzare l'opzione
Threshol (Soglia) nella finestra di dialogo delle opzioni dello strumento.

Forbici intelligenti
Fare clic su una serie di punti nell'immagine. Quando si fa clic, i punti vengono
uniti in base alle differenze di colore. Fare clic sul primo punto per chiudere l'area.
Convertirla in una selezione regolare facendo clic su di essa.
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Uso della maschera veloce
La maschera veloce è un metodo di selezione delle parti di un'immagine tramite gli
strumenti di disegno. Per un uso ottimale di questa funzione, effettuare una selezione
approssimativa utilizzando le forbici intelligenti oppure l'opzione a mano libera (lo
strumento di selezione a mano libera). Quindi attivare la maschera veloce facendo clic
sulla piccola icona con la casella tratteggiata nell'angolo in basso a sinistra.

La maschera veloce consente di visualizzare la selezione utilizzando un overlay di
rosso. La aree ombreggiate di rosso non vengono selezionate. Le aree che vengono
visualizzate esattamente come prima dell'attivazione della maschera vengono selezionate.
Per modificare la selezione, utilizzare gli strumenti di pittura. Se si dipinge con il bianco,
vengono selezionati i pixel dipinti. Se si dipinge con il nero, i pixel vengono
deselezionati. Le sfumature di grigio (i colori vengono trattati come sfumature di grigio)
indicano una selezione parziale. La selezione parziale consente di eseguire transizioni
uniformi tra le aree selezionate e quelle deselezionate.

Per utilizzare un colore differente per la visualizzazione della maschera veloce, fare
clic con il pulsante destro del mouse sul pulsante della maschera, quindi selezionare
Configura colore e opacità dal menu. Fare clic sulla casella colorata nella finestra di
dialogo che viene aperta per selezionare un nuovo colore.

Dopo aver utilizzato gli strumenti di pittura per regolare la selezione come desiderato,
convertire la vista della maschera veloce nella vista di selezione normale facendo clic
sull'icona nell'angolo in basso a sinistra della finestra dell'immagine (attualmente viene
visualizzata una casella rossa). La selezione viene di nuovo visualizzata con le cornici
tratteggiate.

18.5.3 Applicazione e rimozione del colore
La maggior parte delle operazioni di modifica delle immagini comporta l'applicazione
o la rimozione del colore. Selezionando una parte dell'immagine, limitare l'area in cui
è possibile applicare o rimuovere il colore. Quando si seleziona uno strumento e si
sposta il cursore su un'immagine, l'aspetto del cursore assume la forma dello strumento
selezionato. Con numerosi strumenti, l'icona dello strumento attuale viene mostrata
insieme alla freccia. Per gli strumenti di pittura, viene mostrato il profilo del pennello
attuale, che consente di visualizzare esattamente l'area dell'immagine da dipingere e le
relative dimensioni.
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Selezione dei colori
Gli strumenti di disegno utilizzano il colore di sfondo. Per selezionarlo, fare clic sulla
casella di visualizzazione del colore di sfondo. Verrà visualizzata una finestra di dialogo
con quattro schede. Queste schede forniscono differenti metodi di selezione del colore.
Di seguito verrà descritta solo la prima scheda visualizzata in Figura 18.2, "Finestra di
dialogo del selettore del colore di base" (p. 271). Il nuovo colore viene mostrato in
Attuale. Il colore precedente viene mostrato in Precedente.

Figura 18.2 Finestra di dialogo del selettore del colore di base

Il metodo più semplice per la selezione di un colore consiste nell'uso delle aree colorate
nella caselle a sinistra. Nella barra verticale stretta, fare clic su un colore simile a quello
desiderato. Nella casella più grande a sinistra vengono mostrate le tonalità disponibili.
Fare clic sul colore desiderato. Viene mostrato in Attuale. Se il colore visualizzato non
è quello desiderato, riprovare.

Il pulsante freccia a destra di Attuale consente di salvare una serie di colori possibili.
Fare clic sulla freccia per copiare il colore attuale nella cronologia. È possibile quindi
selezionare un colore facendovi clic nella cronologia. Per selezionare un colore, è inoltre
possibile immettere direttamente il relativo codice colore esadecimale inHTMLNotation
(Notazione HTML).

Il selettore del colore viene impostata per default sulla selezione di un colore per tonalità,
che in genere è il metodo più facile per un nuovo utente. Per eseguire una selezione per
saturazione, valore, rosso, verde o blue, selezionare il pulsante di scelta corrispondente
a destra. È inoltre possibile utilizzare i dispositivi di scorrimento e i campi dei numeri
per modificare il colore attualmente selezionato. Eseguire delle prove per trovare la
soluzione più adatta alle proprie esigenze.
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Quando il colore desiderato viene mostrato in Attuale, fare clic su OK. Per ripristinare
i valori originali mostrati all'apertura della finestra, fare clic su Reimposta. Per
interrompere l'operazione che include il cambiamento del colore, fare clic su Cancella.

Per selezionare un colore già esistente nell'immagine, utilizzare lo strumento del selettore
del colore, a cui corrisponde l'icona a forma di contagocce. Con le opzioni degli
strumenti, definire se deve essere selezionato il colore di sfondo o in primo piano.
Successivamente fare clic su un punto dell'immagine in cui viene mostrato il colore
desiderato. Se il colore è corretto, fare clic su Close (Chiudi) per chiudere la finestra
di dialogo dello strumento.

Pittura e cancellazione
Per dipingere e cancellare, utilizzare gli strumenti presenti nell'area strumenti. Sono
disponibili numerose opzioni che consentono di configurare ogni strumento. Le opzioni
di sensibilità alla pressione vengono applicate solo quando si utilizza una tavoletta di
grafica sensibile alla pressione.

Il funzionamento della matita, del pennello, dell'aerografo e della gomma è molto simile
a quello dei rispettivi strumenti equivalenti reali. Lo strumento dell'inchiostro funziona
in modo simile a una penna stilografica. Per dipingere un'area, fare clic su uno strumento
e trascinarlo. Lo strumento di riempimento (con un'icona a forma di secchiello) è un
metodo per colorare le aree di un'immagine. Consente di riempire l'area selezionata in
base ai limiti di colore dell'immagine. Regolando la soglia, è possibile modificare la
relativa sensibilità ai cambiamenti di colore.

Aggiunta di testo
Con lo strumento di testo, è possibile aggiungere facilmente del testo a un'immagine.
Con le opzioni degli strumenti, selezionare il font, la dimensione del font, il colore, la
giustificazione, il rientro e la l'interlinea desiderate. Successivamente fare clic su un
punto iniziale nell'immagine. Viene aperta una piccola finestra di dialogo in cui
immettere il testo. Immettere una o più righe di testo, quindi fare clic su Chiudi.

Lo strumento di testo consente di creare del testo su un livello speciale. Per elaborare
l'immagine dopo aver aggiunto il testo, leggere la Sezione 18.5.6, "Livelli" (p. 274). Se
il livello del testo è attivo, è possibile modificare il testo facendo clic sull'immagine
per riaprire la finestra di dialogo di immissione. Cambiare le impostazioni modificando
le opzioni degli strumenti.
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Ritocco delle immagini - Strumento di duplicazione
Lo strumento di duplicazione è ideale per il ritocco di immagini. Consente di eseguire
la pittura in un'immagine utilizzando le informazioni relative a un'altra parte
dell'immagine. Se lo si desidera, è possibile ottenere informazioni da uno schema.

Durante il ritocco, si consiglia di utilizzare un piccolo pennello con margini morbidi.
In questo modo, le modifiche possono uniformarsi meglio all'immagine originale.

Per selezionare il punto di origine nell'immagine, fare clic sul punto di origine desiderato
tenere premuto Ctrl. Successivamente eseguire la pittura con lo strumento, effettuando
la procedura consueta. Quando si sposta il cursore durante la pittura, anche il punto di
origine, contrassegnato da una croce, si sposta. Se l'opzione Allineamento è impostata
su Non allineato (impostazione di default), l'origine viene reimpostata sull'originale
quando si rilascia il pulsante sinistro del mouse.

18.5.4 Regolazione dei livelli dei colori
Spesso è necessario regolare le immagini in modo da ottenere i risultati di visualizzazione
o di stampa ideali. In numerosi programmi progettati per utenti inesperti, vengono
modificati i livelli di contrasto e di luminosità. Questa funzione è disponibile anche in
The GIMP, ma per ottenere risultati migliori è necessario regolare i livelli dei colori.

Per effettuare questa operazione, selezionare Livello > Colori > Livelli. Viene aperta
una finestra di dialogo per il controllo dei livelli nell'immagine. In genere, per ottenere
buoni risultati fare clic su Auto. Per apportare modifiche manuali a tutti i canali, utilizzare
gli strumenti di selezione in All Channels (Tutti i canali) per selezionare le aree
dell'immagine che devono essere nere, grigio neutro e bianche.

Per modificare un canale singolarmente, selezionarlo in Channel (Canale).
Successivamente trascinare i marker nero, bianco e centrale nel dispositivo di
scorrimento in Livelli di input. In alternativa, utilizzare gli strumenti di prelevamento
del colore per selezionare punti nell'immagine che si devono utilizzare come i punti
bianchi, neri e grigi per quel canale.

Se si seleziona Anteprima, nella finestra dell'immagine viene mostrata un'anteprima
dell'immagine dopo aver applicato le modifiche. Quando si raggiunge il risultato
desiderato, fare clic su OK per applicare le modifiche. Selezionare Reset (Ripristina)
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per ripristinare le impostazioni originali. L'opzione Cancella consente di interrompere
la regolazione del livello.

18.5.5 Annullamento delle modifiche
La maggior parte delle modifiche apportate in The GIMP può essere annullata. Per
visualizzare una cronologia delle modifiche, utilizzare la finestra di dialogo di
annullamento inclusa nel layout della finestra di default oppure aprirne una dal menu
dell'area strumenti con File > Finestre > Cronologia modifiche.

Nella finestra di dialogo viene mostrata un'immagine di base e una serie di modifiche
che possono essere annullate. Utilizzare i pulsanti per annullare e ripristinare le
modifiche. In questo modo, è possibile tornare a utilizzare l'immagine di base. Se si
annulla una modifica e subito dopo se ne esegue una nuova, la modifica annullata non
può essere ripetuta.

Le modifiche possono essere annullate e ripetute anche con il menu Modifica. In
alternativa, usare le combinazioni di tasti Ctrl + Ze Ctrl + Y.

18.5.6 Livelli
I livelli sono un aspetto molto importante di The GIMP. Disegnando parti dell'immagine
su livelli separati, modificare, spostare o cancellare tali parti senza danneggiare il resto
dell'immagine. Per comprendere il funzionamento dei livelli, si provi a pensare a
un'immagine creata da uno stack di fogli trasparenti. Parti diverse dell'immagine vengono
disegnate su fogli differenti. Lo stack può essere riposizionato, modificando le parti
che si trovano in alto. Singoli livelli o gruppi di livelli possono cambiare posizione,
spostando sezioni dell'immagine in altre ubicazioni. È possibile aggiungere nuovi fogli
e metterne da parte altri.

Utilizzare la finestra di dialogo Livelli per visualizzare i livelli disponibili di
un'immagine. Quando si utilizza, lo strumento di testo consente di creare
automaticamente livelli di testo particolari. Il livello attivo viene evidenziato. I pulsanti
nella parte inferiore della finestra di dialogo offrono numerose funzioni. Ulteriori
funzioni sono disponibili nel menu aperto quando si fa clic con il pulsante destro del
mouse su un livello nella finestra di dialogo. I due spazi per le icone prima del nome
dell'immagine vengono utilizzati per l'attivazione della visualizzazione dell'immagine
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(icona dell'occhio se visibile) e per il collegamento dei livelli. I livelli collegati sono
contrassegnati con l'icona della catena e spostati come un gruppo.

Solo i livelli con la trasparenza (canale alfa) possono essere posizionati sopra gli altri
livelli in uno stack. Per aggiungere questo a un livello, fare clic con il pulsante destro
del mouse e selezionarlo dal menu.

18.5.7 Modalità per le immagini
In The GIMP sono disponibili tre modalità per le immagini: RGB, scala di grigi e
indicizzata. RGB è una modalità di colore normale, ottimale per la modifica della
maggior parte delle immagini. La scala di grigi viene utilizzata per immagini in bianco
e nero. La modalità indicizzata limita i colori nell'immagine a un numero impostato.
Viene utilizzata principalmente per immagini GIF. Se è necessaria un'immagine
indicizzata, si consiglia in genere di modificare l'immagine in modalità RGB, quindi
di convertire nella modalità indicizzata prima del salvataggio. Se si salva in un formato
che richiede un'immagine indicizzata, The GIMP supporta l'indicizzazione dell'immagine
durante il salvataggio.

18.5.8 Effetti speciali
The GIMP include una vasta gamma di filtri e script per l'ottimizzazione delle immagini,
l'aggiunta di effetti speciali e la creazione di alterazioni artistiche. Sono disponibili in
Filtri e Script-fu. Eseguire delle prove è il metodo migliore per scoprire le funzioni
disponibili. Xtns nell'area strumenti include una serie di elementi per la creazione di
pulsanti, logo e altri oggetti.

Manipolazione delle immagini con The GIMP 275



18.6 Stampa di immagini
Per stampare un'immagine, scegliere File (File) > Print (Stampa) dal menu
dell'immagine. Se la stampante è configurata in SUSE, verrà visualizzata nell'elenco.
In alcuni casi, potrebbe essere necessario selezionare un driver appropriato con Setup
Printer (Imposta stampante). Selezionare il formato carta appropriato mediante Media
Size (Dimensioni supporto), quindi compilare Media Type (Tipo di supporto). Altre
impostazioni sono disponibili nella scheda Impostazioni di output/immagine.

Figura 18.3 Finestra di dialogo Stampa

Nella parte inferiore della finestra, regolare le dimensioni dell'immagine. Selezionare
Use Original Image Size (Usa dimensioni immagine originale) per acquisire queste
informazioni dalla stessa immagine. Si consiglia di eseguire questa operazione se si
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imposta una risoluzione e una dimensione di stampa appropriate nell'immagine. Regolare
la posizione dell'immagine nella pagina mediante i campi nella sezione Position
(Posizione) oppure trascinando l'immagine nella sezione Preview (Anteprima).

Se si è soddisfatti delle impostazioni, fare clic su Stampa. Per salvare le impostazioni
per il futuro, utilizzare Stampa e salva impostazioni. L'opzione Cancella consente di
interrompere la stampa.

18.7 Ulteriori informazioni
Le seguenti risorse sono utili per gli utenti di The GIMP, benché alcune si riferiscano
alle versioni precedenti.

• L'opzione Aiuto consente di accedere alla guida interna al sistema. Questa
documentazione è disponibile anche nei formati HTML e PDF all'indirizzo
http://docs.gimp.org.

• Esistono numerosi tutorial che spiegano le tecniche elementari e avanzate di
manipolazione delle immagini con The GIMP su http://gimp.org/
tutorials/.

• Il Gruppo utenti di GIMP offre informazioni in un esaustivo sito Web all'indirizzo
http://gug.sunsite.dk.

• http://www.gimp.org è la home page ufficiale di The GIMP.

• Grokking the GIMP scritto da Carey Bunks è un eccellente manuale su una versione
precedente di The GIMP. Sebbene alcuni aspetti dei programmi siano stati
modificati, tale manuale rappresenta un'ottima guida alla manipolazione delle
immagini. La versione in linea è disponibile all'indirizzohttp://gug.sunsite
.dk/docs/Grokking-the-GIMP-v1.0/.
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19Gestione delle raccolte di
immagini digitali
La gestione delle fotografie digitali in Linux è molto semplice. digiKam di KDE scarica
direttamente le immagini dalla fotocamera. Permette di classificare e manipolare le
immagini per ottenere i migliori risultati possibili e presentarle al pubblico.
L'applicazione comprende diversi utili plug-in che permettono di convertire le immagini
in vari formati. Sono anche disponibili plug-in per ritoccare le immagini, come la
riduzione dell'effetto "occhi rossi", la rimozione di macchie e la rimozione dei pixel
irregolari. Diversi plug-in di filtri ed effetti speciali permettono di trasformare le
immagini digitali in piccole opere d'arte.

Avviare digiKam dal menu principale o premendo Alt + F2 e digitando il comando
digiKam. All'avvio, digiKam visualizza una finestra con due aree principali: un elenco
degli album a sinistra e le immagini contenute nell'album corrente a destra. Vedere
Figura 19.1, "Finestra principale di digiKam" (p. 280). Sul bordo destro della finestra
è presente il filtro tag, utilizzabile per filtrare la quantità di immagini visualizzate nella
vista principale utilizzando informazioni di tag. Per dettagli informazioni sul tagging
in digiKam, consultare Sezione 19.5, "Gestione dei tag" (p. 284).
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Figura 19.1 Finestra principale di digiKam

19.1 Configurazione della fotocamera
Per scaricare le immagini dalla fotocamera digitale, collegare la fotocamera al computer
usando il cavo USB fornito dal costruttore della fotocamera. In base al modello di
fotocamera, potrebbe essere necessario accenderla per attivare una speciale modalità
di trasferimento dati. Per informazioni su questa procedura, consultare il manuale della
fotocamera.

Sono a disposizione tre metodi per accedere alle immagini presenti nella fotocamera.
I protocolli più utilizzati sono la memorizzazione di massa USB o PTP (detto anche
PictBridge). Alcuni modelli di fotocamera non funzionano con l'uno o con l'altro e
necessitano di speciali driver forniti da gphoto2 (Sezione 19.10, "Soluzione dei problemi"
(p. 299)).

Se la fotocamera è compatibile con la memorizzazione di massa USB, selezionare quella
opzione. Dopo aver collegato la fotocamera alla porta USB del computer e aver acceso
la fotocamera, il nuovo dispositivo USB viene automaticamente rilevato e montato.
KDE permette di selezionare l'azione di qualsiasi dispositivo che viene montato. È
possibile avviare digiKam o qualsiasi applicazione di visualizzazione o elaborazione
ogni qualvolta viene montato un dispositivo di questo tipo.
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Per configurare una fotocamera in digiKam, selezionare Macchina fotografica >
Aggiungi macchina fotografica. Innanzitutto, provare a rilevare automaticamente la
fotocamera con Rilevamento automatico. Se non vengono ottenuti risultati, scegliere
Aggiungi e scorrere l'elenco alla ricerca del proprio modello. Se il modello della
fotocamera non è incluso nell'elenco, provare un modello meno recente o usareMemoria
di massa USB/IEE e confermare con OK.

19.2 Download di immagini dalla
fotocamera

Per scaricare le immagini da una fotocamera correttamente configurata, collegarla al
computer e selezionarla dal menu Fotocamera. digiKam aprirà una finestra e inizierà
a scaricare le miniature e le visualizzerà come descritto in Figura 19.2, "Download di
immagini dalla fotocamera" (p. 281). Fare clic con il pulsante destro del mouse per
aprire un menu a comparsa contenente le seguenti opzioni riguardanti l'immagine:Vista,
Proprietà o Informazioni EXIF, Scarica o Elimina. Selezionare Avanzate sul fondo
della finestra del download per rinominare i file di immagini utilizzando Opzioni di
ridenominazione e per stabilire in che modo i dati EXIF forniti dalla fotocamera debbano
essere gestiti.

Figura 19.2 Download di immagini dalla fotocamera
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SUGGERIMENTO: ridenominazione di immagini

La ridenominazione di massa delle immagini può essere comoda se i nomi
attribuiti ai file dalla fotocamera non sono sufficientemente espliciti per le
operazioni da svolgere con le foto. È possibile indicare un prefisso univoco,
aggiungere opzionalmente una data, e lasciare che sia digiKam ad attribuire
un numero di sequenza.

Selezionare le fotografie da scaricare dalla fotocamera premendo il pulsante sinistro
del mouse oppure facendo clic sulle singole fotografie premendo Ctrl. Fare clic su
Scarica e selezionare la destinazione dall'elenco oppure creare un nuovo album con
Nuovo album; verrà automaticamente suggerito un nome file con la data corrente.
Confermare con OK per scaricare.

19.3 Recupero di informazioni
Per recuperare informazioni sulle immagini, mantenere il puntatore del mouse
sull'immagine per visualizzare una descrizione con i dati essenziali dell'immagine,
oppure fare clic con il pulsante destro del mouse per creare un'immagine e selezionare
Proprietà dal menu contestuale.

Sono disponibili le seguenti informazioni:

Generale
Questa scheda riporta informazioni essenziali sul file, cioè nome, data, dimensioni,
proprietario e autorizzazioni, nonché alcune informazioni essenziali sull'album a
cui l'immagine appartiene e gli eventuali tag o punteggi assegnati all'immagine.

EXIF
I dati EXIF sono forniti dalla fotocamera e contengono tutti i dettagli tecnici relativi
alla fotocamera e all'immagine, come ad esempio costruttore della fotocamera,
modello, tempo di esposizione e risoluzione. Per una panoramica essenziale,
impostare Livello di dettaglio su Semplice. Per esaminare il dataset completo,
selezionare Completo.

Istogramma
Nella scheda Istogramma è riprodotta la raffigurazione grafica dell'intervallo di
tonalità, dalle più scure alle più chiare, dell'immagine. Utilizzando l'istogramma,
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verificare se è stata utilizzata l'esposizione corretta durante l'acquisizione
dell'immagine.

19.4 Gestione degli album
digiKam crea una cartella denominata I miei album per default, in cui vengono
conservate tutte le immagini. In seguito le immagini potranno essere spostate altrove.
Gli album possono essere ordinati in base al layout, al nome della raccolta definito nelle
proprietà dell'album o alla data di creazione (che può comunque essere modificata nelle
proprietà).

Per creare un nuovo album, seguire una delle procedure sotto illustrate:

• Caricare nuove immagini dalla fotocamera e creare l'album di destinazione all'istante
durante il download.

• Creare un nuovo album facendo clic su Nuovo album nella barra degli strumenti.

• Importare una cartella di immagini esistente dal disco rigido selezionando Album
> Importa > Importa cartelle.

• Fare clic con il pulsante destro del mouse su I miei album e selezionare Nuovo
album.

Una volta deciso di creare un nuovo album, fornire alcune informazioni di base su esso,
come il suo titolo. Se necessario, scegliere una raccolta, inserire commenti e selezionare
una data. La raccolta è il modo in cui si organizzano gli album in base a un'etichetta
comune. Questa etichetta viene sfruttata quando si selezionaVista >Ordinamento album
> Per raccolta. Il commento verrà visualizzato nel banner superiore della finestra
principale. La data dell'album viene sfruttata quando si seleziona Vista > Ordinamento
album > Per data.

digiKam usa la prima fotografia nell'album come anteprima dello stesso nell'elenco I
miei album. Per selezionarne un'altra, fare clic con il pulsante destro del mouse sulla
fotografia preferita e selezionare Set as Album Thumbnail (Imposta come miniatura
dell'album) dal menu contestuale.
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19.5 Gestione dei tag
La gestione di grandi volumi di immagini raggruppate in album diversi può rivelarsi
molto complessa. Per gestire le immagini per categorie personalizzate, distribuite in
album diversi, digiKam offre il sistema I miei tag. Con i tag è possibile classificare le
immagini, alle quali è inoltre possibile attribuire diversi tag.

Si supponga ad esempio di scattare diverse fotografie del proprio amico Fabio e di
distribuirle in vari album Se si desidera trovare un metodo semplice per generare una
panoramica di tutte le foto scattate a Fabio, utilizzare i tag di digiKam, come spiegato
qui di seguito:

1 Selezionare Tag > Nuovo tag nella barra dei menu superiore, quindi immettere
il nome del nuovo tag, in questo caso Giovanni. Se desiderato, attribuire
un'icona e uscire dalla finestra di dialogo selezionando OK.

2 In tutti gli album, attribuire un tag alle immagini di Fabio facendo clic con il
pulsante destro del mouse e selezionando Assegna tag > Fabio.

Se è necessario elaborare numerosissime immagini, un metodo più semplice per attribuire
tag consiste nell'utilizzare l'opzione Modifica commenti e tag del menu contestuale che
viene visualizzato quando si fa clic con il pulsante destro del mouse sull'immagine. In
questa finestra di dialogo è possibile assegnare tag all'immagine, immettere un commento
descrittivo opzionale e attribuirle un punteggio. Terminata la procedura con la prima
immagine, rimanere in questa finestra di dialogo, fare clic su Avanti e procedere con
tutte le altre immagini dell'album. Una volta terminato, fare clic su Applica e OK e
applicare le impostazioni. Proseguire allo stesso modo con tutti gli altri album e con
tutte le altre immagini.

Per recuperare tutte le immagini dell'intera collezione contrassegnate da un determinato
tag (in questo caso Fabio), procedere come segue:

1 Aprire la scheda Tag nella barra delle schede di sinistra.

2 Selezionare l'elemento I miei tag.

3 Selezionare il tag Fabio.

Verranno così visualizzate tutte le immagini della collezione contrassegnate da
questo tag.
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Figura 19.3 Visualizzazione delle sole immagini contrassegnate da tag

Il filtro tag a destra della finestra principale circoscrive il numero di immagini
visualizzate per l'album corrente alle sole contrassegnate dal tag o dai tag qui selezionati.

19.6 Creazione di potenti filtri di
ricerca

Una raccolta di immagini diventa presto ingestibile se non si trova un metodo per
individuare senza troppe complicazioni le immagini desiderate. Per aiutare l'utente a
organizzare le raccolte, digiKam offre due opzioni di ricerca:

Ricerca semplice
Si tratta di una ricerca di base. Basta immettere una stringa di testo che potrebbe
essere associata all'immagine (nome dell'immagine, nome del tag o commento) e
selezionare OK. Questa ricerca può essere salvata per uso futuro in My Searches
(Ricerche personali).

Ricerca avanzata
Comprende filtri di ricerca complessi. Permette di impostare regole complesse
usando qualsiasi proprietà dell'immagine (album, tag, punteggio, data ecc.) e di
combinare queste proprietà come desiderato. Questa ricerca può essere salvata per
uso futuro in My Searches(Ricerche personali).
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L'esempio che segue spiega come creare una ricerca avanzata usando i dati del punteggio
o del tag per individuare le immagini:

1 Selezionare la scheda Ricerche alla sinistra della finestra principale.

2 Fare clic con il pulsante destro del mouse su My Searches (Ricerche personali)
e selezionare Add New Advanced Search (Aggiungi nuova ricerca avanzata).

3 Selezionare il primo criterio di ricerca. In questo caso, selezionare
Rating+Equals+5 Stars (Punteggio+Uguale+5 stelle) per
cercare tutte le immagini che hanno il punteggio di cinque stelle.

4 Nella sezione Add/Delete Option (Aggiungi/cancella opzione), selezionare Or
(o) e fare clic su Add (Aggiungi). Sotto alla regola di ricerca esistente ne viene
aggiunta un'altra.

5 Selezionare il secondo criterio di ricerca. In questo caso, selezionare
Tag+Equals+Filters (Tag+Uguale+Filtri) per cercare tutte le
immagini contrassegnate dal tag denominato Filters.

6 Se necessario aggiungere altri criteri di ricerca, raggruppare i criteri o eliminarli.
I risultati della ricerca verranno visualizzati nella finestra di ricerca.

7 Per salvare la ricerca per uso futuro, specificare un nome per la ricerca e uscire
dalla finestra di dialogo Advanced Search (Ricerca avanzata) facendo clic su
OK.

Figura 19.4 Creazione di filtri di ricerca avanzati
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19.7 Esportazione delle raccolte di
immagini

digiKam offre varie opzioni di esportazione per l'archiviazione e pubblicazione delle
raccolte di immagini personali. L'esportazione può essere fatta verso CD o DVD (con
k3b), verso HTML o una galleria remota.

Per salvare la raccolta di immagini su CD o DVD, procedere come segue:

1 Selezionare Album > Esporta > Archive to CD/DVD (Archivia su CD/DVD).

2 Apportare le opportune modifiche nella finestra di dialogo Create CD/DVD
Archive (Crea archivio CD/DVD) tramite i vari sottomenu a disposizione. Al
termine, fare clic su OK per iniziare il processo di masterizzazione.

2a Con Selezione è possibile determinare quali parti della raccolta archiviare
in base alla selezione di album e tag.

2b In HTML Interface (Interfaccia HTML), stabilire se la raccolta di immagini
possa essere consultata tramite un'interfaccia HTML e se funzionalità di
esecuzione automatica debbano essere presenti sull'archivio su CD o DVD.
Consente anche di selezionare titolo e immagine, font e proprietà dello
sfondo.

2c Modificare le impostazioni della descrizione del volume come in Media
Volume Descriptor (Descrizione volume), se necessario.

2d Impostare i parametri di masterizzazione inMedia Burning (Masterizzazione
supporto),se necessario.

Per creare un'esportazione HTML della raccolta di immagini, procedere come segue:

1 Selezionare Album > Esporta > Esportazione HTML.

2 Regolare le impostazioni in Create Image Galleries (Crea galleria di immagini)
in base alle proprie esigenze tramite i vari sottomenu. Al termine, fare clic su
OK per iniziare la creazione della galleria.
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2a Determinare quali parti della raccolta archiviare in base alla selezione di
album e tag in Selezione.

2b Usare Look (Aspetto) per impostare il titolo e l'aspetto della raccolta HTML.

2c Determinare l'ubicazione della galleria sul disco nonché dimensione,
compressione, formato delle immagini e quantità di metadati da visualizzare
nella galleria in Album.

2d Indicare dimensioni, compressione e tipo di file delle miniature usate per
scorrere la raccolta in Miniature.

Per esportare la raccolta a una galleria di immagini esterna su Internet, procedere
come segue:

1 Ottenere un conto presso un sito Web esterno per caricarvi la galleria.

2 Selezionare Album > Esporta > Export to Remote Gallery (Esporta in galleria
remota), quindi immettere l'URL, il nome utente e la password del sito esterno
quando richiesti. digiKam stabilisce una connessione al sito specificato e apre
una nuova finestra denominata Gallery Export (Esportazione galleria).

3 Determinare l'ubicazione del nuovo album nella galleria.

4 Fare clic su Nuovo album e fornire le informazioni richieste da digiKam.

5 Per caricare le immagini nel nuovo album, premere Add Photos (Aggiungi
fotografie).

19.8 Visualizzazione e modifica delle
immagini

digiKam è dotato di una suite completa per la visualizzazione e la modifica delle
immagini composta da diversi plug-in. Per passare alla modalità di visualizzazione e
di modifica di digiKam, fare doppio clic su una miniatura. Per usare i plug-in, è
necessario installare il pacchettodigikamplugins.
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Utilizzare Vista per ingrandire o ridurre la visualizzazione dell'immagine e per inserire
istogrammi. Con l'opzione Istogramma è possibile valutare l'esposizione dell'immagine
mentre la si visualizza.

Figura 19.5 Controllo dell'istogramma

Utilizzare il menu Immagine per modificare le proprietà, i commenti e i tag delle
immagini e per applicare alcuni effetti semplici o inserire testo:

Applica trama
Selezionare il tipo di trama da applicare all'immagine e determinare quanto questa
debba essere in rilievo (Rilievo). digiKam applica la trama e salva le modifiche alla
copia originale dell'immagine.

Aggiungi bordo
Scegliere il tipo di bordo. A seconda del tipo di bordo scelto, selezionare uno o due
colori per il bordo e impostare la larghezza dello stesso attorno all'immagine.
digiKam crea il bordo e salva le modifiche alla copia originale dell'immagine.
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Inserisci testo
Digitare il testo desiderato da sovrapporre all'immagine, scegliere font, stile del
font e dimensioni. Selezionare l'allineamento del testo e stabilire se il testo debba
essere ruotato e secondo quale angolo. Aggiungere un bordo opzionale e una
semitrasparenza. digiKam aggiunge il testo come se fosse uno strato all'immagine
originale.

19.8.1 Correzione e ritocco delle immagini
Usare il menu Correggi per ovviare ad alcuni difetti insiti nelle immagini digitali:

Colori
Regola diversi parametri cromatici delle immagini.

Blur/Sharpen (Sfocatura/Messa a fuoco)
Regola la sfocatura o la messa a fuoco dell'immagine.

Maschera di contrasto
Migliora la messa a fuoco dell'immagine.

Refocus (Rimessa a fuoco)
Migliora la messa a fuoco dell'immagine provando a rimetterla a fuoco.

Red Eye Reduction (Riduzione occhi rossi)
Permette di ridurre o eliminare l'effetto occhi rossi dovuto all'uso del flash.

Reintegrazione
Permette di "risanare" le aree difettose dell'immagine.

Hot Pixel Correction (Correzione dei pixel irregolari)
Permette di rilevare ed eliminare i pixel irregolari generati dal sensore della
fotocamera.

Ripristino
Permette di elaborare nella loro globalità le immagini affette da tutti i tipi di difetti
digitali, quali rumore e graffi.

Noise Reduction (Riduzione del rumore)
Permette di rimuovere gli artefatti, ad esempio quelli generati dalla polvere sulla
lente o sul sensore. Inoltre compensa il rumore dei pixel causato da impostazioni
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ISO elevate della fotocamera digitale e riduce rumore e artefatti di scansioni di
bassa qualità.

Lens Distortion Correction (Correzione delle distorsioni delle lenti)
Permette di compensare la distorsione a barilotto e a cuscinetto provocato dall'uso
di grandangolo e teleobiettivo.

Anti Vignetting (anti vignettatura)
Permette di compensare le ombre circolari (vignette) ai bordi o al centro
dell'immagine provocate dall'uso di grandangolo e teleobiettivo.

Per osservare l'effetto delle opzioni di Correggi, si provi a considerare Reintegrazione,
ad esempio. Si supponga che la presenza di polvere o graffi sulle lenti abbia rovinato
un'immagine. Per rimuovere questo tipo di artefatto, procedere come segue:

1 Aprire l'immagine.

2 Usare il cursore del mouse per selezionare l'area da ritoccare.

3 Selezionare Correggi > Reintegrazione o premereShift + I.

4 Stabilire il metodo da usare per rimuovere l'artefatto:

• Selezionare una delle opzioni preimpostate (Rimuovi artefatto piccolo,
Rimuovi artefatto medio o Rimuovi artefatto grande) e procedere con Passo
6.

• Impostare i propri parametri del filtro. Procedere con Passo 5.

5 Se si decide di non usare i filtri predefiniti, (nella scheda Preimpostazione), aprire
le schede Lisciatura e Impostazioni avanzate e regolare le impostazioni desiderate.

6 Fare clic su OK per applicare le impostazioni personali e modificare di
conseguenza l'immagine.

SUGGERIMENTO: creazione e riutilizzo delle proprie impostazioni
di filtro

Se fosse necessario utilizzare la stessa serie di impostazioni più volte, ad
esempio se un graffio della lente ha danneggiato un'intera serie di
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immagini, è possibile creare il proprio set di impostazioni di filtro. Salvarle
per riutilizzarle in seguito con Salva come in un file di testo. Per le
immagini successive, aprire la finestra di dialogo Correzione, fare clic su
Carica e selezionare il file di testo, quindi applicare le impostazioni di
filtro con OK.

Figura 19.6 Utilizzo di Reintegrazione per la rimozione degli artefatti

19.8.2 Applicazioni di trasformazioni alle
immagini

Per scalare o ruotare un'immagine, usare il menu Trasforma:

Ruota, Ribalta, Rotazione libera
Permette di ruotare l'immagine di un determinato angolo. Ruota ruota l'immagine
di multipli di 90 gradi. Con Rotazione libera è possibile specificare l'esatto angolo
di rotazione.
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Taglia, Taglia alle proporzioni
Permette di tagliare l'immagine. Taglia taglia una selezione rettangolare sopra
all'immagine. Taglia alle proporzioni taglia l'immagine in basi a complessi principi
geometrici.

Regolazione della prospettiva
Permette di regolare la prospettiva delle immagini. Se ad esempio si notano strane
distorsioni nelle immagini contenenti linee orizzontali o verticali, questo strumento
permette di correggerle. Basta trascinare una delle quattro maniglie agli angoli
delle immagini e spostarle quanto basta. Usare lo strumento Taglia per rimuovere
i bordi neri risultati e rifilare le immagini.

Distorsione
Permette di sollevare parte dell'immagine in una direzione e l'altra nella direzione
opposta, orizzontalmente o verticalmente. Specificare l'angolo di distorsione
orizzontale e verticale e usare Taglia per rifilare l'immagine risultate.

Ridimensionamento, Espansione
Permette di ridimensionare le immagini.Ridimensionamento presenta una semplice
interfaccia che permette di modificare le dimensioni dell'immagine per pixel o
percentuali. Selezionare se mantenere le proporzioni o meno. Espansione esegue
le stesse operazioni di ridimensionamento, ma oltre a queste è possibile applicare
alcuni filtri all'immagine ridimensionata per migliorarne la qualità. Quando è
necessario stampare il risultato finito, selezionare Espansione anziché il semplice
Ridimensionamento. È possibile salvare le impostazioni del filtro in un file di testo
e applicarle ad altre immagini in un secondo tempo.

Si supponga di avere un'immagine perfetta ma la cui composizione non è pienamente
soddisfacente, oppure di dover tagliare un'immagine per un determinato formato di
stampa. In questo caso si utilizzerà Taglia alle proporzioni e si procederà come segue:

1 Aprire l'immagine.

2 Selezionare Trasforma > Taglia alle proporzioni.

3 Determinare l'orientamento e le proporzioni da usare:

Nessuno
Specificare se utilizzare il ritaglio libero, usando le barre di scorrimento X,
Larghezza, e Y, Altezza.
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Personalizzato
Selezionare un rapporto personalizzato larghezza:altezza invece dei valori
preimpostati.

Rapporto X:Y
Questi rapporti sono adatti a gran parte dei formati carta utilizzati per
stampare fotografie. Selezionare quello più adatto alle proprie esigenze di
stampa.

Rapporto aureo
Rapporto (1:1,618) tradizionalmente utilizzato dagli artisti per creare risultati
armoniosi.

Utilizzare Proporzioni massime per impostare l'area di taglio massima per il
rapporto specificato.

4 Una volta determinate le dimensioni della selezione di taglio, applicare se
desiderato regole di composizione. LaGuida alla composizione permette di creare
una selezione di taglio da cui ottenere un'immagine gradevole. Le linee tratteggiate
guidano alla realizzazione di una migliore composizione dell'immagine.

SUGGERIMENTO: ulteriori informazioni

Per una descrizione completa delle opzioni, consultare http://docs
.kde.org/development/en/extragear-graphics/digikam/
using-kapp-imageeditor.html.

5 Se la posizione del ritaglio non soddisfa, spostarla.

6 Fare clic su OK per applicare la selezione di taglio e rifilare l'immagine.
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Figura 19.7 Creazione di un ritaglio personalizzato utilizzando il taglio alle
proporzioni

19.8.3 Applicazione di filtri ed effetti
Sono disponibili diversi effetti e filtri di base da applicare alle immagini per rendere
più artistiche o incisive:

Bianco e nero
Trasforma l'immagine a colori in una in bianco e nero. Selezionare Bianco e nero
neutro per ottenere un'immagine con semplici toni di grigio. Per simulare l'uso di
un filtro colorato (verde, arancio, rosso o giallo) che accentua le aree di un
determinato colore nell'immagine originale selezionare una delle opzioni di Bianco
e nero con filtro.... Per simulare l'effetto delle sostanze chimiche della camera
oscura, selezionare una delle opzioni Bianco e nero con tono....

Gocce di pioggia
Applica l'effetto gocce di pioggia all'immagine. Determinare dimensioni e numero
di gocce, quindi specificare il grado di distorsione causato dalle gocce (Occhi di
pesce).
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Pellicola infrarossa
Simula l'uso di una pellicola infrarossa per ottenere un effetto lievemente surreale.
Il risultato è sorprendentemente diverso dall'immagine originale. Aggiungere
ulteriore grana della pellicola e regolare la sensibilità (ISO) della pellicola per
ottenere un effetto ancora più artistico.

Pittura a olio
Simula la tecnica della pittura a olio. Indicare le dimensioni del pennello e il grado
di attenuazione da applicare all'immagine.

Rilievo
Rende l'immagine come in rilievo su un foglio di carta. Selezionare la profondità
desiderata.

Solarizza immagine
Simula la sovraesposizione alla luce del sole.

Effetti di distorsione
È possibile applicare alcuni bizzarri effetti di distorsione, quali occhi di pesec, alle
immagini. Stabilire tipo, livello e ripetizione.

Aggiungi grana della pellicola
Aggiunge grana della pellicola all'immagine per conferirle un aspetto sgranato.

Effetti di sfocatura
Sfocare le immagini per simulare una sfocatura oppure un movimento che
effettivamente non è stato ripreso quando l'immagine è stata acquisita.

Disegno a carboncino
Trasforma l'immagine in un disegno a carboncino in bianco e nero. Selezionare le
dimensioni desiderate del carboncino e il grado di attenuazione da applicare
all'immagine.

296 Guida per l'utente KDE



Figura 19.8 Simulazione della fotografia agli infrarossi

19.9 Strumenti utili
digiKam offre una serie di utili strumenti per organizzare la raccolta di immagini e per
elaborare queste ultime. Questi sono disponibili nel menu Strumenti:

Trova immagini duplicate
Se si ritiene che la raccolta contenga immagini duplicate, utilizzare questa opzione
per trovarle ed eliminarle. Stabilire innanzitutto quale album o tag coinvolgere
nella ricerca. Fare clic su OK per avviare la ricerca. Se la raccolta contiene duplicati,
verrà visualizzata una schermata suddivisa in cui entrambe le immagini vengono
visualizzate. Selezionare quelle da eliminare.

Crea calendario
È possibile creare un semplice calendario con un layout standard selezionando le
immagini da usare, il formato carta e i font.

Presentazione
Permette di presentare la raccolta di immagini sotto forma di presentazione. Indicare
le immagini da mostrare, gli effetti da usare e le informazioni da visualizzare insieme
alle immagini. Impostare il ritardo fra immagini e avviare la presentazione.
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Convertitore immagini RAW (singole)
digiKam supporta la conversione delle immagini da vari formati RAW proprietari
a formati immagine comuni quali JPEG o PNG. Con questa opzione, convertire
singole immagini. Per convertire più immagini, utilizzare la conversione batch
(Strumenti > Processi non interattivi > Convertitore di immagini RAW (Batch)).
Per stabilire se il formato RAW della propria fotocamera sia supportato dal plug-
in di conversione digiKam, consultare http://www.cybercom.net/
~dcoffin/dcraw/.

Processi batch
Permettono di eseguire determinate azioni su molti file contemporaneamente, ad
esempio aggiungere bordi, modificare i colori, applicare effetti e filtri, rinominare
e ridimensionare le immagini, ricomprimerle, eseguire la conversione RAW.

Un esempio di processo batch potrebbe essere l'applicazione dell'effetto di solarizzazione
a diverse immagini. Per inviare alla coda del processo batch le immagini ed eseguire
l'operazione sulle stesse, procedere come segue:

1 Selezionare Strumenti > Processi batch > Effetti immagine o fare clic con il
pulsante destro del mouse sul nome dell'album e selezionare Processi batch >
Effetti immagine.

2 Impostare l'effetto su Solarizzazione e fare clic su Opzioni per determinare il
grado dell'effetto da applicare e visualizzare un'anteprima opzionale.

3 Decidere se rinominare o sovrascrivere le immagini originali oppure se rimuoverle
dopo la trasformazione.

4 Impostare la cartella di destinazione delle immagini risultanti. Per fare in modo
che le nuove immagini vengano scritte nella cartella originaria, selezionareNuovo
e aggiungere una nuova cartella o sottocartella. Selezionare la nuova cartella con
il puntatore del mouse.

5 Accettare o modificare l'elenco di immagini da trasformare.

6 Fare clic su Avvia per dare inizio alla trasformazione.

digiKam riporta sul progresso e sulla correttezza della trasformazione.
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Figura 19.9 Processi batch: solarizzazione delle immagini

19.10 Soluzione dei problemi
Sebbene SUSE Linux Enterprise e digiKam supportino una vasta gamma di fotocamere,
possono talvolta verificarsi i seguenti problemi nell'utilizzo della fotocamera digitale
con SUSE Linux Enterprise:

Impossibile scaricare le immagini dalla fotocamera
Se non è possibile scaricare le immagini indipendentemente dal protocollo utilizzato
(PTP o USB), provare a usare la riga di comando anziché digiKam. Il comando
gphoto2 --P inizializza la fotocamera e scarica le immagini se egphoto2 supporta
questa fotocamera.
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La fotocamera non è ufficialmente supportata da digiKam
Provare con il comando gphoto2 --list-cameras e consultare http://
www.gphoto.org/ per ottenere ulteriori informazioni sullo stato del supporto
di Linux della fotocamera di cui si dispone.

Se la fotocamera non è elencata, rimuovere il supporto di archiviazione dalla
fotocamera e utilizzare un lettore di schede (interno o esterno). Non appena viene
rilevato il supporto, viene montato automaticamente e quindi è possibile importare
le immagini nella raccolta digiKam con Album > Importa > Aggiungi immagini o
album > Importa > Importa cartelle.

19.11 Ulteriori informazioni
Per ulteriori informazioni sull'uso di fotocamere digitali con Linux, fare riferimento ai
seguenti siti Web:

• http://docs.kde.org/development/en/extragear-graphics/
digikam/index.html—Il manuale ufficiale di digiKam

• http://docs.kde.org/development/en/extragear-graphics/
digikamimageplugins/index.html—Documentazione dei plug-in digiKam

• http://www.gphoto.org—Informazioni su gPhoto2

• http://www.gphoto.org/proj/libgphoto2/support.php—Elenco
completo delle fotocamere supportate
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20Riproduzione di musica e
filmati
Normalmente durante l'installazione YaST identifica e configura automaticamente le
schede audio del computer. In caso contrario, o se è stata installata una nuova scheda
audio, avviare YaST e configurare la scheda audio manualmente nel modulo Sound
(Audio). Al termine della configurazione, è possibile controllare il volume e il
bilanciamento ricorrendo a un mixer e avviare altre applicazioni audio.

Linux include un'ampia gamma di applicazioni audio e multimediali. Alcune di queste
applicazioni vengono installate nel sistema Linux di default. Le applicazioni qui descritte
consentono di controllare il volume e il bilanciamento della riproduzione e riprodurre
CD, musica e file video.

Nel caso in cui una delle applicazioni in elenco non venga installata di default nel
sistema , utilizzare YaST per installare i pacchetti mancanti. Per cercare i nomi dei
pacchetti, utilizzare la funzione di ricerca nello strumento di gestione dei pacchetti
YaST.

20.1 Mixer
I mixer forniscono uno strumento per il controllo del volume e il bilanciamento
dell?audio in uscita e in entrata nel computer. Per una descrizione delle applet predefinite
del mixer di KDE e GNOME, fare riferimento ai capitoli dedicati a KDE e GNOME.
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La differenza principale tra i vari mixer consiste nell'aspetto dell'interfaccia utente.
Esistono tuttavia numerosi mixer progettati per componenti hardware specifici.
envy24control, ad esempio, è un mixer per il chip audio Envy 24, mentre hdspmixer è
progettato per le schede RME Hammerfall. È possibile selezionare il mixer più adatto
alle proprie esigenze tra quelli disponibili.

SUGGERIMENTO: avvio del mixer

È in genere consigliabile avviare il mixer prima di aprire altre applicazioni audio.
Utilizzare il mixer per verificare e regolare le impostazioni di controllo dell'audio
in uscita e in entrata nella scheda audio.

20.2 Riproduzione di file musicali
In Linux è disponibile una vasta gamma di programmi per la riproduzione di file
musicali, quali OGG o WAV. KDE offre, ad esempio, amaroK e JuK.

20.2.1 Lettore multimediale amaroK
Il lettore musicale amaroK consente di riprodurre vari formati audio, creare playlist,
importare brani musicali da supporti estraibili quali lettori MP3 portatili o dischi rigidi
esterni (o caricare file su dischi estraibili), ascoltare trasmissioni audio in streaming
dalle stazioni radio in Internet. I tipi di file supportati dipendono dal motore utilizzato.

Al primo avvio, viene visualizzata una procedura First-Run Wizard (Avvio guidato),
che consente di configurare amaroK. Definire l'ubicazione in cui amaroK deve cercare
la raccolta musicale. amaroK cercherà i supporti riproducibili nelle cartelle specificate.
Per default, amaroK è configurato per eseguire la ricerca nelle cartelle selezionate in
modo ricorsivo per includere tutte le sottodirectory, tenere traccia delle modifiche
apportate al contenuto delle directory specificate e importare qualsiasi playlist
disponibile. Tutte le impostazioni effettuate con la procedura guidata possono essere
modificate in seguito nella finestra di dialogo di configurazione selezionando
Impostazioni > Configure AmaroK (Configura AmaroK).
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Figura 20.1 Lettore multimediale amaroK

Riferimento rapido
All'avvio, amaroK esegue la scansione delle cartelle appartenenti alla raccolta di file
musicali. Sebbene amaroK possa essere utilizzato anche senza creare una raccolta, è
consigliabile eseguire questa operazione, poiché la maggior parte delle potenti e avanzate
funzionalità di amaroK sono disponibili solo in combinazione con una raccolta esistente.

La finestra principale di amaroK è suddivisa in due parti. Nella barra laterale a sinistra
sono disponibili numerose viste: la raccolta musicale, un browser contestuale, le playlist,
un browser dei file e così via. Per cambiare browser, fare clic su una scheda all'estrema
sinistra. La parte destra contiene la finestra delle playlist e, al di sotto di questa, il lettore
(a meno che non sia stata scelta la configurazione che ne prevede la visualizzazione in
una finestra separata).

Per riprodurre la musica, è sufficiente trascinare e rilasciare gli elementi da uno qualsiasi
dei browser della barra laterale nell'area delle playlist. Per selezionare più voci, utilizzare
Shift o Ctrl. Fare doppio clic su un brano presente nella playlist per riprodurlo. È possibile
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aggiungere o cancellare elementi dall'elenco durante la riproduzione utilizzando il menu
di scelta rapida. Utilizzare le icone sopra all'area della playlist per applicare l'opzione
Cancella o Salva alla playlist, per applicare le opzioniAnnulla eRipristina alle modifiche
o per selezionare Ricerca e cercare una traccia specifica. Per manipolare le modalità di
riproduzione, fare più volte clic sulle icone Ripeti o Casuale nella barra di stato di
amaroK per cambiare modalità oppure selezionare la Modalità desiderata dal menu
principale di amaroK.

Browser della barra laterale
Contesto

Con questa scheda è possibile visualizzare le informazioni e le statistiche relative
alla traccia attualmente in riproduzione. Per passare ad altre viste nel browser
Contesto , fare clic sulle schede sopra alla barra laterale. Fare clic sulla scheda
Artista per fare in modo che amaroK cerchi l'articolo Wikipedia correlato e che lo
visualizzi nel browser contestuale. Per visualizzare il testo di una traccia, fare clic
sulla scheda Lyrics (Testi) per avviare una ricerca e visualizzare i risultati. La scheda
Musica mostra la copertina dell'album, se disponibile (vedere Sezione "Manager
di copertine" (p. 306)) e le statistiche di ascolto correlate alla traccia attuale.

Raccolta
Utilizzare questa vista per gestire e visualizzare la raccolta personale di titoli. La
barra degli strumenti, situata nella parte superiore del browser, consente di
configurare la modalità di visualizzazione della raccolta e di riorganizzarla.
L'opzione Raggruppa per permette di definire l'ordine di visualizzazione dei titoli
nel browser. È possibile scegliere i criteri predefiniti oppure creare criteri di
ordinamento personalizzati utilizzandoPrimario, Secondario e Terziario. La quattro
icone successive consentono di alternare la vista ad albero, la vista semplice e la
vista iPod* o di utilizzare Show dividers (Mostra divisori) per una migliore
panoramica nel caso di raccolte musicali di grandi dimensioni. Utilizzare l'icona a
chiave inglese per aggiungere o cancellare le cartelle in cui amaroK cerca i brani
musicali da aggiungere alla raccolta.

Per cercare o applicare un filtro alla raccolta per una determinata traccia o album,
immettere il titolo (o parte di esso) nel campo di ricerca nella parte superiore. Ogni
carattere immesso restringe la ricerca e la selezione nel browser viene modificata
in base alla digitazione. Per cercare particolari metadati, ad esempio Genere o
Velocità in bit oppure per combinare numerose opzioni di ricerca, fare clic sul
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pulsante a destra del campo di ricerca per aprire la finestra di dialogo Modifica
filtro.

Playlist
Il browser di playlist consente di accedere a diverse playlist. In Playlist vengono
memorizzate le playlist personali presenti nelle cartelle della raccolta. Ogni volta
che dalla finestra delle playlist si crea e si salva una nuova playlist, questa viene
visualizzata nella finestra stessa. Fare clic con il pulsante destro del mouse sulla
cartella Playlist per creare o importare una nuova playlist o per aggiungere una
sottocartella. Per aggiungere a una playlist esistente nuove voci tratte dalla finestra
delle playlist, è sufficiente trascinarle e rilasciarle sulla playlist visualizzata nella
finestra del browser.

IMPORTANTE: condivisione delle playlist con altri lettori

Salvare le playlist in formato .m3u in modo da poterlo condiviedere con
altri lettori che utilizzano questo formato.

Smart Playlists (Playlist intelligenti) offre diverse viste di una stessa raccolta, ad
esempio tracce mai riprodotte, nuove o suddivise in base al genere. Per creare ad
esempio una playlist casuale dalla raccolta, selezionare 50 random Tracks (50
tracce casuali) e trascinare la voce nell'area della playlist. Fare clic con il pulsante
destro del mouse sulla cartella Scalette intelligenti per aggiungere sottocartelle o
creare le proprie playlist.

Radio Streams (Flussi radio) consente di ascoltare flussi radio in diretta da Internet.
Un elenco esaustivo viene fornito direttamente con amaroK. Fare clic con il pulsante
destro del mouse per aggiungere o creare sottocartelle.

Podcast permette di importare podcast in amaroK. Fare clic con il pulsante destro
del mouse per aprire un menu che consente di aggiungere podcast e sottocartelle,
aggiornare tutti i podcast o impostare l'intervallo di scansione.

File
Questa scheda consente di aprire un browser file che corrisponde alla finestra di
dialogo del manager file KDE standard. Utilizzare le icone nella parte superiore
per esplorare il file system, cambiare visualizzazione o creare segnalibri. Immettere
l'URL o un percorso direttamente nel campo di input del testo. Trascinare gli
elementi dei contenuti visualizzati nella playlist per includerli.
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Magnatune
Questa scheda consente di stabilire una connessione con l'archivio di Magnatune
da cui è possibile acquistare musica online. Fare clic su Aggiorna per visualizzare
gli album e i titoli disponibili in magnatune.com. Ordinare l'elenco degli album per
Genere e ascoltare alcune tracce con amaroK. Per acquistare brani musicali, fare
clic suPurchase Album (Acquista album), quindi immettere i dettagli del pagamento.

Dispositivi
Se si utilizzano lettori MP3 portaili o dischi rigidi esterni, utilizzare questo browser
per configurare il dispositivo portatile e accedervi da amaroK.

Manager di copertine
Con amaroK è possibile assegnare una copertina a ogni album della raccolta. Cover
Manager (Manager di copertine) semplifica infatti l'aggiunta, l'eliminazione e
l'individuazione delle copertine degli album.

Avviare il manager delle copertine mediante Strumenti > Cover Manager (Manager di
copertine) . Nella parte sinistra della finestra viene visualizzato un albero che include
tutti gli artisti della raccolta. La parte principale della finestra contiene un elenco delle
copertine di tutti gli album. Per filtrare le copertine visualizzate, fare clic su un artista
specifico nella vista ad albero o immettere un termine nel campo di input situato nella
parte superiore della finestra. Utilizzare Visualizza per attivare e disattivare la
visualizzazione di tutti gli album o degli album con copertina o senza.

Per assegnare copertine agli album sono disponibili tre diversi metodi:

Assegnazione automatica delle copertine
amaroK è in grado di recuperare automaticamente tutte le copertine mancanti
visualizzate nelle finestre principali di Amazon. Scegliere Amazon Locale
(Impostazioni internazionali Amazon) per determinare da quale server Web di
Amazon eseguire il recupero delle copertine, quindi fare clic su Fetch Missing
Covers (Recupera copertine mancanti).

IMPORTANTE: aggiunta di tag appropriati

amaroK recupera le copertine da Amazon utilizzando la stringa di
interrogazione Artist - Album (Artista - Album). Questa
informazione viene estratta dai tag dei file musicali. Quanto più i tag sono
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appropriati, tanto maggiore è la frequenza dei riscontri durante il recupero
automatico delle copertine.

Scelta manuale di una copertina recuperata da Amazon
Per un maggiore controllo delle immagini da utilizzare e della stringa di
interrogazione da applicare per recuperare una copertina, fare clic con il pulsante
destro del mouse su un album presente nella finestra principale e scegliere Fetch
From amazon.com (Recupera da amazon.com). Next Cover (Copertina successiva)
consente di scorrere tutte le immagini disponibili. Salva permette di selezionare la
copertina effettiva e di assegnarla all'album selezionato. Se non si è soddisfatti
delle copertine visualizzate, utilizzare Nuova ricerca per restringere la ricerca.
Scegliere Amazon Locale (Impostazioni internazionali Amazon) sulla barra degli
strumenti della finestra principale per determinare da quale server Web di Amazon
eseguire il recupero delle copertine.

Assegnazione manuale delle copertine
Se si dispone di immagini di copertine proprie, per assegnarle fare clic con il
pulsante destro del mouse su un album e scegliere Set Custom Cover (Imposta
copertina personalizzata).

Visualizzazioni
Se le visualizzazioni per amaroK sono installate, è possibile selezionare vari effetti
grafici per il brano musicale in riproduzione mediante Strumenti > Visualizzazioni. Le
visualizzazioni amaroK native vengono visualizzate nella finestra del lettore. Scorrere
le diverse modalità di visualizzazione disponibili facendo clic sull'animazione.

Icona della barra delle applicazioni di amaroK
Come altre applicazioni KDE, anche amaroK aggiunge un'icona alla barra delle
applicazioni KDE. Questa icona può essere utilizzata per controllare numerose
funzionalità di amaroK. Passare il puntatore del mouse sopra l'icona per visualizzare
le informazioni sulla traccia attualmente in riproduzione, scorrere contemporaneamente
la rotellina del mouse per ridurre o aumentare il volume di riproduzione. Se si fa clic
con il pulsante sinistro del mouse è possibile chiudere la finestra dell'applicazione senza
influire sulla riproduzione. Un ulteriore clic riapre la finestra. Se si preme il pulsante
centrale del mouse, la riproduzione viene interrotta temporaneamente e se si fa clic una
seconda volta, la riproduzione riprende. Con un clic del pulsante destro del mouse si
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apre un menu contestuale che consente di accedere ai controlli del lettore e di chiudere
amaroK.

L'utilizzo congiunto dei tasti Shift e Ctrl e del mouse permette di accedere a funzionalità
più avanzate. Se si tiene premuto Shift facendo scorrere la rotellina del mouse, è possibile
cercare la traccia corrente. Se si tiene premuto Ctrl facendo scorrere la rotellina del
mouse, è possibile ignorare determinate tracce della playlist.

Per aggiungere brani alla playlist corrente, è possibile inoltre trascinarli e rilasciarli
sull'icona della barra delle applicazioni. Viene aperto un menu popup che richiede se
si desidera solo inserire la traccia nella playlist oppure inserirla e riprodurla o accodarla
alla traccia corrente.

20.3 Gestione di CD audio
Sono disponibili varie modalità di ascolto dei brani musicali desiderati. È possibile
riprodurre un CD oppure una versione digitalizzata di quest'ultimo. Nella sezione
seguente vengono descritte alcune applicazioni per la riproduzione dei CD, nonché
quelle che è possibile utilizzare per digitalizzarne i contenuti audio.

Per informazioni sulla modalità di creazione di CD, fare riferimento a Capitolo 21,
Masterizzazione di CD e DVD (p. 315).

IMPORTANTE: CDDA e riproduzione analogica di CD

I CD audio possono essere riprodotti in due modi. Le unità CD e DVD che
consentono la riproduzione analogica dei CD leggono i dati audio e li inviano
all'apposito dispositivo di output. Alcune unità esterne collegate tramite
PCMCIA, FireWire o USB devono utilizzare CDDA (Compact Disk Digital Audio)
per estrarre i dati audio prima di riprodurli in formato PCM digitale. I lettori
inclusi nelle sezioni seguenti non supportano la modalità CDDA. Utilizzare
XMMS se è necessario il supporto CDDA.

20.3.1 Kscd - lettore CD audio
KsCD è un lettore CD audio facile da utilizzare incluso nel pacchetto
kdemultimedia3-extra. Se questo lettore è gia installato, premere Alt + F2 e
immettere kscd per avviare l'applicazione. KsCD si integra nel pannello di KDE e
può essere configurato per l'avvio automatico della riproduzione all'inserimento di un
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CD. Per accedere al menu di configurazione, selezionare Altro > Configure KsCD
(Configura KsCD). Se KsCD è opportunamente configurato, è possibile recuperare
informazioni relative al brano e all'album da un server CDDB (Compact Disc DataBase)
su Internet. È inoltre possibile caricare informazioni CDDB da condividere con altri
utenti. Utilizzare la finestra di dialogo CDDB per informazioni sul recupero e il
caricamento.

Figura 20.2 Interfaccia utente di KsCD

20.3.2 Compressione di dati audio: copia
Sono disponibili vari strumenti che consentono di gestire la compressione dell'audio.
Nelle sezioni seguenti vengono descritte le procedure per codificare e riprodurre dati
audio mediante la riga di comando, nonché alcune applicazioni grafiche in grado di
eseguire la compressione dell'audio.

Strumenti della riga di comando per la codifica e la
riproduzione di dati audio
Ogg Vorbis (pacchetto vorbis-tools) è un formato di compressione audio gratuito
supportato ormai dalla maggior parte dei lettori audio, nonché dai lettori MP3 portatili.
È possibile visitare la pagina Web del progetto all'indirizzo http://www.vorbis
.com/ (in lingua inglese).

Il sistema include diversi strumenti che supportano Ogg Vorbis. è uno strumento della
riga di comando utilizzato per codificare i file WAV in Ogg. È sufficiente eseguire
oggenc filepersonale.wav per trasformare un determinato file .wav in Ogg
Vorbis. L'opzione -h consente di visualizzare una panoramica degli altri parametri.
Oggenc supporta la codifica con bit rate variabile. In questo modo è possibile ottenere
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un livello più elevato di compressione. Anziché il bit rate, specificare la qualità desiderata
utilizzando il parametro -q. -b determina il bit rate medio. -m e -M specificano il bit
rate minimo e massimo.

ogg123 è un lettore Ogg della riga di comando. che può essere avviato mediante un
comando del tipo ogg123 mysong.ogg.

Compressione di dati audio mediante KAudioCreator
KAudioCreator è una semplice applicazione per la copia di CD (vedere la Figura 20.3,
"Copia di CD audio con KAudioCreator" (p. 310)). Una volta avviato, viene visualizzato
l'elenco di tutte le tracce del CD nella scheda CD Tracks (Tracce del CD). Selezionare
le tracce da copiare e codificare. Per modificare le informazioni relative alla traccia,
utilizzare Album editor (Editor di album) in File > Edit Album (Modifica album). In
alternativa, avviare il processo di copia e codifica tramite File > Rip Selection (Copia
selezione). È possibile osservare l'avanzamento delle operazioni nella scheda Lavori.
Se opportunamente configurato, KAudioCreator consente inoltre di generare file di
playlist a partire dalla selezione. è possibile utilizzare tali playlist con altri lettori, ad
esempio amaroK, XMMS o Helix Banshee.

Figura 20.3 Copia di CD audio con KAudioCreator
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Compressione di CD audio mediante Konqueror
Prima di avviare il processo di copia vero e proprio di Konqueror, configurare la gestione
dei CD audio e il codificatore Ogg Vorbis nel centro controllo di KDE. Selezionare
Audio e multimedia > CD audio. Il modulo di configurazione è costituito da tre schede:
Generale Nomi e Ogg Vorbis Encoder (Encoder Ogg Vorbis). L'unità CD appropriata
viene in genere rilevata automaticamente. Non modificare questa impostazione di default
a meno che il rilevamento automatico abbia esito negativo e risulti necessario impostare
l'unità CD manualmente. È inoltre possibile impostare qui la correzione degli errori e
la priorità dei codificatori. Nella schedaOgg Vorbis Encoder (Codificatore Ogg Vorbis)
determinare la qualità della codifica. Per configurare la ricerca online di informazioni
relative ad album, brani e artisti per i dati audio copiati, selezionare Add Track
Information (Aggiungi informazioni tracce).

Inserire il CD nell'apposita unità e immettere audiocd:/ nella barra Posizione per
avviare il processo di copia. In Konqueror viene visualizzato l'elenco delle tracce del
CD e di alcune cartelle (vedere la Figura 20.4, "Copia di dati audio con Konqueror"
(p. 311)).

Figura 20.4 Copia di dati audio con Konqueror

Per non comprimere i dati audio nel disco, è sufficiente selezionare i file .wav e
trascinarli in un'altra finestra di Konqueror per copiarli nella rispettiva destinazione.
Per avviare la codifica Ogg Vorbis, trascinare la cartella Ogg Vorbis o i file in essa
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contenuti in un'altra finestra di Konqueror. La codifica viene avviata non appena la
cartella Ogg Vorbis viene rilasciata nella relativa destinazione.

20.4 Riproduzione di file video
SUSE Linux Enterprise viene fornito con diversi lettori video. Kaffeine è il lettore video
predefinito di KDE e può essere eseguito con diversi back-end, quali ad esempio Xine
e MPlayer.

Figura 20.5 Finestra principale di Kaffeine

Il formato video che è possibile visualizzare con Kaffeine varia in base al back-end
(Xine è il predefinito). Xine è in grado di interpretare molti dei formati multimediali
più comuni. Per ulteriori informazioni, fare riferimento a http://xinehq.de/.

Kaffeine è inoltre in grado di riprodurre flussi multimediali da Internet e può essere
utilizzato come plug-in per Konqueror. Fornisce le opzioni comuni per la riproduzione
dei file in modalità schermo intero, l'esplorazione dei file e altro ancora. È anche
possibile eseguire un'istantanea del video e salvarla come immagine.

Oltre a Kaffeine, SUSE Linux Enterprise viene fornito con RealPlayer per Linux.
RealPlayer supporta RealAudio, RealVideo, Ogg Vorbis, Theora e molti altri.
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Figura 20.6 RealPlayer per Linux
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21Masterizzazione di CD e DVD
K3b è un programma completo per la masterizzazione di CD e DVD dati e audio.
Avviare il programma dal menu principale oppure immettendo il comando k3b. Nelle
sezioni seguenti viene brevemente descritto come avviare un processo di masterizzazione
di base per creare un primo CD o DVD con Linux.

21.1 Creazione di CD o DVD dati
Per creare un CD dati, selezionare File > New Project (Nuovo progetto) > New Data
Project (Nuovo progetto dati). Per creare un DVD dati, selezionare File > New Project
(Nuovo progetto) > New Data DVD Project (Nuovo progetto DVD dati). La vista del
progetto viene visualizzata nella parte inferiore della finestra, come illustrato nella
Figura 21.1, "Creazione di un nuovo progetto dati" (p. 316). Trascinare i singoli file o
le directory desiderate dalla home directory alla cartella del progetto e rilasciare tali
elementi. Salvare il progetto con un nome desiderato selezionando File > Salva con
nome.
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Figura 21.1 Creazione di un nuovo progetto dati

Selezionare quindi Masterizza sulla barra degli strumenti oppure premere Ctrl + B.
Viene visualizzata una finestra di dialogo con sei schede contenenti varie opzioni per
la masterizzazione di CD o DVD. Vedere Figura 21.2, "Personalizzazione del processo
di masterizzazione" (p. 316).

Figura 21.2 Personalizzazione del processo di masterizzazione
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La scheda Writing (Scrittura) contiene varie impostazioni per il dispositivo, la velocità
e le opzioni di masterizzazione. Sono disponibili le seguenti opzioni:

Burning Device (Dispositivo di masterizzazione)
Il dispositivo rilevato viene visualizzato in questo menu popup. In questo riquadro
è inoltre possibile selezionare la velocità.

AVVERTIMENTO: prestare attenzione durante la selezione della
velocità di scrittura

In genere, è consigliabile selezionare l'opzione Auto (Automatica) per
impostare la massima velocità di scrittura possibile. Tuttavia, se si aumenta
questo valore e il sistema non è in grado di inviare i dati abbastanza
velocemente, le probabilità di sottocarico del buffer aumenteranno.

Writing Mode (Modalità di scrittura)
Questa opzione determina in che modo il laser scriverà il CD o il DVD. Per i CD
sono disponibili tre modalità: DAO, TAO e RAW. Nella modalità DAO (disk at
once), il laser non viene disattivato durante la scrittura del disco. Questa modalità
è consigliata per la creazione di CD audio. Nella modalità TAO (track at once)
viene utilizzato un processo di scrittura separato per ogni singola traccia. La modalità
RAW non viene utilizzata molto spesso, poiché il masterizzatore non esegue alcuna
correzione di dati.

Anche nel caso del DVD sono disponibili tre modalità di scrittura: DAO,
incrementale e sovrascrittura. Nel caso dei DVD, la modalità DAO non supporta
la multisessione. Per creare un DVD multisessione, selezionare la modalità
incrementale. La modalità sovrascrittura permette di espandere il file system
ISO9660 dalla prima sessione, con supporti riscrivibili, utilizzando growisofs.

In genere è consigliabile utilizzare Auto, perché consente a K3b di utilizzare le
impostazioni più adatte.

Simula
Questa funzione può essere utilizzata per controllare se il sistema supporta la
velocità di scrittura selezionata. La scrittura viene eseguita con il laser disattivato
per eseguire un test del sistema.
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On the Fly (Al volo)
Consente di scrivere i dati desiderati senza creare un file di immagine (non utilizzare
questa funzione in computer a prestazioni ridotte). Un file di immagine, definito
anche immagine ISO, è un file contenente tutti i dati del CD che viene
successivamente scritto sul CD senza alcuna modifica.

Only Create Image (Crea solo immagine)
Questa opzione consente di creare un file di immagine. Impostare il percorso di
questo file sotto File temporaneo nella scheda Immagine. Il file di immagine può
essere scritto su CD in un secondo momento. Per eseguire questa operazione,
selezionare Strumenti > Masterizza immagine CD. Se si utilizza questa opzione,
tutte le altre opzioni presenti in questa sezione vengono disattivate.

Remove Image (Rimuovi immagine)
Questa opzione consente di rimuovere il file di immagine temporaneo dal disco
rigido al termine del processo.

Verify Written Data (Verifica dati scritti)
Questa opzione consente di controllare l'integrità dei dati scritti confrontando le
checksum MD5 dei dati originali e di quelli scritti.

La scheda Immagine risulta accessibile solo se si seleziona l'opzione Only create image
(Crea solo immagine). In questo caso, stabilire il file in cui scrivere l'ISO.

La scheda Impostazioni contiene due opzioni. La prima, Datatrack Mode (Modalità
traccia dati) è disponibile solo per i CD. Contiene la configurazione della modalità di
scrittura delle tracce dati. In genere, auto (automatica) è la modalità più indicata.
L'opzione Multisession Mode (Modalità multisessione) viene utilizzata per aggiungere
dati a un supporto già masterizzato ma non ancora finalizzato.

Nella scheda Volume Desc (Descrizione volume) è possibile immettere alcune
informazioni generali per l'identificazione di un particolare progetto dati, ovvero il
produttore, l'autore e l'applicazione e il sistema operativo utilizzati per la creazione del
progetto. Nella scheda File system, specificare le impostazioni del file system
(RockRidge, Joliet, UDF). Inoltre, determinare il modo in cui i collegamenti simbolici,
le autorizzazioni dei file e gli spazi vengono trattati. Nella scheda Avanzate gli utenti
esperti possono specificare ulteriori impostazioni.

Dopo avere regolato tutte le impostazioni in base alle proprie esigenze, avviare il
processo effettivo di masterizzazione scegliendo Masterizza. In alternativa, salvare le
impostazioni per usi e regolazioni futuri scegliendo Salva.
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21.2 Creazione di un CD audio
Non esistono differenze significative tra la creazione di un CD audio e un CD dati.
Selezionare File > Nuovo progetto audio. Trascinare e rilasciare le singole tracce audio
nella cartella del progetto. I dati audio devono essere in formato WAV o Ogg Vorbis.
Determinare la sequenza delle tracce spostandole verso l'alto o verso il basso nella
cartella del progetto.

CD Text consente di aggiungere alcune informazioni in formato testo a un CD, ad
esempio il titolo, il nome dell'artista e il nome delle tracce. I lettori CD che supportano
questa funzionalità sono in grado di leggere e visualizzare queste informazioni. Per
aggiungere le informazioni di CD Text alle tracce audio, selezionare prima di tutto la
traccia. Fare clic con il pulsante destro del mouse e selezionare Properties (Proprietà.
Viene visualizzata una nuova finestra in cui è possibile immettere le informazioni
desiderate.

La finestra di dialogo per la scrittura di un CD audio non è molto differente da quella
per la scrittura di un CD dati. Tuttavia, le modalità Disc at once (Aggiorna disco) e
Track at once (Aggiorna traccia) hanno una maggiore rilevanza. La modalitàAggiorna
traccia consente di inserire una intermissione di due secondi dopo ogni traccia.

SUGGERIMENTO: salvaguardia dell'integrità dei dati

Quando si masterizzano CD audio, è consigliabile scegliere una velocità ridotta
per limitare i rischi di errore durante la masterizzazione.

Dopo avere regolato tutte le impostazioni in base alle proprie esigenze, avviare il
processo effettivo di masterizzazione scegliendo Burn (Masterizza. In alternativa,
salvare le impostazioni per usi e regolazioni futuri scegliendo Save (Salva.

21.3 Copia di un CD o un DVD
Selezionare Strumenti > Copia CD oppure Strumenti > Copia DVD in base al tipo di
supporto. Nella finestra di dialogo visualizzata configurare le impostazioni per il
dispositivo di lettura e scrittura, come illustrato nella Figura 21.3, "Copia di un CD"
(p. 320). In questa finestra sono disponibili anche le opzioni di scrittura illustrate in
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precedenza. Una funzionalità aggiuntiva consente di creare diverse copie del CD o del
DVD.

Figura 21.3 Copia di un CD

Selezionare On the fly (Al volo) per masterizzare il supporto durante la lettura da un
altro dispositivo. Selezionare Only create Image (Crea solo immagine) per creare
un'immagine nel percorso specificato nella scheda Immagine nell'opzione Write image
file to (Scrivi file immagine in) e masterizzare l'immagine in un secondo tempo.

21.4 Scrittura di immagini ISO
Se si dispone già di un'immagine ISO, selezionare Strumenti > Masterizza immagine
CD. Viene aperta una finestra di dialogo in cui immettere l'ubicazione di Immagine da
scrivere. K3b calcola un checksum e lo visualizza in SommaMD5. Se il file ISO è stato
scaricato da Internet, questa somma mostra se il download è stato eseguito.

Utilizzare le schede Opzioni e Avanzate per impostare le preferenze desiderate. Per
masterizzare il CD, fare clic su Avvia.

Per masterizzare un'immagine ISO su DVD, selezionare Strumenti > Masterizza
immagine DVD ISO e selezionare l'immagine da masterizzare. Specificare la modalità
di scrittura e il numero di copie e selezionare l'opzione di scrittura appropriata.
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Selezionare Verify written data (Verifica dati scritti) per verificare l'integrità dei dati
sul DVD finito.

21.5 Creazione di un CD o un DVD
multisessione

I dischi multisessione possono essere utilizzati per scrivere dati durante più sessioni di
masterizzazione e risultano utili, ad esempio, per creare file di backup di dimensioni
inferiori rispetto al supporto. In ogni sessione è possibile aggiungere un altro file di
backup. L'aspetto interessante è che non si è limitati a utilizzare CD o DVD dati. In un
disco multisessione è anche possibile aggiungere sessioni audio.

Per avviare un nuovo disco multisessione, procedere come indicato di seguito:

1 Creare innanzitutto il disco dati e aggiungere tutti i file. Non è possibile iniziare
con una sessione CD audio. Prestare attenzione a non esaurire lo spazio del disco
perché altrimenti non sarà possibile aggiungere una nuova sessione.

2 Masterizzare i dati selezionando Progetto > Masterizza.

3 Aprire la scheda Settings (Impostazioni) presente nella finestra di dialogo
visualizzata e selezionare Start Multisession (Avvia multisessione). Nel caso dei
DVD non è possibile utilizzare la modalità di scrittura DAO perché non supporta
la multisessione.

4 Se necessario, configurare altre opzioni. Vedere anche Sezione 21.1, "Creazione
di CD o DVD dati" (p. 315).

5 Avviare la sessione di masterizzazione scegliendo Burn (Masterizza).

Se il processo di masterizzazione ha esito positivo, viene creato un disco multisessione.
Se nel supporto è disponibile spazio sufficiente, è possibile aggiungere altre sessioni.
Finalizzare i dischi solo se si è certi di non dover salvare altre sessioni oppure se lo
spazio è esaurito.
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NOTA: informazioni sullo spazio di memorizzazione disponibile nei dischi
multisessione

Si tenga presente che i dischi multisessione richiedono spazio per registrare
tutte le voci delle sessioni. Di conseguenza, nel disco sarà disponibile una
quantità di spazio minore, che dipende dal numero di sessioni salvate.

21.6 Ulteriori informazioni
K3b offre altre funzioni, oltre alle due descritte sopra, che consentono ad esempio
leggere dati audio in formato WAV, riscrivere CD e riprodurre musica con il lettore
audio integrato. Una descrizione dettagliata di tutte le funzionalità del programma è
disponibile all'indirizzo http://k3b.org/.
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ARicerca di informazioni
Per offrire il supporto necessario per le attività quotidiane con SUSE® Linux Enterprise
Desktop e per semplificare l'esplorazione del sistema Linux, Novell SUSE e l'intera
comunità Open Source hanno sviluppato una notevole quantità di informazioni. Le
informazioni correlate sono compilate e rese disponibili in vari formati. L'utente può
quindi accedere a una documentazione dettagliata fornita con il prodotto e a informazioni
aggiuntive disponibili tramite Internet.

A.1 Documentazione inclusa
Le risorse in cui è possibile reperire la documentazione online fornita con il prodotto
sono numerose. Il desktop KDE include un Centro di aiuto che offre una vasta gamma
di documenti. Nel Centro di aiuto è possibile accedere a informazioni specifiche di
SUSE Linux Enterprise, oltre che a descrizioni delle applicazioni fornite dalla comunità
Open Source.

Nella maggior parte dei casi, quando si installa un nuovo software con YaST, viene
installata automaticamente anche la relativa documentazione che, in genere, può essere
visualizzata nel Centro di aiuto del desktop KDE. È tuttavia possibile che, alcune
applicazioni, ad esempio The GIMP, dispongano di pacchetti di Guida online diversi,
che vengono installati separatamente con YaST e non si integrano nel Centro di aiuto.



A.1.1 Utilizzo della Guida di KDE
È possibile accedere a KDE help center dal desktop KDE in vari modi. Per ottenere
informazioni all'interno di un'applicazione, fare clic sul pulsanteGuida dell'applicazione
o premere F1 per aprire la documentazione dell'applicazione nella Guida. Se si avvia
la Guida dal menu principale o dalla riga di comando digitando susehelp, verrà
visualizzata la finestra principale della Guida da cui è possibile sfogliare gli argomenti.

Figura A.1 Finestra principale della Guida di KDE

Il menu e la barra degli strumenti forniscono le opzioni necessarie per stampare i
contenuti dal Centro di aiuto, eseguire ricerche nella pagina corrente ed esplorare e
personalizzare il Centro di aiuto. Il campo di visualizzazione, situato nella parte destra
della finestra, riporta sempre il contenuto attualmente selezionato, ad esempio manuali
online, risultati di ricerca o pagine Web.

L'area di spostamento nella parte sinistra della finestra contiene numerose schede:

Contenuto
Presenta tutte le origini di informazioni disponibili organizzate in una struttura ad
albero. Il Centro di aiuto si rivolge a vari gruppi di destinazione, quali utenti,
amministratori e sviluppatori. Fare clic sulle icone dei libri per aprire e sfogliare
le singole categorie. Sotto l'intestazione Amministrazione, ad esempio, è possibile
scorrere le pagine man (manuale) e info (informazioni) associate ai programmi
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della riga di comando. Il Centro di aiuto fornisce inoltre accesso ad alcuni database
online che trattano speciali problematiche hardware e software relative al prodotto.
È possibile eseguire ricerche in tutte queste origini in modo semplice una volta
generato l'indice di ricerca.

I contenuti del Centro di aiuto dipendono dai pacchetti software attualmente installati
e dalle lingue selezionate come lingue di sistema.

Glossario
Fornisce uno strumento di riferimento rapido in cui è possibile trovare definizioni
di termini sconosciuti.

Opzioni di ricerca
Offre opzioni per la ricerca di testo completa all'interno del Centro di aiuto. È
possibile combinare diversi criteri di ricerca.

Procedura A.1 Ricerche nella Guida

Per utilizzare la ricerca di testo completa, in KDE help center è possibile generare un
indice di ricerca e impostarne i parametri di ricerca. Se l'indice di ricerca non è ancora
stato generato, verrà chiesto se si desidera crearlo quando si fa clic sulla scheda
Ricerca.

1 Per cercare un termine, fare clic su Opzioni di ricerca e immettere la stringa di
ricerca.

2 Per combinare le stringhe di ricerca con gli operandi, fare clic su Metodo e
selezionare l'operando da utilizzare.

3 Scegliere un'opzione in Max. Results (Risultati max) per limitare il numero di
risultati da visualizzare.

4 Per restringere la ricerca a determinati tipi di documentazione, scegliere una delle
opzioni disponibili in Contesto. Se si sceglie Predefinito, la ricerca viene eseguita
in una selezione predefinita di documenti. L'opzione Tutto include nella ricerca
tutti i tipi di documenti. Personalizzato consente di definire quali documenti
includere nella ricerca, attivando i documenti desiderati nell'elenco.
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5 Dopo aver impostato le opzioni come desiderato, fare clic su Cerca. I risultati
della ricerca vengono presentati nel campo di visualizzazione sotto forma di
elenco di collegamenti, a cui è possibile accedere mediante selezione con il
mouse.

Procedura A.2 Generazione di un nuovo indice di ricerca

1 Per creare un nuovo indice di ricerca, selezionare Impostazioni > Costruisci indice
di ricerca dal menu. Verrà visualizzata una finestra che riporta un elenco dei
documenti attualmente disponibili nel Centro di aiuto.

2 Selezionare i documenti da integrare nell'indice di ricerca e fare clic su Costruisci
indice. Una volta generato l'indice, è possibile utilizzare la ricerca di testo
completa.

A.2 Risorse aggiuntive e ulteriori
informazioni

Per consultare su Internet la documentazione e i manuali specifici del prodotto, visitare
il sito all'indirizzo http://www.novell.com/documentation/sled10/.
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Per ulteriori informazioni, è inoltre possibile fare riferimento ai seguenti siti Internet:

Knowledgebase del supporto tecnico Novell
http://www.novell.com/support/

Risorse di supporto tecnico della comunità
http://forums.novell.com/novell-product-support-forums/

Sito Web della documentazione di KDE
http://www.kde.org/documentation

Sito Web della documentazione relativa alle applicazioni KDE
http://www.kde-apps.org

Spesso anche i motori di ricerca generici possono rivelarsi utili. È ad esempio possibile
provare a cercare Linux CD-RW oppure problema di conversione file
OpenOffice qualora si verifichino problemi con la masterizzazione di CD o con la
conversione di file OpenOffice.Org. Google™ mette inoltre a disposizione un utile
motore di ricerca dedicato a Linux all'indirizzohttp://www.google.com/linux.
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BMigrazione da Windows a
Linux
Se si è utilizzato Microsoft Windows* sarà possibile notare come molti elementi comuni
di tale sistema siano disponibili in SUSE Linux Enterprise®. Dopo il login, il desktop
presenta un layout familiare e icone riconoscibili, molte delle quali sono simili a quelle
del desktop di Windows e della scrivania di Macintosh.

Figura B.1 Desktop KDE



B.1 Avvio delle applicazioni dal menu
principale

Simile al menu Start di Windows, il menu principale consente di accedere a tutti i
programmi installati nel sistema. Per aprirlo, fare clic sull'icona SUSE verde situata
nell'angolo sinistro del pannello. La struttura del menu, orientata alla funzione, rende
più semplice individuare l'applicazione adeguata al proprio scopo, anche quando ancora
non si conoscono i nomi delle applicazioni. Ulteriori informazioni sul menu principale
sono disponibili in Sezione 1.3.1, "Accesso al menu principale" (p. 11).

Figura B.2 Menu principale in KDE

In alternativa, è possibile avviare i programmi dalla riga di comando. Premere Alt + F2
per aprire una finestra di dialogo in cui è possibile specificare un comando che consente
di avviare un'applicazione. Spesso, ma non sempre, il nome del comando equivale al
nome dell'applicazione scritto in lettere minuscole.

330 Guida per l'utente KDE



B.2 Gestione di file
Per avviare Konqueror, il file manager e browser Internet predefinito di KDE, premere
Alt + F2 e digitare il comando konqueror. Per visualizzare i contenuti della home
directory, fare clic su File personali. Per aprire questa vista direttamente, utilizzare
l'icona di avvio rapido, che raffigura una casa, presente nel pannello.

Figura B.3 Windows Explorer e Konqueror

Per ulteriori informazioni su Konqueror come file manager, vedere Sezione 1.4,
"Gestione di cartelle e file con Konqueror" (p. 19).

B.3 Utilizzo della riga di comando
Per eseguire i comandi in una riga di comando, analoga al prompt dei comandi di
Windows, premereAlt + F2e digitarekonsole oppure utilizzare l'icona di avvio rapido.
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Figura B.4 Prompt dei comandi di Windows e terminale Konsole

Ulteriori informazioni sull'utilizzo della riga di comando sono disponibili in Capitolo 15,
Working with the Shell (↑Deployment Guide).

B.4 Personalizzazione del desktop
Per modificare l'aspetto e il funzionamento dei desktop KDE, premere Alt + F2 e digitare
il comandokcontrol. Alcune delle impostazioni che è possibile modificare includono
sfondo del desktop, screen saver, configurazione di tastiera e mouse, suoni e associazioni
dei file.
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Figura B.5 Pannello di controllo di Windows e Centro di controllo KDE

Per ulteriori informazioni, consultare Sezione 2.1, "Uso del Centro di controllo KDE"
(p. 51).

B.5 Configurazione delle stampanti
Per configurare o aggiungere una stampante a SUSE Linux Enterprise, avviare Gestione
stampanti dal menu principale. È possibile aggiungere ed eliminare stampanti, gestire
lavori di stampa e configurare il sistema di stampa. Per ulteriori informazioni, consultare
Capitolo 12, Gestione stampanti (p. 207).
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Figura B.6 Stampanti e fax di Windows e Gestione stampanti di KDE

B.6 Spostamento tra le applicazioni
Analogamente alla barra delle applicazioni di Windows, il pannello inferiore di KDE
consente di spostarsi facilmente tra le finestre aperte. A differenza di Windows, in KDE
è possibile configurare più desktop per l?esecuzione di programmi diversi. Per spostarsi
da un programma all'altro, è sufficiente un solo clic del mouse.

SUGGERIMENTO: utilizzo delle combinazioni di tasti

Per spostarsi tra vari desktop e diverse applicazioni in esecuzione è inoltre
possibile ricorrere alle combinazioni di tasti. Per spostarsi tra le applicazioni,
utilizzare l'ormai nota combinazione. Alt +→| I tasti Ctrl + F1, Ctrl + F2 e così
via consentono di spostarsi tra i desktop.

Figura B.7 Pannello di Windows e Panello di KDE
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B.7 Accesso alle risorse di rete
Dal desktop è possibile accedere ai file e alle directory o a determinati servizi su host
remoti, oppure è possibile rendere disponibili i propri file e le proprie directory ad altri
utenti della rete. SUSE Linux Enterprise offre diverse modalità di accesso e creazione
alle risorse condivise in rete. Se la struttura della rete e la configurazione del computer
lo consentono, è possibile utilizzare il file manager Konqueror per esplorare la rete
senza difficoltà alla ricerca di servizi e risorse condivise.

Figura B.8 Risorse di rete di Windows e Navigazione rete locale di Konqueror

Per ulteriori informazioni sulle varie possibilità di accesso alle risorse della rete, fare
riferimento a Capitolo 9, Accesso alle risorse di rete (p. 173).
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CPresentazione del software
per Linux
Linux viene fornito con una ricca gamma di applicazioni, offrendo spesso più di una
soluzione a esigenze specifiche. La difficoltà sta nel trovare quell'applicazione che
soddisfa le proprie esigenze. Le sezioni successive presentano alcuni dei più potenti
programmi per Linux equivalenti ai comuni applicativi per Windows*. Ciascuna sezione
è dedicata a un campo particolare di applicazione, elencando una panoramica delle
applicazioni per Windows e le equivalenti per Linux per diversi task. Sotto ciascuna
tabella sono disponibili maggiori informazioni sulle applicazioni di Linux con
collegamenti a ulteriori informazioni. Questo elenco non intende essere esaustivo,
poiché lo sviluppo del software è un processo in continua evoluzione con nuove
applicazioni che vengono create ogni minuto.

SUGGERIMENTO: applicazioni mancanti

Non tutte le applicazioni indicate sotto sono installate nel sistema per default
e alcune potrebbero non essere fornite con il prodotto. Se l'applicazione che
si desidera utilizzare non è presente, rivolgersi al proprio amministratore di
sistema. Se l'applicazione è fornita con il prodotto, è possibile installarla con
YaST. Per cercare i nomi dei software, utilizzare la funzione cerca dello
strumento di gestione dei pacchetti YaST.

C.1 Ufficio
In questa sezione vengono descritte le più popolari e potenti soluzioni software per
l'ufficio e le aziende. Tra queste vi sono le suite per ufficio, i database, software per la
contabilità e software per gestione dei progetti.



Tabella C.1 Software per l'ufficio per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

OpenOffice.org, StarOffice,
KOffice

Microsoft Office,
StarOffice*, OpenOffice.org

Suite per l'ufficio

OpenOffice.org/StarOffice
Writer, KWord

Ms Word,
Staroffice/Openoffice.org
Writer, WordPerfect

Elaborazione testi

OpenOffice.org/StarOffice
Calc, Gnumeric, KSpread

Microsoft Excel,
Staroffice/Openoffice.org
Calc

Foglio di lavoro

OpenOffice.org/StarOffice
Impress, KPresenter

Microsoft Powerpoint*,
StarOffice/Openoffice.org
Impress

Presentazione

OpenOffice.org Calc, Kst,
Gnuplot, Grace (Xmgr),
LabPlot

Microsoft Excel, MicroCall
Origin

Grafici ed
elaborazione dati

OpenOffice.org Base, Rekall,
kexi, Mergeant, PostgreSQL

Microsoft Access,
Openoffice.org Base

Database locali

GnuCash, KMyMoneyMicrosoft Money, QuickenContabilità
finanziaria

Planner, TaskjugglerMicrosoft ProjectGestione progetti

VYM (View Your Mind), Free
Mind, KDissert

MindManager, Free MindMappe mentali
(Mind Mapping)

FreeMind
FreeMind consente di visualizzare i pensieri tramite la creazione e la modifica di
una mappa mentale. È possibile copiare nodi o lo stile dei nodi e incollare testi da
fonti quali HTML, RTF e messaggi e-mail. Le mappe mentali sono esportabili in
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vari formati quali HTML e XML. Per ulteriori informazioni, fare riferimento a
http://freemind.sourceforge.net/wiki/index.php/Main_Page.

GnuCash
GnuCash è un applicativo per il controllo delle finanze personali e professionali.
Per ulteriori informazioni su GnuCash, consultarehttp://www.gnucash.org.

Gnumeric
Gnumeric è un foglio di calcolo per l'ambiente desktop GNOME. Per ulteriori
informazioni su Gnumeric, consultare http://www.gnumeric.org.

Gnuplot
Gnuplot è un software a riga di comando per la creazione di grafici e l'elaborazione
dei dati molto potente e portabile. È disponibile anche per le piattaforme MacOS
e Windows. I tracciati creati da Gnuplot sono esportabili in vari formati, come
PostScript, PDF e SVG, agevolandone l'elaborazione. Per ulteriori informazioni
su Gnuplot, consultare http://www.gnuplot.info/index.html.

Grace
Grace è un vecchio strumento per i grafici in 2D disponibile per tutti i tipi di
piattaforme Unix, tra cui Linux. Consente di creare e modificare tracciati con
un'interfaccia utente grafica. Grace supporta un numero illimitato di grafici per
tracciato. Tra i formati di esportazione vi sono JPEG, PNG, SVG, PDF, PS, e EPS.
Per ulteriori informazioni, vedere http://plasma-gate.weizmann.ac
.il/Grace/.

Kdissert
Kdissert è un'applicazione per strutturare idee e concetti, appositamente studiata
per gli studenti ma utile anche per insegnanti, decision maker, ingegneri e uomini
d'affari. Le idee vengono messe su un'area di disegno e poi associate nella struttura
ad albero. È possibile generare diversi output dalla mappa mentale quali file PDF,
documenti di testo (anche per OpenOffice.org Writer) e file HTML. Per ulteriori
informazioni, vedere http://freehackers.org/~tnagy/kdissert/.

kexi .
Vedere KOffice (p. 340).

KMyMoney
KMyMoney è un gestore finanziario personale per KDE. Consente agli utenti di
sistemi operativi open source di tenere traccia delle proprie finanze fornendo una
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vasta gamma di funzioni e strumenti finanziari. Per ulteriori informazioni su
KMyMoney, consultare http://kmymoney2.sourceforge.net.

KOffice
KOffice è una suite per l'ufficio integrata per l'ambiente desktop KDE. In dotazione
ha vari moduli come il programma di elaborazione testi (KWord), il foglio di
calcolo, (KSpread), il programma per le presentazioni (KPresenter), diverse
applicazioni per l'elaborazione delle immagini (Kivio, Karbon14, Krita), un
programma front-end per i database (Kexi) e molti altri. Per ulteriori informazioni
su KOffice, consultare http://www.koffice.org/.

KPresenter
Vedere KOffice (p. 340).

Kst
Kst è un'applicazione KDE per la visualizzazione e l'elaborazione dei dati in tempo
reale con la funzionalità di base di analisi dei dati. Kst contiene molte funzioni
potenti quali l'elaborazione efficace di dati live streaming e può essere ampliato
con plug-in ed estensioni. Per ulteriori informazioni su Kst, consultare http://
kst.kde.org/.

KWord
Vedere KOffice (p. 340).

LabPlot
LabPlot è un programma per la creazione e la gestione di tracciati bi o tri-
dimensionali. I grafici possono essere generati sia da dati, sia da funzioni, mentre
un tracciato può contenere più grafici. Inoltre, offre vari metodi di analisi dei dati.
Per ulteriori informazioni su LabPlot, vederehttp://labplot.sourceforge
.net/.

Mergeant
Mergeant è un programma front-end per l'ambiente desktop GNOME. Per ulteriori
informazioni, vedere http://www.gnome-db.org.

Openoffice.org
Openoffice.org è il programma open source equivalente a Microsoft Office. Si
tratta di una suite per l'ufficio molto potente tra cui un programma di elaborazione
testi (Write), un foglio di calcolo (Calc), un programma di gestione dei database
(Base), un programma di gestione delle presentazioni (Impress), un programma
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per il disegno (Draw) è un editor di formule per la generazione di equazioni e
formule matematiche (Math). Gli utenti della famiglia di applicazioni Microsoft
Office troveranno un'interfaccia molto simile e tutte le funzionalità a cui sono
abituati. Dal momento che OpenOffice.org è in grado di importare dati dalle
applicazioni Microsoft Office, la transizione da una suite all'altra non pone grandi
ostacoli. Esiste anche una versione per Windows di OpenOffice.org consentendo
così agli utenti Windows di passare a un'alternativa open source restando nello
stesso sistema operativo. Per ulteriori informazioni su OpenOffice.org, vedere
http://www.openoffice.org/ e consultare il capitolo dedicato a
OpenOffice.org per una breve introduzione alla suite per l'ufficio.

Planner
Planner è uno strumento di gestione dei progetti per il desktop GNOME che fornisce
funzionalità simili agli strumenti equivalenti utilizzati in ambiente Windows. Tra
le varie funzioni vi sono la possibilità di creare grafici Gantt, diversi tipi di
visualizzazioni di task e risorse. Per ulteriori informazioni su Planner, consultare
http://www.imendio.com/projects/planner/.

PostgreSQL
PostgreSQL è un sistema per la gestione di database relazionali che supporta un
sottoinsieme esteso dello standard SQL, incluso transazioni, chiavi esterne,
sottoquery, trigger e tipi e funzioni personalizzati. Per ulteriori informazioni su
PostgreSQL, consultare http://www.postgresql.org/.

Rekall
Rekall è uno strumento per l'elaborazione di database. Tra i formati di database
supportati vi sono MySQL, PostgreSQL, XBase con XBSQL, IBM DB2 e ODBC.
Con Rekall è possibile generare diversi tipi di report e formulari, progettare
interrogazioni ai database e importare/esportare dati in vari formati. Per ulteriori
informazioni su Rekall, consultare http://www.thekompany.com/
products/rekall/.

StarOffice
StarOffice è una versione proprietaria di OpenOffice.org ed è distribuita da Sun
Microsystems. È disponibile su più piattaforme tra cui Windows e Solaris. Include
alcune caratteristiche avanzate non disponibili nella versione gratuita
(OpenOffice.org). Per ulteriori informazioni su StarOffice, consultare http://
www.sun.com/software/star/staroffice/.
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Taskjuggler
Taskjuggler è uno software di gestione dei progetti semplice, ma molto potente.
Controlla i progetti tramite le funzionalità dei grafici Gantt o generando tutti i tipi
di report (in formato XML, HTML o CSV). Gli utenti che non sono pratici dell'uso
delle applicazioni da riga di comando possono utilizzare un'interfaccia grafica per
Taskjuggler. Per ulteriori informazioni su Taskjuggler, consultare http://www
.taskjuggler.org.

VYM (View Your Mind)
VYM è un software per la visualizzazione dei pensieri tramite la creazione e
l'elaborazione di mappe mentali. La maggior parte di queste elaborazioni richiede
solo un clic del mouse. È possibile inserire, eliminare o riordinare i rami in maniera
molto semplice. VYM offre anche un insieme di flag che consentono di
contrassegnare determinate parti della mappa (importante, time-critical e via
dicendo). A una mappa mentale è possibile aggiungere anche collegamenti, note
e immagini. Le mappe mentali di VYM utilizzano un formato XML, consentendo
una facile esportazione al formato HTML. Per ulteriori informazioni su VYM,
consultare http://www.insilmaril.de/vym.

C.2 Rete
Nella sezione seguente sono descritte le applicazioni Linux per la connettività tramite
rete. Di seguito la presentazione dei più popolari browser, client di posta elettronica e
di chat per l'ambiente Linux.

Tabella C.2 Software per la rete per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

Konqueror, Firefox, Opera,
Epiphany

Internet Explorer, Firefox*,
Opera

Browser Web

Evolution, Kontact, Mozilla
Thunderbird

Microsoft Outlook*, Lotus
Notes, Mozilla
Thunderbird*

Client posta
elettronica/Gestione
contatti personali

Gaim, Kopete,
Konversation, XChat

MSN, AIM*, Yahoo!*
Messenger, XChat, Gaim

Messaggistica
istantanea/Client IRC
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Applicazione LinuxApplicazione WindowsCompito

Ekiga (già GnomeMeeting)NetMeetingConferenze (video e
audio)

Linphone, SkypeX-LiteVoice over IP

gftp, kbearleechftp, wsftpClient FTP

Ephiphany
Epiphany è un browser Web semplice, ma potente per l'ambiente desktop GNOME.
Molte sue funzioni ed estensioni ricordano quelle di Firefox. Per ulteriori
informazioni su Epiphany, consultarehttp://www.gnome.org/projects/
epiphany/.

Evolution
Evolution è un software per la gestione dei contatti personali per l'ambiente desktop
GNOME che riunisce funzionalità di posta elettronica, calendario e rubrica. Offre
opzioni avanzate di filtro e ricerca per la posta elettronica, dispone di funzioni di
sincronizzazione per i dispositivi Palm e consente l'esecuzione di Evolution in
qualità di client Exchange o Groupwise® per una migliore integrazione in ambienti
eterogenei. Per ulteriori informazioni su Evolution, vedere http://www.gnome
.org/projects/evolution/.

Firefox
Firefox è il membro più giovane della famiglia di browser Mozilla. È disponibile
per diverse piattaforme, tra cui Linux, MacOS e Windows. Tra le funzioni principali:
ricerca incorporata personalizzabile, blocco dei pop-up, feed di notizie RSS, gestione
parola d'ordine, navigazione a schede e alcune opzioni avanzate per la sicurezza e
la privacy. Firefox è molto flessibile e consente di personalizzare praticamente
tutto (ricerche, barre degli strumenti, skin, pulsanti e così via). Dal sito Web di
Firefox (https://addons.update.mozilla.org/?application=
firefox) possono essere scaricate aggiunte ed estensioni semplici e precise. Per
ulteriori informazioni su Firefox, vedere http://www.mozilla.org/
products/firefox/. È inoltre possibile leggere il capitolo Firefox in Guida
per l'utente KDE o Guida per l'utente di GNOME.
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Gaim
Gaim è un programma di messaggistica istantanea che supporta più protocolli,
come AIM e ICQ (protocollo Oscar), MSN Messenger, Yahoo!, IRC, Jabber, SILC
e GroupWise Messenger®. Consente di accedere a diversi account su reti IM diverse
e a diversi canali di chat contemporaneamente. Gaim dispone anche di una versione
per Windows. Gaim è stato recentemente rinominato Pidgin. Ulteriori informazioni
su Pidgin sono disponibili in http://www.pidgin.im/.

gftp
gftp è un client FTP che utilizza il toolkit GTK. Alcune sue caratteristiche:
scaricamenti simultanei, ripristino di trasferimenti file interrotti, code di
trasferimento file, scaricamento di intere directory, supporto FTP proxy,
memorizzazione cache delle directory remote, trasferimento file passivo e non
passivo e funzione trascina e incolla. Per ulteriori informazioni, vedere http://
gftp.seul.org.

kbear
KBear è un client FTP per KDE in grado di stabilire connessioni contemporanee
a più host, inoltre dispone di tre modalità distinte di visualizzazione, del supporto
per più protocolli (come ftp, sftp e così via), di un plug-in per la gestione dei siti,
del supporto per i firewall, di funzionalità di login e molto altro. Per ulteriori
informazioni, vedere http://sourceforge.net/projects/kbear.

KonquerorKonqueror
Konqueror è un'applicazione dalle mille caratteristiche creata dagli sviluppatori di
KDE. È in pratica un file manager e un visualizzatore di documenti, ma anche un
browser Web molto potente e altamente personalizzabile. Supporta gli standard
Web correnti, come CSS(2), applet Java, plug-in JavaScript e Netscape (Flash e
RealVideo), DOM e SSL. Offre strumenti di aiuto semplici e precisi, come la barra
di ricerca integrata, e supporta la navigazione a schede. È possibile l'importazione
dei bookmark (o preferiti) da vari tipi di browser, come Internet Explorer, Mozilla
e Opera. Per ulteriori informazioni su Konqueror, vedere http://www
.konqueror.org/. È inoltre possibile leggere il capitolo su Konqueror come
browser Web in Guida per l'utente KDE.

Kontact
Kontact è la suite per la gestione dei contatti personali di KDE. Offre funzionalità
di posta elettronica, calendario, rubrica e sincronizzazione con i dispositivi Palm.
Come Evolution, può agire come client Exchange o GroupWise. Kontact riunisce
diverse applicazioni indipendenti KDE (KMail, KAddressbook, KOrganizer e
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KPilot) per formare un'entità in grado di fornire tutte le necessarie funzionalità per
la gestione dei contatti. Per ulteriori informazioni su Kontact, vedere http://
www.kontact.org/. È inoltre possibile leggere l'introduzione su Kontact
disponibile in Guida per l'utente KDE.

Konversation
Konversation è un client IRC per KDE di facile utilizzo. Tra le sue caratteristiche
vi sono: supporto per le connessioni SSL, caratteri barrati, multicanalità, messaggi
di presenza e di assenza, elenco di utenti ignorati, Unicode, autoconnessione a un
server, indicazione facoltativa di data e ora nelle finestre della chat e colori di
sfondo configurabili. Per ulteriori informazioni su Konversation, consultare
http://konversation.kde.org.

Kopete
Kopete è un programma per la messaggistica istantanea molto intuitivo e di semplice
utilizzo che supporta diversi protocolli tra cui IRC, ICQ, AIM, GroupWise
Messenger, Yahoo, MSN, Gadu-Gadu, Lotus Sametime, messaggi SMS e Jabber.
Per ulteriori informazioni su Kopete, vedere http://kopete.kde.org/. È
inoltre possibile leggere l'introduzione su Kopete disponibile in Guida per l'utente
KDE.

Linphone
Linphone è un client Voice over IP brillante e semplice che effettua chiamate
utilizzando il protocollo SIP. Per ulteriori informazioni, vedere http://www
.linphone.org/. È inoltre possibile leggere il capitolo su Linphone.

Mozilla Thunderbird
Thunderbird è un client di posta elettronica che fa parte della suite di Mozilla. È
disponibile anche per Microsoft Windows e MacOS, cosa che facilita la transizione
a Linux da parte degli utenti di questi sistemi operativi. Per ulteriori informazioni
su Mozilla Thunderbird, consultarehttp://www.mozilla.org/products/
thunderbird/.

Opera
Opera è un potente browser Web con funzioni aggiuntive semplici e precisi come
un client di posta elettronica facoltativo e un modulo per le chat. Inoltre, offre
funzioni come blocco dei pop-up, feed RSS, ricerche incorporate e personalizzabili,
gestione delle parole d'ordine e navigazione a schede. Le principali funzionalità
sono facilmente raggiungibili tramite i rispettivi pannelli. Dal momento che questo
strumento è disponibile anche per Windows, per gli utenti di quella piattaforma
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che già lo conoscono, la transizione a Linux sarà molto più agevole. Per ulteriori
informazioni su Opera, consultare http://www.opera.com/.

Skype
Skype è un'applicazione per diverse piattaforme (Linux, Windows, Mac Os X) che
può essere utilizzata per chiamate tramite Internet con una buona qualità del suono
e cifratura di tipo end-to-end. Quando si utilizza Skype, non è necessario configurare
il firewall o il router. Per ulteriori informazioni, fare riferimento a http://www
.skype.com/.

XChat
XChat è un client IRC disponibile per la maggior parte delle piattaforme Linux e
UNIX, nonché per Windows e MacOS X. Per ulteriori informazioni su XChat,
consultare http://www.xchat.org/.

C.3 Multimedia
La sezione seguente presenta le più diffuse applicazioni multimediali per Linux. Di
seguito, la presentazione di lettori di contenuti multimediali, soluzioni per l'editing
audio e di strumenti per l'editing video.

Tabella C.3 Software multimediale per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

KsCD, Grip, Helix BansheeCD Player, Winamp,
Windows Media Player

Lettore CD audio

K3bNero, Roxio Easy CD CreatorProgramma di
masterizzazione

kaudiocreator, Sound Juicer,
Helix Banshee

WMPlayerEstrazione audio da
CD

amaroK, XMMS,
Rhythmbox, Helix Banshee

Winamp, Windows Media
Player, iTunes

Lettore audio
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Applicazione LinuxApplicazione WindowsCompito

Kaffeine, MPlayer, Xine,
XMMS, Totem, RealPlayer

Winamp, Windows Media
Player

Lettore video

AudacitySoundForge, Cooledit,
Audacity

Editor audio

alsamixer, Kmixsndvol32Mixer suoni

LilyPond, MusE, Noteedit,
Rosegarden

Finale, SmartScore, SibeliusNotazione musicale

MainActor, KinoWindows Movie Maker,
Adobe Premiere, Media
Studio Pro, MainActor

Creazione ed editing
video

xawtv (analogico), motv
(analogico), xawtv4, tvtime,
kdetv, zapping, Kaffeine

AVerTV, PowerVCR 3.0,
CinePlayer DVR

Visualizzatore TV

amaroK
Il lettore multimediale amaroK consente di gestire diversi formati audio e di
riprodurre le trasmissioni audio in streaming di stazioni radio su Internet. Il
programma gestisce tutti i tipi di file supportati dal server audio che svolge il ruolo
di backend, attualmente aRts o GStreamer. Per ulteriori informazioni su amaroK,
vedere http://amarok.kde.org/. È inoltre possibile leggere l'introduzione
su amaroK disponibile in Guida per l'utente KDE.

Audacity
Audacity è un potente strumento gratuito di editing audio. Registra, modifica e
riproduce qualsiasi file Ogg Vorbis o WAV. Esegue il mixaggio di brani, applicando
effetti speciali ed esportando i risultati in formato WAV o Ogg Vorbis. Per ulteriori
informazioni su Audacity, vederehttp://audacity.sourceforge.net/.

Helix Banshee
Helix Banshee è un'applicazione per la gestione e la riproduzione di brani musicali
per il desktop GNOME. Helix Banshee consente di importare CD, sincronizzare
le raccolte musicali su un iPod, riprodurre brani musicali direttamente da un iPod,
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creare playlist inserendovi brani tratti dalla propria libreria. Per ulteriori informazioni
fare riferimento a Guida per l'utente di GNOME.

Grip
Grip offre funzionalità di lettore CD per l'ambiente desktop GNOME. Supporta le
ricerche su database CDDB per brani e album. Per ulteriori informazioni, vedere
http://www.nostatic.org/grip/.

kaffeine
Kaffeine è un'applicazione multimediale versatile che supporta un'ampia gamma
di formati audio e video, tra cui Ogg Vorbis, WMV, MOV e AVI. Importa e
modifica playlist di vari tipi, crea screenshot e salva flussi di streaming sul disco
rigido locale. Per ulteriori informazioni su Kaffeine, consultare http://
kaffeine.kde.org/.

KAudiocreator
KAudioCreator è un'applicazione per la copia di CD. Se opportunamente
configurato, KAudioCreator consente inoltre di generare file di playlist a partire
dalla selezione. è possibile utilizzare tali playlist con altri lettori, ad esempio
amaroK, XMMS o Helix Banshee. Ulteriori informazioni sull'utilizzo di
KAudioCreator sono disponibili in Guida per l'utente KDE o visitare http://
www.icefox.net/programs/?program=KAudioCreator.

kdetv
Un visualizzatore e un registratore di canali analogici TV per l'ambiente desktop
KDE. Per ulteriori informazioni su kdetv, consultare http://kde-apps.org/
content/show.php?content=11602.

KsCD
KsCD è un lettore CD piccolo e semplice per l'ambiente desktop KDE. La sua
interfaccia utente somiglia molto a quella di un normale lettore CD hardware,
garantendo così facilità d'uso. KsCD supporta i database CDDB, consentendo di
recuperare qualsiasi informazione su brano e album sia da Internet sia da un file
system locale. Per ulteriori informazioni, vedere http://docs.kde.org/en/
3.3/kdemultimedia/kscd/.

K3b
K3b è uno strumento di creazione supporti dalle mille caratteristiche. Crea progetti
dati, audio, CD video e DVD semplicemente trascinando e incollando i file. Per
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ulteriori informazioni su K3b, vederehttp://www.k3b.org/. È anche possibile
fare riferimento al capitolo su K3b.

LilyPond
LilyPond è un editor gratuito per la notazione musicale. Dal momento che il formato
di immissione è testuale, per creare le partiture è possibile utilizzare qualsiasi editor
di testo. Gli utenti non dovranno far fronte ad alcuna problematica legata alla
formattazione o alla notazione, come la spaziatura, l'interruzione di riga o le
collisioni polifoniche. Tutte queste problematiche vengono risolte automaticamente
da LilyPond. Supporta molte notazioni speciali come i nomi degli accordi e le
tablature. Il risultato può essere esportato in formato PNG, TeX, PDF, PostScript
e MIDI. Per ulteriori informazioni su LilyPond, consultare http://lilypond
.org/web/.

MainActor
MainActor è un software di creazione video veramente completo. Dal momento
che esiste una versione per Windows, la transizione da quel sistema operativo sarà
facile. Per ulteriori informazioni su MainActor, consultare http://www
.mainactor.com/.

MPlayer
MPlayer è un lettore di filmati che viene eseguito su diversi sistemi. Per ulteriori
informazioni su MPlayer, vederehttp://www.mplayerhq.hu/homepage/
design7/info.html.

MusE
Lo scopo di MusE è di essere uno studio virtuale multitraccia completo per Linux.
Per ulteriori informazioni su MusE, consultarehttp://www.muse-sequencer
.org/index.php.

Noteedit
Noteedit è un potente editor di spartiti per Linux. Utilizzato per creare partiture e
per esportare e importare spartiti da e verso molti formati, come MIDI, MusicXML
e LilyPond. Per ulteriori informazioni su Noteedit, consultare http://
developer.berlios.de/projects/noteedit/.

Rhythmbox
Rhythmbox è un potente lettore multimediale dalle mille caratteristiche per
l'ambiente desktop GNOME. Consente l'organizzazione e la navigazione nella
collezione di brani musicali tramite l'utilizzo di playlist e supporta anche la radio
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via Internet. Per ulteriori informazioni su Rhythmbox, consultare http://www
.gnome.org/projects/rhythmbox/.

Rosegarden
Rosegarden è un ambiente gratuito per la composizione e l'editing musicale.
Contiene un sequencer audio e MIDI e un editor di spartiti. Per ulteriori informazioni
su Rosegarden, consultare http://rosegardenmusic.com/.

Sound Juicer
Sound Juicer è una semplice applicazione di estrazione per CD audio per l'ambiente
desktop GNOME. Per ulteriori informazioni su Sound Juicer, consultare http://
www.burtonini.com/blog/computers/sound-juicer.

Totem
Totem è un'applicazione per la riproduzione dei filmati per l'ambiente desktop
GNOME. Supporta le playlist Shoutcast, m3u, asx, SMIL e ra, consente l'utilizzo
di controlli da tastiera e riproduce un'ampia gamma di formati audio e video. Per
ulteriori informazioni su Totem, consultare http://www.gnome.org/
projects/totem/.

tvtime
tvtime è una semplice applicazione per la visualizzazione di canali TV analogici.
Per ulteriori informazioni su tvtime, compresa una guida d'uso completa, consultare
http://tvtime.sourceforge.net/.

xawtv e motv
xawtv è un visualizzatore e registratore di programmi TV che per canali analogici.
motv è praticamente uguale a xawtv, ma presenta un'interfaccia utente leggermente
diversa. Per ulteriori informazioni sul progetto xawtv, consultare http://linux
.bytesex.org/xawtv/.

xawtv4
xawtv4 è il successore dell'applicazione xawtv. Supporta le trasmissioni audio e
video sia analogiche, sia digitali. Per ulteriori informazioni, fare riferimento a
http://linux.bytesex.org/xawtv/.

Xine
Xine è un lettore multimediale che riproduce CD, DVD e VCD. È in grado di
leggere molti formati multimediali. Per ulteriori informazioni, fare riferimento a
http://xinehq.de/.
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XMMS
XMMS è la soluzione tradizionale per la riproduzione di contenuti multimediali.
Si concentra soprattutto sulla riproduzione musicale e supporta CD audio e file
Ogg Vorbis. Gli utenti di Winamp dovrebbero essere agevolati a causa delle
somiglianze con XMMS. Per ulteriori informazioni su XMMS, vedere http://
www.xmms.org/.

zapping
Un visualizzatore e un registratore di canali analogici TV per l'ambiente desktop
GNOME. Per ulteriori informazioni su Zapping, consultare http://zapping
.sourceforge.net/Zapping/index.html.

C.4 Immagini
La seguente sezione presenta alcune applicazioni Linux per l'elaborazione delle
immagini. Tra queste vi sono semplici applicazioni per il disegno, nonché strumenti
completi per l'editing delle immagini e potenti programmi per il rendering e l'animazione.

Tabella C.4 Software per l'elaborazione delle immagini per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

KolourPaintMicrosoft PaintSemplice editing delle
immagini

The GIMP, KritaAdobe Photoshop, Paint Shop
Pro, Corel PhotoPaint, The
GIMP

Editing professionale
delle immagini

OpenOffice.org Draw,
Inkscape, Dia

Adobe Illustrator, CorelDraw,
OpenOffice.org Draw, Free-
hand

Creazione di immagini
vettoriali

Inkscape, Dia, KivioWebDraw, Freehand, Adobe
Illustrator

Editing di file SVG

POV-Ray, Blender,
KPovmodeler

3D Studio MAX, Maya,
POV-Ray, Blender

Creazione di immagini
3D
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Applicazione LinuxApplicazione WindowsCompito

Digikam, f-spotSoftware fornito dal
produttore della fotocamera

Gestione fotografie
digitali

Vuescan, The GIMPVuescanAcquisizione con scanner

gwenview, gThumb, Eye
of Gnome, f-spot

ACDSeeVisualizzazione immagini

Blender
Blender è uno strumento per il rendering e l'animazione disponibile su molte
piattaforme, tra cui Windows, MacOS e Linux. Per ulteriori informazioni su Blender,
consultare http://www.blender3d.com/.

Dia
Dia è un'applicazione Linux che si propone come l'equivalente di Visio. Supporta
molti tipi di diagrammi speciali, come i grafici UML o di rete. I formati di
esportazione sono SVG, PNG e EPS. Fornisce nuove forme in uno speciale formato
XML, per supportare i tipi di diagramma personalizzati. Per ulteriori informazioni
su Dia, consultare http://www.gnome.org/projects/dia/.

DigiKam
Digikam è un brillante strumento per la gestione delle foto DIGITALI per l'ambiente
desktop KDE. L'importazione e l'organizzazione delle immagini digitali si risolve
in pochi clic. Crea album, aggiunge tag per far risparmiare all'utente la copia delle
immagini contenute in diverse sottocartelle e infine esporta le immagini sui siti
Web. Per ulteriori informazioni su Digikam, vedere http://www.digikam
.org/. È inoltre possibile consultare il capitolo DigiKam in Guida per l'utente
KDE.

Eye of Gnome (eog)
Eye of Gnome è un visualizzatore di immagini per il desktop GNOME. Per ulteriori
informazioni, vedere http://www.gnome.org/projects/eog/.

f-spot
f-spot è uno strumento flessibile per la gestione delle fotografie digitali per
l'ambiente desktop GNOME. Consente di creare e gestire album e supporta varie
opzioni di esportazione come le pagine HTML o la masterizzazione su CD degli
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archivi di immagini. È inoltre possibile utilizzarlo come visualizzatore di immagini
sulla riga di comando. Per ulteriori informazioni su f-spot, vedere http://www
.gnome.org/projects/f-spot/. È inoltre possibile consultare l'apposito
capitolo in Guida per l'utente KDE.

gThumb
gThumb è un programma per la visualizzazione, la navigazione e l'organizzazione
di immagini per l'ambiente desktop GNOME. Supporta l'importazione delle
immagini digitali tramite gphoto2, consente di eseguire trasformazioni e modifiche
e di apporre tag alle immagini per la creazione di album che corrispondono a
determinate categorie. Per ulteriori informazioni su gThumb, consultare http://
gthumb.sourceforge.net/.

Gwenview
Gwenview è un semplice visualizzatore di immagini per KDE. Presenta una finestra
a struttura ad albero e una finestra con un elenco di file che consente una facile
navigazione nella gerarchia dei file. Per ulteriori informazioni, vedere http://
gwenview.sourceforge.net/home/.

Inkscape
Inkscape è un editor SVG gratuito. Gli utenti di Adobe Illustrator, Corel Draw e
Visio potranno trovarvi molte somiglianze tra le funzioni e un'interfaccia utente
familiare. Tra le sue funzioni: l'esportazione da SVG a PNG, livelli, trasformazioni,
gradienti, gruppi di oggetti. Per ulteriori informazioni su Inkscape, consultare
http://www.inkscape.org/.

Kivio
Kivio è un'applicazione per i diagrammi di flusso integrata nella suite KOffice. Gli
utenti di Visio troveranno un look familiare in questo programma. Per ulteriori
informazioni su Kivio, consultare http://www.koffice.org/kivio/.

KolourPaint
KolourPaint è un programma di pittura di facile utilizzo per il desktop KDE. È
possibile utilizzarlo per task quali la pittura o il disegno di diagrammi e la modifica
di screenshot, fotografie e icone. Per ulteriori informazioni, fare riferimento a
http://kolourpaint.sourceforge.net/.

KPovmodeler
KPovmodeler è un'interfaccia per POV-Ray integrata nell'ambiente desktop KDE.
Traducendo il linguaggio POV-Ray in una visualizzazione ad albero di facile
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comprensione, KPovmodeler risparmia all'utente l'apprendimento dello scripting
tipico di quel programma. Gli script nativi di POV-Ray possono essere anche
importati in KPovmodeler. Per ulteriori informazioni, vedere http://www
.kpovmodeler.org.

Krita
Krita è la risposta di KOffice ad Adobe Photoshop e a The GIMP. Può essere
utilizzato per la creazione e l'editing delle immagini basate su pixel. Tra le sue
caratteristiche vi sono molte funzionalità per l'editing avanzato delle immagini che
ci si aspetterebbe di trovare in Adobe Photoshop o The GIMP. Per ulteriori
informazioni, vedere http://www.koffice.org/krita.

Disegno OpenOffice.org
Vedere Openoffice.org (p. 340).

POV-Ray
Il programma Persistence of Vision Raytracer crea immagini tridimensionali,
realistiche di qualità fotografica utilizzando una tecnica di rendering chiamata ray
tracing. Dal momento che esiste una versione per Windows di POC-Ray, gli utenti
della versione Windows non dovranno faticare molto per passare alla versione
Linux. Per ulteriori informazioni su POV-Ray, consultare http://www.povray
.org/.

The Gimp Gimp
The GIMP è l'alternativa open source ad Adobe Photoshop. L'elenco delle sue
funzioni rivaleggia con quello di Photoshop, per questo motivo è adatto alla
elaborazione delle immagini di tipo professionale. È disponibile anche una versione
per Windows. Per ulteriori informazioni, vedere http://www.gimp.org/. È
anche possibile fare riferimento al capitolo su GIMP.

VueScan
VueScan è un software di scansione disponibile per diverse piattaforme. È possibile
installarlo in parallelo al software del proprio scanner. Supporta l'hardware speciale
dello scanner, ad esempio la scansione a batch, l'autofocus, i canali infrarossi per
l'eliminazione della polvere e dei graffi, oltre al multiscan per ridurre l'interferenza
dello scanner nelle zone scure delle diapositive. È dotato di funzioni per la
correzione del colore semplice e precisa da negativi a colori. Per ulteriori
informazioni, vedere http://www.hamrick.com/index.html.
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C.5 Gestione del sistema e gestione
dei file

La seguente sezione fornisce una panoramica sugli strumenti di Linux per la gestione
del sistema e dei file. Di seguito, la presentazione di editor di testo e di codice sorgente,
soluzioni di backup e strumenti di archiviazione.

Tabella C.5 Software per la gestione del sistema e dei file per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

Konqueror, NautilusEsplora risorseFile manager

kate, GEdit, (X)Emacs,
vim

NotePad, WordPad,
(X)Emacs

Editor di testo

ScribusAdobe DistillerCreazione di file PDF

Adobe Reader, Evince,
KPDF, Xpdf

Adobe ReaderVisualizzatore di file PDF

GOCRRecognita, FineReaderRiconoscimento di testo

zip, tar, gzip, bzip2 e via
dicendo

zip, rar, arj, lha e via
dicendo

Programmi a riga di comando
per la compressione dei file

Ark, File RollerWinZipProgrammi con interfaccia
utente per la compressione
dei file

YaST, GNU PartedPowerQuest, Acronis,
Partition Commander

Partizionamento dei dischi
rigidi

KDar, taper, dumpntbackup, VeritasSoftware per il backup

Adobe Reader
Adobe Reader per Linux è l'esatto equivalente delle versioni Windows e Linux di
questa applicazione. L'aspetto del programma per Linux è uguale alla corrispondente
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versione per altre piattaforme. Le altre componenti della suite Adobe Acrobat non
sono state portate su Linux. Per ulteriori informazioni, vedere http://www
.adobe.com/products/acrobat/readermain.html.

Ark
Ark è un programma di compressione basata su interfaccia utente grafica per il
desktop KDE. che supporta molti formati comuni, ovverozip,tar.gz,tar.bz2,
lha e rar. È possibile visualizzare, selezionare, comprimere e decomprimere file
in un archivio. Grazie all'integrazione di Ark con Konqueror, è possibile inoltre
generare azioni (ad esempio la decompressione di un archivio) dal menu contestuale
nel file manager, in modo analogo a WinZip. Per una breve introduzione sull'utilizzo
di Ark, consultare il capitolo sul desktop KDE disponibile in Guida per l'utente
KDE.

dump
Il pacchetto di dump contiene sia dump, sia restore. dump esamina i file di un file
system, determina quali debbano essere sottoposti a backup e li copia in una
posizione specificata su disco, nastro o altro supporto di archiviazione. Il comando
restore esegue l'operazione inversa di dump ed è in grado di ripristinare il backup
completo di un file system. Per ulteriori informazioni, vedere http://dump
.sourceforge.net/.

Evince
Evince è un visualizzatore di documenti per i formati PDF e PostScript per
l'ambiente desktop GNOME. Per ulteriori informazioni, vedere http://www
.gnome.org/projects/evince/.

File Roller
File Roller è un programma di compressione basato su interfaccia utente grafica
per il desktop GNOME. che fornisce funzionalità analoghe a quelle di Ark. Per
ulteriori informazioni, fare riferimento ahttp://fileroller.sourceforge
.net/home.html.

GEdit
GEdit è l'editor di testo ufficiale dell'ambiente desktop GNOME. Fornisce
funzionalità analoghe a quelle di Kate. Per ulteriori informazioni, fare riferimento
a http://www.gnome.org/projects/gedit/.
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GNU Parted
GNU Parted è uno strumento a riga di comando per la creazione, la distruzione, il
ridimensionamento, la verifica e la copia delle partizioni e di file system al loro
interno. Se è necessario creare spazio per i nuovi sistemi operativi, occorre utilizzare
questo strumento per riorganizzare l'utilizzo del disco e copiare i dati tra dischi
rigidi diversi. Per ulteriori informazioni, vedere http://www.gnu.org/
software/parted/.

GOCR
GOCR è uno strumento OCR (optical character recognition). Dopo la scansione,
converte le immagini di testo in un file di testo. Per ulteriori informazioni, vedere
http://jocr.sourceforge.net/.

gzip, tar, bzip2
Per ridurre lo spazio disco occupato esistono molti programmi di compressione.
In generale, differiscono solo per l'algoritmo di compressione. Anche Linux può
gestire i formati di compressione utilizzati su Windows. bzip2 è un po' più
efficiente di gzipma anche più lento, in base anche all'algoritmo di compressione.
Ulteriori informazioni su gzip e tar sono disponibili nel capitolo della shell.

kate
Kate fa parte della suite di KDE. Consente di aprire diversi file contemporaneamente
sia locali, sia remoti. Grazie all'evidenziazione della sintassi,la creazione di file di
progetto e all'esecuzioni di script esterni, è uno strumento perfetto per i
programmatori. Per ulteriori informazioni, vedere http://kate.kde.org/.

KDar
Kerr è l'acronimo di KDE disk archiver ed è una soluzione di backup indipendente
dall'hardware. KDar utilizza i cataloghi (a differenza di tar), in questo modo è
possibile estrarre un singolo file senza dover leggere l'intero archivio. Inoltre, è
possibile creare backup incrementali. KDar può dividere un archivio in più parti e
avviare la masterizzazione di un CD o un DVD di dati per ognuna di queste parti.
Per ulteriori informazioni su KDar, consultare http://kdar.sourceforge
.net/.

Konqueror Konqueror
Konqueror è il file manager di default del desktop KDE che può essere utilizzato
anche come browser Web, visualizzatore di documenti e di immagini e per la copia
di CD. Per un'introduzione all'utilizzo di Konqueror come file manager, consultare
i capitoli sul desktop KDE disponibili in Guida per l'utente KDE. Per ulteriori
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informazioni su questo programma multifunzionale, vedere http://www
.konqueror.org/.

KPDF
KPDF è un visualizzatore PDF per l'ambiente desktop KDE. Tra le sue funzioni
vi sono la ricerca nei documenti PDF e la modalità di lettura a schermo intero come
in Adobe Reader. Per ulteriori informazioni, vederehttp://kpdf.kde.org/.

Nautilus
Nautilus è il file manager di default del desktop GNOME. È possibile utilizzarlo
per creare cartelle e documenti, visualizzare e gestire file e cartelle, eseguire script,
scrivere dati su un CD e aprire percorsi URI. Per un'introduzione all'utilizzo di
Nautilus come file manager, vedere Guida per l'utente di GNOME. Ulteriori
informazioni su Nautilus sono disponibili su Internet all'indirizzo http://www
.gnome.org/projects/nautilus/.

taper
Taper è un programma per il backup e il ripristino dei file con un interfaccia di
facile utilizzo per il backup e il ripristino da e verso un'unità a nastro. In alternativa,
i file possono essere salvati su file di archivio. Sono supportate le directory
selezionate in maniera ricorsiva. Per ulteriori informazioni, vederehttp://taper
.sourceforge.net/.

vim
vim (vi improved) è un programma simile all'editor di testo vi. Gli utenti potrebbero
richiedere tempo per adattarsi a vim, poiché fa distinzione tra modalità di comando
e modalità di inserimento. Le caratteristiche di base sono le stesse di tutti gli editor
di testo. vim offre alcune opzioni speciali, come registrazione di macro, rilevamento
e conversione del formato di file e buffer multipli in una schermata. Per ulteriori
informazioni, vedere http://www.vim.org/.

(X)Emacs
GNU Emacs e XEmacs sono editor molto professionali. XEmacs è basato su GNU
Emacs. Da una citazione del manuale di GNU Emacs: "Emacs è l'editor in tempo
reale visuale, estensibile, personalizzabile e autodocumentante." Entrambi offrono
quasi le stesse funzionalità con piccole differenze. Utilizzati da esperti sviluppatori,
sono altamente estensibili grazie al linguaggio Emacs Lisp. Supportano molte
lingue, tra cui russo, greco, giapponese, cinese e coreano. Per ulteriori informazioni,
vederehttp://www.xemacs.org/ ehttp://www.gnu.org/software/
emacs/emacs.html.

358 Guida per l'utente KDE

http://www.konqueror.org/
http://www.konqueror.org/
http://kpdf.kde.org/
http://www.gnome.org/projects/nautilus/
http://www.gnome.org/projects/nautilus/
http://taper.sourceforge.net/
http://taper.sourceforge.net/
http://www.vim.org/
http://www.xemacs.org/
http://www.gnu.org/software/emacs/emacs.html
http://www.gnu.org/software/emacs/emacs.html


Xpdf
Xpdf è una semplice suite di visualizzazione per le piattaforme Linux e Unix.
Comprende un visualizzatore e alcuni plug-in di esportazione per i formati PostScript
e di testo. Per ulteriori informazioni, vedere http://www.foolabs.com/
xpdf/.

C.6 Sviluppo di software
Questa sezione presenta gli IDE, i toolkit, gli strumenti di sviluppo e i sistemi di
versioning per lo sviluppo di software professionale sotto Linux.

Tabella C.6 Software di sviluppo per Windows e Linux

Applicazione LinuxApplicazione WindowsCompito

KDevelop, Eric, Eclipse,
MonoDevelop, Anjuta

Borland C++, Delphi, Visual
Studio, .NET

Ambienti di sviluppo
integrato (IDE)

Qt, GTK+MFC, Qt, GTK+Toolkit

GCCVisualStudioCompilatori

GDB, valgrindVisual StudioStrumenti per il
debugging

Glade, Qt DesignerVisual Basic, Visual C++Progettazione di GUI

CVS, SubversionClearcase, Perforce,
SourceSafe

Sistemi di versioning

Anjuta
Anjuta è un IDE per lo sviluppo di applicazioni GNOME/GTK+. Contiene un editor
con formattazione automatica, completamento ed evidenziazione del codice. Come
GTK+, supporta lo sviluppo per i linguaggi Perl, Pascal e Java. È incluso anche
uno strumento per il debugging basato su GDB. Per ulteriori informazioni su Anjuta,
consultare http://anjuta.sourceforge.net.
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CVS
CVS, Concurrent Versions System, è uno dei più importanti sistemi di controllo
delle versioni per l'open source. È un'interfaccia per il Revision Control System
(RCS) inclusa nelle distribuzioni standard di Linux. Per ulteriori informazioni,
vedere http://ximbiot.com/cvs/wiki/.

Eclipse
La piattaforma Eclipse è progettata per la creazione di ambienti di sviluppo integrati
estensibili con plug-in personalizzati. La distribuzione di base contiene anche un
ambiente di sviluppo Java completamente accessoriato. Per ulteriori informazioni,
vedere http://www.eclipse.org.

Eric
Eric è un IDE ottimizzato per lo sviluppo in Python e Python-Qt. Per ulteriori
informazioni su Eric, consultarehttp://www.die-offenbachs.de/eric/
index.html.

GCC
GCC è una collezione di compilatori con un'interfaccia per vari linguaggi di
programmazione. A questo indirizzo http://gcc.gnu.org è disponibile un
elenco completo di funzioni e un'esauriente documentazione.

GDB
GDB è uno strumento per il debugging per programmi scritti in vari linguaggi di
programmazione. Per ulteriori informazioni su GDB, consultare http://www
.gnu.org/software/gdb/gdb.html.

Glade
Glade è un programma per la creazione di interfacce utente per lo sviluppo su
GTK+ e GNOME. Come GTK+, supporta C, C++, C#, Perl, Python, Java e altri
linguaggi. Per ulteriori informazioni su Glade, consultarehttp://glade.gnome
.org/.

GTK+
GTK+ è un toolkit multi-piattaforma per la creazione di interfacce grafiche utente.
È utilizzato per tutte le applicazioni GNOME, The GIMP e molte altre. GTK+ è
stato progettato per supportare un'ampia gamma di linguaggi, non solo C/C++.
Originariamente era stato scritto per GIMP, da qui il nome "GIMP Toolkit." Per
ulteriori informazioni, vedere http://www.gtk.org. I limiti imposti ai
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linguaggi per GTK+ sono riepilogati all'indirizzohttp://gtk.org/features
.html#LanguageBindings.

KDevelop
KDevelop consente la scrittura di programmi in diverse lingue (C/C++, Python,
Perl e così via). Contiene un browser per la documentazione, un editor di codice
sorgente con evidenziazione della sintassi, un'interfaccia grafica per il compilatore
e molto altro. Per ulteriori informazioni, vedere http://www.kdevelop.org.

MonoDevelop
Il progetto Mono è un'iniziativa di sviluppo aperta che lavora per lo sviluppo di
una versione open source per Unix della piattaforma di sviluppo .NET. Il suo
obiettivo è di consentire agli sviluppatori Unix di creare e distribuire applicazioni
.NET funzionanti su più piattaforme. MonoDevelop è il complemento dello sviluppo
di Mono con un IDE. Per ulteriori informazioni su MonoDevelop, consultare
http://www.monodevelop.com/.

Qt
Qt è un programma per le applicazioni di sviluppo con interfacce grafiche. Consente
di sviluppare rapidamente programmi professionali. La libreria di Qt non è
disponibile solo per Linux, ma per un certo numero di versioni di Unix e anche per
Windows e Macintosh. In questo modo è possibile scrivere programmi facilmente
portabili su quelle piattaforme. Per ulteriori informazioni, vedere http://
trolltech.com. I limiti imposti ai linguaggi per lo sviluppo su Qt sono
riepilogati all'indirizzo http://developer.kde.org/
language-bindings/.

QT Designer
Qt Designer è un programma per la creazione di interfacce utente e moduli per lo
sviluppo su Qt e KDE. Può essere eseguito come componente dell'IDE di KDevelop
IDE o in modalità indipendente. QtDesigner può essere eseguito sotto Windows
ed è parte integrante anche della suite di sviluppo Visual Studio. Per ulteriori
informazioni su Qt Designer, consultare http://trolltech.com/
products/qt/designer.html.

Subversion
Subversion svolge esattamente lo stesso compito di CVS, ma offre miglioramenti
più significativi, come la possibilità di spostare, rinominare e allegare meta-
informazioni a file e directory. La home page di Subversion è disponibile
all'indirizzo http://subversion.tigris.org/.
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Valgrind
Valgrind è una suite di programmi per il debugging e il profiling di applicazioni
x86. Per ulteriori informazioni su Valgrind, consultarehttp://valgrind.org/
info/.
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DUtilizzo di un lettore di
impronte digitali
Mediante il driver ThinkFinger, SUSE Linux Enterprise® supporta il lettore di impronte
digitali di UPEK/SGS Thomson Microelectronics fornito con alcuni ThinkPad di IBM
e Lenovo. Lo stesso lettore di impronte digitali può essere anche incluso in altri computer
portatili come dispositivo autonomo o incorporato in alcune tastiere USB. Per ulteriori
informazioni, fare riferimento a http://thinkfinger.svn.sourceforge
.net/viewvc/*checkout*/thinkfinger/README.in. Se il sistema include
il lettore di impronte digitali, è possibile utilizzare l'autenticazione biometrica oltre a
quella standard mediante login e password. Dopo aver registrato la propria impronta
digitale, gli utenti possono eseguire il login al sistema poggiando un dito sul lettore di
impronte digitali o immettendo una password.

Se un controllo hardware rileva il lettore di impronte digitali integrato nel computer
portatile, oppure collegato al sistema, i pacchetti libthinkfinger,
pam_thinkfinger e yast2-fingerprint-reader vengono installati
automaticamente.

Attualmente è possibile registrare solo un'impronta digitale per utente. Le informazioni
sull'impronta digitale dell'utente vengono salvate in /etc/pam
_thinkfinger/login.bir. Per gestire l'autenticazione basata su impronte digitali,
utilizzare YaST. A questo scopo consultare Sezione D.2, "Gestione di impronte digitali
con YaST" (p. 364) o lo strumento a riga di comando tf-tool che include opzioni
aggiuntive (vedere Sezione D.3, "Gestione di impronte digitali con tf-tool" (p. 367)).
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D.1 Applicazioni e azioni supportate
Il modulo PAM pam_thinkfinger supporta l'autenticazione con impronta digitale
per le seguenti applicazioni e azioni (anche se non sempre può venire richiesto di
poggiare il dito):

• Login a GDM/KDM o a una shell di login

• Sblocco dello schermo sul desktop GNOME/KDE

• Avvio di YaST e dei moduli YaST

• Avvio di un'applicazione con autorizzazione root: sudo o gnomesu

• Cambio in un'altra identità utente con su o su - nome utente

D.2 Gestione di impronte digitali con
YaST

Procedura D.1 Abilitazione dell'autenticazione basata su impronta digitale

Per consentire l'autenticazione biometrica ad alcuni utenti, in genere è innanzitutto
necessario abilitare il supporto per limpronta digitale in YaST.

1 Avviare YaST e selezionareHardware > Fingerprint Reader (Lettore di impronte
digitali).
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2 Attivare Use Fingerprint Reader (Usa lettore di impronte digitali) nella finestra
di dialogo di configurazione, quindi fare clic su Finish (Fine) per salvare le
modifiche e chiudere la finestra di dialogo.

È ora possibile registrare un'impronta digitale per vari utenti.

Procedura D.2 Registrazione di un'impronta digitale

1 In YaST, fare clic su Sicurezza e utenti > Gestione utenti per aprire la finestra di
dialogo Amministrazione utenti e gruppi. Verrà visualizzato un elenco degli utenti
e dei gruppi disponibili nel sistema.

2 Selezionare l'utente per cui si desidera registrare un'impronta digitale e fare clic
su Modifica.

3 Nella scheda Plug-Ins (Plug-in) selezionare la voce relativa all'impronta digitale
e fare clic su Launch (Avvia) per aprire la finestra di dialogo Fingerprint
Configuration (Configurazione impronta digitale).

4 In YaST verrà chiesto all'utente di poggiare un dito finché non sono state raccolte
tre impronte digitali leggibili.
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5 Una volta acquisita l'impronta digitale, fare clic su Accept (Accetta) per chiudere
la finestra di dialogo Fingerprint Configuration (Configurazione impronta
digitale) e quella relativa all'utente.

6 Se si desidera utilizzare l'autenticazione basata su impronte digitali per avviare
YaST o i moduli YaST, è necessario registrare un'impronta digitale anche per
root.

A questo scopo, impostare il filtro nella finestra di dialogo Amministrazione
utenti e gruppi su Utenti del sistema, selezionare la voce relativa a root e
registrare un'impronta digitale come già descritto.

7 Dopo aver registrato le impronte digitali degli utenti desiderati, fare clic su Finish
(Fine) per chiudere la finestra di dialogo di amministrazione e salvare le
modifiche.

Dopo aver registrato l'impronta digitale dell'utente, quest'ultimo può scegliere di
effettuare l'autenticazione mediante l'impronta digitale o la password per le azioni e le
applicazioni elencate in Sezione D.1, "Applicazioni e azioni supportate" (p. 364).

YaST non consente attualmente di verificare o rimuovere le impronte digitali ma è
possibile eseguire queste operazioni dalla riga di comando. Per ulteriori informazioni
consultare Verifica o rimozione di un'impronta digitale (p. 367).

YaST consente inoltre di importare i file delle impronte digitali (*.bir) già archiviati
nel file system. Fare clic su Hardware > Fingerprint Reader (Lettore di impronte
digitali) e selezionare o specificare la Directory with fingerprint files (Directory con
file delle impronte digitali). Fare clic su Finish (Fine) per avviare l'importazione. I file
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delle impronte digitali verranno copiati in/etc/pam_thinkfinger/login.bir,
vale a dire la directory di default per i file delle impronte digitali.

D.3 Gestione di impronte digitali con
tf-tool

Procedura D.3 Registrazione di un'impronta digitale

1 Aprire una shell ed eseguire il login come root.

2 Per registrare un'impronta digitale per un determinato utente, immettere
tf-tool --add-user login

In tf-tool verrà chiesto all'utente di poggiare il dito finché non sono state
raccolte tre impronte digitali leggibili.

3 Se si desidera utilizzare l'autenticazione basata su impronte digitali per avviare
YaST o i moduli YaST nel Centro di controllo NOME, è necessario registrare
un'impronta digitale anche per root.

Dopo aver registrato l'impronta digitale dell'utente, quest'ultimo può scegliere di
effettuare l'autenticazione mediante l'impronta digitale o la password per le azioni e le
applicazioni elencate in Sezione D.1, "Applicazioni e azioni supportate" (p. 364).

Procedura D.4 Verifica o rimozione di un'impronta digitale

1 Aprire una shell ed eseguire il login come root.

2 Per verificare un'impronta digitale esistente per un determinato utente, eseguire
il seguente comando:
tf-tool --verify-user login

3 Lasciare che l'utente poggi il dito. In tf-tool l'impronta digitale verrà
confrontata con la stampa memorizzata per l'utente in questione e, se le impronte
digitali corrispondono, verrà visualizzato un messaggio.
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4 Per rimuovere l'impronta digitale di un utente, eliminare il relativo file utilizzando
il seguente comando:
shred /etc/pam_thinkfinger/login.bir

Con tf-tool --acquire è possibile effettuare test con tf-tool. L'impronta
digitale verrà archiviata come /tmp/test.bir e può essere verificata con tf-tool
--verify.

D.4 Ulteriori informazioni
• La home page del progetto è disponibile su http://thinkfinger
.sourceforge.net/

• Per ulteriori dettagli tecnici, consultare /usr/share/doc/packages/
libthinkfinger/README nel sistema installato.

• È inoltre disponibile una documentazione man per pam_thinkfinger e
tf-tool.
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ESupporto di tablet PC
SUSE Linux Enterprise® viene fornito con il supporto dei tablet PC per i dispositivi
Wacom seriali. Benchè la maggior parte del processo di installazione sia uguale quello
degli altri sistemi, è necessario aggiungere manualmente alcuni pacchetti. È quindi
necessario configurare correttamente il dispositivo di immissione.

NOTA: funzionalità dei tablet PC nelle architetture a 64 bit

Attualmente il supporto per il tablet PC è disponibile solo per le architetture
a 32 bit. Per utlilizzare le funzionalità di un tablet PC nelle architetture a 64 bit,
è necessario installare un sistema a 32 bit.

Dopo aver installato i pacchetti per il tablet PC e aver configurato correttamente il
digitalizzatore, è possibile utilizzare la penna, o stilo, come dispositivo di immissione
per eseguire le seguenti azioni e applicazioni:

• Login a KDM o GDM

• Sblocco dello schermo sui desktop KDE e GNOME

• Azioni che è possibile attivare da altri dispositivi di puntamento, quali mouse o
touch pad, ad esempio lo spostamento del cursore sullo schermo, l'avvio di
applicazioni, il ridimensionamento e lo spostamento di finestre, l'attivazione di
un'altra finestra e il trascinamento di oggetti.

• Utilizzo del riconoscimento dei segni nelle applicazioni di X Window System

• Disegno con The GIMP



• Annotazioni e schizzi con applicazioni quali Jarnal o Xournal o modifica di porzioni
più ampie di un testo con Dasher.

NOTA: tastiera o mouse necessario per l'installazione

Durante l'installazione di SUSE Linux Enterprise non è possibile utilizzare la
penna come dispositivo di immissione. Se il tablet PC in uso non supporta una
tastiera o un touch pad incorporato, collegare il tablet PC a una tastiera o un
mouse esterno per l'installazione del sistema.

E.1 Installazione di pacchetti per
tablet PC

Poiché YaST non rileva automaticamente i tablet PC, è possibile installare ulteriori
pacchetti durante o dopo l'installazione del sistema. Il modello di installazione del
tabletPC contiene i seguenti pacchetti:

• jarnal: un'applicazione per annotazioni basata su Java

• xournal: un'applicazione per annotazioni e schizzi

• xstroke: un'applicazione per il riconoscimento dei segni per X Window System

• xvkbd: una tastiera virtuale X Window System

• x11-input-wacom: il modulo di immissione X per tablet Wacom

• x11-input-wacom-tools: configurazione, diagnostica e librerie per tablet
Wacom

È possibile installare i pacchetti manualmente dalla riga di comando oppure selezionare
il modello per l'installazione in YaST.

1 Avviare il package manager di YaST dalla riga di comando o aprire YaST e
selezionare Software > Gestione pacchetti.

2 Per Filtro, selezionareModello per visualizzare i pacchetti disponibili raggruppati
in modelli.
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3 Nel gruppo Software aggiuntivi selezionare il modello TabletPC per
l'installazione.

4 Fare clic su Accept (Accetta) per avviare l'installazione dei pacchetti.

E.2 Configurazione del dispositivo
Wacom

Dopo aver installato i pacchetti Tablet PC, configurare il dispositivo tablet. SUSE Linux
Enterprise attualmente non supporta la configurazione dei dispositivi Wacom con SaX2.
È quindi necessario modificare un file di configurazione del sistema. Solo
l'amministratore del sistema può apportare modifiche al file /etc/X11/xorg.conf.

AVVERTIMENTO: una configurazione errata di X può danneggiare i
componenti hardware

Prima di modificare il file /etc/X11/xorg.conf, creare una copia di backup
del file originale. Non modificare le altre sezioni del file per evitare di
danneggiare i componenti hardware.

Per i dispositivi Wacom, aggiungere un paio di righe a /etc/X11/xorg.conf come
illustrato in Esempio E.1, "Configurazione per dispositivi Wacom" (p. 372).
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Esempio E.1 Configurazione per dispositivi Wacom

1. Aggiungere le seguenti sezioni InputDevice:
  Section "InputDevice" ❶
    Driver       "wacom"
    Identifier   "Mouse[5]"
    Option       "Device" "/dev/ttyS0"
    Option       "ForceDevice" "ISDV4"
    Option       "InputFashion" "Tablet"
    Option       "Mode" "Absolute"
    Option       "SendCoreEvents" "on"
    Option       "Type" "cursor"
  EndSection

  Section "InputDevice" ❷
    Driver       "wacom"
    Identifier   "Mouse[7]"
    Option       "Device" "/dev/ttyS0"
    Option       "ForceDevice" "ISDV4"
    Option       "InputFashion" "Pen"
    Option       "Mode" "Absolute"
    Option       "Type" "stylus"
  EndSection

  Section "InputDevice" ❸
    Driver       "wacom"
    Identifier   "Mouse[9]"
    Option       "Device" "/dev/ttyS0"
    Option       "ForceDevice" "ISDV4"
    Option       "InputFashion" "Eraser"
    Option       "Mode" "Absolute"
    Option       "Type" "eraser"
  EndSection

❶ Configurazione per il dispositivo di immissione cursore tavoletta connesso
a /dev/ttyS0. Se si utilizza un dispositivo HP Compaq tc4200, provare
/dev/ttyS2. Al dispositivo viene assegnato l'identificatore"Mouse[5]"
per evitare problemi nelle versioni successive di SaX2.

❷ Configurazione per il dispositivo di immissione stilo tavoletta.

❸ Configurazione per il dispositivo di immissione gomma tavoletta. In alcune
applicazioni è possibile utilizzare questa parte della penna per cancellare
l'immissione.
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2. Aggiungere le seguenti linee nella sezione ServerLayout:
  InputDevice  "Mouse[5]" "SendCoreEvents"
  InputDevice  "Mouse[7]" "SendCoreEvents"
  InputDevice  "Mouse[9]" "SendCoreEvents"

Con queste modifiche /etc/X11/xorg.conf sarà simile a:
   [...]

   Section "InputDevice"  ❶
     Driver       "mouse"
     Identifier   "Mouse[3]"
     Option       "Buttons" "5"
     Option       "Device" "/dev/input/mice"
     Option       "Name" "ImPS/2 Generic Wheel Mouse"
     Option       "Protocol" "explorerps/2"
     Option       "Vendor" "Sysp"
     Option       "ZAxisMapping" "4 5"
   EndSection

   Section "InputDevice"  ❷
     Driver       "wacom"
     Identifier   "Mouse[5]"
     Option       "Device" "/dev/ttyS0"
     Option       "ForceDevice" "ISDV4"
     Option       "InputFashion" "Tablet"
     Option       "Mode" "Absolute"
     Option       "SendCoreEvents" "on"
     Option       "Type" "cursor"
   EndSection

   Section "InputDevice"  ❸
     Driver       "wacom"
     Identifier   "Mouse[7]"
     Option       "Device" "/dev/ttyS0"
     Option       "ForceDevice" "ISDV4"
     Option       "InputFashion" "Pen"
     Option       "Mode" "Absolute"
     Option       "Type" "stylus"
   EndSection

   Section "InputDevice" ❹
     Driver       "wacom"
     Identifier   "Mouse[9]"
     Option       "Device" "/dev/ttyS0"
     Option       "ForceDevice" "ISDV4"
     Option       "InputFashion" "Eraser"
     Option       "Mode" "Absolute"
     Option       "Type" "eraser"
   EndSection
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   [...]

   Section "ServerLayout"
     Identifier   "Layout[all]"
     InputDevice  "Keyboard[0]" "CoreKeyboard"
     InputDevice  "Mouse[1]" "CorePointer"
     InputDevice  "Mouse[3]" "SendCoreEvents"
     InputDevice  "Mouse[5]" "SendCoreEvents"  ❺
     InputDevice  "Mouse[7]" "SendCoreEvents"  
     InputDevice  "Mouse[9]" "SendCoreEvents"  
     Option       "Clone" "off"
     Option       "Xinerama" "off"
     Screen       "Screen[0]"
   EndSection

❶ Configurazione di default del mouse.

❷ Configurazione appena aggiunta per il dispositivo di immissione cursore
della tavoletta.

❸ Configurazione appena aggiunta per il dispositivo di immissione stilo della
tavoletta.

❹ Configurazione appena aggiunta per il dispositivo di immissione gomma
della tavoletta.

❺ I dispositivi di immissione della tavoletta "Mouse[5]", "Mouse[7]" e
"Mouse[9]" vengono aggiunti ai dispositivi server X.

Questa configurazione di esempio è supportata dalla maggior parte dei Tablet PC.
Per ulteriori informazioni, consultare gli articoli procedurali sul sito Web di Linux
Wacom:http://linuxwacom.sourceforge.net/index.php/howto/
x11.

3. Al termine della configurazione di X Window System, riavviare il server X
eseguendo il log out oppure uscire dall'interfaccia ed eseguire init 3 && init
5 in una console virtuale.
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E.3 Utilizzo delle funzionalità comuni
di un tablet PC

Dopo aver configurato il dispositivo Wacom, è possibile utilizzare la penna come
dispositivo di immissione.

E.3.1 Utilizzo della tastiera virtuale
Per eseguire il login al desktop KDE o GNOME oppure per sbloccare lo schermo, è
possibile immettere il nome utente e la password come di consueto oppure tramite la
tastiera virtuale xvkbd, visualizzata sotto il campo di login. Per configurare la tastiera
o accedere alla guida integrata, fare clic sul campo xvkbd nell'angolo in basso a sinistra
per aprire il menu principale di xvkbd.

Figura E.1 Tastiera virtuale xvkbd

Per utilizzare xvkbd dopo il login, avviarla dal menu principale oppure digitare xvkbd
in una shell.

E.3.2 Rotazione del display
Quando si ruota il monitor del tablet PC, l'orientamento del display o della tavoletta
grafica non viene regolato automaticamente. Per il desktop KDE utilizzare KRandRTray
per ruotare o ridimensionare manualmente il display al volo. KRandRTray è un applet
KDE per l'estensione RANDR del server X.
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1 Avviare KRandRTray dal menu principale oppure digitare krandrtray in una
shell. Verrà aggiunta l'icona KRandRTray nella barra delle applicazioni.

2 Per ruotare il display, fare clic sull'icona e selezionare l'orientamento desiderato
dal menu di scelta rapida. Il display verrà inclinato immediatamente secondo la
nuova direzione. Anche l'orientamento della tavoletta grafica cambia in modo
da interpretare correttamente il movimento della penna.

Per il desktop GNOME attualmente è possibile ottenere una funzionalità simile solo
tramite un work-around. Per ulteriori informazioni, vedere la Sezione E.4, "Soluzione
dei problemi" (p. 379).

E.3.3 Utilizzo del riconoscimento dei segni
xstroke consente di utilizzare i segni creati con la penna o un altro dispositivo di
puntamento come input per le applicazioni in X Window System. xstroke utilizza un
alfabeto unistroke, simile al Graffiti*. xstroke, quando attivato, invia l'input alla finestra
attualmente in primo piano.

1 Avviare xstroke dal menu principale oppure digitando xstroke in una shell.
Verrà aggiunta un'icona nella barra delle applicazioni.

2 Avviare l'applicazione in cui si desidera creare l'immissione di testo con la penna,
ad esempio una finestra di terminale, un editor di testo o OpenOffice.org Writer.

3 Per attivare la modalità di riconoscimento dei segni, fare clic una volta sull'icona
a forma di matita.

4 Creare alcuni segni sulla tavoletta grafica utilizzando la penna o un altro
dispositivo di puntamento. xstroke cattura i segni e li trasferisce al testo
visualizzato nella finestra dell'applicazione attiva.

5 Per attivare un'altra finestra, fare clic su di essa con la penna e tenere permuto
per alcuni istanti, oppure utilizzare le scorciatoie della tastiera specificate nel
centro di controllo del desktop.

6 Per disattivare la modalità di riconoscimento dei segni, fare di nuovo clic sull'icona
a forma di matita.
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E.3.4 Annotazioni e schizzi con la penna
Per creare disegni con la penna, è possibile utilizzare un editor di grafica professionale
quale The GIMP oppure un'applicazione per annotazioni quale Xournal o Jarnal. Xournal
e Jarnal consentono di prendere appunti, creare disegni o aggiungere commenti nei file
PDF utilizzando la penna. Jarnal è un'applicazione basata su Java disponibile per più
piattaforme e include quindi funzionalità di base per la collaborazione. Per ulteriori
informazioni, fare riferimento a http://www.dklevine.com/general/
software/tc1000/jarnal-net.htm. Quando si salvano contenuti, in Jarnal
questi dati vengono memorizzati in un formato archivio (*.jaj) che contiene anche un
file nel formato SVG.

Avviare Jarnal o Xournal dal menu principale oppure immettendojarnal o xournal
in una shell. Per commentare un file PDF ad esempio in Xournal, selezionare File >
Annotate PDF (Annota PDF) e aprire il file PDF dal file system. Utilizzare la penna o
un altro dispositivo di puntamento per inserire annotazioni nel file PDF, quindi salvare
le modifiche selezionando File > Print to PDF (Stampa in PDF).

Figura E.2 Aggiunta di annotazioni a un file PDF con Xournal
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Dasher è un'altra applicazione utile poiché è stata progettata per i casi in cui non è
possibile l'immissione con la tastiera. Dopo un po' di esercizio sarà possibile immettere
velocemente molto più testo utilizzando solo la penna o un altro dispositivo o addirittura
un eye tracker.

Avviare Dasher dal menu principale oppure immettendoxstroke in una shell. Spostare
la penna in una direzione per ingrandire le lettere sulla destra. Il testo viene creato o
anticipato in base alle lettere che attraversano il mirino e quindi viene stampato nella
parte superiore della finestra. Per interrompere la scrittura o iniziare a scrivere, fare clic
una volta sul display con la penna. Modificare la velocità di zoom nella parte inferiore
della finestra.

Figura E.3 Modifica di testi con Dasher

Dasher supporta molte lingue. Per ulteriori informazioni, consultare il sito Web di
Dasher che include una documentazione esauriente, dimostrazioni e testi con istruzioni.
Disponibile all'indirizzohttp://www.inference.phy.cam.ac.uk/dasher/
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E.4 Soluzione dei problemi
La tastiera virtuale non viene visualizzata nella schermata di login

Ogni tanto la tastiera virtuale non viene visualizzata nella schermata di login. Per
risolvere questo problema, riavviare il server X premendo Ctrl + Alt + <— oppure
premere il tasto appropriato sul Tablet PC (se si utilizza un modello a lavagna senza
tastiera integrata). Se la tastiera virtuale non viene ancora visualizzata, collegare
una tastiera esterna al modello a lavagna ed eseguire il login utilizzando la tastiera
hardware.

L'orientamento delle tavolette grafiche non cambia in GNOME
Utilizzare il comando xrandr per cambiare l'orientamento del display in una shell.
Per visualizzare le opzioni disponibili, digitare xrandr --help. Per cambiare
contemporaneamente l'orientamento della tavoletta grafica, è necessario modificare
il comando come descritto di seguito:

• Per l'orientamento normale (rotazione di 0°):
xrandr -o 0 && xsetwacom set "Mouse[7]" Rotate 0

• Per una rotazione di 90° (senso orario, verticale):
xrandr -o 3 && xsetwacom set "Mouse[7]" Rotate 1

• Per una rotazione di 180° (orizzontale):
 xrandr -o 2 && xsetwacom set "Mouse[7]" Rotate 3

• Per una rotazione di 270° (senso antiorario, verticale):
 xrandr -o 1 && xsetwacom set "Mouse[7]" Rotate 2

I comandi appena illustrati dipendono dal contenuto del file di configurazione
/etc/X11/xorg.conf. Se è stata utilizzata la configurazione di esempio
descritta in Esempio E.1, "Configurazione per dispositivi Wacom" (p. 372), i comandi
funzioneranno così come sono stati scritti. Se è stato modificato
l'identificatore del dispositivo di immissione stilo della tavoletta in xorg
.conf, sostituire "Mouse[7]" con il nuovo Identificatore.
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E.5 Ulteriori informazioni
Alcune delle applicazioni descritte in questo paragrafo non supportano la Guida online
integrata. È tuttavia possibile trovare utili informazioni sull'utilizzo e la configurazione
nel sistema installato in /usr/share/doc/package/nome pacchetto o sul
Web:

• Per il manuale di Xournal, vedere http://xournal.sourceforge.net/
manual.html

• La documentazione su Jarnal è disponibile in http://www.dklevine.com/
general/software/tc1000/jarnal.htm#documentation

• La manpage di xstroke è disponibile in http://davesource.com/
Projects/xstroke/xstroke.txt

• Un HOWTO per la configurazione di X è disponibile sul sito Web di Linux Wacom:
http://linuxwacom.sourceforge.net/index.php/howto/x11

• Un sito Web molto istruttivo sul progetto Dasher è http://www.inference
.phy.cam.ac.uk/dasher/
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